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Amendment Transmittal 
 

A Reasons for Amendment 
 
Paragraph 10.5 has been added to show the change to the View Contract Screen for SHIPP 
contracts.  
 
Paragraph 49 has been amended to clarify action taken before a transfer.  
 
Paragraphs 159 through 166 have been added to provide procedure for dividing and transferring 
TIP contracts. 

 
Paragraph 251 has been amended to: 
 
 remove eligibility requirements for Federal Crop Insurance 
 provide that a grower of a controlled substance is eligible to receive CRP and TIP payments. 
 
Paragraph 282 has been amended to provide instances when the “Make NPS Payment” option 
must be taken by a user. 
 
Paragraphs 284 and 285 have been amended to include TIP as a payment type for “make NPS 
Payment”. 
 
Paragraph 287 has been added to include screens of exceptions when PIP payments are 
attempted on CRP contracts that are not eligible to receive PIP or the PIP must be issued from 
Cost Share System. 
 
Paragraph 307 has been amended to include TIP as a payment type for “Cancel NPS Payment”. 
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Amendment Transmittal (Continued) 
 

A Reasons for Amendment (Continued) 
 

Paragraphs 393 and 398 have been amended to include TIP contracts available under the 
“Update AGI” option. 
 
Paragraph 409 has been amended to include TIP contracts available under the “Load AGI” 
option. 
 
Paragraph 411 has been amended to include TIP contracts available under the: 

 
• “Load AGI” option 
• “Obligate Payment” option. 
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Par. 1 
Part 1    Basic Provisions 

 
1  Overview  
 

A Handbook Purpose 
 
This handbook provides instructions for CCMS and the Conservation Payments Application.   
 

B Related Handbooks 
 

The following FSA handbooks are related to CRP contract and payment software. 
 

IF question is about… THEN see… 
signature requirement, power of attorney, and maintaining the name 
and address file common provisions 

1-CM. 

constitution of farms 10-CM. 
maintaining farm, tract, and crop data through maintenance 10-CM. 
acreage determinations 2-CP. 
payment reductions and violations 4-CP. 
HEL and WC provisions 6-CP. 
depositing remittances 3-FI. 
accounting payment process 6-FI. 
claims and withholdings 58-FI. 
handling prompt payment interest penalties 61-FI. 
reporting data to IRS 62-FI. 
assignments and joint payees 63-FI. 
establishing and reporting receivables in NRRS 64-FI. 
information available to the public 2-INFO. 
payment limitations 1-PL, 4PL, or 5-PL. 
subsidiary files 2-PL. 
web-based subsidiary files 3-PL  
CRP Policy  2-CRP. 

 
C Sources of Authority 
 

Sources of authority for CRP are: 
 
• the Food Security Act of 1985, as amended  
• 7 CFR Part 1410 
• annual appropriations acts. 

 
2-5  (Reserved) 
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Par. 6 
Part 2    CCMS 

 
6  General Information 
 

A Purpose 
 
CCMS is web-based software that allows FSA State and County Office users to perform 
maintenance activities for, and allows National Office users to view and print, CRP contracts. 
 
This part will provide instructions for CCMS. 
 

B CCMS Functions 
 
Within CCMS, users can perform the following functions: 
 
• searching contracts 

 
• viewing and printing contracts 

 
• updating tract numbers and CLU’s on System 36 migrated contracts 

 
• revising contracts that includes the following: 

 
• adding or removing  

 
• conservation practices 
• farm and tract numbers 
• producers 

 
• adjusting acreage 

 
• cancelling revisions 

 
• submitting revisions for COC approval 
 

• dividing contracts that includes the following: 
 
• adjusting acreage 

 
• cancelling divisions 

 
• completing divisions for placeholder contracts 

 
• creating child contracts 

 
• entering COC approval of divisions 

 
• finalizing divisions 
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Par. 6 
6  General Information (Continued) 
 

B CCMS Functions (Continued) 
 

• initiating divisions 
 
• revising  

 
• farms and tracts 
• practices 
• producers 

 
• terminating contracts 
 
• reinstating contracts 
 
• transferring contracts 
 
• entering approvals for contract changes 
 
• dividing predecessor-successor payments 
 
• correcting start dates 
 
• revising rental rates 
 
• generating reports. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5-15-19     5-CRP Amend. 1 Page 2-2  



Par. 6 
6  General Information (Continued) 
 

C Systematic Conversion of COLS CRP Offers to CCMS Contracts 
 
When an offer has been approved and the user enters the COC approval date for the offer in 
COLS, COLS will systematically send the data to CCMS to create a new contract.  CCMS 
will create the contract and return the contract number to COLS.  The following CRP Screen 
will be displayed in COLS with the message, “The offer is converted to contract in Contract 
Maintenance System.  Contract Number is XXX.”, CLICK “OK”.  COLS will save the 
contract number with the offer detail. 
 

 
 
CCMS will automatically send a message to: 
 
• the Conservation Payments software to update the producer’s AGI information 

 
• update FRS for the cropland and/or MPL acres associated with the farm on the contract 

 
Note: Obligations for the annual payment will be handled in the background.  If there 

are CRP-SIP’s or practice incentive payments on the contract, users will need to 
enter them into the Conservation Payments software.  The Conservation Payments 
software will obtain and save AGI eligibility for each producer on the contract, 
and process the obligations for the Annual Payment.  CCMS will update FRS data 
with the new contract information at the farm level.  

 
Important: The contract acreage associated with the tract will require FRS 

updates by the user. 
 

D Acreage Allocations 
 
CCMS will provide the total number of acres that have been approved for CRP so COC can 
compute the available allocated acres for a new contract when the offer is submitted for COC 
approval. 
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Par. 7 
Section 1    Basic Functions 

 
7  Accessing CCMS 
 

A Logging Into CCMS 
 
The following table provides the steps to access CCMS. 
 
Note: Always access CCMS using Internet Explorer.  
 

Step Action 
1 Access the FSA Applications page at   

http://fsaintranet.sc.egov.usda.gov/fsa/applications.asp 
2 From the FSA Intranet Screen, under “FSA Applications”, “Applications 

Directory”, CLICK “A-C”, then select “Conservation CCMS – Conservation 
Contract Maintenance System”. 

3 On the USDA eAuthentication Warning Screen, CLICK “I Agree” to proceed or 
“Cancel” to end the process. 

4 If user clicks “I Agree”, user must do either of the following: 
 
• enter eAuthentication user ID and password, and CLICK “Login” 
• CLICK “Login with my LincPass”. 
 
Note: If user is unable to log in, contact the eAuthentication Help Desk by either of 

the following: 
 
• e-mail to eAuthHelpDesk@usda.gov 
• telephone at 800-457-4642. 
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Par. 7 
7  Accessing CCMS (Continued) 
 

A Logging Into CCMS (Continued) 
 

Step Action 
5 The Welcome to the Conservation Contract Maintenance System Screen will be 

displayed.  Under “CCMS Menu”, CLICK “Search Contract”. 
 

 
 

B Access Levels 
 
County Office users have access to all phases of contracts.  National and State Office users 
can view and print contracts using the “Search Contract” function and generate reports using 
the “Generate Reports” function.   Authorized State Office users can also correct contract 
start dates. 
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Par. 8 
8  Search Contract Screen  
 

A Overview 
 
The Search Contract Screen will allow users to search by multiple criteria.  Users are 
required to select “Admin State” and “Admin County”.  No other fields are required.  The 
more fields the user completes the more specific the search will be. 

 
B Example of Search Contract Screen   

 
Following is an example of the Search Contract Screen. 
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Par. 8 
8  Search Contract Screen (Continued) 
 

C  Search Contract Options   
 

The following options are available on the Search Contract Screen. 
 

 
Field/Button 

 
Description/Action 

Required 
Entry 

Admin State All administrative states associated with the user’s 
EAS profile will be displayed.     

Yes 

Admin County  All administrative counties associated with the users 
EAS profile for the Admin State selected will be 
displayed.   

Yes 

Program Type  CRP is the only option and CCMS will default to this 
selection.  

Yes 

Signup All CRP signups that have a contract in CCMS for the 
selected Admin State and County will be displayed.    

No 

Contract Number  User can enter the specific contract number to search.    
 
Note: If there is a child contract, include the alpha 

suffix, if it is known.  If there are child 
contracts and suffix is not entered, all contracts 
having the base contract number will be 
displayed. 

No 

Contract Status  All or a specific contract status can be selected.    No 
Program Year All program years for contracts in CCMS in the 

selected admin State and county will appear.  The user 
can only select one.    

No 

Producer Name  The SCIMS Customer Search page will be displayed.     No 
Farm Number   Enter the desired farm number to search. No 
Tract Number  Enter the desired tract number to search. No 
Search  Once selected, the user will be taken to the Select 

Contract Screen with the list of contracts that meet the 
entered search criteria.     

 

Reset  All search fields will be removed, no search will be 
executed.    
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Par. 8 
8  Search Contract Screen (Continued) 
 

D Error Messages 
 

The error message “There were no Contracts found.  Please revise your search criteria and try 
again” may be displayed on the Search Contract Screen.  This error means that the entered 
search criteria did not return any results.  Users must revise the search criteria before 
proceeding to the next applicable page.  
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Par. 9 
9  Select Contract Screen  
 

A Overview  
 
The Select Contract Screen will return all contracts that match the search criteria entered on 
the Search Contract Screen.   The screen will display 10 entries at a time.  If the search 
returns more than ten entries, users will see arrows and numbers displayed at the bottom of 
the results.  These arrows and numbers will help users navigate to different pages.  If users 
click: 

 
• “left arrow with a bar”, the first page of the list will be displayed 
• “left arrow”, the previous page will be displayed 
• a “number”, that specific page numbers will be displayed 
• “right arrow”, the next page will be displayed 
• “right arrow with a bar”, the last page of the list will be displayed. 

 
B Example of Select Contract Screen   

 
Following is an example of the Select Contract Screen. 
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Par. 9 
9  Select Contract Screen (Continued) 
 

C  Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Select Contract Screen.  
  

Field/Button Description  Action 
Admin State The administrative State selected 

on the Search Contract Screen will 
be displayed.  

 

Admin County  The administrative county selected 
on the Search Contract Screen will 
be displayed. 

 

Contract Number The contract numbers that meet 
the search criteria entered on the 
Search Contract Screen will be 
displayed.  

CLICK “Contract Number”. 

Farm Number  Farm Number listed on the 
contract will be displayed. 

 

Tract Number  Tract Number listed on the 
contract will be displayed. 

 

Contract Acres  Number of acres on the contract 
will be displayed. 

 

Status  Contract status will be displayed.   
Contract 
Description  

The data entered in the contract 
description of the CRP contract 
will be displayed.  

 

Signup Name The applicable signup name for 
the contract will be displayed.  

 

Program Year  The applicable program year for 
the contract will be displayed. 

 

Modify Search User will be returned to the Search 
Contract Screen and all prior 
entered details will be displayed. 

CLICK “Modify Search”. 

Back User will be returned to the Search 
Contract Screen and all fields will 
be reset. 

CLICK “Back”. 
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Par. 10 

10  View Contract Screen 

 

A Overview 

 

After user has selected a contract, the View Contract Screen will be displayed.  This screen 

provides the general contract details and the links for maintenance. 

 

Note: The View Contract Screen will also be displayed when maintenance functions are 

completed. 

 

The View Contract Screen defaults to a “View Less Detail” display.  To view all contract 

details, users shall select the “View More Detail” link. 

 

B Example of View Contract Screen 

 

Following is an example of the top of the View Contract Screen. 
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Par. 10 

10  View Contract Screen (Continued) 

 

B Example of View Contract Screen (Continued) 

*-- 

 
--* 
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Par. 10 
10  View Contract Screen (Continued)  
 

C Field Descriptions 
 

The following table provides the field descriptions for the View Contract Screen. 
  

Field  Description  
Contract Status  The current status of the contract will display.  
Activity Type  No Activity, Divide, or Revise will be displayed based on the 

maintenance being done to the contract.  
Admin State The administrative State of the contract.   
Admin County  The administrative county of the contract.  
Physical State  The physical location State of the tract associated with the 

contract.  
Physical County  The physical location county of the tract associated with the 

contract. 
Contract Number The contract number that was selected on the Select Contract 

Screen.   
Signup Number  The applicable signup number recorded for this contract.  
Program Type  Will display CRP. 
Signup Name  The applicable signup name recorded for this contract. 
Program Year  The program year associated with this contract.  This value is 

set to the program year of the first month the contract was 
effective.  

Signup Type  The applicable signup type recorded for this contract. 
Contract Description  This field will display the contract description entered in the 

TERRA/COLS process. 
  
Note: Will be blank for S36 migrated contracts.  

Subcategory Type  The applicable CRP subcategory recorded for this contract. 
Parent Contract This field will only be visible if the contract has been modified. 

The contract number listed will display a hyperlink to the View 
Contract Screen of the parent contract.   

Child Contract This field will only be visible if the contract has been modified 
and the contract the user is viewing has been subsequently 
revised.  The contract number(s) listed will display a hyperlink 
to the View Contract Screen of any child contracts.  

Approval Date  This field will display the COC approval date entered for this 
contract.  

Original Contract 
Start Date 

This field will display the original contract start date for the 
contract family.    

Revised Contract 
Start Date  

Will display the start date of the revised contract.  If the 
contract has never been revised the field will display a N/A.  
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Par. 10 
10  View Contract Screen (Continued)  
 

C  Field Descriptions (Continued) 
 

Field  Description  
Contract End Date The last day the contract is active.  Updated if the contract is 

modified.  Only active contracts will display the original end 
date.   

Contract Acres  The number of acres in hundredths for the contract 
Re-Enrolled Acres  The number of acres on this contract that were enrolled in CRP 

prior for this contract.   
Cropland Acres  Number of cropland acres in hundredths on the contract.  
Marginal Pastureland 
Acres 

Number of marginal pastureland acres in hundredths on the 
contract.  

Non-Cropland Acres  Number of non-cropland acres in hundredths on the contract.  
Only grassland contracts can have a value in this field.   

HUC Code The predominate HUC code of the contract as determined by 
TERRA/COLS. 

Extended  Yes or No. indicates if the contract has been extended. 
Approved for Early 
Out  

Yes or No. indicates if the contract was approved for an early 
out.  

Activity Reason(s) The reason selected in CCMS for a prior contract modification.  
Rate Information and PL Rule 

Effective Start Date  The first date the displayed rate went into effect.  
Effective End Date  The last day the displayed rate went into effect.  
Rental Rate per Acre  The per acre dollar value of the rental rate.  
Annual Contract 
Payment  

The potential full year value the contract will earn based on the 
contract acres multiplied by the rental rate.   
 
Note: This value is subject to further program and eligibility 

reductions.  
PL Rule  The payment limitation rule applicable to this contract.  
AGI Threshold  The AGI amount that the contract is subject to.  
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Par. 10 
10  View Contract Screen (Continued)  
 

C Field Descriptions (Continued) 
 

Field  Description  
Farm/Tract and CLU Information 

Farm Number  Farm number listed on the contract. 
Tract Number  Tract number listed on the contract.   

 
Note: Some S36 migrated contracts will display “unknown” if 

a tract number has not been previously entered.  This 
will need to be corrected before a modification can be 
made to the contract.  

CLU The CLU number(s) on the contract.  
 
Note: Some S36 migrated contracts will display “unknown” if 

a CLU number has not been previously entered.  This 
will need to be corrected before a modification can be 
made to the contract. 

CLU Acres  Number of acres in hundredths for each CLU entered. 
Producer Information 

Producer Name  The business or first and last name of all producers associated 
with the contract.  

Address Producer’s street address. 
City  Producer’s city of address. 
State Producer’s State of address.  
Zip  Producer’s zip code of address. 
Share  The percentage of share in the contract recorded to the 

hundredths value.  
Practice Information 

Practice Code  The practice code(s) associated with the contract.  
CLU The CLU number associated to the practice code.  
Practice Status  The practice status loaded for the practice.  
Practice Acres  The number of acres in hundredths for the practice.  
Estimated Cost Share 
per Practice  

The estimated cost share for the number of acres associated to 
that CLU and practice.  
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Par. 10 
10  View Contract Screen (Continued)  
 

C Field Descriptions (Continued) 
 

Field  Description  
Contract Extension Information 

 
This section will only display if a contract extension has been recorded on the contract. 
Contract Extension 
Type   

The name of the contract extension will be displayed.  

Rate  The annual rental rate for the extension time frame will be 
displayed.  

Effective Start Date  The start date of the extension time frame.  
Effective End Date   The end date of the extension time frame. 

Predecessor – Successor Division(s) of Payment Agreement 
 

This section will only display if an agreement has been recorded on the contract. 
Contract  The applicable contract numbers. 

 
Note: Only contracts that had active days in the same FY will be 

displayed.  
Annual Contract 
Payment  

The potential full year value the contract will earn based on the 
contract acres multiplied by the rental rate.   

Start of Period  The start of the applicable FY or effective start date of the contract. 
End of Period  The end of the applicable FY or last day the contract was active in 

that year.   
Days Active in 20XX Number of days the contract was active in the FY. 
Days in 20XX Total number of calendar days in that FY. 
Calculated Estimated 
Payment by Dates  

Annual contract payment divided by days in the FY multiplied by 
the number of active days in the FY.  

FY 20XX Payment 
Ratio  

This value will default as a percentage of the dollar value earned 
based on active days.  Users can enter a value between 0-100.  The 
total of all percentages must equal 100 percent.   

FY 20XX Estimated 
Payment  

This value will default as the dollar value earned based on active 
days or will be adjusted if the user adjusts the payment ratio shares.  
Users can also enter a dollar value in whole numbers.  The total of 
all dollars entered must equal the total value earned by all contracts 
in the table.  

Contract Reductions 
 

This section will only display if a contract reduction has been recorded on the contract. 
FY The fiscal year the reduction was applied.  
Reduction Amount  The total dollar amount that was reduced.  
Type  The reason code for the reduction. 
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Par. 10 

10  View Contract Screen (Continued) 

 

C Field Descriptions (Continued) 

 

Field Description 

Contract Reinstatement Information 

 

This section will only display if a contract reinstatement has been recorded on the contract. 

DAFP Approval Date The date in mm/dd/yyyy format that DAFP provided relief. 

Reason for 

Reinstatement 

The reason entered by the user during reinstatement. 

Date of Termination The reinstatement date entered during reinstatement. 

Reason for 

Termination 

The reason code selected during termination. 

*--Re-Enrolled Acres Information 

 

This section will only display if the contract has re-enrolled acres and started in 2020 and 

future years. 

CLU The CLU number or numbers on the contract. 

Expired Contract 

Number 

The contract number from the expired contract that was 

re-enrolled.  These contract numbers will contain a hyperlink.  

When selected, the user will be taken to the View Contract Page 

for that expired contract. 

Expired Signup Name The signup name of the expired contract will be displayed. 

Expired Practice Code The practice code from the expired contract will be displayed. 

Re-enrolled Acres The number of acres on this contract that were enrolled in CRP 

before this contract.--* 

 

D Actions 

 

The following table provides actions on the View Contract Screen. 

 

Field/Button Action 

Select a form to 

view 

The user must click on CRP-1 or, if applicable, CRP-41 to display the 

contract. 

Select an Action 

to Perform 

CRP-1 maintenance functions are provided on the View Contract 

Screen, “Select an action to perform” drop-down menu.  The available 

options will vary depending on CRP-1 status.  For approved CRP-1’s, 

users have the following options: 

 

●*--Correct > Adjust Re-Enrolled Acreage (paragraph 17) 

• Initiate > Divide (paragraph 80) 

• Initiate > Early Out (paragraph 66) 

• Initiate > Revise (paragraph 25) 

• Initiate > Revise Rates (paragraph 36)--* 
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Par. 10 

10  View Contract Screen (Continued) 

 

D Actions (Continued) 

 

Field Action 

Select an Action to 

Perform 

(Continued) 

•*--Initiate > TIP Enrollment (paragraph 152) 

• Initiate > Terminate (paragraph 38) 

• Initiate > Transfer (paragraph 49) 

• Refresh > Determine Contract Validity (paragraph 100) 

• Refresh > Farm Number (paragraph 15) 

• View > Division of Payment (paragraph 37) 

• View > Producer Subsidiary Year (paragraph 16) 

• View > Farm Number by Year (paragraph 15). 

Go The user will be taken to the action to perform the action selected 

from the drop-down menu.--* 

Back Returns the user to the Select Contract Screen. 

 

E Error Messages 

 

The View Contract Screen is set up to provide potential validation errors when comparing the 

contract to the current year in FRS.  If the user will be modifying the contract effective date 

in a prior FY, disregard the validation messages until they set the “Effective Start Date” 

during the modification.  The following error messages may be displayed. 

 

Error Message Description Corrective Action 

“Tract number is not 

found in farm records, 

correct tract number.” 

The tract number is either 

“unknown” or not active 

in FRS for the current 

FY. 

If the tract number is “unknown” 

and the farm number is current, 

users can take the correct tract/CLU 

action to perform.  If the farm 

number is not active or the tract 

number is present but not correct, 

the user should modify the contract 

to correct the tract number. 

“The unknown CLU 

number is not valid. 

Please correct the CLU 

number.” 

The CLU number is 

listed as “unknown”. 

If the CLU number is “unknown” 

and the farm number is current, 

users can take the correct tract/CLU 

action to perform.  If the farm 

number is not active or the tract 

number is present but not correct, 

the user should modify the contract 

to correct the CLU number or 

numbers. 
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Par. 10 

10  View Contract Screen (Continued) 

 

E Error Messages (Continued) 

 

Error Message Description Corrective Action 

“Farm number is not found in 

farm records, correct farm 

number.” 

The farm number is not 

active in the current FY. 

Correct the farm number by 

modifying the contact. 

“Producer X association to 

this farm in Farm Records 

has changed, please update 

the producer X.” 

The producer listed on the 

contract is no longer linked 

to the farm number on the 

contract for the applicable 

FY. 

Modify producer according 

to paragraph 29. 

“The total of share 

percentages must equal 100.” 

The shares for producers in 

CCMS do not equal 

100 percent. 

Correct producer’s share 

according to paragraph 29. 

“Owner X is not shown as a 

producer on the contract.  All 

owners associated with the 

tract in Farm Records must 

be on the contract, even if 

they are not receiving 

payments from the contract. 

Please add Owner X to the 

contract.” 

An owner as recorded in 

FRS is not recorded on the 

contract. 

Modify producer according 

to paragraph 29 to add all 

owners. 

“Total Practice Acres of X 

does not equal the total 

contract acres of X.” 

Practice acres are less than or 

greater than the contract 

acres. 

Modify contract or practice 

acres according to 

paragraph 30. 

“No Existing Practices 

Found” 

No practices are associated 

with the contract in CCMS. 

Modify contract to add 

practices according to 

paragraph 30. 

“Please select a primary 

Producer.” 

One producer must be 

designated as the primary 

producer. 

Modify contract to select a 

primary producer according 

to paragraph 29. 

“The tract number is not a 

valid tract number (XXX)” 

for this farm in Farm 

Records.  Please correct the 

tract number.” 

The tract number is not 

associated with the farm 

number of the contract 

according to FRS. 

Modify contract to correct 

farm and or tract number 

according to paragraph 14. 
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Par. 10 

10  View Contract Screen (Continued) 

 

F Status 

 

The status of the CRP contracts on the View Contract Screen will display 1 of the following. 

 

Status Description 

Approved The contract is in an approved status. 

Revision Pending 

COC Approval 

(Finalized) 

This status will appear on the parent contract while it is undergoing 

a modification and has been finalized according to Part 2, Sections 2 

and 5 but has not been COC approved. 

Early Termination in 

Process 

An early termination has been started according to paragraph 66 but 

has not yet been finalized. 

Revision in Process This status will appear on the resulting contracts of a revision or 

division while the contract is undergoing a modification and has not 

been finalized. 

Revision Finalized This status will appear on the resulting contracts of a revision or 

division after the contracts have been finalized but has not been 

COC approved. 

Expired This status will appear on a contract after the original end date has 

past. 

Early Termination 

Finalized 

An early termination has been started according to paragraph 66 but 

has not yet been COC approved. 

Terminated (Pending 

Finalization and 

Approval) 

This status will appear on the parent contract while it is undergoing 

a modification and has not been finalized according to paragraph 32 

or 86 but has not been COC approved. 

Terminated The contract has been terminated according to paragraph 38. 

Terminated 

(Replaced) 

This status will appear on a parent contract after a modification has 

been COC approved and the resulting contracts have become 

approved. 
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Par. 10.5 
*--10.5 View Contact Screen for SHIPP Signups 
 

A SHIPP Signup 
 

In addition to the data elements outlined in paragraph 10 for the View Contract Screen, 
SHIPP contracts will show additional information with the PL rule.  For the information 
outlined in subparagraph 10 C for Rate Information and PL Rule, the rule will be renamed 
SHIPP Rate Information and PL Rule.   
 
The change is limited to rental rate being split into two values.  Regular Rental Rate per Acre 
will represent the per acre rental rate for any producers that are not socially disadvantaged, 
limited resource producer, a beginning farmer or rancher, or a new veteran.  The second field 
will be the rental rate that any socially disadvantaged, limited resource, beginning farmer or 
rancher, or a new veteran (SDA/LR/BF/V) producer will receive.   
 
Users will review the share each producer has combined with the applicable rate to determine 
the annual contract payment.  
  

B Example of the SHIPP Rate Information and PL Rate section of the View Contract 
Screen 

 
The following is an example of the SHIPP Rate Information and PL Rate section of the  
View Contract Screen.  
 

 
--* 
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Par. 10.5 
*--10.5 View Contact Screen for SHIPP Signups 
 

C Field Descriptions and Actions 
 
The following table provides the field descriptions and actions for the SHIPP Rate 
Information and PL Rate section of the View Contract Screen.  

 
Field Description 

Effective Start Date The first date the displayed rate went into effect. 
Effective End Date The last day the displayed rate is in effect. 
PL Rule The payment limitation rule applicable to this contract. 
AGI Threshold The AGI amount that the contract is subject to. 
Regular Rental Rate 
Per Acre  

The per acre dollar value of the rental rate applicable to  
non SDA/LR/BF/V producers.  

SDA/LR/BF/V Rental 
Rate per Acre  

The per acre dollar value of the rental rate applicable to 
SDA/LR/BF/V producers. 

Annual Contract 
Payment 

The potential full year value the contract will earn based on the 
contract acres multiplied by the rental rate. 
 
Note: This value is subject to further program and eligibility 

reductions. 
--* 
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Par. 11 
11  Correct Farm/Tract and CLU Information  
 

A Overview  
 
Tract numbers and CLU numbers were not included on contracts migrated from System 36 
to CCMS.  As part of the migration of contracts from System 36, the tract numbers for farms 
having a single tract have been updated with the tract number from FRS.  Contracts having a 
farm with more than one tract migrated with “unknown” for the tract number.  These data 
fields are required entries when maintenance is performed.  However, users can also update 
the tract and CLU on active, approved System 36 contracts without causing a revision or 
creating a child contract.  To update “unknown” tract and CLU numbers select the action to 
perform “Correct Tract/CLU” from the drop-down list and CLICK “Go” from the View 
Contract Screen. 
  

B Example of Correct Tract/CLU Screen   
 

The following is an example of the Correct Tract/CLU Screen. 
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Par. 11 
11  Correct Farm/Tract and CLU Information (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Correct Tract/CLU 
Screen. 

 
Field  Description  Action 

Contract Status  The current status of the contract.   
Activity Type  No Activity, Divide, or Revise based on 

the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The physical location State of the tract for 

this contract.  
 

Physical County  The physical location county associated 
with this contract. 

 

Contract Number The contract number that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract 
Description  

The contract description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Approval Date  The COC approval date entered for this 
contract.  

 

Original Contract 
Start Date 

The original contract start date for the 
contract family.  

 

Revised Contract 
Start Date  

The start date of the revised contract. 
 
Note: If the contract has never been 

revised the field will display a 
N/A.  
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Par. 11 
11  Correct Farm/Tract and CLU Information (Continued) 
 

C Field Descriptions and Action (Continued)  
 

Field/Button Description Action  
Contract End Date The last day the contract is active.  This 

field will be updated if the contract is 
modified.  Only active contracts will display 
the original end date.   

 

Contract Acres  The number of acres in hundredths for the 
contract. 

 

Re-Enrolled Acres  The number of acres on this contract that 
were enrolled in CRP prior for this contract.   

 

Cropland Acres  Number of cropland acres in hundredths on 
this contract.  

 

Marginal 
Pastureland Acres 

Number of Marginal Pastureland Acres in 
hundredths on this contract.  

 

Non-Cropland Acres  Number of Non-Cropland Acres in 
hundredths on the contract.  Only Grassland 
contracts can have a value in this field.   

 

HUC Code The predominate HUC code of the contract 
as determined by TERRA/COLS. 

 

Extended  Yes or No.  Indicates if this contract has 
been extended. 

 

Approved for Early 
Out  

Yes or No.  Indicates if this contract was 
approved for an early out.  

 

Farm Number  The farm number associated with the 
contract. 

 

Tract Number  The tract number associated with the 
contract and the farm number above.  
 

         
         

Enter the applicable 
tract number. 

Back  User will be taken back to the View 
Contract Screen and data will not be saved.  

CLICK “Back”. 

Next  Data will be saved and the user will be taken 
to the Revise Acreage CLU Screen.   

CLICK “Next”. 
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Par. 11 
11  Correct Farm/Tract and CLU Information (Continued) 
 

D Correct Tract/CLU Screen Error Messages 
    

The Correct Tract/CLU Screen is set up to provide potential validation errors when 
comparing the contract to the current year in FRS.  
 

Error Message Description Corrective Action 
“The farm and tract number 
entered ((XXX), (XXX)) are not 
valid in the receiving county for 
Fiscal Year (XXX).  Please 
establish the farm and tract 
numbers for the receiving 
county.” 

The Correct/Tract CLU 
option only allows 
users to update to the 
tract number for the 
current year.  

Enter correct tract number.  
If the tract number is not 
active a contract revision 
will be needed. 

“The tract number (XXX) does 
not exist for the farm for Fiscal 
Year (XXX).” 

The Correct/Tract CLU 
option only allows 
users to update to the 
tract number for the 
current year. 

Enter correct tract number.  
If the tract number is not 
active a contract revision 
will be needed.  
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Par. 12 
12  Revise Acreage CLU Screen   

 
A Overview 
 
 The Revise Acreage CLU Screen as part of the Correct Farm/Tract and CLU process will 

allow users to enter all the CLU numbers for the farm and tract on the contract.   
 
B Example of Revise Acreage CLU Screen   
 

The following is an example of the Revise Acreage CLU Screen. 
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Par. 12 
12  Revise Acreage CLU Screen (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Revise Acreage CLU 
Screen. 

 
Field  Description  Action 

Contract Status  Will display the current status of the 
contract.  

 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance 
being done to the contract.  

 

Admin State The administrative State of the 
contract.  

 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of 
tract for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen.  

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name 

recorded for this contract. 
 

Program Year  The Program year associated with 
this contract.  This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded 
for this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

Farm Number  The farm number associated with 
the contract.  
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Par. 12 
12  Revise Acreage CLU Screen (Continued) 
 

C Field Descriptions and Actions 
 

Field Description Action 
Tract Number  The Tract number associated 

with the contract. 
 

Contract Acres  The cropland, MPL, and 
wellhead acres that are 
associated with the contract.  

 

Farm Number  The Farm number associated with 
the contract. 

 

Tract Number  The tract number associated with 
the contract. 

 

CLU The CLU number associated with 
the Contract. 

Enter the applicable CLU 
number.  

CLU Acres The acres associated with the 
CLU entered above.   

Enter the acreage in hundredths 

for the CLU number entered.  
 
Note: The Correct Tract/CLU 

feature will not allow the 
contract to be shifted 
from tenths to 
hundredths, to Correct 
acreages use the 
Revise>Acreage Option.  
To ensure the sum on the 
CLU acres equals the 
total Contract acres 
rounding may be needed.  

Delete The CLU record for the row will 
be removed.   

CLICK “Remove”. 
 
Note: This option will need to 

be repeated for each 
CLU to remove.  

Add New CLU 
Information  

This will be used to record all 
CLU associated with the contract. 

Enter the CLU number and 
CLU acres and CLICK “Add”.  
Repeat as needed until all 
CLU’s are added to the 
Contract.  

Re-enrolled Acres  Displays the number of acres on 
the contract that were a result of 
reenrollment.  

 

Back  Correct Tract/CLU Screen will 
display.  Data will not be saved.  

CLICK “Back”. 

Cancel View Contract Screen will 
display. Data will not be saved.  

CLICK “Cancel”. 

Next  Revise Practice CLU Screen will 
display.  Data will be saved.   

CLICK “Next”. 
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Par. 12 
12  Revise Acreage CLU Screen (Continued) 
 

D Error Messages 
    

The Revise Acreage CLU Screen is set up to provide potential validation errors when 
comparing the contract to the current year in FRS.  The following error messages may be 
displayed.  
 

Error Message Description Corrective Action 
“CLU Acres value must be 
greater than zero for the 
CLU (XXX).” 

The acreage on the CLU 
must be greater than 0. 

Enter the acreage value in 
hundredths greater than zero.  

“Cropland acreage cannot 
be added to a contract which 
does not already have 
Cropland acreage.” 

The acreage type cannot be 
revised when revising the 
CLU. 

Correct acreage type for the 
CLU’s entered.  

“Field/CLU Number (XXX) 
is missing acreage 
information.” 

CLU cannot have null value 
for acreage amount. 

Enter the acreage value in 
hundredths greater than zero. 

“MPL acreage cannot be 
added to a contract which 
does not already have MPL 
acreage.” 

A contract that does not have 
MPL acres cannot be revised 
to have MPL acres. 

Correct acreage type for the 
CLU’s entered. 

“Non-Cropland acreage 
cannot be added to a 
contract which does not 
already have Non-Cropland 
acreage.” 

If the parent contract does 
not have non-cropland acres 
but a practice on the child 
contract has non-cropland 
acreage (likely due to System 
36 migrated data), this 
warning occurs. 

Correct acreage type for the 
CLU’s entered. 

“Please add CLU before 
saving.” 

No CLU's have been found 
from the contract. 

Add at least one CLU before 
saving. 

“The CLU acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter the acreage value in 
hundredths greater than zero. 

“The CLU number (XXX) 
is already added to this 
contract.” 

Multiple CLU's of the same 
number/identifier cannot 
exist on the same contract. 

Correct CLU number.  

“The combination of MPL 
acres and Non-Cropland 
acres (XXX) on the tract 
(XXX) are more than 
available acres (XXX) for 
Fiscal Year (XXX).” 

There cannot be more MPL 
and Non-Cropland Acres on 
the Farm Tract than there are 
available (available amount 
retrieved from FRS and 
added to parent acreage).  

Correct the acreage value 
entered.  
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Par. 12 
12  Revise Acreage CLU Screen (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The Cropland acreage on 
this contract cannot be 
reduced to zero.” 

If the parent contract has 
cropland acres, the child 
contract must have cropland 
acres. 

Enter the acreage value in 
hundredths greater than 
zero. 

“The MPL acreage on this 
contract cannot be reduced to 
zero.” 

If the parent contract has 
MPL acres, the child contract 
must have MPL acres. 

Enter the acreage value in 
hundredths greater than 
zero. 

“The Non-Cropland acreage 
on this contract cannot be 
reduced to zero.” 

If the parent has non-
cropland acres, the child 
contract must have non-
cropland acres. 

Enter the acreage value in 
hundredths greater than 
zero. 

“The Wellhead Acres (XXX) 
must not exceed the Cropland 
Acres (XXX).” 

The wellhead Acres must not 
exceed the cropland Acres. 

Correct CLU wellhead 
value to not exceed the 
contract wellhead value.  

“Total Wellhead acres 
(XXX) not equal to approved 
Wellhead acres (XXX).” 

The sum of the wellhead 
practice acreage must equal 
the wellhead protection acres 
on the contract. 

Correct CLU’s wellhead 
value to equal the contract 
wellhead value. 

“Tract (XXX) shall have 
Cropland or MPL acres.” 

The tract must have at least 
one valid acreage type. 

Correct acreage type for 
the CLU entered. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5-15-19     5-CRP Amend. 1 Page 2-29  



Par. 13 
13  Revise Practice CLU   
 

A Overview 
  
 The Revise Practice CLU Screen as part of the Correct Tract/CLU option allows users to 

record the practice associated with each CLU they have added.  Practices on the contract 
cannot be changed with this action.  

  
B Example of Revise Practice CLU Screen   
 

The following is an example of the Revise Practice CLU Screen. 
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Par. 13 
13  Revise Practice CLU (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Revise Practice CLU 
Screen. 

 
Field/Button  Description  Actions 

Contract Status  Will display the current status of the 
contract.  

 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance 
being done to the contract.  

 

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen.   

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded 

for this contract. 
 

Program Year  The program year associated with 
this contract. This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded 
for this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

Contract Acres  The number of Cropland acres 
associated with the contract 
displayed in hundredths.  
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Par. 13 
13  Revise Practice CLU (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Cropland Acres  
MPL Acres  

The number of MPL acres 
associated with the contract 
displayed in hundredths. 

 

Wellhead Acres  The number of Wellhead acres 
associated with the contract 
displayed in hundredths. 

 

Payable Acres  The number of payable acres 
associated with the contract 
displayed in hundredths. 

 

Assigned Practices 
Farm Number  Farm number associated with the 

contract.  
 

Tract Number Tract number associated with the 
contract.  

 

CLU CLU number for the practice.  Select correct CLU from the 
drop-down list.  CLU 
numbers on the drop-down 
list are the CLU’s entered on 
the Revise Acreage CLU 
Screen. 

Code The practice code.   
Practice Acres  The number of practice acres for each 

practice. 
 

Acreage  Acres value in hundredths for the 
CLU.   Will display the acreage type 
of cropland, MPL, wellhead based on 
the acreage types on the contract.    

Enter the acreage value in 
hundredths.  This value needs 
to match the CLU acreage for 
the CLU selected. 

Estimated Cost Share 
Per Acre  

Displays the estimated cost share 
based on the acres loaded for the CLU.  

 

Estimated Cost Share 
for Practice  

Displays the estimated cost share for 
the practice.  

 

Delete  Will remove the CLU and practice 
record for that row.  

CLICK “Delete”. 
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Par. 13 
13  Revise Practice CLU (Continued) 
 
  C Field Descriptions and Actions (Continued) 

 
Field/Button Description Action  

Tools 
Practice Acres  Total practice acres for all CLU’s.  
MPL Acres  Total MPL acres for the practices.   
Cropland Acres  Total cropland acres for the practices.  
Wellhead Acres  Total wellhead acres for the practices.  
Total Estimated Cost 
Share 

Total estimated cost share for the 
contract.  

 

Add New Practice  The Add Practice CLU Screen will be 
displayed.  

CLICK “Add new Practice”.  

Back  The Revise Acreage CLU Screen will 
be displayed.  Date will not be saved.  

CLICK “Back”. 

Cancel  The View Contract Screen will be 
displayed, and data will not be saved.  

CLICK “Cancel”. 

Save  A confirmation pop-up window will be 
displayed to confirm to save.  If “OK” 
is selected all data is saved and the 
View Contract Screen is displayed.  If 
cancel is chosen, the Practice CLU 
Screen is displayed.  

CLICK “Save” and “OK” or 
“Cancel” on the pop-up 
confirmation window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5-15-19     5-CRP Amend. 1 Page 2-33  



Par. 13 
13  Revise Practice CLU (Continued) 
 

D Error Messages 
 

The Revise Practice CLU Screen is set up to provide potential validation errors when 
comparing the contract to the current year in FRS. The following error messages may be 
displayed.  
 

Error Message Description Corrective Action 
“CP12 practice cannot have 
Estimated Cost Share per 
Acreage value greater than 
0.00.” 

CP12 practice cannot have a 
cost share value above 0. 

Remove entered cost share 
value for the CP12 practice.  

“Practice (XXX) shall have 
practice acres.” 

Each practice must have 
practice acres. 

Enter acreage value in 
hundredths for the practice.  

“The XXXX practice acres 
cannot exceed more than two 
decimals.” 

All acreage must be entered 
hundredths. 

Enter acreage value in 
hundredths for the practice. 

“The Practice (XXX) doesn't 
match with any of the 
original practices on the 
contract.” 

All of the practices on the 
corrected contract must 
match with the practices on 
the contract before 
correction. 

Correct practice to match 
existing practices on the 
contract.  If the practice is 
incorrect on the contract a 
contract revision will be 
need.  

“The practice (XXX) should 
be added as it exists on the 
original contract.” 

All of the practices on the 
corrected contract must 
match with the practices on 
the contract before 
correction. 

Correct practice to match 
existing practices on the 
contract.  If the practice is 
incorrect on the contract a 
contract revision will be 
need. 

“The sum of cropland 
practice acres (XXX) does 
not match with the sum of 
cropland practice acres 
(XXX) on the original 
contract.” 

The sum of cropland acres 
for the practices of the 
contract must match the total 
cropland acres for the 
practices of the original 
contract. 

Correct practice cropland 
acreage values to match the 
contract level values.  

“The sum of MPL acres 
(XXX) does not match with 
the sum of MPL practice 
acres (XXX) on the original 
contract.” 

The sum of MPL acres for 
the practices of the contract 
must match the total MPL 
acres for the practices of the 
original contract. 

Correct practice MPL 
acreage values to match the 
contract level values. 

The sum of practice acres 
(XXX) does not match the 
sum of practice acres (XXX) 
on the original contract for 
the practice ((XXX)).” 

The sum of practice acres 
must match the sum of 
practice acres on the original 
contract for the practice. 

Correct practice acreage 
values to match the contract 
level values. 
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Par. 13 
13  Revise Practice CLU (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The sum of wellhead 
practice acres (XXX) does 
not match with the sum of 
wellhead practice acres 
(XXX) on the original 
contract.” 

The sum of wellhead acres 
for the practices of the 
contract must match the total 
Wellhead acres for the 
practices of the original 
contract. 

Correct practice wellhead 
acreage values to match 
the contract level values.  

“The total practice acres 
cannot exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage value in 
100ths for the practice. 

“The Wellhead Practice 
Acres (XXX) shall not 
exceed the Practice Cropland 
Acres (XXX) for practice 
(XXX).” 

For each practice on the 
contract, the wellhead acres 
on the practice cannot exceed 
the cropland acres on the 
practice. 

Correct practice wellhead 
acreage values to match 
the contract level values. 

“The wellhead practice acres 
cannot exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage value in 
hundredths for the practice. 

“Total practice acres not 
equal to contract acres.” 

The total acres for the 
contract must equal the total 
acres for the practices. 

Correct practice acreage 
values to match the 
contract level values. 

“Total Wellhead acres 
(XXX) not equal to approved 
Wellhead acres (XXX).” 

The sum of the wellhead 
practice acreage must equal 
the wellhead protection acres 
on the contract. 

Correct practice wellhead 
acreage values to match 
the contract level values. 
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Par. 14 
14  Add Practice CLU  
 

A Overview  
 

The Add Practice CLU Screen as part of the Correct Tract/CLU option allows users to record 
the practice associated with each CLU they have added.  Practices on the contract cannot be 
changed with this action. 
 

B Example of Add Practice CLU Screen   
 

The following is an example of the Add Practice CLU Screen. 
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Par. 14 
14  Add Practice CLU (Continued) 

 
C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Add Practice CLU 
Screen. 
 

Field/Button  Description  Action 
Contract Status  Will display the current status of 

the contract. 
 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance 
being done to the contract.  

 

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of 
tract for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen.  

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name 

recorded for this contract. 
 

Program Year  The program year associated with 
this contract.  This value is set to 
the program year of the first month 
the contract was effective.  

 

Signup Type  The applicable signup type 
recorded for this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the 
TERRA/COLS process.  
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory 
recorded for this contract. 
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Par. 14 
14  Add Practice CLU (Continued) 

 
C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Farm Number The farm number associated with 

the contract. 
 

Tract Number  The tract number associated with 
the contract. 

 

CLU  CLU number and acres recorded by 
the user on the Revise Acreage 
CLU Screen.  

Select the CLU number from 
the drop-down.  

Code List of practice codes on the 
contract.   

Select the applicable practice 
code from the drop-down.  

Status List of practice statues, including 
“New”, “Enhanced”, or “Existing”.  
Default value is “N/A”.   

Select the applicable status 
value.   

Practice Acres  The number of practice acres.  This 
is a display only field based on the 
value entered for MPL, cropland, 
and wellhead Acres.   

 

MPL Acres The number of MPL acres for this 
practice.  This field will be grayed 
out unless the contract already 
contains MPL acres.  Acreage value 
must match CLU acreage.  

Enter acreage value in 
hundredths, if applicable. 

Cropland Acres  The number of Cropland acres for 
this practice.  This field will be 
grayed out unless the contract 
already contains cropland acres. 
Acreage value must match CLU 
acreage. 

Enter acreage value in 
hundredths, if applicable. 

Wellhead Acres The number of wellhead acres for 
this practice.  This field will be 
grayed out unless the contract 
already contains wellhead acres. 
Acreage value must match CLU 
acreage. 

Enter acreage value in 
hundredths, if applicable. 
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Par. 14 

14  Add Practice CLU (Continued) 

 

C Field Descriptions and Actions (Continued) 

 

Field/Button Description Action 

Estimated Cost 

Share Per Acre 

Displays dollar value of estimated 

cost share per acre already 

recorded on the contract. 

 

Back The Revise Practice CLU Screen 

is displayed and no data is saved. 

CLICK “Back”. 

Cancel The View Contract Screen is 

displayed and no data is saved. 

CLICK “Cancel”. 

Save The Revise Practice CLU Screen 

is displayed and data is saved. 

CLICK “Save”. 

 

D Add Practice CLU Screen Error Messages 

 

The Add Practice CLU Screen is set up to provide potential validation errors when 

comparing the contract to the current year in FRS.  The error message “The following CLUs 

are not found: (XXX). Please choose a valid CLU from the available choice(s).” may be 

displayed.  The CLU cannot be “unknown” to modify the practices.  Correct the CLU 

number first according to paragraph 11. 
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Par. 15 

*--15 Contract Farm Number by Year 

 

A Overview 

 

To view the Contract Farm Number by Year Screen, from the “Select an action to perform” 

drop-down menu on the View Contract Screen, select “View > Farm Numbers by Year” and 

CLICK “Go”. 

 

CCMS will display the last active farm number for each year a contract was active on the 

Contract Farm Number by Year Screen.  The farm number is determined based on the active 

tract associated to the contract in each applicable year.  If the tract was linked to more than 

1 farm number in a year, only the last active farm number will be displayed. 

 

Only years between the effective start date and effective end date will be displayed.  Users 

may need to look at the parent or child contracts to determine all associated farm numbers for 

the length of the CRP contract. 

 

Note: This screen is for information only and no actions can be taken. 

 

B Example of Contract Farm Number by Year Screen 

 

The following is an example of the Contract Farm Number by Year Screen. 

 

 
--* 
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Par. 15 

*--15 Contract Farm Number by Year (Continued) 

 

C Fields and Descriptions 

 

The following table provides the fields and descriptions for the Contract Farm Number by 

Year Screen. 

 

Field/Button Description Action 

Contract Status Will display the current status of the contract.  

Activity Type Will display “No Activity”.  

Admin State The administrative State of the contract.  

Admin County The administrative county of the contract.  

Physical State The State of the physical location of tract for this 

contract. 

 

Physical County The county of the physical location associated with 

this contract. 

 

Contract Number The contract number that was selected on the 

Select Contract Screen. 

 

Signup Number The applicable signup number recorded for this 

contract. 

 

Program Type Will display “CRP”.  

Signup Name The applicable signup name recorded for this 

contract. 

 

Program Year The program year associated with this contract.  

This value is set to the program year of the first 

month the contract was effective. 

 

Signup Type The applicable signup type recorded for this 

contract. 

 

Contract 

Description 

This field will display the contract description 

entered in the TERRA/COLS process. 

 

Note: Will be blank for S36 migrated contracts. 

 

Subcategory 

Type 

The applicable CRP subcategory recorded for this 

contract. 

 

 

D Action 

 

The following action can be taken on the Contract Farm Number by Year Screen. 

 

Field Action 

Back The user will be returned to the Search Contract Screen. 

--* 

 

 

 

 

 

 

12-27-19     5-CRP Amend. 3 Page 2-41 



Par. 16 

*--16 Contract Family Producer Subsidiary Year 

 

A Overview 

 

To view the Contract Family Producer Subsidiary Year Screen, from the “Select an action to 

perform” drop-down menu on the View Contract Screen, select “View > Producer Subsidiary 

Year” and CLICK “Go”. 

 

The Contract Family Producer Subsidiary Year Screen will display all producers associated 

with CRP contract families, including known members of an entity or joint operation along 

with the subsidiary year for that producer, errors, AGI indicators, and AGI waiver 

information. 

 

CCMS determines the earliest year of involvement for: 

 

• all existing participants based on the first year they are associated with CRP-1 in CCMS 

• revisions according to 2-CRP, subparagraphs 131 H and I. 

 

Note: Users must ensure that correct dates are entered into CCMS for the original contract 

approval date and for the revised contract effective start date. 

 

The Conservation Payments System will use the subsidiary year displayed on the Contract 

Family Producer Subsidiary Year Screen for the contract in CCMS to retrieve the correct 

subsidiary year eligibility determination. 

 

CCMS is not storing or recording the value of the AGI certification; CCMS is simply 

checking that the applicable form has been recorded according to 3-PL (Rev. 2).  Contracts 

that are subject to AGI rules will not be able to be finalized or COC approved in CCMS until 

the AGI certification has been filed according to the following table. 

 

Program Years Validation for Filed AGI in CCMS 

2012 and Prior Not Validated 

2013 and Future Validated 

 

Note: CCMS will not validate AGI for any current or future signup with no AGI limitation. 

 

B 2012 and Prior Year Contracts 

 

CCMS will not validate that the applicable AGI certification has been filed for contracts 

effective for program years 2012 and prior.  CCMS will rely on the Business File application 

to determine the business structure for entities and joint operations.  Since it is not mandatory 

to load the business structure before 2013, CCMS will not enforce the AGI certification for 

contracts with program years 2012 and prior.--* 
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Par. 16 

*--16 Contract Family Producer Subsidiary Year (Continued) 

 

C Determining Which AGI Rule Applies 

 

CCMS will use the AGI threshold displayed on the View Contract Screen.  The following is 

an example of the Rate Information and PL Rule Section of the View Contract Screen where 

the AGI threshold is displayed. 

 

 
 
CCMS will determine which AGI value to retrieve according to the following table. 

 

AGI Threshold Displayed Corresponding Subsidiary Eligibility Value 

$900,000 Adjusted Gross Income - 2014/2018 Farm Bill 

$1,000,000 Adjusted Gross Income - 2008 Farm Bill Conservation 

Program 

$2,500,000 Adjusted Gross Income - 2002 Farm Bill 

--* 
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Par. 16 

*--16 Contract Family Producer Subsidiary Year (Continued) 

 

D Example of Contract Family Producer Subsidiary Year Screen 

 

The following is an example of the Contract Family Producer Subsidiary Year Screen. 

 

 
 

E Fields and Descriptions 

 

The following table provides the field descriptions and actions for the Contract Family 

Producer Subsidiary Year Screen. 

 

Field/Button Description Action 

Contract Status Will display the current status of the contract.  

Activity Type Will display “No Activity”.  

Admin State The administrative State of the contract.  

Admin County The administrative county of the contract.  

Physical State The State of the physical location of tract for this 

contract. 

 

Physical County The county of the physical location associated 

with this contract. 

 

--* 
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Par. 16 

*--16 Contract Family Producer Subsidiary Year (Continued) 

 

E Fields and Descriptions (Continued) 

 

Field/Button Description Action 

Contract 

Number 

The contract number that was selected on the Select 

Contract Screen. 

 

Signup 

Number 

The applicable signup number recorded for this 

contract. 

 

Program Type Will display “CRP”.  

Signup Name The applicable signup name recorded for this 

contract. 

 

Program Year The program year associated with this contract.  This 

value is set to the program year of the first month the 

contract was effective. 

 

Signup Type The applicable signup type recorded for this contract.  

Contract 

Description 

This field will display the contract description 

entered in the TERRA/COLS process. 

 

Note: Will be blank for S36 migrated contracts. 

 

Subcategory 

Type 

The applicable CRP subcategory recorded for this 

contract. 

 

Producer 

Name 

The producer listed on any CRP-1 for this contract 

family. 

 

Subsidiary 

Year 

The value determined to be the earliest year of 

involvement according to subparagraph A. 

 

Error Code The error value as outlined in subparagraph F.  

Error Year The year of the error displayed for the error code.  

Income Filed “Y” or “N” will be displayed if the corresponding 

AGI value for the subsidiary year is set to any value 

but “Not Filed” in the web-based Subsidiary System. 

 

AGI Indicator “Y” or “N” will be displayed if the corresponding 

AGI value for the subsidiary year in the web-based 

Subsidiary System of the applicable AGI threshold is 

compliant. 

 

AGI Waiver “Y” will be displayed if the producer on the contract 

has had AGI provisions waived for environmentally 

sensitive land. 

 

Refresh CCMS redetermines the subsidiary year and error 

code values displayed on the screen. 

CLICK “Refresh” 

and “OK” in the 

pop-up window. 

Back Returns the user to the View Contract Screen and no 

data will be saved. 

CLICK “Back”. 

--* 

 

 

 

 

12-27-19     5-CRP Amend. 3 Page 2-45 



Par. 16 

*--16 Contract Family Producer Subsidiary Year (Continued) 

 

F Error Code Descriptions 

 

The Contract Family Producer Subsidiary Year Screen is set up to provide potential errors in 

the business structure for entities and joint operations when determining the applicable 

subsidiary year. 

 

The following table provides the description of the AGI error code that will be displayed in 

CCMS and the reference for the needed corrective action. 

 

AGI Error 

Code Error Description Corrective Action 

AGI_09 Entity type in business file does not match the 

business type in Business Partner. 

See 9-CM, 

subparagraph 66 E. 

AGI_10 Entity file information is for a county that is not linked 

in Business Partner. 

AGI_11 Payment entity and/or member does not meet AGI 

requirements as determined through the AGI 

compliance review process. 

AGI_99 Payment entity meets all requirements, but at least 

1 member has an error condition. 

CRP_01 Producer is not found in Business Partner. 

CRP_03 Missing business type in Business Partner. 

 

G Error Messages Displayed During Contract Finalization 

 

If users experience the following AGI-related error messages during contract finalization in 

CCMS, follow the corrective action. 

 

Error Message Definition/Corrective Action 

AGI errors in the year of revision, for the 

following producer(s)(year) (See Producer 

Subsidiary Year page for more information): 

(followed by the name of the producer and 

year with AGI error) 

A producer with an AGI error will be 

displayed along with the year of the error.  

Users shall return to the Contract Family 

Producer Subsidiary Year Screen and refer 

to the error messages in subparagraph F. 

If Eligibility not filed: Message-> 

Corresponding Eligibility data are not filed 

for producer (year): (followed by the name 

of the producer and year with non-compliant 

eligibility) 

The applicable AGI certification is not 

recorded in the Subsidiary Eligibility 

record for the year indicated. 

The subsidiary year of the following 

producer(s) is estimated, due to historical 

AGI problems on the contract family (See 

Producer Subsidiary Year page for more 

information): (followed by the name of the 

producer) 

A producer with an AGI error will be 

displayed along with the year of the error.  

Users shall return to the Contract Family 

Producer Subsidiary Year Screen and refer 

to the error messages in subparagraph F. 

--* 
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Par. 17 

*--17 Adjust Re-Enrolled Acreage Screen 

 

A Overview 

 

The Adjust Re-Enrolled Acreage Screen will be open to users to update parent contract 

information from the expired CRP contract that was re-enrolled into the acreage for the 

existing contract.  This option will only need to be used to correct missing or incorrect data 

recorded during the TERRA and COLS offer process. 

 

To update the re-enrolled acres information, from the “Select an action to perform” 

drop-down menu on the View Contract Screen, select “Correct > Adjust Re-Enrolled 

Acreage” and CLICK “Go”. 

 

B Example of Adjust Re-Enrolled Acreage Screen 

 

The following is an example of the Adjust Re-Enrolled Acreage Screen. 

 

 
--* 
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Par. 17 

*--17 Adjust Re-Enrolled Acreage Screen (Continued) 

 

C Fields and Descriptions 

 

The following table provides the field descriptions and actions for the Adjust Re-Enrolled 

Acreage Screen. 

 

Field/Button Description Action 

Contract Status Will display the current status of the contract.  

Activity Type Will display “No Activity”.  

Admin State The administrative State of the contract.  

Admin County The administrative county of the contract.  

Physical State The State of the physical location of tract for this 

contract. 

 

Physical County The county of the physical location associated 

with this contract. 

 

Contract Number The contract number that was selected on the 

Select Contract Screen. 

 

Signup Number The applicable signup number recorded for this 

contract. 

 

Program Type Will display “CRP”.  

Signup Name The applicable signup name recorded for this 

contract. 

 

Program Year The program year associated with this contract.  

This value is set to the program year of the first 

month the contract was effective. 

 

Signup Type The applicable signup type recorded for this 

contract. 

 

Contract 

Description 

This field will display the contract description 

entered in the TERRA/COLS process. 

 

Note: Will be blank for S36 migrated contracts. 

 

Subcategory 

Type 

The applicable CRP subcategory recorded for 

this contract. 

 

Farm Number The farm number associated with the contract.  

Tract Number The tract number associated with the contract.  

CLU The CLU number associated with the contract.  

CLU Acres The acres associated with the CLU entered.  

--* 
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Par. 17 

*--17 Adjust Re-Enrolled Acreage Screen (Continued) 

 

C Fields and Descriptions (Continued) 

 

Field/Button Description Action 

Re-Enrolled 

Acres 

Displays the number of acres on the contract that 

were a result of re-enrollment. 

 

CLU The CLU number associated with the contract. Select the 

applicable CLU 

number from the 

drop-down menu. 

Expired 

Contract 

Number 

The contract number of the contract that expired 

before the current acres being re-enrolled to this 

contract. 

Enter the applicable 

expired contract 

number. 

Expired Signup 

Name 

The expired signup name from the contract that 

expired before the current acres being re-enrolled 

to this contract. 

 

Note: This value will be populated from the 

expired contract number that was entered. 

 

Expired 

Practice Code 

The practice code from the contract that expired 

before the current acres being re-enrolled to this 

contract. 

 

Note: This value will be populated from the 

expired contract number that was entered. 

 

Re-Enrolled 

Acres 

Displays the number of acres on the contract that 

was a result of re-enrollment. 

Enter the number 

of acres re-enrolled 

on that CLU. 

Action Will allow for the options for the CLU data to be 

added or deleted. 

CLICK “Add” or 

“Delete”. 

Save After the user clicks “Save”, they will receive a 

pop-up window to confirm the save.  Clicking 

“OK” will save all data.  The Success Screen will 

be displayed if all page validations are met.  The 

user will CLICK “OK” on the Success Screen to 

be returned to the View Contract Screen.  

Clicking “Cancel” on the pop-up window will 

return the user to the Adjust Re-Enrolled Acreage 

Screen without saving data. 

CLICK “Save”, 

then “OK” or 

“Cancel”. 

Back Returns the user to the View Contract Screen and 

no data will be saved. 

CLICK “Back”. 

--* 
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Par. 17 

*--17 Adjust Re-Enrolled Acreage Screen (Continued)  

 

D Error Messages 

 

The Adjust Re-Enrolled Acreage Screen is set up to provide potential validation errors.  The 

following error messages may be displayed. 

 

Error Message Description Corrective Action 

There is no contract number 

{XXXX} for state/county 

code {XX/XXX}. 

The contract number entered 

as the expired contract number 

was not found for the State and 

county selected. 

Re-enter the correct 

expired contract number. 

Contract number {XXX} for 

state/county code 

{XX/XXX} is not in a valid 

status for reenrollment 

({XX}). 

The effective end date for the 

contract number entered as the 

expired contract number is not 

before the start date of the 

existing CRP contract. 

Re-enter the correct 

expired contract number. 

At least 1 reenrollment detail 

is positioned on an 

'unknown' CLU. 

The CLU number is missing 

from the contract. 

Enter the CLU number 

on the Adjust Acreage 

Screen according to 

paragraph 28. 

Reenrollment Detail must 

have some acreage (greater 

than zero). 

The value for re-enrolled acres 

is zero or blank. 

Enter an acreage value 

greater than zero. 

Reenrollment Details must 

define all reenrollment acres 

on the contract ({XXX} vs 

{XXX}). 

The re-enrolled CLU acreage 

does not add up to the total 

re-enrolled acreage for the 

contract. 

Enter additional CLU’s 

to account for all 

re-enrolled acres. 

Practice {XXX} is not on 

contract number {XXX}. 

The expired contract did not 

contain the practice the user 

has entered. 

Enter the expired 

practices from the 

expired contract number 

or correct the expired 

contract number. 

CLU {XXX} is only {XXX} 

acres, not enough to support 

{XXX} acres of 

reenrollment associated to it. 

Only one CLU is entered and 

the acres for that CLU is less 

than the total re-enrolled acres 

on the contract. 

Enter additional CLU’s 

to account for all 

re-enrolled acres. 

You must define some 

enrollment details. 

The contract shows re-enrolled 

acres, but no CLU level details 

are provided on this screen. 

Enter additional CLU’s 

to account for all 

re-enrolled acres. 

The expiring contract must 

end ({XXX}) prior to this 

contract original start date 

({XXX}). 

The expired contract listed did 

not expire before the start date 

of the current contract. 

Re-enter the correct 

expired contract number. 

--* 

18-24 (Reserved) 
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Par. 25 

Section 2    Contract Revisions 

 

25  Revising Contracts 

 

A Contract Revise Actions 

 

The contract revise actions are used for changing acreage, farm and tract numbers, practices, 

producers and rates. 

 

Note: Contracts that were migrated into CCMS from System 36 may not have the tract 

number and will be missing CLU’s.  These contracts will display “unknown” in the 

“Tract Number” and “CLU” fields.  When these contracts are revised, the “Tract 

Number” and “CLU” fields will be required and the tract number and CLU will have 

to be updated. 

 

After selecting the contract requiring maintenance on the Search Contract Screen  

(paragraph 8), the selected contract will be displayed on the View Contract Screen.  At the 

bottom of the screen is a “Select an action to perform” drop-down list.  When the user selects 

“Initiate>Revise”,  the user will need to select the “Revision Effective Date” and “Reason for 

Revision”, on the Start Contract Revision Screen according to paragraph 13.  The user will 

then be able to do the following maintenance actions to the contract: 

 

• “Modify > Acreage” (paragraph 28) 

●*--“Modify > Adjust Re-Enrolled Acreage” (paragraph 28.5)--* 

• “Modify > Practices” (paragraph 30) 

• “Modify > Farm/Tract” (paragraph 27) 

• “Modify > Producers” (paragraph 29) 

• “Modify > Rates” (paragraph 35). 

 

Users only need to perform actions for which the contract is being changed.  These actions 

may be performed in any order; however: 

 

• if there has been a reconstitution and new farm and/or tract numbers are needed, the 

“Modify > Farm/Tract” action should be accessed first so that the acreage validations will 

be applied to the appropriate information in FRS 

 

• CLU’s for the practices are dependent on CLU’s defined on the Revise Acreage Screen. 

 

After each action the user will see a “Success” screen once that step passes all screen 

validations.  After clicking “OK” the user will be returned to the View Contract Screen and 

will be able to select another action to complete as needed.  

 

Note: If the selected contract was in “Approved” status, when user clicks “Go”, the parent 

contract status will be changed from “Approved” to “Terminated (Pending 

Finalization and Approval)”.  The contract number for the child contract will be the 

same as the parent with the next available alphabetic suffix added.  The child contract 

will be set to “Revision in Process” status.  

 

 

12-27-19     5-CRP Amend. 3 Page 2-69  



Par. 25 

25  Revising Contracts (Continued) 

 

B Setting Effective Dates 

 

The effective start date of a CRP contract revision is crucial when properly dividing 

payments between participants on original and revised CRP contracts.  With the release of 

CCMS, payments from contracts that have been revised will be date-based.  

 

This table lists the dates captured in CCMS at the start of a revision or division and how 

these dates affect payments. 

 

Date Field Description 

Approval Date The COC approval date for the contract.  This date is specific to 

the contract or revision. 

 

Example: Contract 1459 would show the original approval date 

and contract 1459A will show the approval date COC 

approved the revision. 

Effective Contract 

Start Date 

The date the contract or contract revision becomes effective. 

CCMS uses this date to determine active days in FY for payment. 

Original Contract Start 

Date 

The original start date of the contract without regard to revision. 

This date will always display the same original contract start date 

in CCMS for an entire contract family.  This date is also used to 

populate block 9, “Contract Period”, of the automated CRP-1. 

Effective Contract End 

Date 

The last day the CRP contract is active.  This date will change on 

a contract, if revised. If a contract is replaced by a revision or 

division, the effective contract end date on the parent contract 

will be updated to the date 1 day before the effective start date of 

the new revised contract. 

 

Example: Effective contract end date on contract 1459 changes 

from “09/30/2022” to “03/06/2016” when contract 

1459A is created with an effective contract start date 

of “03/07/2016”. 

 

CCMS uses this date to determine active days for payment in FY. 

 

C Effective Contract Start Date  

 

In CCMS, the calculated payment amounts after a revision will be date-driven based on the 

revision effective start date.  When setting the effective contract start date, the types of 

revisions can be separated into the following 2 categories:  

 

• Contract Successions 

• Farm Maintenance Changes. 
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Par. 25 
25  Revising Contracts (Continued) 
 

D Effective Contract Start Dates for Contract Successions 
 

When a contract revision or division is being completed to reflect contract changes, such as 
ownership changes, users must enter the date the succession took place according to 2-CRP, 
subparagraph 555 B.  If there is a subsequent agreement between the producers that further 
divides or redirects the payment, users must still enter the actual date of the succession.  
Users can then access the “Division of Payment” option in CCMS to adjust the payment 
distribution by either a percentage or fixed dollar amount.  
 
Note: Users must not manipulate the effective contract start date to drive the payment for 

contract successions. 
 
Following are some examples of contract revisions for contract successions in CCMS: 

 
 
 

Reason for Change 

 
 

User Action in CCMS 

Effective 
Contract 

Start Date 

 
 

Payment Effect 
Producer of contract 
100 sold their land 
on March 4, 2015 
and the new owner 
is succeeding to the 
contract.  There is no 
payment agreement 
between the 
producers 

Revise producer in CCMS. 
 

Contract 100 becomes 100A. 
 

Contract 100 will be in effect 
from 10/01/2015 to 
03/03/2015 for 154 active 
days in FY 2015. 

 
Contract 100A will be in 
effect from 03/04/2015 to 
9/30/2015 for 121 active days 
in FY 2015. 

03/04/2015 Contract 100 will be 
issued a payment on 
154 active days.  
Contract 100A will 
be issued a payment 
on 121 active days.   

Producer of contract 
64 sold their land on 
March 4, 2015 and 
the new owner is 
succeeding to the 
contract.  However, 
there is a payment 
agreement between 
the producers and 
the new owner will 
receive 100 percent 
of the payment for 
FY 2015. 

Revise producer in CCMS.  
 

Contract 64 becomes 64A. 
 

Contract 64 will be in effect 
from 10/01/2014 to 
03/03/2015 for 154 active 
days in FY 2015. 
 
Contract 64A will be in effect 
from 03/04/2015 to 9/36/2015 
for 121 active days in FY 
2015. 

03/04/2015 The user will access 
the “Division of 
Payment” option and 
load 100 percent or 
the total payment 
dollars under contract 
64A. 
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Par. 25 
25  Revising Contracts (Continued) 

 
D Effective Contract Start Dates for Contract Successions (Continued) 

 
 
 

Reason for Change 

 
 

User Action in CCMS 

Effective 
Contract 

Start Date 

 
 

Payment Effect 
Producer A with 100 
percent share on 
contract 400 sold 
their land on March 
12, 2015, to 
Producer B.  The 
County Office did 
not learn about this 
until November 15, 
2015. 

Cancel the full FY2015 
payment on contract 400 by 
what has already been issued 
before initiating the revision 
in CCMS by using the 
“Cancel NPS Payment” 
option in the Conservation 
Payment System. 

 
Revise producer in CCMS. 
Contract 400 becomes 400A. 
 
Contract 400 will be in effect 
from 10/01/2014 to 
03/11/2015 for 162 active 
days in FY 2015. 
 
Contract 400A will be in 
effect from 03/12/2015 to 
9/30/2015 for 203 active days 
in FY 2015. 
 
Note: The canceled payment 

will go to the Pending 
Overpayment Report as 
referenced in 9-CM, 
paragraph 65. It is 
transferred to NRRS 
after 20 workdays by 
the Common Payment 
System or the user can 
transfer it to NRRS 
immediately. 

03/12/2015 Contract 400 will be 
issued a payment on 7 
active days in FY 2015. 
 
Contract 400A will be 
issued a payment on 67 
active days in FY 2015. 
 
Notes: Users will need 

to take the 
“Make NPS 
Payment” option 
in the 
Conservation 
Payment System 
to reissue the 
2015payment 
after the revision 
is completed. 

 
Canceling the 
payment will 
trigger the 
Conservation 
Payment System 
to create a 
receivable on 
contract 400. 
The payment 
will be reissued 
on contract 400. 
That payment 
will need to be 
applied to the 
receivable 
created and the 
producer will 
owe the balance. 
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Par. 25 
25  Revising Contracts (Continued) 
 
  E Effective Contract Start Dates for Farm Maintenance Changes 
 

When a contract revision or division is being completed to reflect changes in the FRS 
structure or to record a partial termination of contract acres, the user must enter the earlier of 
the first day of the FY or the start date of the prior revision if already completed in that same 
FY. 
 
Note: If a contract has already undergone a revision in the same FY according to 

subparagraph D, the effective contract start date will be limited to the effective 
contract start date of the prior revision. 

 
Following are examples of contract revisions for farm maintenance changes in CCMS: 

 
 

Reason for Change 
 

User Action in 
CCMS 

Effective Contract 
Start Date 

 
Payment Effects 

The County Office 
completed a recon on 
April 14, 2015, that 
only impacted the 
farm or tract and not 
any other CRP 
contract detail. 
Contract 360 is 
revised to become 
360A. 

Revise farm 
and/or tract in 
CCMS to 
correct the farm 
and/or tract 
number.  
Contract 360 
becomes 360A. 

Start of FY 
(10/1/14). 

100 percent of the payment 
will be issued to contract 360A 

The producer of 
contract 700 requests a 
partial termination for 
5 of the 25 acres on 
the contract to build a 
house. COC approves 
the partial termination 
on March 12, 2014. 

Complete a 
division of 
contract 700 to 
create 700A 
with 5 acres 
and 700B with 
20 acres. After 
those contracts 
are approved, 
terminate 
contract 700A 

Start of FY 
(10/1/13) for both 
the division and 
termination. The 
user needs to enter 
on the terminated 
contract the “Last 
Day the Contract is 
in Effect” 
(10/1/2014) 
according to page 
137 of the CCMS 
User Guide. Set the 
payment flag to 
“Refunds” on 
contract 700A. 
Setting the payment 
flag to “Refunds” 
ensures that no 
future payment will 
be issued on contract 
700A. 

Contract 700 will have zero 
active days in FY 2014.  No 
payment will be issued. 
 
Contract 700A will have zero 
active days in FY 2014.  No 
payment will be issued. 
 
Contract 700B will be paid for 
the entire FY 2014 on 20 acres. 
 
Note: Manual receivables will 

need to be created for 
the 5 acres that are 
terminated for each of 
the prior year’s 
payments issued 
according to 2-CRP, 
paragraph 574. 
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Par. 25 
25  Revising Contracts (Continued) 
 

E Effective Contract Start Dates for Farm Maintenance Changes 
 

 
Reason for Change 

 
User Action in 

CCMS 

Effective 
Contract 

Start Date 

 
Payment Effects 

The producer of 
contract 800 requests 
a partial termination 
for 5 of the 25 acres 
on the contract.  COC 
approves the partial 
termination on 
September 2, 2014. 
The County Office 
does not complete the 
division/termination 
process until  
FY 2015 (after 
10/1/14).  However, 
the FY 2013 payment 
was issued under the 
parent contract 

Cancel the 2013 
payment on contract 
800 in the 
Conservation 
Payment System. See 
note in the “Payment 
Effect” column. 
 
Complete a division 
of contract 800 to 
create 800A with 5 
acres and 800B with 
20 acres. After those 
contracts are 
approved, terminate 
contract 800A. 
 
Note: The canceled 

payment will 
go to the 
Pending 
Overpayment 
Report as 
referenced in 
9-CM, 
paragraph 65. 
It is 
transferred to 
NRRS after 
20 workdays 
by the 
Common 
Payment 
System or the 
user can 
transfer it to 
NRRS 
immediately. 

Start of FY 
(10/1/13) for 
both the 
division and 
termination. 
Set the 
payment flag to 
“Refunds” on 
contract 800A. 

Contract 800 will have zero 
active days in FY 2013. No 
payment will be issued. A 
receivable will be created 
for 100 percent of the FY 
2013 payment. 
 
Contract 800B will be paid 
on 20 acres for the number 
of active days in FY 2013. 
 
Note: Canceling the 

payment will trigger 
the Conservation 
Payment System to 
create a receivable 
on contract 800.  The 
payment will be 
reissued on contract 
800B.  That payment 
will need to be 
applied to the 
receivable created 
and the producer will 
owe the balance.  If 
the producer has 
changed, follow  
64-FI, subparagraph 
26 B to change the 
name on the 
receivable. A manual 
receivable will need 
to be created for the 
5 acres that are 
terminated for each 
of the prior years a 
payment was 
received. 
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Par. 25 
25  Revising Contracts (Continued) 
 

F Actions for Incorrectly Loaded Effective Contract Start Dates 
 

If an incorrect effective contract start date has been entered, State Offices must follow 
paragraph 127 to make the correction.   
 
If the State Office cannot complete the start date correction, submit the contract details 
including the incorrect effective date, the correct effective date, and status of payment in any 
year involved with the correction to the PECD Contract and Application Issues SharePoint at 
https://sharepoint.fsa.usda.net/mgr/dafp/PECD/Payment_Issues/Lists/Contract%20and
%20Application%20Issues/AllItems.aspx. 
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Par. 26 
26  Start Contract Revision Screen 
 

A Overview  
 

After “Initiate>Revise” is selected on the View Contract Screen the user will select the 
“Revision Effective Date” and “Reason for Revision”, on the Start Contract Revision Screen.  
Setting the “Effective Start Date” at the start of the revision process will dictate which 
Program Year CCMS will read in FRS. 
 
Example: The user set the revision effective date as 07/17/2015, CCMS will look at the FRS 

values active in FY 2015.  If the user sets the revision effective date as 
07/17/2016, CCMS will look at the FRS values active in FY 2016.  

  
B Example of Start Contract Revision Screen 

 
The following is an example of the Start Contract Revision Screen. 
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Par. 26 
26  Start Contract Revision Screen (Continued)  
  

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Start Contract 
Revision Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the 

contract.  
 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded 

for this contract. 
 

Program Year  The Program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the 
TERRA/COLS process.  
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

Parent Contract 
Start Date 

The effective start date of the parent 
contract.   

 

Contract End Date  The last day the contract will be in 
effect. 
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Par. 26 
26  Start Contract Revision Screen (Continued)  
  

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Revision 
Effective Date  

The date the revised contract will 
become effective.  

Enter the date in the 
mm/dd/yyyy format.  

Reason for 
Revision 

Reason contract is being revised. 
 
Note: If the revision is to increase 

acreage, by policy the only 
reason for an increase is 
because of new aerial 
imagery. 

Select reason from the drop-
down menu.   
 
Note: If user selects “Other”, 

a text box will be 
displayed to enter a 
reason. 

Save  The user will receive a pop-up 
window to confirm they want to 
modify the contract.  Selecting “OK” 
will save the revision effective date 
and reason for revision.  
 
The Success Screen will be displayed 
if all page validations are met.  
CLICK “OK” on the Success Screen 
to be returned to the View Contract 
Screen.   
 
Selecting “Cancel” on the pop-up 
window will return the user to the 
Start Contract Revision Screen 
without saving data.   

CLICK “Save” then “OK” or 
“Cancel”. 

Back The View Contract Screen will be 
displayed, no data will be saved and 
the revision will be canceled. 

CLICK “Back”. 
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Par. 26 
26  Start Contract Revision Screen (Continued)  
 

D Error Messages 
 

The Start Contract Revision Screen is set up to provide potential validation errors when 
comparing the contract to the current year in FRS.  
 

Error Message Description Corrective Action 
“Selection is required.” Reason for Revision is a 

required field. 
Select a reason for revision 
from the drop-down. 

“The effective date (XXX) 
cannot be after the current 
date (XXX).” 

A new child contract (not yet 
approved) cannot be future 
dated unless its parent is also 
future dated. 

Set an effective date equal 
to or prior than the current 
date.  

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity 
cannot begin after the 
contract ends. 

Set an effective date prior 
to the last day the contract 
is active.  

“The effective date (XXX) 
cannot be different than 
parent effective date (XXX).” 

If the parent contract is 
deferred, the child contract 
must start on the same date 
as the parent. 

Set the effective date as the 
deferred start date of the 
parent contract.  

“The effective date (XXX) 
cannot be earlier than the 
start date (XXX).” 

A child contract cannot start 
before its parent. 

Set the effective date equal 
to or later than the parents 
start date.  

 
E Modify Effective Date/Reason   

    
If the revision effective date or reason for revision is entered incorrectly return to the Start 
Contract Revision Screen by selecting “Modify >Effective Date/Reasons” and CLICK “Go” 
on the View Contract Screen.  
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Par. 27 
27  Modify Farm and Tract Screen   
 

A Overview  
 
 To modify the farm and/or tract number on the contract, users must select the action for 

Modify >Farm/Tract and CLICK “Go” after the revision has been started according to 
paragraph 13.   

 
The farm, tract, and producer name will be returned for the program year in FRS based on 
the revision effective date recorded in paragraph 26.   

 
B Example of Modify Farm and Tract Screen    

 
The following is an example of the Modify Farm and Tract Screen.  
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Par. 27 
27  Modify Farm and Tract Screen 
 

C Field Descriptions and Actions (Continued)  
 

The following table provides the field descriptions and actions for the Modify Farm and 
Tract Screen. 

 
Field  Description  Action 

Contract Status  Will display the current status of the contract.   
Activity Type  Will display No Activity, Divide or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract 
Number 

The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program year 
of the first month the contract was effective. 

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.   
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for 
this contract. 

 

Farm/Tract and CLU Information 
Farm Number The Farm number currently associated with 

the contract.  
 

Tract Number The Tract number currently associated with 
the contract. 

 

CLU The CLU number(s) currently associated with 
the contract. 

 

CLU Acres  The acres in hundredths for each CLU 
displayed on the screen.   
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Par. 27 

27  Modify Farm and Tract Screen (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Search for New Farm and Tract 

Farm Number  To search for a contract to modify 
by farm number. 

Enter the desired farm 
number. 

Tract Number To search for a contract to modify 
by tract number. 

Enter the desired tract number. 

Producer Name To search for a contract to modify 
by producer. 

CLICK “Find Producer” and 
user will be taken to the 
SCIMS Customer Search Page 
to search for the desired 
producer.  Once the producer 
is selected on the SCIMS 
Customer Search, their name 
will populate in the Producer 
name box.   

Search The Modify Farm and Tract Screen 
will be updated with the Farms and 
Tracts that meet the search criteria.      

CLICK “Search”. 

Back The View Contract Screen will be 
displayed, no data will be saved.  

CLICK “Back”. 

Reset All entered values will be 
removed.  

CLICK “Reset”. 

 
D Example of the Bottom of the Modify Farm and Tract Screen-After Search  

 
The following is an example of the bottom of the Modify Farm and Tract Screen after the 
user searched by farm, tract, or producer.  
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Par. 27 
27  Modify Farm and Tract Screen (Continued) 

 
E Field Descriptions and Actions for Bottom of the Modify Farm and Tract Screen-After 

Search Options  
    

The following table provides the field descriptions and actions for the updated Modify Farm 
and Tract Screen after the user searched for a farm, tract, or producer. 

 
Field/Button Description Action 

Farm Number  All Farm numbers that matched the search 
criteria will be displayed. 

Select the radio 
button on the desired 
farm. 

Tract Number The tract number(s) for the corresponding Farm 
number that matched the search criteria will be 
displayed. 

 

Tract Description  The tract description for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Farmland Acres The farmland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Cropland Acres  The cropland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

CRP Cropland 
Acres 

The CRP cropland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

CRP MPL Acres  The CRP MPL acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Modify Search  The farm, tract, and producer options according 
to subparagraph C will be displayed.   

CLICK “Modify 
Search”. 

Save After the user selects the radio button for the 
“Farm/Tract Number” to add to the contract and 
they select “Save” a pop-up window will be 
displayed to confirm the save.  Selecting “OK” 
will save all data.   
 
The Success Screen will be displayed if all page 
validations are met.  CLICK “OK” on the 
Success Screen to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the pop-up window will 
return the user to the Modify Farm and Tract 
Screen without saving data.   

CLICK “Save” then 
“OK” or “Cancel”.  

Back  Will return to the View Contract Screen and no 
data will be saved. 

CLICK “Back”. 
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Par. 27 
27  Modify Farm and Tract Screen (Continued)  
 

F Error Messages 
 

The Modify Farm and Tract Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  The following error messages 
may be displayed. 
 

Error Message Description Corrective Action 
“The Farm number (XXX) 
currently on this contract is 
no longer in an active status 
for Fiscal Year (XXX).” 

Farm number the user is 
adding to the contract must 
be active in the FY of the 
contract revision effective 
date. 

Enter active farm number 
for the year of the 
contract revision effective 
date. 

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX).  Please 
establish the tract number for 
this county.” 

The tract number(s) cannot 
be missing or inactive. 

Enter active tract number 
for the year of the 
contract revision effective 
date. 
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Par. 28 
28  Adjust Acreage  
 

A Overview  
 

To modify the contract acres and to modify or add CLU number and acres on the contract, 
users must select the action for Modify >Acreage and CLICK “Go” after the revision has 
been started according to paragraph 13.   

 
Note: MPL acres cannot be added to a child contract if the parent contract did not have 

MPL acres; likewise, cropland acres cannot be added to a child contract if the parent 
had only MPL acres. 
 

Important:  If there has been a reconstitution on the farm, it is recommended that the 
“Modify > Farm/Tract” action (paragraph 14) be accessed to update the farm 
and tract information before adjusting the acreage. 

 
When contract acres increase due to correction of a survey error or to move the contract from 
tenths to hundredths, CCMS will validate with FRS to ensure there are available acres based 
on the program year that corresponds to the effective revision date of the contract.  

 
CCMS calculates available acres from Farm Records as follows for revisions: 

 
Effective DCP Cropland + Double Cropped Acres + Parent Contract Acres= Acres available 
for CRP. 
 
CCMS also considers base acres but will only provide a warning that a CCC-505 is needed.   
In cases that the entire tract is enrolled in CRP, CCMS will provide the error that there are 
not available acres to increase the contract acres, if the CLU/CRP attributes in MIDAS are 
already updated to display the CRP attributes.  In these cases, users must remove the 
CRP/CLU attributes in MIDAS before completing the revision in CCMS.  Once the revision 
is Finalized in CCMS, the user can correct MIDAS Farm Records and add the CRP/CLU 
attributes back to the farm record.   
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Par. 28 
28  Adjust Acreage (Continued)  
 

B Example of Adjust Acreage Screen  
 

The following is an example of the Adjust Acreage Screen.  
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Par. 28 
28  Adjust Acreage (Continued)  
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Adjust Acreage 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Farm Number  The farm number associated with the contract.  

Tract Number The tract number associated with the contract.   

Available Cropland 
Acres  

Displays the available cropland and/or non-
cropland & MPL acres currently on the tract 
in farm records.  
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Par. 28 
28  Adjust Acreage (Continued)  
 

C Field Descriptions and Actions (Continued)  
 

Field/Button Description Action 

Contract Acres  Displays the cropland, MPL, non-
cropland, and wellhead acres on the 
contracts.  The acreage type(s) currently 
on the contract will be the only types the 
user can edit.  

Correct the applicable 
acreage field as needed.  
Acres must be entered to the 
hundredths precision.  

Farm Number  The farm number associated with the 
contract. 

 

Tract Number The tract number associated with the 
contract.  

 

CLU The CLU number associated with the 
contract.  

Enter the CLU number from 
farm records.  

CLU Acres The acreage value that corresponds to the 
CLU number that was entered.  

Enter the CLU acres value in 
hundredths for the CLU 
number entered.  

Delete  Removes the CLU record for the specified 
line item.  

CLICK “Delete”. 

Add New CLU Information 
Farm Number  This value will be prepopulated based on 

the farm number associated with the 
contract. 

 

Tract Number  This value will be prepopulated based on 
the tract number associated with the 
contract. 

 

CLU The CLU number to associate with the 
contract. 

Enter the CLU number.  

CLU Acres The acreage value that corresponds to the 
CLU number to associate with the 
contract. 

Enter the CLU acres value in 
hundredths for the CLU 
number entered.  

Add Adds the data entered. CLICK “Add”. 
Total  Total CLU acreage on the contract.   
Re-Enrolled 
Acres  

Displays the number of acres on the 
contract that were a result of reenrollment.  
 
Note: If the user is decreasing the size of 

the contract they must decrease the 
re-enrolled acre to be equal to or 
less than the total contract acres.  

Adjust the acres value in 
hundredths as needed.  
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Par. 28 
28  Adjust Acreage (Continued)  
 

C Field Descriptions and Actions (Continued)  
 

Field/Button Description Action 

Save After the user selects “Save”, a pop-up 
window will be displayed to confirm save.  
Selecting “OK” will save all data.   
 
The Success Screen will be displayed if 
all page validations are met.  User will 
click “OK” on the Success Screen to be 
returned to the View Contract Screen.   
 
Selecting “Cancel” on the pop-up window 
will return the user to the Adjust Acreage 
Screen without saving data.   

CLICK “Save” then “OK” or 
“Cancel”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 28 
28  Adjust Acreage (Continued)  
 

D Error Messages 
 

The Adjust Acreage Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Cropland acreage cannot be added 
to a contract which does not 
already have cropland acreage.” 

A contract that does not have 
cropland acres cannot be 
revised to have cropland 
acres. 

Correct the acreage type 
on the CLU to match the 
acres type of the 
contract.  If the acre type 
of the contract is 
incorrect notify the State 
Office. State Office users 
will place the issue on 
SharePoint for 
resolution.  

“Farm Tract Acres (Cropland 
Acres + MPL Acres) do not match 
Total CLU Acres. Farm Number = 
(XXX) Tract Number = (XXX) 
Farm Tract Acres = (XXX) Total 
CLU Acres = {XX}.” 

Total CLU acres must add up 
to acres on the farm tract 
(farm-level validation). 

Correct CLU acres to not 
exceed tract acres. 

“Farm Tract Acres (Cropland 
Acres + Non-Cropland Acres + 
MPL Acres) do not match Total 
CLU Acres. Farm Number = 
(XXX) Tract Number = (XXX) 
Farm Tract Acres = (XXX) Total 
CLU Acres = {XX}.” 

Total CLU acres must add up 
to acres on the farm tract. 

Correct CLU or contract 
acres.  

“Field/CLU Number (XXX) is 
missing acreage information.” 

CLU cannot have null value 
for acreage amount. 

Enter the acreage value 
for the CLU.  

“Field/CLU Numbers are required. 
Please enter the Field/CLU 
Numbers before proceeding.” 

CLU number must be valid 
(cannot be null/missing, 
blank or -99). 

Enter a valid CLU 
number.  

“MPL acreage cannot be added to a 
contract which does not already 
have MPL acreage.” 

A contract that does not have 
MPL acres cannot be revised 
to have MPL acres. 

Correct acreage type on 
the CLU to match the 
acres type of the 
contract.  If the acre type 
of the contract is 
incorrect, notify the State 
Office.  State Office 
users will contact the 
National Office for 
resolution.   

5-15-19     5-CRP Amend. 1 Page 2-90  



Par. 28 
28  Adjust Acreage (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“Non-Cropland acreage 
cannot be added to a 
contract which does not 
already have Non-Cropland 
acreage.” 

A contract that does not have MPL 
acres cannot be revised to have 
MPL acres. 

Correct acreage type on 
the CLU to match the 
acres type of the 
contract.  If the acre 
type of the contract is 
incorrect, notify the 
State Office.  State 
Office users will place 
the issue on SharePoint 
for resolution.  

“Please add CLU before 
saving.” 

No CLU's have been found from 
the contract. 

Enter a valid CLU 
number and acreage.  

“The CLU acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths.  

“The CLU number (XXX) 
is already added to this 
contract.” 

Multiple CLU's of the same 
number/identifier cannot exist on 
the same contract. 

Enter a valid CLU 
number. 

“The combination of MPL 
acres and Non-Cropland 
acres (XXX) on the tract 
(XXX) are more than 
available acres (XXX). 
These acres will only fit if 
the combination of MPL 
acreage and Non-Cropland 
acreage on this tract grows 
for Fiscal Year (XXX).” 

There are more MPL and non- 
cropland acres on the farm tract 
than there are available (available 
amount retrieved from FRS and 
added to the parent acreage). 

Correct CLU or 
contract acres. 

“The Cropland acreage on 
this contract cannot be 
reduced to zero.” 

If the parent contract has cropland 
acres, the child contract must have 
cropland acres. 

Enter CLU cropland 
acreage value greater 
than 0, acreage values 
in hundredths. 
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Par. 28 
28  Adjust Acreage (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The cropland acres 
(XXX) entered for the tract 
(XXX) exceed available 
acres (XXX) for Fiscal 
Year (XXX).” 

If the Cropland on the farm tract is 
greater than the available cropland 
acres (including base acres). 

Correct CLU acres to 
not exceed tract acres. 

“The cropland acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths. 

“The MPL acreage on this 
contract cannot be reduced 
to zero.” 

If the parent contract has MPL 
acres, the child contract must have 
MPL acres. 

Enter CLU MPL 
acreage value greater 
than zero, acres values 
in hundredths 

“The MPL acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths. 

“The Non-Cropland 
acreage on this contract 
cannot be reduced to zero.” 

If the parent has non-cropland 
acres, the child contract must have 
non-cropland acres. 

Enter CLU Non-
Cropland acreage value 
greater than zero, 
acreage values in 
hundredths. 

“The Non-Cropland acres 
cannot exceed more than 
two decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths. 

“The re-enrolled acres 
cannot exceed more than 
two decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths 

“The sum of cropland,  
Non-cropland, and MPL 
acres of all farm tracts 
(contract acres) cannot 
exceed more than two 
decimals.” 

All acreage entries must be entered 
in hundredths. 

Enter acreage values in 
hundredths. 
 

“The sum of the CLU 
Acres shall equal the 
Contract Acres.” 

Sum of CLU acres must be equal 
to the contract acreage. 

Correct CLU or 
contract acres. 
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Par. 28 

28  Adjust Acreage (Continued) 

 

D Error Messages (Continued) 

 

Error Message Description Corrective Action 

“The total CLU acres 

cannot exceed more than 

two decimals.” 

All acreage entries must be entered 

in hundredths. 

Enter acreage values 

in hundredths. 

“The Tract and/or CLU 

Number on this contract 

were unavailable when this 

contract was migrated. 

They shall be updated in 

order to complete this 

transaction.” 

All tracts and CLU’s on the 

contract cannot be “unknown”. 

Add tract and CLU 

numbers to the 

contract according to 

paragraphs 11.  

“The tract number (XXX) 

is not valid for this county 

for Fiscal Year (XXX). 

Please establish the tract 

number for this county.” 

The tract number(s) cannot be 

missing. 

Add tract number to 

the contract according 

to paragraph 11. 

“The Wellhead Acres 

(XXX) shall not exceed the 

Cropland Acres (XXX).” 

The wellhead acres must not 

exceed the cropland acres. 

Correct CLU or 

contract wellhead 

acres. 

“The Wellhead acres 

cannot exceed more than 

two decimals.” 

All acreage entries must be entered 

in hundredths. 

Enter acreage values 

in hundredths. 

“Total Wellhead acres 

(XXX) not equal to 

approved Wellhead acres 

(XXX).” 

The sum of the wellhead practice 

acreage must equal the wellhead 

protection acres on the contract. 

Correct CLU or 

contract wellhead 

acres. 

“Tract (XXX) shall have 

Cropland or MPL acres.” 

The tract must have at least 1 valid 

acreage type. 

Add tract number to 

the contract according 

to paragraph 11. 
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Par. 28.5 

*--28.5 Adjust Re-Enrolled Acreage Screen 

 

A Overview 

 

The Adjust Re-Enrolled Acreage Screen will be open to users to update parent contract 

information from the expired CRP contract that was re-enrolled into the acreage for the 

existing contract.  This option will only need to be used to correct missing or incorrect data 

recorded during the TERRA and COLS offer process or to update when the CLU numbers 

change on the CRP contact. 

 

To update the re-enrolled acres information during a revision, from the “Select an action to 

perform” drop-down menu on the View Contract Screen, select “Modify > Adjust 

Re-Enrolled Acreage” and CLICK “Go”. 

 

B Example of Adjust Re-Enrolled Acreage Screen 

 

The following is an example of the Adjust Re-Enrolled Acreage Screen. 

 

 
--* 
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Par. 28.5 

*--28.5 Adjust Re-Enrolled Acreage Screen (Continued) 

 

C Fields and Descriptions 

 

The following table provides the field descriptions and actions for the Adjust Re-Enrolled 

Acreage Screen. 

 

Field/Button Description Action 

Contract Status Will display the current status of the contract.  

Activity Type Will display “No Activity”.  

Admin State The administrative State of the contract.  

Admin County The administrative county of the contract.  

Physical State The State of the physical location of tract for this 

contract. 

 

Physical County The county of the physical location associated with 

this contract. 

 

Contract Number The contract number that was selected on the 

Select Contract Screen. 

 

Signup Number The applicable signup number recorded for this 

contract. 

 

Program Type Will display “CRP”.  

Signup Name The applicable signup name recorded for this 

contract. 

 

Program Year The program year associated with this contract.  

This value is set to the program year of the first 

month the contract was effective. 

 

Signup Type The applicable signup type recorded for this 

contract. 

 

Contract 

Description 

This field will display the contract description 

entered in the TERRA/COLS process. 

 

Note: Will be blank for S36 migrated contracts. 

 

Subcategory 

Type 

The applicable CRP subcategory recorded for this 

contract. 

 

Farm Number The farm number associated with the contract.  

Tract Number The tract number associated with the contract.  

CLU The CLU number associated with the contract.  

CLU Acres The acres associated with the CLU entered.  

--* 
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Par. 28.5 

*--28.5 Adjust Re-Enrolled Acreage Screen (Continued) 

 

C Fields and Descriptions (Continued) 

 

Field/Button Description Action 

Re-Enrolled 

Acres 

Displays the number of acres on the contract 

that were a result of re-enrollment. 

 

CLU The CLU number associated with the contract. Select the applicable 

CLU number from 

the drop-down menu. 

Expired Contract 

Number 

The contract number of the contract that 

expired before the current acres being 

re-enrolled to this contract. 

Enter the applicable 

expired contract 

number. 

Expired Signup 

Name 

The expired signup name from the contract 

that expired before the current acres being 

re-enrolled to this contract. 

 

Note: This value will be populated from the 

expired contract number that was 

entered. 

 

Expired Practice 

Code 

The practice code from the contract that 

expired before the current acres being 

re-enrolled to this contract. 

 

Note: This value will be populated from the 

expired contract number that was 

entered. 

 

Re-Enrolled 

Acres 

Displays the number of acres on the contract 

that was a result of re-enrollment. 

Enter the number of 

acres re-enrolled on 

that CLU. 

Action Will allow for the options for the CLU data to 

be added or deleted. 

CLICK “Add” or 

“Delete”. 

Save After the user clicks “Save”, they will receive 

a pop-up window to confirm the save.  

Clicking “OK” will save all data.  The Success 

Screen will be displayed if all page validations 

are met.  The user will CLICK “OK” on the 

Success Screen to be returned to the View 

Contract Screen.  Clicking “Cancel” on the 

pop-up window will return the user to the 

Adjust Re-Enrolled Acreage Screen without 

saving data. 

CLICK “Save”, then 

“OK” or “Cancel”. 

Back Returns the user to the View Contract Screen 

and no data will be saved. 

CLICK “Back”. 

--* 
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Par. 28.5 

*--28.5 Adjust Re-Enrolled Acreage Screen (Continued) 

 

D Error Messages 

 

The Adjust Re-Enrolled Acreage Screen is set up to provide potential validation errors.  The 

following error messages may be displayed. 

 

Error Message Description Corrective Action 

There is no contract 

number {XXXX} for 

state/county code 

{XX/XXX}. 

The contract number entered as 

the expired contract number 

was not found for the State and 

county selected. 

Re-enter the correct 

expired contract number. 

Contract number {XXX} 

for state/county code 

{XX/XXX} is not in a 

valid status for 

reenrollment ({XX}). 

The effective end date for the 

contract number entered as the 

expired contract number is not 

before the start date of the 

existing CRP contract. 

Re-enter the correct 

expired contract number. 

At least 1 reenrollment 

detail is positioned on an 

'unknown' CLU. 

The CLU number is missing 

from the contract. 

Enter the CLU number on 

the Adjust Acreage Screen 

according to paragraph 28. 

Reenrollment Detail must 

have some acreage 

(greater than zero). 

The value for re-enrolled acres 

is zero or blank. 

Enter an acreage value 

greater than zero. 

Reenrollment Details must 

define all reenrollment 

acres on the contract 

({XXX} vs {XXX}). 

The re-enrolled CLU acreage 

does not add up to the total 

re-enrolled acreage for the 

contract. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

Practice {XXX} is not on 

contract number {XXX}. 

The expired contract did not 

contain the practice the user has 

entered. 

Enter the expired practices 

from the expired contract 

number or correct the 

expired contract number. 

CLU {XXX} is only 

{XXX} acres, not enough 

to support {XXX} acres 

of reenrollment associated 

to it. 

Only one CLU is entered and 

the acres for that CLU is less 

than the total re-enrolled acres 

on the contract. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

You must define some 

enrollment details. 

The contract shows re-enrolled 

acres, but no CLU level details 

are provided on this screen. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

The expiring contract 

must end ({XXX}) prior 

to this contract original 

start date ({XXX}). 

The expired contract listed did 

not expire before the start date 

of the current contract. 

Re-enter the correct 

expired contract number. 

--* 
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Par. 29 

29  Modify Producers 

 

A Overview 

 

To modify producers on the contract, from the “Select an action to perform” drop-down 

menu on the View Contract Screen, select “Modify > Producers” and CLICK “Go”. 

 

The Modify Producers Screen will be displayed with information for all owners and other 

producers associated with the tract and all operators associated with the farm from FRS for 

the program year that corresponds to the revision effective date set in CCMS.  If a producer 

is not displayed in CCMS, they must first be added to the farm record. 

 

Policy requires all owners of a tract to be on the contract, even if they are not receiving any 

shares. 

 

B Example of Modify Producers Screen 

 

The following is an example of the Modify Producers Screen. 
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Par. 29 
29  Modify Producers (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Modify Producers 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract. This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for 
this contract. 
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Par. 29 
29  Modify Producer (Continued)   
 

C Fields Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Assigned Producers 

Remove  Will remove the producer from the list of 
Assigned Producers and the producer will 
not display on the revised CRP-1.   

CLICK “Remove”. 

Producer Name  Name of the producer associated with the 
farm/tract in farm records for the program 
year that corresponds to the revision 
effective date and assigned to the contract. 

 

Type The type of association the producer has 
on the tract associated with the contract 
according to FRS.  Owner, operator, or 
other tenant will be displayed.  

 

Share  The percent share interest the producer has 
in the CRP-1.  

Enter the percentage value 
between 0 and 100 percent in 
hundredths.   

Primary Designates the primary point of contact for 
the CRP contract.  

Enter a check () in the box 
of the producer that is the 
primary point of contact.   

Available Producers 
Add Will add the producer from the list of 

available producers to the list of assigned 
producers and the producer will display on 
the revised CRP-1.   

CLICK “Add”. 

Producer Name  Name of the producer associated with the 
farm/tract in farm records for the program 
year that corresponds to the revision 
effective date and assigned to the contract. 
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Par. 29 
29  Modify Producer (Continued)   
 

C Fields Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Type The type of association the 

producer has on the tract 
associated with the contract 
according to FRS.  Owner, 
operator, or other tenant will be 
displayed. 

 

Save Will save the data entered on the 
Modify Producers Screen. 

CLICK “Save” then “OK” or 
“Cancel”.  After “Save” is 
selected a pop-up window will 
be displayed to confirm they 
wish to save.  Selecting “OK” 
will save all data.   
 
The Success Screen will be 
displayed if all page 
validations are met.  CLICK 
“OK” on the Success Screen 
to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the 
pop-up window will return the 
user to the Modify Producer 
Screen without saving data.   

Back  Will return the user to the View 
Contract Screen and no data will 
be saved. 

CLICK “Back”. 
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Par. 29 
29  Modify Producer (Continued) 
 

D Error Messages 
    

The Modify Producers Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“All owners on the contract 
shall have shares, even if 
zero.” 

All producers on the contract 
must have shares, even if 
zero. 

Enter share percentage 
between 0 and 100 percent 
for each producer on the 
contract. 

“The Farm number (XXX) 
currently on this contract is 
no longer in an active status 
for Fiscal Year (XXX). 
Without a valid Farm 
Number, all other data 
validations will fail. Please 
correct the Farm Number.” 

Farm on Contract must be in 
FRS. 

Correct farm and tract 
number.  

“The total of share 
percentages shall equal 100.” 

The sum of the producer 
share percentages must equal 
100. 

Enter share percentage 
between 0 and 100 percent 
for each producer on the 
contract. 
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Par. 30 
30  Modify Practices   
 

A Overview  
 

The Modify Practices Screen that will be displayed has 3 sections, as follows: 
 
• top section is basic signup information 

 
• middle section is acreage and acreage types associated with the contract 

 
• bottom “Assigned Practices” section provides the practices assigned by CLU with the 

associated acreage and estimated cost share, a summary of the practice acreage, and 
estimated cost share. 

 
Users can modify the acreage associated with each practice, modify the estimated cost share 
associated with each practice, delete assigned practices, and add new practices. 

 
To modify conservation practices, on the View Contract Screen, from the “Select an action to 
perform” drop-down list, select “Modify > Practices” and CLICK “Go”. 
 

B Example of Modify Practices Screen    
 

The following is an example of the Modify Practices Screen.  
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Par. 30 
30  Modify Practices (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Modify Practices 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Contract Acres  The number of acres on the contract.  

Cropland Acres Displays the number of cropland acres on 
the contract.  Display as N/A if the 
contract is not cropland eligible.  
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Par. 30 
30  Modify Practices (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
MPL Acres  Displays the number of MPL acres on the 

contract.  Display as N/A if the contract is 
not MPL eligible. 

 

Non-Cropland 
Acres 

Displays the number of Non-Cropland 
acres on the contract.  Displays as N/A if 
the contract is not non-cropland eligible. 

 

Wellhead Acres  Displays the number of Wellhead acres on 
the contract.  Display as N/A if the 
contract is not wellhead eligible. 

 

Payable Acres Display the number of acres payable for 
the contract.  This field can only be edited 
on FWP contracts.  

If applicable, enter the 
number of payable acres in 
hundredths.   

Assigned Practices 
Farm  Farm number associated with the contract.   
Tract Tract number associated with the contract.  
CLU Displays CLU number and, in 

parentheses, the number of acres 
associated with CLU in hundredths.  
There can be multiple CLU’s on the 
contracts and the drop-down list will 
include all CLU’s associated with the 
contract.   

Select CLU for the practice 
being adding from the 
drop-down list.    

Code Displays the practice code.  Drop-down 
list will display the practice codes 
configured for the signup for which the 
contract was approved.   

 

Practice Acres  Practice acres are automatically calculated 
as users enter the acreage values in the 
acreage field. 

 

Acreage  The number of acres on the CLU for the 
corresponding practice.  This value should 
equal the CLU acres.   

Enter acreage value in 
hundredths.  

Estimated Cost 
Share per acre 
for the Practice  

Allows the user to enter the estimated cost 
share amount per acre and will display the 
total by practice.   

Enter estimated cost share 
per acre.  

Delete Will remove the CLU row that Delete was 
selected.  A pop-up window will be 
displayed to confirm the deletion of the 
CLU.  Selecting “No” will return the user 
to the Modify Practice Screen without 
deleting the CLU. 

 CLICK “Delete” then 
“OK” or “No”. 
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Par. 30 
30  Modify Practices (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Totals 

Practice Acres Total practice acres entered above for 
each CLU. 

 

Acreage  Total acreage entered above for each 
CLU, displayed by acre type for MPL, 
cropland, non-cropland, and wellhead. 

 

Total Estimated 
Cost Share  

Total estimated cost share entered above 
for each CLU. 

 

Add New 
Practice  

The Add Practice Screen will be 
displayed and users will enter new 
practice details according to paragraph 
31.  

CLICK “Add New Practice”. 

Save Will save the data entered on the Modify 
Practices Screen. 

CLICK “Save”. 
After the user selects “Save” a 
pop-up window will be 
displayed to confirm they wish 
to save.  Selecting “OK” will 
save all data.   
 
The Success Screen will be 
displayed if all page 
validations are met.  CLICK 
“OK” on the Success Screen to 
be returned to the View 
Contract Screen. 
 
Selecting “Cancel” on the pop-
up window will return the user 
to the Modify Practices Screen 
without saving data.   

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 31 
31  Add Practice Screen    
 

A Overview  
 

The Add Practice Screen will allow users to add a new practice to the CRP contract.  
Practices listed will be contract by signup type by the Conservation Configuration System.   

  
B Example of Add Practice Screen   
 

The following is an example of the Add Practice Screen.   
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Par. 31 
31  Add Practice Screen (Continued) 

 
C Field Descriptions and Actions 

 
The following table provides the field descriptions and actions for the Add Practice Screen. 

 
Field Description Action 

Contract Status  Will display the current status of the 
contract.  

 

Activity Type  Will display No Activity, Divide or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the 

contract.  
 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded 

for this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory 
recorded for this contract. 
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Par. 31 
31  Add Practice Screen (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Farm Number The farm number associated with the 

contract. 
 

Tract Number  The tract number associated with the 
contract. 

 

CLU  CLU number and acres recorded by 
the user on the Revise Acreage CLU 
Screen.  

Select the correct CLU 
number from the drop-down.  

Code List of practice codes on the contract.   Select the correct practice 
code from the drop-down.  

Status List of practice is “New”, “Enhanced”, 
or “Existing”.  Default value is “N/A”.   

Select the correct status value.   

Practice Acres  Displays the practice acres.  This is a 
display field only based on the value 
entered for MPL, cropland, and 
wellhead acres.   

 

MPL Acres The number of MPL acres for this 
practice.  This field will be grayed out 
unless the contract already contains 
MPL acres.  Acreage value must 
match CLU acreage.  

Enter acreage value in 
hundredths, if applicable 

Cropland Acres  The number of Cropland acres for this 
practice.  This field will be grayed out 
unless the contract already contains 
Cropland acres.  Acreage value must 
match CLU acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  

Non-Cropland Acres The number of Non-Cropland acres for 
this practice.  This field will be grayed 
out unless the contract already 
contains non-cropland acres.  Acreage 
value must match CLU acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  

Wellhead Acres The number of Wellhead acres for this 
practice.  This field will be grayed out 
unless the contract already contains 
wellhead acres.  Acreage value must 
match CLU acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  
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Par. 31 
31  Add Practice Screen (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Estimated Cost Share 
Per Acre: $ 

Displays dollar value of estimated 
cost share per acre recorded on the 
contract.   

Enter estimated cost share per 
acre in dollars and cents.  

Save  The Modify Practice Screen is 
displayed and data is saved.    

CLICK “Save”. 

Back The Modify Practice Screen is 
displayed and no data is saved.  

CLICK “Back”. 

 
D Error Messages 
 

The Modify Practices Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Tract number or 
CLU = “unknown”. 

If either “Tract Number” or “CLU” 
field contain the value “unknown”, 
a message will be displayed that the 
fields must be updated to complete 
the transaction. 

Tract number is assigned on the 
Modify Farm and Tract Numbers 
Screen.  CLU is assigned on the 
Adjust Acreage Screen.  Practices 
must be assigned to CLU. 

“Sum of the practice 
acres = contract 
acres.” 

If the sum of the practice acres does 
not match the contract acres, a 
warning message will be displayed. 

Either the contract acreage or the 
practice acreage must be adjusted 
before the contract is finalized. 

“Wellhead Practice 
acres <= Cropland 
Acres.” 

If the contract has wellhead 
protection acres and the wellhead 
practice acres are greater than the 
cropland acres, an error message 
will be displayed.  

The wellhead practice acres must 
be reduced to be less than or equal 
to the contract acres. 

“Wellhead Practice 
acres = Wellhead 
Protection Area 
acres.” 

If the contract has wellhead 
protection area acres and the 
wellhead practice acres are not 
equal to the wellhead protection 
area acres, an error message will be 
displayed. 

Adjust the wellhead practice acres 
to equal the wellhead protection 
area acres. 

“FWP practices 
requiring buffer area 
present.” 

If the contract is for FWP, CCMS 
will determine whether buffer area 
acres are required.  This is based on 
the program year of the contract and 
the assigned practices.  If a buffer 
area is required and not on the 
contract, an error message will be 
displayed. 

The buffer area practice (CP31) 
must be assigned to the contract. 
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Par. 31 
31  Add Practice Screen (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“FWP Payable 
Acres > FWP 
Practice Acres.” 

FWP payable acres are for FWP 
contracts written under the 2008 
Farm Bill.  The 2008 Farm Bill 
stipulated that payment would be 
made for up to 5 acres per FWP plot.  
A contract can have multiple plots 
so CCMS can only validate that the 
payable acres are not greater than 
the practice acres.  If the payable 
acres are greater, a warning will be 
displayed. 

Reduce FWP payable acres to be 
less than or equal to the FWP 
practice acres. 

“Sum of MPL 
Practice Acres = 
Contract MPL 
Acres.” 

If the sum of the MPL practice acres 
is not equal to the contract MPL 
acres, a warning message will be 
displayed. 

Correct either the MPL practice 
acreage or the MPL contract 
acreage.  This must be complete 
before the contract is finalized. 

“Sum of 
Cropland 
Practice Acres = 
Contract 
Cropland Acres.” 

If the sum of the cropland practice 
acres is not equal to the contract 
cropland acres, a warning message 
will be displayed. 

Correct either the cropland 
practice acreage or the contract 
cropland acreage.  This must be 
complete before the contract is 
finalized. 

“FS Technical 
Responsibilities 
completed for 
any Forestry 
practices.” 

CCMS will determine whether any 
FS practices are present on the 
contract.  If yes, CCMS will verify 
that the user has indicated the FS 
technical responsibilities have been 
completed. 

User must verify the technical 
responsibilities have been 
completed (manually) and then 
check () the box indicating that 
FS technical responsibilities have 
been completed.  It is a required 
entry, if displayed. 
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Par. 32 
32 Finalize Contracts  
 

A Overview  
 
CCMS requires a step after the details of the revision have been updated to prepare the 
contract for COC approval.  To finalize revisions, on the following View Contract Screen, 
from the “Select an action to perform” drop-down list, select “Modify > Finalize” and 
CLICK “Go”. 

 
B Example of the Finalize Screen    

 
The following is an example of the Finalize Screen.  
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Par. 32 
32  Finalize Contracts (Continued)  
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Finalize Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of 

the contract. 
 

Activity Type  Will display No Activity, Divide 
or Revise based on the 
maintenance being done to the 
contract.  

 

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative County of the 
contract.  

 

Physical State  The State of physical location of 
tract for this contract.  

 

Physical County  The county of the physical 
location associated with this 
contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen.   

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name 

recorded for this contract. 
 

Program Year  The program year associated with 
this contract.  This value is set to 
the program year of the first month 
the contract was effective.  

 

Signup Type  The applicable signup type 
recorded for this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Contract Description  A free form optional field that the user can 

add contract descriptions based on 
revisions. 

Add contract descriptions 
as applicable.  Do not load 
any PII information in this 
field.   

Parent Contract Start 
Date 

The start date of the contract that was 
modified. 

 

Contract End Date  The final date the contract will be in effect.   
Revision Effective 
Date 

The first day the newly modified contract 
will be effective.  This date is set on the 
Start Contract Revision Screen in 
paragraph 13. 

 

Reason for Revision  The reason the user selected on the Start 
Contract Revision Screen.  

 

Check box to 
indicate CPO 
Update Received  

Indicator to allow the user to record that the 
CPO has been received.  
 
Note: This field will only be displayed if 

an updated CPO is needed.   

Check (), if CPO update 
has been received.  

FS Technical 
Responsibilities 
Completed? 

Indicator to allow the user to record that the 
FS technical responsibilities have been 
received.  
 
Note:  This field will only be displayed if 

updated FS Technical 
Responsibilities are needed for the 
practices on the contract.   

Check (), if FS technical 
responsibilities 
documentation has been 
completed. 

CRP-1 Producer 
Signed Date 

The date the last producer on the CRP-1 
signed the CRP-1.   

Enter the date in the 
mm/dd/yyyy format or 
select the date from the 
calendar icon.  

Finalize  Will save the data entered on the Finalize 
Screen and create the new child contract. 

CLICK “Finalize” and 
“OK”. 
 
After the user selects 
“Save” a pop-up window 
will be displayed to 
confirm they wish to save.  
Selecting “OK” will save 
all data.   
 
CCMS will execute a 
series of validations.  If 
any validations fail, 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages 
 

The Finalize Contract Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“(XXX)'s involvement has 
changed for Fiscal Year 
(XXX), please update the 
producer's involvement.” 

The producer involvement on the 
contract must match the producer 
involvement in FRS. 

Correct producer 
according to 
paragraph 29. 

“All owners associated 
with the tract in Farm 
Records for Fiscal year 
(XXX) shall be on the 
contract, even if they are 
not receiving payments 
from the contract. Other 
Producers on the tract and 
Operators are optional. 
Please add all owners of the 
tract to the contract.” 

All owners must be on the contract, 
including those with zero percent 
interest on the contract. 

Correct producer 
according to 
paragraph 29. 

“Cropland acreage cannot 
be added to a contract 
which does not already 
have Cropland acreage.” 

A contract that does not have 
cropland acres cannot be revised to 
have cropland acres. 

Correct CLU or 
contract acre type 
according to 
paragraph 28. 

“CRP-1 Producer Signed 
Date is required.” 

Producer signed date is a required 
field. 

Enter date in 
mm/dd/yyyy format 
according to this 
paragraph.  

“Field/CLU Numbers are 
required. Please enter the 
Field/CLU Numbers before 
proceeding.” 

CLU number must be valid (cannot 
be null/missing, blank or -99). 

Enter CLU numbers 
according to 
paragraph 28. 

“MPL acreage cannot be 
added to a contract which 
does not already have MPL 
acreage.” 

A contract that does not have MPL 
acres cannot be revised to have 
MPL acres. 

Correct CLU or 
Contract acre type 
according to 
paragraph 28. 

“MPL practices cannot be 
added to a contract which 
does not already have MPL 
acreage.” 

If the parent contract does not have 
MPL acres but a practice on the 
child contract has MPL acres (likely 
due to System 36 migrated data), 
this warning occurs. 

Correct practice 
acreage according to 
paragraph 30. 

“No Available Practices 
Found” 

There are no supporting practices 
for the acreage type of the contract. 
Either the acreage type on the 
contract needs to be fixed or signup 
configuration needs to be updated. 

Enter practice data 
according to 
paragraph 30. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“Non-Cropland acreage 
cannot be added to a 
contract which does not 
already have Non-Cropland 
acreage.” 

If the parent contract does not have 
non-cropland acres but a practice on 
the child contract has non-cropland 
acreage (likely due to System 36 
migrated data), this warning occurs. 

Correct CLU or 
Contract acre type 
according to paragraph 
28. 

“Non-Cropland practices 
cannot be added to a 
contract which does not 
already have Non-Cropland 
practices.” 

If the parent contract does not have 
non-cropland practice but the child 
contract has non-cropland practices 
(likely due to System 36 migrated 
data), this warning occurs. 

Correct practice 
acreage type according 
to paragraph 30. 

“Only one Primary 
Producer may be assigned 
to the contract.” 

There cannot be more than one 
primary producer on the contract. On 
the View Contract Screen, this 
message shows as a warning.  User 
would never see this if software was 
working correctly. 

Correct producer 
according to paragraph 
29. 

“Pivot corner response 
shall be 'N/A' for practice 
(XXX).” 

If the available practice is not pivot 
corner eligible, that practice cannot 
have pivot corners. 

Correct Pivot Corner 
response under modify 
practices according to 
paragraph 30. 

“Pivot corner response 
shall be 'Yes' or 'No' for 
practice (XXX).” 

If the available practice is pivot 
corner eligible, the user must respond 
to the question of whether or not there 
is a pivot corner practice on this 
contract. 

Correct Pivot Corner 
response under modify 
practices according to 
paragraph 30. 

“Please add CLU before 
saving.” 

No CLU's have been found from the 
contract. 

Enter CLU numbers 
according to paragraph 
28. 

“Practice (XXX) is defined 
on CLU (XXX) that is not 
on the contract.” 

The CLU numbers on the contract 
must contain all the CLU numbers 
from the practices. 

Enter CLU numbers 
according to paragraph 
28. 

“Practice (XXX) cannot 
have cropland Acres.” 

If the practice is not cropland eligible, 
it cannot have cropland acres. 

Correct practice 
acreage type according 
to paragraph 30. 

“Practice (XXX) cannot 
have MPL Acres.” 

If the practice is not MPL eligible, it 
cannot have MPL acres. 

Correct practice 
acreage type according 
to paragraph 30. 

“Practice (XXX) cannot 
have Wellhead Acres.” 

 If the practice is not wellhead 
eligible, it cannot have wellhead 
acres. 

Correct practice 
acreage type according 
to paragraph 30. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“Practice (XXX) is a 
reforestation practice that 
needs to have its technical 
responsibility completed.” 

If there is a forestry practice on the 
contract, it must be completed. 

Enter required check 
box indicator 
according to this 
paragraph  

“Primary Producer Not 
Assigned.” 

A primary producer must be 
assigned to the contract. 

Correct producer 
according to 
paragraph 29. 

“Selection is required.” Form validation. CPO must be 
received for a child or a rate 
revision. 

Enter required check 
box indicator 
according to this 
paragraph. 

“Selection is required.” Form validation. If a forestry 
practice exists on the contract, it 
must be completed before 
finalizing a revision or child. 

Enter required check 
box indicator 
according to this 
paragraph. 

“The combination of MPL 
acres and Non-Cropland 
acres (XXX) on the tract 
(XXX) are more than 
available acres (XXX) for 
Fiscal Year (XXX).” 

There cannot be more MPL and 
non-cropland acres on the farm 
tract than there are available 
(available amount retrieved from 
FRS and added to parent acreage). 
Hard error that is only applicable 
for current year.  

Correct practice 
acreage type 
according to 
paragraph 30. 

“The Cropland acreage on 
this contract cannot be 
reduced to zero.” 

If the parent contract has cropland 
acres, the child contract must have 
cropland acres. 

Enter CLU Cropland 
Acreage value greater 
than zero, acres 
values in hundredths 
according to 
paragraph 28. 

“The cropland acres 
(XXX) entered for the tract 
(XXX) exceed available 
acres (XXX) for Fiscal 
Year (XXX).” 

The cropland on the farm tract is 
greater than the available cropland 
acres (including base acres).  If 
current year, shown as error.  If 
previous year, shown as warning.  

Correct CLU acres to 
not exceed tract acres 
according to 
paragraph 28. 

“The cropland acres 
(XXX) entered for the tract 
(XXX) exceed available 
acres (XXX) for Fiscal 
Year (XXX) The acreage 
entered can only be 
processed for this contract 
if there is an overall 
increase in available 
cropland acres.” 

Warning: The Cropland on the 
farm tract is greater than the 
available cropland acres (including 
base acres).   

Correct CLU acres to 
not exceed tract acres 
according to 
paragraph 28. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The CRP Contract acres are 
being placed on Base Acres. 
Please complete a base 
reduction in Farm Records for 
Fiscal Year (XXX).” 

Warning: If the cropland acres do 
not exceed the available cropland 
+ base acres but they do exceed 
the available cropland acres, this 
message will show as an error 
during a finalize contract action if 
the activity (contract start date) is 
in the current fiscal year. 

This is a warning 
message only, after 
the contract is 
approved reduce 
base according to 
10-CM.  

“The date of the CRP-1 
Producer Signature(s) cannot 
be later than today. Please 
correct the date.” 

Producer signatures cannot be 
future dated. 

Enter a date in the 
mm/dd/yyyy format 
that is not in the 
future.  

“The date you have entered for 
the CRP-1 Producer 
Signature(s) precedes the 
original contract start date. 
Please correct the date.” 

Producer signed date for a 
revision cannot precede the 
original start date of the contract 
family. 

Enter a date in the 
mm/dd/yyyy format 
that equal to or 
greater than the 
original contract 
start date.  

“The effective date (XXX) 
cannot be after the current date 
(XXX).” 

A new child contract (not yet 
approved) cannot be future dated 
unless its parent is also future 
dated. 

Enter a date in the 
mm/dd/yyyy format 
that is not in the 
future. 

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity cannot 
begin after the contract ends. 

Enter a date in the 
mm/dd/yyyy format 
that is prior to the 
contracts end date.  

“The effective date (XXX) 
cannot be different than parent 
effective date (XXX).” 

If the parent contract is deferred 
then the child contract must start 
on the same date as the parent. 

Enter a date in the 
mm/dd/yyyy format 
that matches the 
parent contract for 
the deferred 
contract.  

“The effective date (XXX) 
cannot be earlier than the start 
date (XXX).” 

A child contract cannot start 
before its parent. 

Enter a date in the 
mm/dd/yyyy format 
that equal to or 
greater than the 
original contract 
start date 

“The Farm number (XXX) 
currently on this contract is no 
longer in an active status for 
Fiscal Year (XXX). Without a 
valid Farm Number, all other 
data validations will fail. Please 
correct the Farm Number.” 

Farm number on Contract must be 
in FRS. 

Correct the farm 
number or Correct 
the Effective date 
according to 
paragraphs 13 or 14. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The following producer(s) 
are not associated with the 
Farm for Fiscal year 
(XXX). Please remove the 
invalid producer(s) from 
the contract. (XXX).” 

The producers on the contract 
must be in FRS. 

Correct producer 
according to paragraph 29. 

“The MPL acreage on this 
contract cannot be reduced 
to zero.” 

If the parent contract has MPL 
acres, the child contract must 
have MPL acres. 

Enter CLU MPL Acreage 
value greater than 0, acres 
values in hundredths 
according to paragraph 28. 

“The Non-Cropland 
acreage on this contract 
cannot be reduced to zero.” 

If the parent has non-cropland 
acres, the child contract must 
have non-cropland acres. 

Enter CLU non-cropland 
acreage value greater than 
0, acres values in 
hundredths according to 
paragraph 28. 

“The sum of acres on all 
the child contracts cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths according to 
paragraph 28. 

“The sum of the Cropland 
Acres for the practices shall 
equal the Cropland Acres 
for the Contract.” 

The sum of cropland acres for 
farm tract must match the sum 
of cropland acres for the 
practices.  Error thrown on any 
finalizing action. 

Correct CLU or contract 
acres according to  
paragraph 28. 

“The sum of the MPL 
Acres for the practices shall 
equal the MPL Acres for 
the Contract.” 

The sum of MPL acres for 
farm tract must match the sum 
of MPL acres for the practices. 
Error thrown on any finalizing 
action. 

Correct CLU or contract 
acres according to 
paragraph 28. 

“The sum of the Non-
Cropland Acres for the 
practices shall equal the 
Non-Cropland Acres for 
the Contract.” 

The sum of non-cropland acres 
for farm tract must match the 
sum of non-cropland acres for 
the practices.  Error thrown on 
any finalizing action. 

Correct CLU or Contract 
acres according to 
paragraph 28. 

“The total CLU acres 
cannot exceed more than 
two decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths according to 
paragraph 28. 

“The total of share 
percentages shall equal 
100.” 

The sum of the producer share 
percentages must equal 100. 

Correct producer shares 
according to paragraph 29. 

“The total practice acres 
cannot exceed more than 
two decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter practice acres in 
hundredths according to 
paragraph 28. 
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Par. 32 
32  Finalize Contracts (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The Tract and/or CLU 
Number on this contract 
were unavailable when this 
contract was migrated.  They 
shall be updated in order to 
complete this transaction.” 

All tracts and CLUs on the 
contract cannot be "unknown". 

Update tract and 
CLU numbers 
according to 
paragraphs 11 and 28. 

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX). Please 
establish the tract number for 
this county.” 

The tract number(s) cannot be 
missing. 

Add tract number to 
the contract 
according to 
paragraph 11. 

“The Wellhead Acres (XXX) 
shall not exceed the 
Cropland Acres (XXX).” 

The wellhead acres must not 
exceed the cropland acres. 

Enter acreage values 
in hundredths 
according to 
paragraph 28. 

“Total practice acres not 
equal to contract acres.” 

The total acres for the contract 
must equal the total acres for 
the practices. 

Correct CLU or 
contract acres 
according to 
paragraph 28. 

“Total Wellhead acres 
(XXX) not equal to 
approved Wellhead acres 
(XXX).” 

The sum of the wellhead 
practice acreage must equal the 
wellhead protection acres on 
the contract. 

Correct CLU or 
contract acres 
according to 
paragraph 28. 

“Tract (XXX) shall have 
Cropland or MPL acres.” 

The tract must have at least one 
valid acreage type. 

Correct CLU or 
contract acres 
according to 
paragraph 28. 
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Par. 33 
33  Cancel Revision 
 

A Overview  
 
If at any time prior to COC approval of a revision the user determines they have started the 
revision in error they can cancel the revision and return the parent contract to an approved 
status.  To cancel a revision, on the View Contract Screen, from the “Select an action to 
perform” drop-down list, select “Modify > Cancel” and CLICK “Go”. 

 
B Example of the Cancel Revision Confirmation Screen    

 
The following is an example of the Cancel Revision Confirmation Screen. 
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Par. 33 
33  Cancel Revision (Continued)  
 

C  Field Descriptions and Actions 
    

The following table provides the field descriptions and actions for the Cancel Revision 
Confirmation Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise based 

on the maintenance being done to the contract.  
 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for this 
contract. 

 

Are you sure that you want to Cancel Revision at this time? 

OK Revision will be canceled and the parent contract 
will be returned to an active status.  The user will 
be taken to the Success Screen and must select 
“OK” to be returned to the View Contract Screen.   

CLICK “OK”.  

Back  Will return the user to the View Contract Screen 
and no data will be saved. 

CLICK “Back”. 
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Par. 34 
34  COC Approval  
 

A Overview  
 
If COC has approved the contract changes, the approval needs to be recorded on the contract. 
 
After users have selected a contract according to paragraph 9, the View Contract Screen will 
be displayed.  On the View Contract Screen, from the “Select an action to perform” drop-
down list, select “Modify >COC Approve” and CLICK “Go”. 
 
Note: Users can narrow the search on the Search Contract Screen to display a short list from 

which to select.  Using the “Contract Status” drop-down list, select 
“Revision Finalized”.  The “Revision Finalized” selection will include all contracts 
that have been finalized.  For divisions, the parent contracts will be listed because 
they are approved at the parent contract level.  All the child contracts for a division 
will be approved when the parent approval has been completed.  Other contracts 
ready for approval will list the child contracts. 

 
B Example of the COC Approval Screen    

 
The following is an example of the COC Approval Screen. 
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Par. 34 
34  COC Approval (Continued) 

 
C Field Descriptions and Actions 

 
The following table provides the field descriptions and actions for the COC Approval Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

COC Approval 
(mm/dd/yyyy) 

Allows the user to enter the date the COC 
approved the contract revision.   

Enter the date in the 
mm/dd/yyyy format 
or select the date 
from the calendar 
icon. 
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Par. 34 
34  COC Approval (Continued) 

 
C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Payment 
Schedule for 
FY 20XX 

This allows the user to shift payments between 
contracts involved in the division in the effective 
year of the revision.  See paragraph 37 for complete 
division of payment schedule details.  
 
Note: The table will be populated based on active 

days of each contract in the FY as a default.   

As applicable adjust 
the percentage or 
dollar value to be 
paid to each 
contract.  

Approve  After the user selects “Approve” a pop-up window 
be displayed to confirm they wish to “Approve”.  
Selecting “OK” will save all data.   
 
The user will see validation errors according to 
subparagraph D or the Success Screen.  On the 
Success Screen CLICK “OK” to be returned to the 
View Contract Screen.  

CLICK “Approve” 
and “OK”. 

Reject  After the user selects “Reject” a pop-up window will 
be displayed to confirm they wish to reject.  
Selecting “OK” will return the user to the View 
Contract Screen and the contract will be returned to 
a Revision in Process status.  User will be able to 
further modify the contract as needed.  

CLICK “Reject” 
and “OK”. 

Back  Will return the user to the View Contract Screen and 
no data will be saved. 

CLICK “Back”. 

 
D Error Messages 

    
The COC Approval Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Approval date (XXX) shall 
be no later than Today's 
Date (XXX).” 

The COC approval date 
cannot exceed today's date. 

Enter a date in the 
mm/dd/yyyy format or that 
is not a future date.  

“The COC Approval Date 
(XXX) for this contract 
cannot be earlier than the 
COC Approval Date of the 
original offer (XXX).” 

The COC approval date 
cannot exceed the contract 
family's original start date. 

Enter a date in the 
mm/dd/yyyy format or that 
is equal to or later than the 
approval date of the original 
offer.   
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Par. 35 
35  Rate Revisions   
 

A Overview  
 

Contract rate changes may be applied only on “Active” status contracts.  The rate change is a 
correct-and-go-forward process. The revision effective date will be set to either the start of 
the FY or the revision effective date of the prior revision if the contract has already been 
revised in the current FY.  There is no processing for over or under payments.  The contract 
will have a prorated payment based on the effective date of the change.  The rate change will 
have the same validations as any revision.  If any of the validations fail, the rate revision will 
have to be cancelled and the contract will need to be revised to correct the failed validations. 
Because of the complexities involved with validating rate changes with other contract 
modifications, rate changes must be completed separately. 

 
On the View Contract Screen, from the “Select an action to perform” drop-down list, select 
“Initiate >Revise Rates” and CLICK “Go”. 
 

B Example of the Start Rates Revision Screen 
 

The following is an example of the Start Rate Revision Screen. 
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Par. 35 
35  Rate Revisions (Continued) 
 

C Field Descriptions and Actions  
    

The following table provides the field descriptions and actions for the Start Rate Revision 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract. This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Are you sure you want to revise the contract?  
Save  After the user selects “Save” a pop-up 

window will be displayed to confirm the 
modification.  Selecting “OK” will display the 
Success Screen.  Clicking “OK” will return 
the user to the View Contract Screen.   

CLICK “Save” and 
“OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 36 
36  Revise Rates 
 
  A Revise Rates Screen 
 

After the user has initiated the rate revision and returned to the View Contract Screen, from 
the “Select an action to perform” drop-down list, select “Modify >Rates” and CLICK “Go”. 
 

B Example of the Revise Rate Screen 
 
The following is an example of the Revise Rate Screen. 
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Par. 36 
36  Revise Rates (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Revise Rates Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Existing Annual 
Rental Rate Per 
Acre 

The current rental rate recorded for the 
contract.  

 

Existing Weighted 
Average 
Maintenance Rate 
Per Acre 

The current weighted average maintenance 
rate per acre recorded on the contract. 
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Par. 36 
36  Revise Rates (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Annual Rental Rate 
Per Acre 

Enter the corrected rental rate for the 
revisions.  

Enter the per acre 
rental rate in dollars 
and cents. 

Weighted Average 
Maintenance Rate 
Per Acre 

As applicable, enter the corrected weighted 
average maintenance rate per acre. 

Enter the per acre 
rate in dollars and 
cents. 

Revise Rate After the user selects “Revise Rate” a pop-
up window will be displayed confirming 
the rate revision.  Selecting “OK” will 
display the Success Screen or the validation 
errors in subparagraph D.  Clicking “OK” 
on the Success Screen will return the user 
to the View Contract Screen. 

CLICK “Revise 
Rate” and “OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 

 
After the user is returned to the View Contract Screen, they will need to complete the 
finalization step according to paragraph 32 and COC Approve the contract according to 
paragraph 34 before the rate revision will be complete. 
 

D Error Messages 
 

The Revise Rates Screen is set up to provide potential validation errors when comparing the 
contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“(XXX) is required.” Field is required. Enter a value in the required 

field.  
“The Maintenance Rate 
exceeds the National 
Maintenance Rate for this 
signup. Please correct the 
Maintenance Rate on this 
contract.” 

The maintenance rate on the 
contract cannot exceed the 
national maintenance rate 
(the maximum maintenance 
rate for the signup). 

Correct the maintenance 
rate.  
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Par. 37 
37  Division of Payments    
 

A Overview  
 

If land under CRP contract is sold, there may be a Division of Payment agreement among the 
buyers and sellers about the distribution of the CRP rental payment for FY in which the sale 
occurs.  When there is a Division of Payment agreement, all involved producers must agree 
to the distribution.  The Division of Payment agreement will be supported by FSA and will 
supersede any proration that would have been based on the effective date of the sale. 
 
The “Division of Payment” option is available on either of the following: 
 
• COC Approval Screen for in-progress maintenance 
• View Contract Screen for contracts in an “Approved” status. 
 
Note: For contract reinstatements, the “Division of Payment” option will be available only 

if a Division of Payment agreement existed in FY in which the contract was 
terminated. 

 
B Example of the Predecessor - Successor Division(s) of Payment Agreement Screen    

 
The following is an example of the Predecessor-Successor Division(s) of Payment agreement 
Screen. 
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Par. 37 
37  Division of Payments (Continued)  
 
  C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Predecessor-Successor 
Division(s) of Payments Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen. 

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

View estimated 
payment for 
contracts in Fiscal 
Year 

This option will not be displayed if the user is 
viewing the payment agreement on the COC 
Approval Screen.  If the user accesses the 
division of payment from the View Contract 
Screen they will have the choice to select all 
FY’s that a contract modification took place. 

Select FY from the 
drop-down menu.  
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Par. 37 
37  Division of Payments (Continued)  
 
  C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Contract Displays the contract number with suffix that 
were involved with a contract modification and 
have active dates in the FY that was selected 
above. 

 

Annual 
Contract 
Payment  

Displays the full contract payment based on 
acres multiplied by the annual rental rate.  

 

Start of Period  The earlier of the start of the FY or the revision 
effective date of the contract.  

 

End of Period The later of the last day of the FY or the end 
date of the contract.   

 

Days Active in 
FY 20XX 

The number of days the contract was active 
based on the start of period and end of period 
dates.  

 

Days in FY 
20XX 

The number of days in the year.  

Calculated 
Estimated 
Payment by 
Dates 

The Annual Contract Payment field divided by 
the Days Active in FY 20XX field.   

 

FY 20XX 
Payment Ratio 

The default display shows the percentage of the 
payment based on calculated estimated payment 
by dates for each contract on the table divided 
by the total calculated estimated payments. The 
user can enter any value between 0 and100 
percent.  This column is interactive with the 
“FY 20XX Estimated Payment” column, 
changes in this column will update the payment 
amount in the payment column.  

If applicable enter the 
value in hundredths 
between 0 and 100 
percent.   

FY 20XX 
Estimated 
Payment  

As a default this column will match the 
“Calculated Estimated Payment by Dates” 
column.  Users can enter a dollar amount in 
whole dollars to record the payment agreement.  
This column is interactive with the “FY 20XX 
Payment Ratio” column, updating the dollar 
amount will update the percentages.  The total 
of this column cannot exceed the total calculated 
estimated payments by dates.  

If applicable enter the 
dollar value of the 
agreement to be paid 
to each contract in 
whole dollars.  
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Par. 37 
37  Division of Payments (Continued)  
 
  C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Delete 
Agreement  

Will delate an agreement that has been recorded and 
payments will be made based of the number of active 
days in the FY.  
 
When “Delete Agreement” is clicked a pop-up window 
will be displayed confirming the deletion of the 
agreement.  Once “OK” is clicked thee Success Screen 
will be displayed, CLICK “OK” to be returned to the 
View Contract Screen.  

CLICK “Delete 
Agreement” and 
“OK”. 

Create 
Agreement 

This button will only be displayed if an agreement is 
not yet created.  Once this button is selected users can 
edit the division of payments table.   

CLICK “Create 
Agreement”.  

Save All entered data will be saved. 
 
When the user clicks “Save” a pop-up window will be 
displayed confirming agreement should be saved.  
Once “OK” is clicked the Success Screen will be 
displayed, CLICK “OK” to be returned to the View 
Contract Screen. 

CLICK “Save” 
and “OK”. 

Back  Will return the user to the View Contract Screen and no 
data will be saved. 

CLICK “Back”. 
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Par. 37 
37  Division of Payments (Continued)  
 

D Error Messages 
 

The Predecessor-Successor Division(s) of Payment Agreement Screen is set up to provide 
potential validation errors when comparing the contract to the current year in Farm Records.  
The following error messages may be displayed. 

 
Error Message Description Corrective Action 

“All payments shall be at 
least zero dollars. The 
payment on contract (XXX) 
was $(XXX). Please edit the 
submitted payments.” 

The “FY 20XX Estimated 
Payment” column must have 
a value between 0 and 100 
for every contract.   

Enter a dollar value or zero 
for each contract. 

“No payment may be 
greater than that contract's 
annual payment value. The 
payment on contract (XXX) 
was $(XXX), but its annual 
payment value is $(XXX). 
Please edit the submitted 
payments.” 

The values entered in the 
“FY 20XX Estimated 
Payment” column does not 
equal the calculated 
estimated payment by dates. 

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates. 

“The amount available for 
negotiation is $(XXX), but 
the payments submitted add 
up to $(XXX). Please edit 
the submitted payments.” 

The values entered in the 
“FY 20XX Estimated 
Payment” column does not 
equal the calculated 
estimated payment by dates. 

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates. 

“The payment ratio and 
estimated payment values 
cannot be null.” 

The “FY 20XX Payment 
Ratio” column must have a 
value between 0 and 100 for 
every contract.   

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates. 
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Par. 38 
38  Terminations 
 

A Overview  
 
CCMS provides users the option to record a termination on any contract in “Approved” or 
“Expired” status.  When the contract to be terminated is displayed on the View Contract 
Screen, from the “Select an action to perform” drop-down list, SELECT 
“Initiate>Terminate” and CLICK “Go”.  
 
If the contract has an existing Division of Payments the Division of Payments table will be 
able to be modified during the termination according to paragraph 37.  
 

B Example of the Terminate Contract Screen    
 

The following is an example of the Terminate Contract Screen.  
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Par. 38 
38  Terminations (Continued)  
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Terminate Contract 
Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or Revise 
based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process.  
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Producer Name  Lists all producers assigned to the CRP-1.  

Share List the percent share in the contract for all 
producers with a share in the contract.   

 

Effective Contract 
Start Date  

The original or revised effective start date 
of the contract.  
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Par. 38 
38  Terminations (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Last Day that 
Contract is in 
Effect  

User must enter the last date the contract will be active.   Enter the date in 
the mm/dd/yyyy 
format or select 
the date from the 
calendar icon. 

Reason for 
Termination  

User must select the applicable reason for termination 
from the drop-down list. 

Select the reason 
code from the 
drop-down list.  

Termination 
Criteria 

Selection from this drop-down list will determine what 
subsequent action must be taken about payments that 
have been or will be made. 
 
The three options and their effects on payments are: 
 
No Refund Required, no additional payments will be 
made to the producer and no funds will be collected 
back from the producer.   
 
Prorated Payment, producers will be paid through the 
contract termination date on the next payment date. 
 
Refunds Required, producers must repay all or a 
portion of the payments that have been made.  To 
generate the receivables for these contract users must 
use the Conservation Payment application to cancel all 
payments that were made using the Web in FY 2013 
and future years and NRRS to manually create a 
receivable for all payments made in FY 2012 and prior 
years and for any liquidated damages owed. 

Select 
“Termination 
Criteria” from the 
drop-down list.  

Terminate 
Contract  

Contract will be terminated and the end date will be 
updated to the last day the contract was in effect.   
 
When the user clicks “Terminate Contract” a pop-up 
window will be displayed confirming contract 
termination.   Once “OK” is clicked the Success Screen 
will be displayed, CLICK “OK” to be returned to the 
View Contract Screen. 

CLICK 
“Terminate 
Contract” and 
“OK”. 

Back  Will return the user to the View Contract Screen and no 
data will be saved. 

CLICK “Back”. 

 
 
 
 
5-15-19     5-CRP Amend. 1 Page 2-134  



Par. 38 
38  Terminations (Continued)  
 

D Error Messages  
 
The Terminate Contract Screen is set up to provide potential validation errors.  The following 
messages may be displayed.  
 

Error Message Description Corrective Action 
“A future termination date is 
only possible for continuous 
contracts with a deferred 
start date.” 

The Last Day that Contract 
is in Effect that was entered 
is after today’s date and the 
contract is not during the 
deferred start date period.  

Insure the correct contract is 
being terminated and enter a 
Last Day that Contract is in 
Effect that is not a future 
date.  

“Termination date cannot be 
earlier than effective 
contract start date.” 

The Last Day that Contract 
is in Effect that was entered 
is before the contract 
started.  

Insure the correct contract is 
being terminated and enter a 
Last Day that Contract is in 
Effect that is after the 
contract started.  

“Termination date shall not 
be later than the contract 
end date.” 

The Last Day that Contract 
is in Effect that was entered 
is after the end date of the 
contract.  

Insure the correct contract is 
being terminated and enter a 
Last Day that Contract is in 
Effect that is before the end 
date of the contract.  

The following errors can only be displayed if the division of payment table is present. 
“All payments shall be at 
least zero dollars. The 
payment on contract (XXX) 
was $(XXX). Please edit the 
submitted payments.” 

The “FY 20XX Estimated 
Payment” column must 
have a value between 0 and 
100 for every contract.   

Enter a dollar value or zero 
for each contract. 

“No payment may be 
greater than that contract's 
annual payment value. The 
payment on contract (XXX) 
was $(XXX), but its annual 
payment value is $(XXX). 
Please edit the submitted 
payments.” 

The values entered in the 
“FY 20XX Estimated 
Payment” column does not 
equal the calculated 
estimated payment by dates. 

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates. 

“The amount available for 
negotiation is $(XXX), but 
the payments submitted add 
up to $(XXX). Please edit 
the submitted payments.” 

The values entered in the 
“FY 20XX Estimated 
Payment” column does not 
equal the calculated 
estimated payment by dates. 

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates. 

“The payment ratio and 
estimated payment values 
cannot be null.” 

The “FY 20XX Payment 
Ratio” column must have a 
value between 0 and 100 for 
every contract.   

Adjust payment values or 
percentages to equal 
calculated estimated 
payment by dates 
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Par. 39 
39  Reinstate Contract 
 

A Overview 
 

If it becomes necessary to reinstate a contract, the contract must be in “Terminated” status to 
use the “Reinstate” option.  When the contract to be terminated is displayed on the View 
Contract Screen, from the “Select an action to perform” drop-down list, SELECT 
“Initiate>Terminate” and CLICK “Go”.  
 
Contract reinstatements must have DAFP approval before being reinstated unless the 
reinstatement is for the sole purpose to correct the termination payment criteria entered 
according to paragraph 38.  In these cases, users can reinstate a contract using the current 
date as the DAFP approval date, however, users must immediately terminate the contract 
correctly.  
 
If the contract has an existing division of payments the division of payments table will be 
able to be modified during the reinstatement according to paragraph 37.  

 
B Example of the Reinstate Contract Screen 

 
The following is an example of the Reinstate Contract Screen. 
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Par. 39 
39  Reinstate Contract (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides field descriptions and actions for the Reinstate Contract Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide or Revise based on the 

maintenance being done to the contract.  
 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The state of physical location of tract for this contract.   
Physical County  The county of the physical location associated with this 

contract. 
 

Contract Number The contract numbers that was selected on the Select 
Contract Screen.   

 

Signup Number  The applicable signup number recorded for this contract.   
Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this contract.  
Program Year  The program year associated with this contract.  This 

value is set to the program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for this contract.  
Contract 
Description  

This field will display the contract description entered in 
the TERRA/COLS process.  
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for this 
contract. 

 

Reason for 
Reinstatement  

The user must type the reason for reinstatement in this 
free form field. 

Type the reason 
for 
reinstatement  

DAFP Approval 
Date 
(mm/dd/yyyy) 

The date DAFP granted approval for the reinstatement or 
the system date if reinstating to correct termination 
payment criteria.  

Enter date in the 
mm/dd/yyyy 
format or select 
date from the 
calendar icon. 

Reinstate  Contract will be reinstated, and the end date will be 
updated to the original end date.   When the user clicks 
“Reinstate” a pop-up window will be displayed 
confirming the reinstatement of the contract.  Once “OK” 
is clicked the Success Screen will be displayed, CLICK 
“OK” to be returned to the View Contract Screen. 

CLICK 
“Terminate 
Contract” and 
“OK”. 

Back  Will return the user to the View Contract Screen and no 
data will be saved. 

CLICK “Back”. 
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Par. 39 
39  Reinstate Contract (Continued) 
 

D Error Messages 
 

The Reinstate Contract Screen is set up to provide potential validation errors.  The following 
messages may be displayed.   
 

Error Message Description Corrective Action 
“Farm and Tract 
Numbers (XXX) are no 
Longer Active in FRS 
for Fiscal Year (XXX).” 

The farm and or tract 
number listed on the 
contract are not active in 
FRS.  Without active farm 
and or tract numbers CCMS 
cannot correctly validate 
available acres on the farm 
to support the reinstatement.  

This contract will not be able to 
be reinstated by a County Office 
user.  State Offices must request 
reinstatement by an 
administrative user by posting 
the request on the Contract and 
Application Issues SharePoint 
site.   

“No Existing Practices 
Found.” 

The contract does not 
contain any practices in 
CCMS.  

This contract will not be able to 
be reinstated by a County Office 
user.  State Offices must request 
reinstatement by an 
administrative user by posting 
the request on the Contract and 
Application Issues SharePoint 
site.   

“The combination of 
MPL acres and Non-
Cropland acres (XXX) 
on the tract (XXX) are 
more than available 
acres (XXX) for Fiscal 
Year (XXX).” 

The acres trying to be 
reinstated are more than the 
available acres in FRS.   

Users will need to remove the 
CRP/CLU attributes in MIDAS 
for the CLU’s linked to the 
contract that is being reinstated.  
After that if there are still not 
enough available acres the farm 
may not be large enough to 
support this reinstatement.  State 
Offices must request 
reinstatement by an 
administrative user by posting 
the request on the Contract and 
Application Issues SharePoint 
site.   

“The Farm number 
(XXX) currently on this 
contract is no longer in 
an active status for 
Fiscal Year (XXX). 
Without a valid Farm 
Number, all other data 
validations will fail. 
Please correct the Farm 
Number.” 

The farm number listed on 
the contract are not active in 
FRS.  Without active farm 
number CCMS cannot 
correct validate available 
acres on the farm to support 
the reinstatement.  

This contract will not be able to 
be reinstated by a County Office 
user.  State Offices must request 
reinstatement by an 
administrative user by posting 
the request on the Contract and 
Application Issues SharePoint 
site.   
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Par. 39 
39  Reinstate Contract (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The following 
producer(s) are not 
associated with the 
Farm for Fiscal year 
(XXX). Please remove 
the invalid producer(s) 
from the contract. 
(XXX).” 

The producers in FRS for 
the farm and tract linked 
to the contract in CCMS 
are no longer recorded on 
the farm record.   

This contract will not be able to be 
reinstated by a County Office user.   
State Offices must request 
reinstatement by an administrative 
user by posting the request on the 
Contract and Application Issues 
SharePoint site.   

“The Tract and/or 
CLU Number on this 
contract were 
unavailable when this 
contract was migrated. 
They shall be updated 
in order to complete 
this transaction.” 

Due to missing tract and 
CLU data CCMS cannot 
correctly validate 
available acres on the 
farm to support the 
reinstatement. 

This contract will not be able to be 
reinstated by a County Office user.   
State Offices must request 
reinstatement by an administrative 
user by posting the request on the 
Contract and Application Issues 
SharePoint site.   

“The tract number 
(XXX) is not valid for 
this county for Fiscal 
Year (XXX). Please 
establish the tract 
number for this 
county.” 

The tract number listed 
on the contract are not 
active in FRS.  Without 
active tract number 
CCMS cannot correctly 
validate available acres 
on the farm to support 
the reinstatement.  

This contract will not be able to be 
reinstated by a County Office user.   
State Offices must request 
reinstatement by an administrative 
user by posting the request on the 
Contract and Application Issues 
SharePoint site.   

“The tract number 
(XXX) is not 
valid/unknown for 
Fiscal Year (XXX). 
Please establish the 
tract number before 
reinstating the 
Contract.” 

The tract number is 
unknown in CCMS on 
the contract.  Without 
active tract number 
CCMS cannot correctly 
validate available acres 
on the farm to support 
the reinstatement.  

This contract will not be able to be 
reinstated by a County Office user.   
State Offices must request 
reinstatement by an administrative 
user by posting the request on the 
Contract and Application Issues 
SharePoint site.   

“Tract (XXX) shall 
have Cropland or 
MPL acres.” 

The acres trying to be 
reinstated are more than 
the available acres in 
FRS.   

Users will need to remove the 
CRP/CLU attributes in MIDAS for 
the CLU’s linked to the contract that 
is being reinstated.  After that if there 
are still not enough available acres 
the farm may not be large enough to 
support this reinstatement.  State 
Offices must request reinstatement 
by an administrative user by posting 
the request on the Contract and 
Application Issues SharePoint site.   
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Par. 39 
39  Reinstate Contract (Continued) 
 

D Error Messages (Continued) 
 

The following errors can only be displayed if the division of payment table is present during 
the reinstatement.  

 
Error Message Description Corrective Action 

“All payments shall be at 
least zero dollars. The 
payment on contract (XXX) 
was $(XXX). Please edit the 
submitted payments.” 

The “FY 20XX 
Estimated Payment” 
column must have a 
value between 0 and 
100 for every contract.   

Enter a dollar value or zero for 
each contract. 

“No payment may be 
greater than that contract's 
annual payment value. The 
payment on contract (XXX) 
was $(XXX), but its annual 
payment value is $(XXX). 
Please edit the submitted 
payments.” 

The values entered in 
the “FY 20XX 
Estimated Payment” 
column does not equal 
the calculated 
estimated payment by 
dates. 

Adjust payment values or 
percentages to equal calculated 
estimated payment by dates. 

“The amount available for 
negotiation is $(XXX), but 
the payments submitted add 
up to $(XXX). Please edit 
the submitted payments.” 

The values entered in 
the “FY 20XX 
Estimated Payment” 
column does not equal 
the calculated 
estimated payment by 
dates. 

Adjust payment values or 
percentages to equal calculated 
estimated payment by dates. 

“The payment ratio and 
estimated payment values 
cannot be null.” 

The “FY 20XX 
Payment Ratio” 
column must have a 
value between 0 and 
100 for every contract.   

Adjust payment values or 
percentages to equal calculated 
estimated payment by dates. 
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Par. 39 
39  Reinstate Contract (Continued) 
 

E Reinstate Contract Screen Farm Records Acre Validations 
 

During the reinstatement process CCMS validates with FRS to determine if there are 
available acres in FRS for the contract.  CCMS does assess existing Base acres, if the 
contract will exceed Effective DCP + Double Crop acres - CRP cropland - Existing Base 
Acres the user will be warned that a CCC-505 will need to be completed.   
 
The following table provide the calculations CCMS completes.  
 

Acreage Type Calculation 
Cropland  Effective DCP + Double Crop acres - CRP cropland 
Non-Cropland  Farmland – Cropland + Existing MPL Acres 
MPL Farmland – Cropland + Existing MPL Acres 

 
40-48 (Reserved) 
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Par. 49 
 

Section 3    Contract Transfers 
 
49  Transfer Contract 
 

A Overview  
 

The transfer option is used to transfer a CRP contract to another county and/or State.  During 
a transfer: 
 
 a new contract number will be automatically assigned using the next available number 

from the receiving county 
 
 the producers assigned to the contract may change 
 
 there can be a producer Division of Payment agreement, if new producers are assigned. 
 
The transfer is initiated by the original or sending county.  The transferring county user needs 
to know the farm and tract number to which the contract will be assigned in the receiving 

 *--county.  The receiving county will need to establish the farm and tract in CRM Farm 
Records.  It is important that the contract is not terminated as part of the farm record--* 
transfer.  For the farm records transfer in MIDAS, the user needs to remove the contract 
attributes from the fields enrolled in CRP and the CRP cropland from the tract level data 
before CCMS will allow the transfer of the farm.  
 

 *--When the receiving county farm and tract numbers have been established in CRM Farm 
Records, the transferring county user can begin the transfer.  Contracts originally--* 
transferred from System 36 will show “unknown” for “CLU” field and possibly for the 
“Tract Number” field when the contract is displayed on the View Contract Screen.  These are 
required fields and must be updated before the transferring county transfer steps can be 
completed.   
 
It is very important that the transfer in CCMS happens in the same FY as the transfer of the 
land in MIDAS farm Records.   

 
 *--Important: The transfer in CCMS must be made in the same FY as the transfer of the land 

in CRM Farm Records.  
 

Any outstanding CRP-1 modifications must be completed prior to the farm 
being transferred in CRM Farm Records.  CCMS will need the farm and tract 
to be active in that year to complete the revision needed prior to the farm 
transfer. 
 
For example, CCMS shows the contract as invalid due to a deceased producer.  
A revision of the CRP-1 will be needed prior to the transfer.--* 
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Par. 50 
50  Transfer Contract – Transferring County 
 

A Overview  
 

The transferring county will start the transfer process, after they have communicated with the 
receiving county to identify the new farm and tract number.  From the View Contract Screen, 
from the “Select an action to perform” drop-down list, select “Initiate>Transfer” and CLICK 
“Go”. 

 
B Example of the Transfer Contract Screen    

 
The following is an example of the Transfer Contract Screen. 
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Par. 50 
50  Transfer Contract – Transferring County (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Transfer Contract 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The state of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract number(s) that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Admin State The drop-down menu will display all States.  The 
user must select the “Admin State” receiving the 
transferred contract.   

Select receiving 
State from the 
drop-down 
menu. 

Admin County  The drop-down menu will display all counties for 
the Admin State selected above.  The user shall 
select the “Admin County” receiving the 
transferred contract.   

Select receiving 
county from the 
drop-down 
menu.  

Transfer Effective 
Date 

Will display 10/01/XXXX of the program year 
the transfer has been initiated.   

 

 
5-15-19    5-CRP Amend. 1 Page 2-171  



Par. 50 
50  Transfer Contract – Transferring County (Continued) 
 

C Field Descriptions and Actions 
 

Field/Button Description Action 
Reason for Transfer  Select the reason the contract is being 

transferred from the drop-down menu.  
Select 1 or more reasons 
for the transfer by 
pressing the “Ctrl” key 
and clicking choices as 
needed. 

DAFP Approval 
Date  

Optional field.  If DAFP has approved 
the transfer enter the date.   

If applicable, type date in 
mm/dd/yyyy format or 
select the date from the 
calendar icon.  

Farm Number The new farm number from the 
receiving county.  

Enter farm number for 
the receiving county. 

Tract Number The new tract number from the 
receiving county. 

Enter tract number for 
the receiving county. 

Transfer Contract  When the user clicks “Transfer 
Contract” a pop-up window will be 
displayed confirming the transfer.  Once 
“OK” is clicked the Success Screen will 
appear and the new contract number will 
be displayed.  On that screen CLICK 
“OK” to be returned to the View 
Contract Screen. 

CLICK “Terminate 
Contract” and “OK”. 

Back Will return the user to the View 
Contract Screen and no data will be 
saved. 

CLICK “Back”. 

 
CCMS will validate that the receiving county farm and tract numbers have been established 
in FRS.  CCMS will then create a child contract for the receiving county using the next 
available contract number for the receiving county.  The child contract will be populated with 
the data from the transferring county contract. 
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Par. 50 
50  Transfer Contract – Transferring County (Continued) 
 

D Error Messages 
 

The Transfer Contract Screen is set up to provide potential validation errors.  The following 
messages may be displayed.   

 
Error Message Description Corrective Action 

“The farm and tract number 
entered ((XXX),(XXX)) are 
not valid in the receiving 
county for Fiscal Year 
(XXX). Please establish the 
farm and tract numbers for 
the receiving county”. 

The farm and tract in the 
new county shall exist in 
FRS in order to transfer the 
contract. 

Enter correct farm and tract 
number for the receiving 
county.  

“(XXX) is required.” Field is required. Enter a choice for the field 
that is required. 

“The receiving state and 
county cannot be same as 
source state and county.” 

The new State and county 
codes shall be different than 
the old state and county 
codes (at least one shall be 
different). 

Enter the correct receiving 
State and county names.  

“The tract number (XXX) 
does not exist for the farm 
for Fiscal Year (XXX).” 

The combination of farm 
and tract shall exist in FRS. 

Enter correct farm and tract 
number for the receiving 
county. 

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX). Please 
establish the tract number 
for this county.” 

The tract number(s) cannot 
be missing. 

Enter correct farm and tract 
number for the receiving 
county. 
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Par. 51 
51  Transfer Contract Finalize – Receiving County  
 

A Overview  
 
 Once the transferring county has completed the steps in paragraph 50, the receiving county 

will finish the transfer process.  The easiest way to identify the new contract number is 
communication with the transferring county.  However, if the transferring county failed to 
provide the new contract number the receiving county shall search for the contract using the 
“Revision in Process” status criteria.  

 
 If the receiving county needs to correct the producers on the contract, CLICK “Modify 

>Producer” and follow paragraph 29 to correct the producers on the contract.  
 
 If the contract contains the correct producers and shares, from the View Contract Screen 

CLICK “Modify >Finalize” and “Go”.  
 

B Example of the Finalize Screen 
 

The following is an example of the Finalize Contract Screen. 
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Par. 51 
51  Transfer Contract Finalize – Receiving County (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Finalize Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The state of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for 
this contract. 
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Par. 51 
51  Transfer Contract Finalize – Receiving County (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Contract End Date  The final date the contract will be in effect.   
Transfer Effective 
Date 

This date will be set at 10/1 of the program 
year of the transfer, unless the producers 
changed as part of the transfer process.  If the 
producer did change, the user shall be able to 
select a date between 10/1 of that program 
year and the current date by taking the 
Modify >Effective Date/Reasons action on 
the View Contract Screen and following 
paragraph 26.  

If applicable, enter 
the date in the 
mm/dd/yyyy format 
or select the date 
from the calendar 
icon.   

Reason for 
Transfer 

Will display the reason code(s) selected by 
transferring county.   

 

CRP-1 Producer 
Signed Date 

The date the last producer on the CRP-1 
signed the CRP-1.   

Enter the date in the 
mm/dd/yyyy format 
or select the date 
from the calendar 
icon.  

Finalize  After the user selects “Finalize” a pop-up 
window will be displayed confirming the 
save.  CLICK “OK” to save all data.   
 
CCMS will execute a series of validations.  If 
any validations fail, error messages will be 
displayed according to subparagraph D.  
 
If all validations pass the user will see the 
Success Screen.  CLICK “OK” to be returned 
to the View Contract Screen.  

CLICK “Finalize” 
and “OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 51 
51  Transfer Contract Finalize – Receiving County (Continued) 
 

D Error Messages  
 

The Transfer Contract Finalize - Receiving County Screen is set up to provide potential 
validation errors when comparing the contract to your transfer in Farm Records.  The 
following messages may be displayed.   

 
Error Message Description Corrective Action 

“(XXX)'s involvement has 
changed for Fiscal Year 
(XXX), please update the 
producer's involvement.” 

The producer involvement 
on the contract shall match 
the producer involvement in 
FRS. 

Modify >Producers 
according to paragraph 29 to 
correct the producers on the 
contract.   

“All owners associated with 
the tract in Farm Records 
for Fiscal year (XXX) shall 
be on the contract, even if 
they are not receiving 
payments from the contract. 
Other Producers on the tract 
and Operators are optional. 
Please add all owners of the 
tract to the contract.” 

All owners shall be on the 
contract, including those 
with zero percent interest on 
the contract. 

Modify >Producers 
according to paragraph 29 to 
correct the producers on the 
contract.   

“CRP-1 Producer Signed 
Date is required.” 

Producer signed date is a 
required field. 

Enter CRP-1 Producer 
Signed Date in the 
mm/dd/yyyy format or 
select date from the calendar 
icon.  

“Only one Primary Producer 
may be assigned to the 
contract.” 

There cannot be more than 
one primary producer on the 
contract.  On the View 
Contract Screen, this 
message shows as a 
warning.  User would never 
see this if software was 
working correctly. 

Modify >Producers 
according to paragraph 29 to 
correct the producers on the 
contract.   

“Primary Producer Not 
Assigned.” 

A primary producer shall be 
assigned to the contract. 

Modify >Producers 
according to paragraph 29 to 
correct the producers on the 
contract.   

“The date of the CRP-1 
Producer Signature(s) 
cannot be later than today. 
Please correct the date.” 

Producer signatures cannot 
be future dated. 

Signed Date in the 
mm/dd/yyyy format or 
select date from the calendar 
icon. 
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Par. 51 
51  Transfer Contract Finalize – Receiving County (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The effective date (XXX) 
cannot be after the current 
date (XXX).” 

A new child contract (not 
yet approved) cannot be 
future dated unless its parent 
is also future dated. 

Select a date between 10/1 
of that program year and the 
current date by taking the 
Modify >Effective 
Date/Reasons action on the 
View Contract Screen and 
following paragraph 13. 

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity 
cannot begin after the 
contract ends. 

Select a date between 10/1 
of that program year and the 
current date by taking the 
Modify >Effective 
Date/Reasons action on the 
View Contract Screen and 
following paragraph 13. 

“The effective date (XXX) 
cannot be different than 
parent effective date 
(XXX).” 

If the parent contract is 
deferred then the child 
contract shall start on the 
same date as the parent. 

Select a date between 10/1 
of that program year and the 
current date by taking the 
Modify >Effective 
Date/Reasons action on the 
View Contract Screen and 
following paragraph 13. 

“The Farm number (XXX) 
currently on this contract is 
no longer in an active status 
for Fiscal Year (XXX). 
Without a valid Farm 
Number, all other data 
validations will fail. Please 
correct the Farm Number.” 

Farm on Contract shall be in 
FRS and active in the 
current FY.  

Cancel the transfer 
according to paragraph 33 
and re-transfer the contract 
with the correct farm and 
tract number. 

“The following producer(s) 
are not associated with the 
Farm for Fiscal year 
(XXX). Please remove the 
invalid producer(s) from the 
contract. (XXX).” 

The producers on the 
contract shall be in FRS. 

Modify >Producers 
according to paragraph 29 to 
correct the producers on the 
contract. 

“The total of share 
percentages shall equal 
100.” 

The sum of the producer 
share percentages shall 
equal 100. 

Modify >Producers 
according to paragraph 29 to 
correct the producers share 
on the contract. 
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Par. 52 
52  Transfer Contract COC Approve – Receiving County  
 
  A COC Approval of Transferred Contracts 
 

After the transferred contract is finalized in the receiving county the user shall record the 
COC approval date.  Follow paragraph 34 to record the COC approval date and record a 
division of payments is applicable.  
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Par. 53 
53  Transfer Contract Cancel - Receiving County  
 

A Overview 
 

If it is determined that the contract was transferred in error or the transfer can be canceled 
any time prior to COC approval.  On the View Contract Screen, from the “Select an action to 
perform” drop-down list, CLICK “Transfer> Cancel” and “Go”. 

 
B Example of the Cancel Transfer Confirmation Screen  

 
The following is an example of the Cancel Transfer Contract Screen. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5-15-19     5-CRP Amend. 1 Page 2-180  



Par. 53 
53  Transfer Contract Cancel - Receiving County  
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Cancel Transfer 
Confirmation Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise based 

on the maintenance being done to the contract.  
 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The state of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for this 
contract. 

 

OK Contract transfer is canceled, the Success Screen 
will display, CLICK “OK” to be returned to the 
View Contract Screen. 
 
Note: The transferred contract will return to an 

approved status in the transferring county.  

CLICK “OK”. 

Back  Contract transfer is not canceled, and the user is 
returned to the View Contract Screen 

CLICK “Back”. 

 
54-63 (Reserved) 
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Par. 64 
 

Section 4    Extensions and Early Outs 
 
64  Modify the Notification Sent Date Screen 
 

A Overview 
 

According to 2-CRP, paragraph 546 outlines that participants have 60 calendar days from the 
date of notification to sign a revised CRP-1.  When the user starts a revision, division, or 
transfer in CCMS a 60 calendar day notification clock is started.  Currently CCMS does not 
terminate contracts that exceed 60 days but future enhancements are planned to automate this 
process.  At this time users have the ability in CCMS to modify the date set by CCMS out to 
7 days after the revision, division, or transfer was started.   To modify the date on the View 
Contract Screen for the child contract, from the “Select an action to perform” drop-down list, 
select “Modify > 60-Day Notification Date” and CLICK “Go”. 
 

B Example of the Modify the Notification Sent Date Screen 
 

The following is an example of the Modify the Notification Sent Date Screen. 
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Par. 64 
64  Modify the Notification Sent Date Screen (Continued) 
 

C Field Descriptions and Actions  
    

The following table provides the field descriptions and actions for the Modify the 
Notification Sent Date Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  

Activity Type  Will display No Activity, Divide, or Revise based on the 
maintenance being done to the contract.  

 

Admin State The administrative State of the contract.    

Admin County  The administrative county of the contract.   

Physical State  The state of physical location of tract for this contract.   

Physical County  The county of the physical location associated with this 
contract. 

 

Contract Number The contract numbers that was selected on the Select 
Contract Screen.   

 

Signup Number  The applicable signup number recorded for this contract.   

Program Type  Will display CRP.  

Signup Name  The applicable signup name recorded for this contract.  

Program Year  The program year associated with this contract.  This value 
is set to the program year of the first month the contract 
was effective.  

 

Signup Type  The applicable signup type recorded for this contract.  

Contract 
Description  

This field will display the contract description entered in 
the TERRA/COLS process. 
 
Note:  Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for this contract.  

Modify the 
Notification sent 
date  
(mm/dd/yyyy) 

Enter the correct date the notification was sent.  This value 
can only be set between 1 to 7 days after the date the 
revision, division, or transfer was initiated in CCMS.  

Enter new date 
in the 
mm/dd/yyyy 
format.  

Save After the user selects “Save” a pop-up window will be 
displayed confirming the save.  Selecting “OK” will save 
all data.   
 
CCMS will execute a series of validations.  If any 
validations fail, error messages will be displayed according 
to subparagraph D.  
 
If all validations pass the user will see the Success Screen.  
CLICK “OK” to be returned to the View Contract Screen.   

CLICK “Save” 
then “OK” or 
“Cancel”. 

Back  User is returned to the View Contract Screen no data is 
saved.  

CLICK “Back”. 

 
5-15-19     5-CRP Amend. 1 Page 2-214  



Par. 64 
64  Modify the Notification Sent Date Screen (Continued) 
 

D Error Messages  
 

The Modify the Notification Sent Date Screen is set up to provide potential validation errors.  
The following messages may be displayed.   
 

Error Message Description Corrective Action 
“Notification date (XXX) 
can only be updated within 
seven days of contract 
Creation Date (XXX).” 

The date the notification 
letter was sent can only be 
updated within 7 days of the 
contract's creation date. 

Enter a date in the 
mm/dd/yyyy format that is 
within 7 days of the 
contract's creation date. 

“Notification date (XXX) 
shall be no later than 
Today's Date (XXX).” 

The date the notification 
letter was sent cannot be 
beyond the current date. 

Enter a date in the 
mm/dd/yyyy format that is 
within 7 days of the 
contract's creation date and 
not in the future.  

“Notification date shall be 
after Creation Date (XXX).” 

The date the notification 
letter was sent cannot 
precede the contract's 
creation date. 

Enter a date in the 
mm/dd/yyyy format that is 
within 7 days of the 
contract's creation date.  
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Par. 65 
65  One-Year Contract Extensions   
 

A Overview 
 
When contract extensions are authorized they will be recorded in CCMS.   To record the 
contract extension on the View Contract Screen, from the “Select an action to perform” drop-
down list, select “Initiate>Extension” and CLICK “Go”. Only contracts that are eligible for 
an extension will see this option.   
 
CCMS only allows the contract extensions based on the current set of rules.  If contract 
extensions are not timely recorded they will need to be reported to the National Office to 
record by the user’s State Office.  
 
Note: There is no automated way to cancel or ‘undo’ this extension confirmation.  Please 

ensure this action is correct before the ‘Extend’ button is clicked.  If the extension is 
recorded in error and needs to be removed that can only be done by the National Office.  
Please report the contract information to your State Office for extension removal.   

 
B Example of the One-Year Extension Screen 

 
The following is an example of the One-Year Extension Screen. 
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Par. 65 
65  One-Year Contract Extensions (Continued) 
 

C Field Descriptions and Actions   
    

The following table provides the field descriptions and actions for the One-Year Extension 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise based on 

the maintenance being done to the contract.  
 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The state of physical location of tract for this contract.   
Physical 
County  

The county of the physical location associated with this 
contract. 

 

Contract 
Number 

The contract numbers that was selected on the Select 
Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this contract.  
Program Year  The program year associated with this contract.  This 

value is set to the program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for this contract.  
Contract 
Description  

This field will display the contract description entered 
in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for this 
contract. 

 

Extend After the user selects “Extend” CCMS will execute a 
series of validations.  If any validations fail, error 
messages will be displayed according to  
subparagraph D.  
 
If all validations pass the Success Screen will be 
displayed.  CLICK “OK” to be returned to the View 
Contract Screen.   
 
The View Contract Screen will also be updated to show 
“Contract Extension Information” as explained in 
paragraph 10. 

CLICK “Extend”. 

Back  User is returned to the View Contract Screen no data is 
saved.  

CLICK “Back”. 
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Par. 65 
65  One-Year Contract Extensions (Continued) 
 

D Error Messages  
 

The One Year Contract Extensions Screen is set up to receive potential validation errors.  
The error message “Contract is not eligible for extension because it has been approved for an 
early out.” may be displayed.  Contracts with an early out cannot be extended so there can be 
no extension recorded.   
 

66  Early Contract Terminations 
 

A Overview 
 
 When early contract terminations are authorized, functionality in CCMS will be activated to 

record those authorized early terminations. During that period uses will see the option “Propose 
Early Out” from the action to perform menu. 

 
 Recording the early out will be a three-step process: 
 

• Propose Early out 
• Finalize Early Out  
• COC Approve Early Out. 

 
Users will also be able to generate the CRP-41 once the early out proposed by selecting the 
“CRP-41” link on the View Contract Page. 
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Par. 67 
67  Propose Early Out 
 

A Overview 
 

When early contract terminations are authorized, functionality in CCMS will be activated to 
record those authorized early terminations.  During that period uses will see the option “Propose 
Early Out” from the action to perform menu.  To record the Early Contract Termination on the 
View Contract Screen, from the “Select an action to perform” drop-down list, select “propose 
Early Out” and CLICK “Go”.  After the user takes the option for Propose Early Out they will be 
taken to the Propose Early Out Screen.  Users will be able to select from all active early outs. 

 
B Example of the Propose Early Out Screen 

 
The following is an example of the Propose Early Out Screen. 
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Par. 67 
67  Propose Early Out (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Propose Early Out 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  

Activity Type  Will display No Activity, Divide, or Revise based on the 
maintenance being done to the contract.  

 

Admin State The administrative State of the contract.    

Admin County  The administrative county of the contract.   

Physical State  The state of physical location of tract for this contract.   

Physical County  The county of the physical location associated with this 
contract. 

 

Contract Number The contract numbers that was selected on the Select 
Contract Screen.   

 

Signup Number  The applicable signup number recorded for this contract.   

Program Type  Will display CRP.  

Signup Name  The applicable signup name recorded for this contract.  

Program Year  The program year associated with this contract.  This 
value is set to the program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for this contract.  

Contract Description  This field will display the contract description entered in 
the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for this 
contract. 

 

Active Early Out All active early contract terminations will be displayed in 
the drop-down.  If no early contract terminations are 
active the drop-down list will be empty.  

Selected 
applicable early 
out.  

Early Out Date Users will enter the date the early contract termination 
will become effective.   

Enter date in 
mm/dd/yyyy 
format or select 
date from the 
calendar icon.  

Save After the user selects “Save” CCMS will execute a series 
of validations.  If any validations fail, error messages will 
be displayed according to subparagraph D.  
 
If all validations pass the Success Screen will be 
displayed.  CLICK “OK” to be returned to the View 
Contract Screen.   

CLICK “Save”. 

Back  User is returned to the View Contract Screen no data is 
saved.  

CLICK “Back”. 
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Par. 67 
67  Propose Early Out (Continued) 
 

D Error Messages 
 

The Propose Early Out Screen is set up to provide potential validation errors.  The following 
messages may be displayed.  

 
Error Message Description Corrective Action 

“(XXX) Format is invalid. Shall be 
mm/dd/yyyy.” 

Shall use valid date format. Enter date in mm/dd/yyyy 
format or select date from 
the calendar icon. 

“(XXX) is required.” Field is required. Enter missing field  
“Active Early Out Signup is 
required.” 

Early Out signup is a required 
field. 

Selected applicable early 
out. 

“Early Out Date is greater than the 
Contract End Date (XXX).” 

The proposed date for the Early 
Out cannot go beyond the contract 
end date 

Select a date prior to the 
current end date of the 
contract.  

“Early Out Date is less than the 
Contract Start Date (XXX).” 

The proposed date for the Early 
Out cannot precede the contract 
start date. 

Select a date later than the 
contract effective start 
date.  

“Only one early out can be 
proposed for a contract.” 

An existing Early Out for the 
contract has been found, and only 
one can exist per contract. 

An early contract 
termination can no longer 
be applied to this contract.  

“The effective date for the Early 
Out cannot be earlier than (XXX).” 

The Early Out date for the contract 
cannot precede the earliest 
possible Early Out date according 
to the signup configuration. 

Select a date after the 
indicated date.  

“The effective date for the Early 
Out cannot be later than (XXX).” 

The Early Out date for the contract 
cannot go beyond the latest 
possible Early Out date according 
to the signup configuration. 

Select a date earlier than 
the indicated date.  

“There is no active Early Out 
enrollment period.” 

Today's date shall be between the 
when the Early Out signup begins 
and when it ends. 

Select a date between the 
when the Early Out signup 
begins and when it ends. 

“This contract is ineligible for Early 
Out enrollment because contracts 
enrolled under a (XXX) program 
are not eligible for Early Out.” 

The signup of the contract shall be 
an allowed signup for Early Out. 

An early contract 
termination cannot be 
applied to this contract. 

“This contract is ineligible for Early 
Out enrollment because the contract 
has not been active for a minimum 
of (XXX) years.” 

The proposed date for the Early 
Out cannot result in a contract 
length that is below the minimum 
allowed contract length based on 
configuration settings. 

An early contract 
termination cannot be 
applied to this contract. 

“This contract is ineligible for Early 
Out enrollment because the 
practices (XXX) are not eligible for 
early out.” 

All of the practices on the contract 
shall be allowable for Early Out in 
order to propose an Early Out, or 
to modify or finalize a contract 
with an Early Out record. 

An early contract 
termination cannot be 
applied to this contract. 

‘Your revision includes practice(s) 
(XXX) that are not eligible for 
Early Out.” 

All of the practices on the contract 
shall be allowable for Early Out in 
order to propose an Early Out, or 
to modify or finalize a contract 
with an Early Out record. 

An early contract 
termination cannot be 
applied to this contract. 
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Par. 68 
68  Finalize Early Out 
 

A Overview 
 
To finalize the early contract termination on the View Contract Screen, from the “Select an 
action to perform” drop-down list, select “Finalize Early Out” and CLICK “Go”.   

 
B Example of the Finalize Early Out Screen 

 
The following is an example of the Finalize Early Out Screen. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5-15-19     5-CRP Amend. 1 Page 2-222  



Par. 68 
68  Finalize Early Out (Continued)  
 
  C Field Descriptions and Actions  
    

The following table provides the field descriptions and actions for the Finalize Early Out 
Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise based 

on the maintenance being done to the contract.  
 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated with 
this contract. 

 

Contract 
Number 

The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for this 
contract. 

 

Date Eligibility 
Was Confirmed  

Early contract terminations can have eligibility 
rules that CCMS will not be able to enforce. 
 
Example: EBI ratings.  
 
These checks will need to be done manually 
according to the policy that is provided specific to 
the early termination being applied to the contract.  
Users will need to enter the date they verified all 
eligibility on the contract was reviewed and 
confirmed.  

Enter the date in 
mm/dd/yyyy 
format or select 
date from the 
calendar icon. 
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Par. 68 
68  Finalize Early Out (Continued)  
 
  C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Date All 
Producers 
Signed  

Users shall enter the latest signature date on the 
CRP-41.  

Enter the date in 
mm/dd/yyyy format 
or select date from 
the calendar icon. 

Finalize After the user selects “Finalize” CCMS will 
execute a series of validations.  If any validations 
fail, error messages will be displayed according to 
subparagraph D.  
 
If all validations pass the Success Screen will be 
displayed.  CLICK “OK” to be returned to the 
View Contract Screen.   

CLICK “Finalize”. 

Back  User is returned to the View Contract Screen no 
data is saved.  

CLICK “Back”. 
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Par. 68 
68  Finalize Early Out (Continued)  
 

D Error Messages  
 

The Finalize Early Out Screen is set up to provide potential validation errors.  The following 
messages may be displayed.  

 
Error Message Description Corrective Action 

“(XXX) Format is invalid. Shall be 
mm/dd/yyyy.” 

Use valid date format. Enter date in 
mm/dd/yyyy format 
or select date from 
the calendar icon. 

“(XXX) is required.” Field is required. Enter missing field. 
“The date all signatures have been 
completed cannot be earlier than the 
configured Early Out Enrollment 
Start Date (XXX) for (XXX).” 

Producer signatures cannot 
be date prior to the start 
date of the early 
termination period.  

Enter a date after the 
start date of the early 
termination period. 

“The date all signatures have been 
completed cannot be later than the 
current date (XXX).” 

Producer signatures cannot 
be future dated. 

Enter a date prior to 
the current date. 

“The date the eligibility questions 
were confirmed.” 

The date the eligibility 
questions were confirmed 
is a required field. 

Enter date in 
mm/dd/yyyy format 
or select date from 
the calendar icon. 

“The date the eligibility questions 
were confirmed cannot be earlier than 
the configured Early Out Enrollment 
Start Date (XXX) for (XXX).” 

The date the eligibility 
questions were confirmed 
cannot be earlier than the 
configured Early Out 
Enrollment Start Date. 

Enter a date after the 
start date of the early 
termination period. 

“The date the eligibility questions 
were confirmed cannot be later than 
the current date (XXX).” 

The date the eligibility 
questions were confirmed 
cannot be later than the 
current date. 

Enter a date prior to 
the current date. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5-15-19     5-CRP Amend. 1 Page 2-225  



Par. 69 
69  COC Approve Early Out 

 
A Overview 

 
To record the COC approval of the early contract termination on the View Contract Screen, 
from the “Select an action to perform” drop-down list, select “COC Approve Early Out” and 
CLICK “Go”.   

 
B Example of the COC Approve Early Out Screen 

 
The following is an example of the COC Approve Early Out Screen.  
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Par. 69 
69  COC Approve Early Out (Continued)  
 

C Field Descriptions and Actions 
    

The following table provides the field descriptions and actions for the COC Approve Early 
Out Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the 

contract.  
 

Physical State  The State of physical location of tract for 
this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

Early Out COC 
Approval Date 

The date the COC approved the early 
termination.  

Enter date in 
mm/dd/yyyy format or 
use the calendar icon.  

 
 
 
5-15-19     5-CRP Amend. 1 Page 2-227  



Par. 69 
69  COC Approve Early Out (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Approve  After the user selects “Approve” CCMS 
will execute a series of validations.  If any 
validations fail, error messages will be 
displayed according to subparagraph D.  
 
If all validations pass the Success Screen 
will be displayed.  CLICK “OK” to be 
returned to the View Contract Screen.   

CLICK “Approve”. 

Reject Will remove the finalization of the early 
contract termination and return the user to 
the View Contract Screen.  

CLICK “Reject”. 

Back  User is returned to the View Contract 
Screen no data is saved.  

CLICK “Back”. 

 
D Error Messages  

 
The COC Approve Early Out Screen is set up to provide potential validation errors.  The 
following messages may be displayed.   

 
Error Message Description Corrective Action 
“(XXX) Format is invalid. 
Shall be mm/dd/yyyy.” 

Use valid date format. Enter date in mm/dd/yyyy 
format or select date from 
the calendar icon. 

“(XXX) is required.” Field is required. Enter missing field. 
“COC Approval date 
cannot be later than the 
current date.” 

The COC approval date cannot 
go beyond the current date. 

Enter a COC Approval date 
than is not in the future.  

“No Existing Practices 
Found.” 

There are no supporting practices 
for the acreage type of the 
contract.  Either the acreage type 
on the contract needs to be fixed 
or signup configuration needs to 
be updated. 

Reject COC Early 
Termination.  Revise 
contract to correct the 
practices, reload the early 
termination.    

“The COC Approval date 
cannot be earlier than the 
configured Early Out 
Enrollment Start Date 
(XXX) for (XXX).” 

The COC approval date cannot 
precede the earliest possible 
Early Out date. 

Enter a date after the start 
date of the early termination 
period. 

 
70-79 (Reserved) 
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Par. 80 

 

Section 5    Contract Divisions 

 

80  Divide Contract 

 

A Overview 

 

CCMS allows users to record a contract division.  CCMS is designed to allow the user to 

choose the number of contracts the existing contract will be divided into and then align the 

Farm/Tract, Producers, Practices, and Acres for each resulting contract.  CCMS strictly 

enforces that the no overall acre changes are made as a result of the division.  In the move to 

transition contract from tenths to hundredths, offices may need to modify the contract to 

correct the acres prior to starting the division. 

 

CCMS will create child contracts for the number of divisions entered.  Each child contract 

will be pre-populated with the contract information from the parent.  Therefore, all child 

contracts have the same acreage, the same practices, the same farm and tract, and the same 

producers. 

 

The first step in the division process is setting the effective date.  Please refer to paragraph 12 

for determining the correct effective date.  After the division is started users will be able to 

do the following maintenance actions for each of the resulting contracts. 

 

• “Modify > Acreage” (paragraph 82) 

●*--“Modify > Adjust Re-Enrolled Acreage” (paragraph 82.5)--* 

• “Modify > Practices” (paragraph 84) 

• “Modify > Farm/Tract” (paragraph 81) 

• “Modify > Producers” (paragraph 83). 

 

To move between contracts users should use the hyper link between the parent and child 

contract on the View Contract Screen or use the “Back” button to return to the Select 

Contract Screen. 

 

When the contract to be divided is displayed on the following View Contract Screen, from 

the “Select an action to perform” drop-down list, select “Initiate” then  “Divide” and CLICK 

“Go”. 
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Par. 80 

80  Divide Contract (Continued)  

 

B Example of the Divide Contract Screen 

 

The following is an example of the Divide Contract Screen. 
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Par. 80 
80  Divide Contract (Continued)  
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Divide Contract 
Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or Revise 
based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen. 

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the program 
year to the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 
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80  Divide Contract (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Enter the Number of 
Contract Division  

The user shall enter the number of 
resulting contracts. 

Enter a whole number greater 
than one.   

Parent Contract Start 
Date 

The Effective Start Date of the 
Parent contract.  

 

Contract End Date  The last day the contract will be 
in effect. 

 

Divide Effective 
Date  

The date the divided contracts 
will become effective.  

Enter the date in the 
mm/dd/yyyy format or select 
the date from the calendar 
icon.    

Reason for Division  Select the reason for Division.  Select reason from the drop-
down menu.   

Save  The user will receive a pop-up 
window to confirm they want to 
divide the contract.  Selecting 
“OK” will save the Division 
Effective Date and Reason for 
Division.  
 
The Success Screen will be 
displayed if all page validations 
are met.  User must click “OK” 
on the Success Screen to be 
returned to the View Contract 
Screen.   
 
Selecting “Cancel” on the pop-up 
window will return the user to the 
Start Contract Revision Screen 
without saving data.   

CLICK “Save” then “OK” or 
“Cancel”. 

Back The View Contract Screen will be 
displayed, no data will be saved, 
and the division will be canceled. 

CLICK “Back”. 
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Par. 80 
80  Divide Contract (Continued)  
 

D Error Messages 
 

The Divide Contract Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Selection is required.” Reason for Revision is a 

required field. 
Select a reason for revision 
from the drop-down. 

“The effective date (XXX) 
cannot be after the current 
date (XXX).” 

A new child contract (not yet 
approved) cannot be future 
dated unless its parent is also 
future dated. 

Set an effective date equal 
to or prior than the current 
date.  

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity 
cannot begin after the 
contract ends. 

Set an effective date prior 
to the last day the contract 
is active.  

“The effective date (XXX) 
cannot be different than 
parent effective date (XXX).” 

If the parent contract is 
deferred then the child 
contract must start on the 
same date as the parent. 

Set the effective date as the 
deferred start date of the 
parent contract.  

“The effective date (XXX) 
cannot be earlier than the 
start date (XXX).” 

A child contract cannot start 
before its parent 

Set the effective date equal 
to or later than the parents 
start date.  

 
E Modify Effective Date/Reason   

    
If the user enters the Division Effective Date or Reason for Revision incorrectly they can 
revisit the Start Contract Revision Screen by selecting the action of “Modify >Effective 
Date/Reasons” and CLICK “Go” on the view Contract Screen of one of the child contracts.  
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Par. 81 
81  Modify Farm and Tract Screen – Division  
 

A Overview  
 

To modify the Farm and/or Tract number on the contract, users must select the action for 
Modify >Farm/Tract and CLICK “Go” after the division has been started according to 
paragraph 81.   

 
The farm, tract, and producer name will be returned for the program year in FRS based on 
the revision effective date recorded in paragraph 80. 
 

B Example of Modify Farm and Tract Screen 
 

The following is an example of the Modify Farm and Tract Screen. 
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Par. 81 
81  Modify Farm and Tract Screen – Division (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Modify Farm and 
Tract Screen. 

 
Field  Description  Action  

Contract Status  Will display the current status of the contract.   
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract Description  This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 
contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Farm/Tract and CLU Information 
Farm Number The farm number currently associated with the 

contract.  
 

Tract Number The tract number currently associated with the 
contract. 

 

CLU The CLU number(s) currently associated with 
the contract. 

 

CLU Acres  The acres in hundredths for each CLU 
displayed on the screen.   
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Par. 81 
81  Modify Farm and Tract Screen – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Search for new farm and tract 

Farm Number  To search by farm number enter the 
farm number.  

Enter the desired farm 
number. 

Tract Number To search by tract number enter the 
tract number.  

Enter the desired tract number. 

Producer Name Users will be taken to the SCIMS 
Customer Search page to search for the 
desired producer.  Once the producer 
is selected on the SCIMS Customer 
Search page, their name will populate 
in the “Producer Name” field.   

CLICK “Find Producer”. 

Search The Modify Farm and Tract Screen 
will be updated with the farms and 
tracts that meet the search criteria.   

CLICK “Search”. 

Back The View Contract Screen will be 
displayed, no data will be saved.  

CLICK “Back”. 

Reset All entered values will be removed.  CLICK “Reset”. 
 
D Example of the Modify Farm and Tract Screen-After Search  

 
The following is an example of the bottom of the Modify Farm and Tract Screen after the 
user searched by farm, tract, or producer. 
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Par. 81 
81  Modify Farm and Tract Screen–Division (Continued)  
 
  E Modify Farm and Tract Screen-After Search Options  
   

The following table provides the field descriptions and actions for the updated Modify Farm 
and Tract Screen after the user searched for a Farm, Tract, or Producer. 
 

Field/Button Description Action 
Farm Number  All farm numbers that matched the search 

criteria will be displayed. 
 

Tract Number The tract number(s) for the corresponding arm 
number that matched the search criteria will be 
displayed. 

 

Tract Description  The tract description for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Farmland Acres The farmland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Cropland Acres  The cropland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

CRP Cropland 
Acres 

The CRP cropland acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

CRP MPL Acres  The CRP MPL acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Modify Search  The farm, tract, and producer options according 
to subparagraph C will be displayed.   

CLICK “Modify 
Search”. 

Save After the user selects the radio button for the 
“Farm/Tract Number” they wish to add to the 
contract and then click “Save” a pop-up 
window will be displayed confirming the save.  
Selecting “OK” will save all data.   
 
The Success Screen will be displayed if all page 
validations are met.  User must click “OK” on 
the Success Screen to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the pop-up window will 
return the user to the Modify Farm and Tract 
Screen without saving data.   

CLICK “Save” 
then “OK” or 
“Cancel”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 
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Par. 81 
81  Modify Farm and Tract Screen–Division (Continued)    
 

F Error Messages  
 

The Modify Farm and Tract Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  The following error messages 
may be displayed. 
 

Error Message Description Corrective Action 
“The Farm number (XXX) 
currently on this contract is 
no longer in an active status 
for Fiscal Year (XXX).” 

Farm number the user is 
adding to the contract must 
be active in the FY of the 
contract revision effective 
date. 

Enter active farm number 
for the year of the contract 
revision effective date. 

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX). Please 
establish the tract number for 
this county.” 

The tract number(s) cannot 
be missing. 

Enter active tract number 
for the year of the contract 
revision effective date. 
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Par. 82 
82  Adjust Acreage – Division  
 

A Overview  
 
 To modify the contract acres and to modify or add CLU number and acres on the contract, 

users must select the action for Modify >Acreage and CLICK “Go” after the division has 
been started according to paragraph 82.   

 
Notes: MPL acres cannot be added to a child contract if the parent contract did not have 

MPL acres; likewise, cropland acres cannot be added to a child contract if the parent 
had only MPL acres. 
 
If there has been a reconstitution on the farm, it is recommended that the “Modify 
> Farm/Tract” action (paragraph 81) be accessed to update the farm and tract 
information before adjusting the acreage. 

 
During a division users will need to adjust the contract acres on each resulting child contract 
to represent the acres for the new contract.  However, the total number of acres on all 
resulting contract must equal the original acres of the parent contract.   
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Par. 82 
82  Adjust Acreage – Division (Continued) 
 

B Example of Adjust Acreage Screen 
 

The following is an example of the Adjust Acreage Screen. 
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

C Field Descriptions and Actions  
    

The following table provides the field descriptions and actions for the Adjust Acreage 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Farm Number  The Farm number associated with the 
contract. 

 

Tract Number The Tract number associated with the 
contract.  

 

Available Cropland 
Acres  

Displays the available cropland and/or 
non-cropland & MPL acres currently on 
the tract in farm records.  
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Contract Acres  Displays the cropland, MPL, non-

cropland, and wellhead acres on the 
contracts.  The acreage type(s) currently 
on the contract will be the only types the 
user can edit.  

Correct the applicable 
acreage field to show the 
acres on each new 
contract.  Acres must be 
entered to the 
hundredths precision.  

Farm Number  The farm number associated with the 
contract. 

 

Tract Number The tract number associated with the 
contract.  

 

CLU The CLU number associated with the 
contract.  

Enter the CLU number 
from farm records.  

CLU Acres The acreage value that corresponds to the 
CLU number that was entered.  

Enter the CLU acres 
value in hundredths for 
the CLU number 
entered.  

Delete  Removed the CLU record for the line item 
that “Delete” was selected.  

CLICK “Delete”. 

Add New CLU Information 
Farm Number  This value will be prepopulated based on 

the farm number associated with the 
contract. 

 

Tract Number  This value will be prepopulated based on 
the tract number associated with the 
contract. 

 

CLU The CLU number to associate with the 
contract. 

Enter the CLU number.  

CLU Acres The Acreage value that corresponds to the 
CLU number to associate with the 
contract. 

Enter the CLU acres 
value in hundredths for 
the CLU number 
entered.  

Add  CLICK “Add”. 
Re-Enrolled Acres  Displays the number of acres on the 

contract that were a result of reenrollment.  
 
If the user is decreasing the size of the 
contract they must decrease the  
re-enrolled acres to be equal to or less 
than the total contract acres.  

Adjust the acres value in 
hundredths as needed.  
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Save After the user selects “Save” a pop-up window 
will be displayed confirming the save.  Selecting 
“OK” will save all data.   
 
The Success Screen will be displayed if all page 
validations are met.  User must click “OK” on 
the Success Screen to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the pop-up window will 
return the user to the Adjust Acreage Screen 
without saving data.   

CLICK “Save” then 
“OK” or “Cancel”. 

Back  Will return the user to the View Contract Screen 
and no data will be saved. 

CLICK “Back”. 
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

D Error Messages 
 

The Adjust Acreage Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed.   
 

Error Message Description Corrective Action 
“Cropland acreage cannot be 
added to a contract which 
does not already have 
Cropland acreage.” 

A contract that does not have 
Cropland acres cannot be 
revised to have Cropland 
acres. 

Correct acreage type on 
the CLU to match the 
acres type of the contract.  
If the acre type of the 
contract is incorrect 
notify the State Office.  
State Office users will 
notify the National Office 
for resolution.  

“Farm Tract Acres (Cropland 
Acres + MPL Acres) do not 
match Total CLU Acres. 
Farm Number = (XXX) Tract 
Number = (XXX) Farm Tract 
Acres = (XXX) Total CLU 
Acres = {3}.” 

Total CLU acres must add up 
to acres on the farm tract 
(farm-level validation). 

Correct CLU acres to not 
exceed tract acres. 

“Farm Tract Acres (Cropland 
Acres + Non-Cropland Acres 
+ MPL Acres) do not match 
Total CLU Acres. Farm 
Number = (XXX) Tract 
Number = (XXX) Farm Tract 
Acres = (XXX) Total CLU 
Acres = {3}.” 

Total CLU acres must add up 
to acres on the farm tract. 

Correct CLU or contract 
acres.  

“Field/CLU Number (XXX) 
is missing acres information.” 

CLU cannot have null value 
for acreage amount. 

Enter the acreage value 
for the CLU.  

“Field/CLU Numbers are 
required. Please enter the 
Field/CLU Numbers before 
proceeding.” 

CLU number must be valid 
(cannot be null/missing, 
blank, or -99). 

Enter a valid CLU 
number.  
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“MPL acreage cannot be 
added to a contract which 
does not already have MPL 
acreage.” 

A contract that does not 
have MPL acres cannot 
be revised to have MPL 
acres. 

Correct acreage type on the CLU 
to match the acres type of the 
contract.  If the acre type of the 
contract is incorrect notify the 
State Office.  State Office users 
will notify the National Office for 
resolution.  

“Non-Cropland acreage 
cannot be added to a 
contract which does not 
already have Non-
Cropland acreage.” 

A contract that does not 
have MPL acres cannot 
be revised to have MPL 
acres. 

Correct acreage type on the CLU 
to match the acres type of the 
contract.  If the acre type of the 
contract is incorrect notify the 
State Office. State Office users 
will notify the National Office for 
resolution. 

“Please add CLU before 
saving.” 

No CLU's have been 
found from the 
contract. 

Enter a valid CLU number and 
acreage.  

“The CLU acres cannot 
exceed more than two 
decimals.” 

All acreage entries 
must be entered in 
hundredths. 

Enter acreage values in 
hundredths.  

“The CLU number (XXX) 
is already added to this 
contract.” 

Multiple CLU's of the 
same number/identifier 
cannot exist on the 
same contract. 

Enter a valid CLU number. 

“The combination of MPL 
acres and Non-Cropland 
acres (XXX) on the tract 
(XXX) are more than 
available acres (XXX). 
These acres will only fit if 
the combination of MPL 
acreage and Non-Cropland 
acreage on this tract grows 
for Fiscal Year (XXX).” 

There are more MPL 
and non-cropland acres 
on the farm tract than 
there are available 
(available amount 
retrieved from FRS and 
added to the parent 
acreage). 

Correct CLU or contract acres. 
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Par. 82 
82  Adjust Acreage – Division (Continued)  
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The Cropland acreage on this 
contract cannot be reduced to 
zero.” 

If the parent contract has 
cropland acres, the child 
contract must have cropland 
acres. 

Enter CLU cropland 
acreage value greater 
than zero, acres values in 
hundredths. 

“The cropland acres (XXX) 
entered for the tract (XXX) 
exceed available acres (XXX) 
for Fiscal Year (XXX).” 

If the cropland on the farm 
tract is greater than the 
available cropland acres 
(including base acres). 

Correct CLU acres to not 
exceed tract acres. 

“The cropland acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths. 

“The MPL acreage on this 
contract cannot be reduced to 
zero.” 

If the parent contract has 
MPL acres, the child 
contract must have MPL 
acres. 

Enter CLU MPL acreage 
value greater than zero, 
acres values in 
hundredths 

“The MPL acres cannot exceed 
more than two decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths. 

“The Non-Cropland acreage on 
this contract cannot be reduced 
to zero.” 

If the parent has non-
cropland acres, the child 
contract must have non-
cropland acres. 

Enter CLU non-cropland 
acreage value greater 
than zero, acres values in 
hundredths. 

“The non-cropland acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths. 

“The re-enrolled acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths. 

“The sum of cropland. Non-
cropland and MPL acres of all 
farm tracts (contract acres) 
cannot exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths. 
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Par. 82 

82  Adjust Acreage – Division (Continued)  

 

D Error Messages (Continued) 

 

Error Message Description Corrective Action 

“The sum of the CLU Acres 

must equal the Contract Acres.” 

Sum of CLU acres must be 

equal to the contract acreage. 

Correct CLU or 

contract acres. 

“The total CLU acres cannot 

exceed more than two 

decimals.” 

All acreage entries must be 

entered in hundredths. 

Enter acreage values in 

hundredths. 

“The Tract and/or CLU Number 

on this contract were 

unavailable when this contract 

was migrated. They must be 

updated in order to complete 

this transaction.” 

All tracts and CLU’s on the 

contract cannot be 

“unknown”. 

Add Tract and CLU 

numbers to the contract 

according to 

paragraphs 81 and 82. 

“The tract number (XXX) is not 

valid for this county for Fiscal 

Year (XXX). Please establish 

the tract number for this 

county.” 

The tract number(s) cannot be 

missing. 

Add Tract number to 

the contract according 

to paragraph 81. 

“The Wellhead Acres (XXX) 

shall not exceed the Cropland 

Acres (XXX).” 

The wellhead acres must not 

exceed the cropland acres. 

Correct CLU or 

contract wellhead 

acres. 

“The wellhead acres cannot 

exceed more than two 

decimals.” 

All acreage entries must be 

entered in hundredths. 

Enter acreage values in 

hundredths. 

“Total Wellhead acres (XXX) 

not equal to approved Wellhead 

acres (XXX).” 

The sum of the wellhead 

practice acreage must equal 

the wellhead protection acres 

on the contract. 

Correct CLU or 

contract wellhead 

acres. 

“Tract (XXX) must have 

Cropland or MPL acres.” 

The tract must have at least 

one valid acreage type. 

Add Tract number to 

the contract according 

to paragraph 81. 
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Par. 82.5 

*--82.5 Adjust Re-Enrolled Acreage Screen - Division 

 

A Overview 

 

The Adjust Re-Enrolled Acreage Screen will be open to users to update parent contract 

information from the expired CRP contract that was re-enrolled into the acreage for the 

existing contract.  This option will only need to be used to correct missing or incorrect data 

recorded during the TERRA and COLS offer process or to update when the CLU numbers 

change on the CRP contact. 

 

To update the re-enrolled acres information during a division, from the “Select an action to 

perform” drop-down menu on the View Contract Screen, select “Modify > Adjust 

Re-Enrolled Acreage” and CLICK “Go”. 

 

B Example of Adjust Re-Enrolled Acreage Screen 

 

The following is an example of the Adjust Re-Enrolled Acreage Screen. 

 

 
--* 
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Par. 82.5 

*--82.5 Adjust Re-Enrolled Acreage Screen - Division (Continued) 

 

C Fields and Descriptions 

 

The following table provides the field descriptions and actions for the Adjust Re-Enrolled 

Acreage Screen. 

 

Field/Button Description Action 

Contract Status Will display the current status of the contract.  

Activity Type Will display “No Activity”.  

Admin State The administrative State of the contract.  

Admin County The administrative county of the contract.  

Physical State The State of the physical location of tract for this 

contract. 

 

Physical County The county of the physical location associated with 

this contract. 

 

Contract Number The contract number that was selected on the 

Select Contract Screen. 

 

Signup Number The applicable signup number recorded for this 

contract. 

 

Program Type Will display “CRP”.  

Signup Name The applicable signup name recorded for this 

contract. 

 

Program Year The program year associated with this contract.  

This value is set to the program year of the first 

month the contract was effective. 

 

Signup Type The applicable signup type recorded for this 

contract. 

 

Contract 

Description 

This field will display the contract description 

entered in the TERRA/COLS process. 

 

Note: Will be blank for S36 migrated contracts. 

 

Subcategory 

Type 

The applicable CRP subcategory recorded for this 

contract. 

 

Farm Number The farm number associated with the contract.  

Tract Number The tract number associated with the contract.  

CLU The CLU number associated with the contract.  

CLU Acres The acres associated with the CLU entered.  

--* 
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Par. 82.5 

*--82.5 Adjust Re-Enrolled Acreage Screen - Division (Continued) 

 

C Fields and Descriptions (Continued) 

 

Field/Button Description Action 

Re-Enrolled 

Acres 

Displays the number of acres on the contract that 

were a result of re-enrollment. 

 

CLU The CLU number associated with the contract. Select the applicable 

CLU number from 

the drop-down list. 

Expired Contract 

Number 

The contract number of the contract that expired 

before the current acres being re-enrolled to this 

contract. 

Enter the applicable 

expired contract 

number. 

Expired Signup 

Name 

The expired signup name from the contract that 

expired before the current acres being re-enrolled 

to this contract. 

 

Note: This value will be populated from the 

expired contract number that was entered. 

 

Expired Practice 

Code 

The practice code from the contract that expired 

before the current acres being re-enrolled to this 

contract. 

 

Note: This value will be populated from the 

expired contract number that was entered. 

 

Re-Enrolled 

Acres 

Displays the number of acres on the contract that 

was a result of re-enrollment. 

Enter the number of 

acres re-enrolled on 

that CLU. 

Action Will allow for the options for the CLU data to be 

added or deleted. 

CLICK “Add” or 

“Delete”. 

Save After the user clicks “Save”, they will receive a 

pop-up window to confirm the save.  Clicking 

“OK” will save all data.  The Success Screen will 

be displayed if all page validations are met.  The 

user will CLICK “OK” on the Success Screen to 

be returned to the View Contract Screen.  

Clicking “Cancel” on the pop-up window will 

return the user to the Adjust Re-Enrolled 

Acreage Screen without saving data. 

CLICK “Save”, then 

“OK” or “Cancel”. 

Back Returns the user to the View Contract Screen and 

no data will be saved. 

CLICK “Back”. 

--* 
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Par. 82.5 

*--82.5 Adjust Re-Enrolled Acreage Screen - Division (Continued) 

 

D Error Messages 

 

The Adjust Re-Enrolled Acreage Screen is set up to provide potential validation errors.  The 

following error messages may be displayed. 

 

Error Message Description Corrective Action 

There is no contract number 

{XXXX} for state/county 

code {XX/XXX}. 

The contract number entered as 

the expired contract number 

was not found for the State and 

county selected. 

Re-enter the correct 

expired contract number. 

Contract number {XXX} for 

state/county code 

{XX/XXX} is not in a valid 

status for reenrollment 

({XX}). 

The effective end date for the 

contract number entered as the 

expired contract number is not 

before the start date of the 

existing CRP contract. 

Re-enter the correct 

expired contract number. 

At least 1 reenrollment 

detail is positioned on an 

'unknown' CLU. 

The CLU number is missing 

from the contract. 

Enter the CLU number on 

the Adjust Acreage Screen 

according to paragraph 28. 

Reenrollment Detail must 

have some acreage (greater 

than zero). 

The value for re-enrolled acres 

is zero or blank. 

Enter an acreage value 

greater than zero. 

Reenrollment Details must 

define all reenrollment acres 

on the contract ({XXX} vs 

{XXX}). 

The re-enrolled CLU acreage 

does not add up to the total 

re-enrolled acreage for the 

contract. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

Practice {XXX} is not on 

contract number {XXX}. 

The expired contract did not 

contain the practice the user 

has entered. 

Enter the expired practices 

from the expired contract 

number or correct the 

expired contract number. 

CLU {XXX} is only 

{XXX} acres, not enough to 

support {XXX} acres of 

reenrollment associated to it. 

Only one CLU is entered and 

the acres for that CLU is less 

than the total re-enrolled acres 

on the contract. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

You must define some 

enrollment details. 

The contract shows re-enrolled 

acres, but no CLU level details 

are provided on this screen. 

Enter additional CLU’s to 

account for all re-enrolled 

acres. 

The expiring contract must 

end ({XXX}) prior to this 

contract original start date 

({XXX}). 

The expired contract listed did 

not expire before the start date 

of the current contract. 

Re-enter the correct 

expired contract number. 

--* 
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Par. 83 

83  Modify Producer – Division 

 

A Overview 

 

To modify producers, from the “Select an action to perform” drop-down menu on the View 

Contract Screen, select “Modify > Producers” and CLICK “Go”. 

 

The Modify Producers Screen will be displayed with information for all owners and other 

producers associated with the tract and all operators associated with the farm from FRS for 

the program year that corresponds to the revision effective date set in CCMS.  If a producer 

is not displayed in CCMS, they must first be added to the farm record for that tract. 

 

Policy requires all owners of a tract to be on the contract, even if they are not receiving any 

shares. 

 

B Example of Modify Producers Screen 

 

The following is an example of the Modify Producers Screen. 
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Par. 83 
83  Modify Producer – Division (Continue) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Modify Producers 
Screen. 
 

Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or 
Revise based on the maintenance 
being done to the contract.  

 

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen   

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded 

for this contract. 
 

Program Year  The program year associated with 
this contract.  This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded 
for this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 
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Par. 83 
83  Modify Producer – Division (Continue) 
 

C Field Descriptions and Actions (Continued) 
 

The following table provides the field descriptions and actions for the Modify Producers 
Screen. 

 
Field/Button Description Action 

Assigned Producers 
Remove  Will remove the producer from the list of 

Assigned Producers and the producer will 
not display on the revised CRP-1. 

CLICK “Remove”. 

Producer 
Name  

Name of the producer associated with the 
farm in farm records for the program year 
that corresponds to the revision effective 
date and assigned to the contract. 

 

Type The type of association the producer has 
on the tract associated with the contract 
according to Farm Records.  Owner, 
operator, or other tenant will be displayed.  

 

Share  The percent share interest the producer has 
in the CRP-1. 

Enter the percentage value 
between 0 and100 percent in 
hundredths.   

Primary Designates the primary point of contract 
for the CRP contract  

Enter a check () in the box 
of the producer that is the 
primary point of contact.   

Available Producers 
Add Will add the producer from the list of 

available Producers to the list of assigned 
producers and the producer will display on 
the revised CRP-1.   

CLICK “Add”. 

Producer 
Name  

Name of the producer associated with the 
farm in farm records for the program year 
that corresponds to the revision effective 
date and assigned to the contract. 
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Par. 83 
83  Modify Producer – Division (Continue) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Type The type of association the producer 

has on the tract associated with the 
contract according to Farm Records.  
Owner, operator, or other tenant will 
be displayed. 

 

Save After the user selects “Save” a pop-up 
window will be displayed to confirm 
the save.  Selecting “OK” will save all 
data.   
 
The Success Screen will be displayed 
if all page validations are met.  User 
must click “OK” on the Success 
Screen to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the pop-up 
window will return the user to the 
Modify Producer Screen without 
saving data.   

CLICK “Save” then “OK” or 
“Cancel”. 

Back  Will return the user to the View 
Contract Screen and no data will be 
saved. 

CLICK “Back”. 

 
D Error Messages 

 
The Modify Producers Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed.   

 
Error Message Description Corrective Action 

“All owners on the contract must 
have shares, even if zero.” 

All producers on the 
contract must have shares, 
even if zero. 

Enter share between 0 and 
100 for each producer on 
the contract.  

“The Farm number (XXX) 
currently on this contract is no 
longer in an active status for 
Fiscal Year (XXX). Without a 
valid Farm Number, all other data 
validations will fail. Please 
correct the Farm Number.” 

Farm on the Contract must 
be in FRS. 

Correct farm and tract 
number.  

“The total of share percentages 
shall equal 100.” 

The sum of the producer 
share percentages must 
equal 100. 

Enter share between 0 and 
100 for each producer on 
the contract not to exceed a 
total of 100 percent.  
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Par. 84 
84  Modify Practices – Division   
 

A Overview  
 

The Modify Practices Screen that will be displayed has 3 sections, as follows: 
 
• top section is basic signup information 

 
• middle section is acreage and acreage types associated with the contract 

 
• bottom “Assigned Practices” section provides the practices assigned by CLU with the 

associated acreage and estimated cost share, a summary of the practice acreage, and 
estimated cost share. 

 
Users can modify the acreage associated with each practice, modify the estimated cost share 
associated with each practice, delete assigned practices, and add new practices. 

 
To modify conservation practices, on the View Contract Screen, from the “Select an action to 
perform” drop-down list, select “Modify > Practices” and CLICK “Go”. 
 

B Example of Modify Practices Screen 
 

The following is an example of the Modify Practices Screen. 
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Par. 84 
84  Modify Practices – Division (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Modify Practices 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display No Activity, Divide, or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the 

contract.  
 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract number that was selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

Contract Acres  The number of acres on the contract.   
Cropland Acres Displays the number of cropland acres 

on the contract.  Will display as N/A if 
the contract is not cropland eligible.  
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Par. 84 
84  Modify Practices – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
MPL Acres  Displays the number of MPL acres on the 

contract.  Will display as N/A if the 
contract is not MPL eligible. 

 

Non-Cropland Acres Displays the number of MPL acres on the 
contract.  Will display as N/A if the 
contract is not non-cropland eligible. 

 

Wellhead Acres  Displays the number of Wellhead acres 
on the contract.  Will display as N/A if 
the contract is not wellhead eligible. 

 

Payable Acres Will display the number of acres payable 
for the contract.  This field can only be 
edited on FWP contracts.  

If applicable, enter the 
number of payable 
acres in hundredths.   

Assigned Practices 
Farm  Farm number associated with the 

contract.  
 

Tract Tract number associated with the 
contract. 

 

CLU Displays CLU and, in parenthesis, the 
number of acres associated with CLU.  
There can be multiple CLU’s on the 
contracts and the drop-down list will 
include all CLU’s associated with the 
contract.   

Select CLU for the 
practice being adding 
from the drop-down 
list.    

Code Displays the practice code.  Drop-down 
list will display the practice codes 
configured for the signup for which the 
contract was approved.   

 

Practice Acres  Practice acres are automatically 
calculated as users enter the acreage 
values in the “Acreage” field. 

 

Acreage  The number of acres on the CLU for the 
corresponding Practice.  This value 
should equal the CLU acres   

Enter acreage value in 
hundredths.  

Estimated Cost Share Allows the user to enter the estimated 
cost share amount per acre and will 
display the total by practice.   

Enter estimated cost 
share per acre.  

Delete Will remove the CLU row that delete 
was selected.  The user will receive a  
pop- up window to confirm they wish to 
delete the CLU.  Selecting “No” will 
return the user to the Modify Practice 
Screen without deleting the CLU. 

CLICK “Delete” then 
“OK” or “No.” 
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Par. 84 
84  Modify Practices – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Totals 
Practice Acres Total practice acres entered above for 

each CLU. 
 

Acreage  Total acreage entered above for each 
CLU, displayed by acre type for MPL, 
cropland, non-cropland, and wellhead. 

 

Total Estimated Cost 
Share  

Total estimated cost share entered 
above for each CLU. 

 

Add New Practice  The X Screen will be displayed, and 
users will enter new practice details 
according to subparagraph D.  

CLICK “Add New 
Practice”. 

Save After the user selects “Save” a pop-up 
window will be displayed to confirm 
they wish to save.  Selecting “OK” 
will save all data.   
 
The Success Screen will be displayed 
if all page validations are met.  User 
must click “OK” on the Success 
Screen to be returned to the View 
Contract Screen.   
 
Selecting “Cancel” on the pop-up 
window will return the user to the 
Modify Practices Screen without 
saving data.  

CLICK “Save”. 

Back  Will return the user to the View 
Contract Screen and no data will be 
saved. 

CLICK “Back”. 
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Par. 84 
84  Modify Practices – Division (Continued) 
 

D Error Messages 
 

The Modify Practices Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following errors may be displayed. 
 

Error Message Description Corrective Action 
“Tract number or 
CLU = “unknown”.” 

If either “Tract Number” or 
“CLU” field contain the value 
“unknown”, a message will be 
displayed that the fields must be 
updated to complete the 
transaction. 

Tract number is assigned on the 
Modify Farm and Tract Numbers 
Screen.  CLU is assigned on the 
Adjust Acreage Screen.  
Practices must be assigned to 
CLU. 

“Sum of the practice 
acres = contract 
acres?” 

If the sum of the practice acres do 
not match the contract acres, a 
warning message will be 
displayed. 

Either the contract acreage or the 
practice acreage must be 
adjusted before the contract is 
finalized. 

“Wellhead Practice 
acres <= Cropland 
Acres?” 

If the contract has wellhead 
protection acres and the wellhead 
practice acres are greater than the 
cropland acres, an error message 
will be displayed.  

The wellhead practice acres must 
be reduced to be less than or 
equal to the contract acres. 

“Wellhead Practice 
acres = Wellhead 
Protection Area 
acres?” 

If the contract has wellhead 
protection area acres and the 
wellhead practice acres are not 
equal to the wellhead protection 
area acres, an error message will 
be displayed. 

Adjust the wellhead practice 
acres to equal the wellhead 
protection area acres. 

“FWP practices 
requiring buffer area 
present?” 

If the contract is for FWP, CCMS 
will determine whether buffer area 
acres are required.  This is based 
on the program year of the 
contract and the assigned 
practices.  If a buffer area is 
required and not on the contract, 
an error message will be 
displayed. 

The buffer area practice (CP31) 
must be assigned to the contract. 
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Par. 84 
84  Modify Practices – Division (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“FWP Payable 
Acres > FWP 
Practice 
Acres?” 

FWP payable acres are for FWP 
contracts written under the 642 Farm 
Bill.  The 642 Farm Bill stipulated that 
payment would be made for up to 
5 acres per FWP plot.  A contract can 
have multiple plots so CCMS can only 
validate that the payable acres are not 
greater than the practice acres.  If the 
payable acres are greater, a warning 
will be displayed. 

Reduce FWP payable acres to be 
less than or equal to the FWP 
practice acres. 

“Sum of MPL 
Practice Acres 
= Contract 
MPL Acres?” 

If the sum of the MPL practice acres is 
not equal to the contract MPL acres, a 
warning message will be displayed. 

Correct either the MPL practice 
acreage or the MPL contract 
acreage.  This must be complete 
before the contract is finalized. 

“Sum of 
Cropland 
Practice Acres 
= Contract 
Cropland 
Acres?” 

If the sum of the cropland practice 
acres is not equal to the contract 
cropland acres, a warning message 
will be displayed. 

Correct either the cropland 
practice acreage or the contract 
cropland acreage.  This must be 
complete before the contract is 
finalized. 

“FS Technical 
Responsibilities 
completed for 
any Forestry 
practices?” 

CCMS will determine whether any FS 
practices are present on the contract.  
If yes, CCMS will verify that the user 
has indicated the FS technical 
responsibilities have been completed. 

User must verify the technical 
responsibilities have been 
completed (manually) and then 
check () the box indicating that 
FS technical responsibilities have 
been completed.  It is a required 
entry, if displayed. 
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Par. 85 
85  Add Practice – Division  
 

A Overview 
 
The Add Practice Screen will allow users to add a new practice to the CRP contract.  
Practices listed will be contract by signup type by the Conservation Configuration System.   

   
  

B Example of Add Practice Screen   
 

The following is an example of the Add Practice Screen. 
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Par. 85 
85  Add Practice – Division (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Add Practice Screen. 
 

Field/Button Description  Action 
Contract Status  Will display the current status 

of the contract.  
 

Activity Type  Will display No Activity, 
Divide, or Revise based on the 
maintenance being done to the 
contract.  

 

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative county of 
the contract.  

 

Physical State  The State of physical location 
of tract for this contract.  

 

Physical County  The county of the physical 
location associated with this 
contract. 

 

Contract Number The contract numbers that was 
selected on the Select Contract 
Screen.  

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name 

recorded for this contract. 
 

Program Year  The program year associated 
with this contract. This value is 
set to the program year of the 
first month the contract was 
effective.  

 

Signup Type  The applicable signup type 
recorded for this contract. 

 

Contract Description  This field will display the 
contract description entered in 
the TERRA/COLS process. 
 
Note: Will be blank for S36 

migrated contracts.  

 

Subcategory Type  The applicable CRP 
subcategory recorded for this 
contract. 
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Par. 85 
85  Add Practice – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action  
Farm Number The farm number associated with the 

contract. 
 

Tract Number  The tract number associated with the contract.  
CLU  CLU number and acres recorded by the user 

on the Revise Acreage CLU Screen.  
Select the correct CLU 
number from the drop-
down.  

Code List of practice codes on the contract. Select the correct practice 
code from the drop-down.  

Status 
 

List of practice is new, enhanced, or existing.  
Default value is N/A.   

Select the correct status 
value.   

Practice Acres  Displays the practice acres.  This is a display 
field only based on the value entered for 
MPL, cropland, and wellhead acres.   

 

MPL Acres The number of MPL acres for this practice.  
This field will be grayed out unless the 
contract already contains MPL acres.  
Acreage value must match CLU acreage.  

Enter acreage value in 
hundredths, if applicable 

Cropland Acres  The number of Cropland acres for this 
practice.  This field will be grayed out unless 
the contract already contains cropland acres. 
Acreage value must match CLU acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  

Non-Cropland 
Acres  

The number of non-cropland acres for this 
practice.  This field will be grayed out unless 
the contract already contains non-cropland 
acres.  Acreage value must match CLU 
acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  

Wellhead Acres The number of Wellhead acres for this 
practice.  This field will be grayed out unless 
the contract already contains wellhead acres. 
Acreage value must match CLU acreage. 

Enter acre value in 
hundredths, if acre type is 
applicable.  
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Par. 85 
85  Add Practice – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action  
Estimated Cost Share 
Per Acre  

 Displays dollar value of estimated 
cost share per acre recorded on the 
contract.   

Enter estimated cost share in 
whole dollars 

Back The Modify Practice Screen is 
displayed and no data is saved.  

CLICK “Back”. 

Save  The Modify Practice Screen is 
displayed and data is saved.    

CLICK “Save”. 

 
D Error Messages 

    
The Add Practices Screen is set up to provide potential validation errors when comparing the 
contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 
Error Message Description Corrective Action 
“Tract number 
or CLU = 
unknown” 

If either “Tract Number” or “CLU” 
field contain the value unknown, a 
message will be displayed that the 
fields must be updated to complete the 
transaction. 

Tract number is assigned on the 
Modify Farm and Tract Numbers 
Screen.  CLU is assigned on the 
Adjust Acreage Screen.  
Practices must be assigned to 
CLU. 

“Sum of the 
practice acres = 
contract acres?’ 

If the sum of the practice acres does 
not match the contract acres, a 
warning message will be displayed. 

Either the contract acreage or the 
practice acreage must be 
adjusted before the contract is 
finalized. 

“Wellhead 
Practice acres 
<= Cropland 
Acres?” 

If the contract has wellhead protection 
acres and the wellhead practice acres 
are greater than the cropland acres, an 
error message will be displayed.  

The wellhead practice acres must 
be reduced to be less than or 
equal to the contract acres. 

“Wellhead 
Practice acres = 
Wellhead 
Protection Area 
acres?” 

If the contract has wellhead protection 
area acres and the wellhead practice 
acres are not equal to the wellhead 
protection area acres, an error message 
will be displayed. 

Adjust the wellhead practice 
acres to equal the wellhead 
protection area acres. 
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Par. 85 
85  Add Practice – Division (Continued) 
 

D Error Messages (Continued) 
 

Error Message Description Corrective Action 
“FWP practices 
requiring buffer 
area present?” 

If the contract is for FWP, CCMS will 
determine whether buffer area acres 
are required.  This is based on the 
program year of the contract and the 
assigned practices.  If a buffer area is 
required and not on the contract, an 
error message will be displayed. 

The buffer area practice (CP31) 
must be assigned to the contract. 

“FWP Payable 
Acres > FWP 
Practice 
Acres?” 

FWP payable acres are for FWP 
contracts written under the 2008 Farm 
Bill.  The 2008 Farm Bill stipulated 
that payment would be made for up to 
5 acres per FWP plot.  A contract can 
have multiple plots so CCMS can only 
validate that the payable acres are not 
greater than the practice acres.  If the 
payable acres are greater, a warning 
will be displayed. 

Reduce FWP payable acres to be 
less than or equal to the FWP 
practice acres. 

“Sum of MPL 
Practice Acres 
= Contract 
MPL Acres?” 

If the sum of the MPL practice acres is 
not equal to the contract MPL acres, a 
warning message will be displayed. 

Correct either the MPL practice 
acreage or the MPL contract 
acreage.  This must be complete 
before the contract is finalized. 

“Sum of 
Cropland 
Practice Acres 
= Contract 
Cropland 
Acres?” 

If the sum of the cropland practice 
acres is not equal to the contract 
cropland acres, a warning message 
will be displayed. 

Correct either the cropland 
practice acreage or the contract 
cropland acreage.  This must be 
complete before the contract is 
finalized. 

“FS Technical 
Responsibilities 
completed for 
any Forestry 
practices?” 

CCMS will determine whether any FS 
practices are present on the contract.  
If yes, CCMS will verify that the user 
has indicated the FS technical 
responsibilities have been completed. 

User must verify the technical 
responsibilities have been 
completed (manually) and then 
check () the box indicating that 
FS technical responsibilities have 
been completed.  It is a required 
entry, if displayed. 
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Par. 86 
86  Finalize Contracts – Division  
 

A Overview  
 
CCMS requires a step after the details of the division have been updated to prepare the 
contract for COC approval.  Users must perform this step on every resulting contract as well 
as the parent contract for divisions.  To finalize child contracts, on the following View 
Contract Screen, from the “Select an action to perform” drop-down list, select “Modify > 
Finalize Child” and CLICK “Go”.  To finalize parent contracts, on the following View 
Contract Screen, from the “Select an action to perform” drop-down list, select “Modify > 
Finalize Parent” and CLICK “Go”. 
 

B Example of the Finalize Child Contract Screen    
 

The following is an example of the Finalize Child Contract Screen. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

C Field Descriptions and Actions  
    

The following table provides the field descriptions and actions for the Finalize Child 
Contract Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display No Activity, Divide, or 
Revise based on the maintenance being 
done to the contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract number(s) that was selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process. 
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Contract Description  A free form optional field that the user can 
add contract descriptions based on 
revisions.  

Add contract 
descriptions as 
applicable.  Do not load 
any PII information in 
this field.   

Parent Contract Start 
Date 

The start date of the contract that was 
modified. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Contract End Date  The final date the contract will be in 

effect.  
 

Divide Effective Date The first day the newly divided 
contracts will be effective.  This date 
is set on the Divide Contract Screen 
in paragraph 80. 

 

Reason for Division  The reason the user selected on the 
Divide Contract Screen.  

 

Check box to indicate 
CPO Update Received  

Indicator to allow the user to record 
that the CPO has been received.  
 
Note: This field will only be displayed 

if an updated CPO is needed.   

Check (), if CPO update has 
been received. 

FS Technical 
Responsibilities 
Completed? 

Indicator to allow the user to record 
that the FS Technical Responsibilities 
have been received.  
 
Note: This field will only be 

displayed if updated FS 
technical responsibilities are 
needed for the practices on the 
contract.   

Check (), if FS technical 
responsibilities documentation 
has been completed. 

This Contract Will be 
a Placeholder  

Indicator to allow the user to record 
that this contract will be placed in a 
placeholder status according to 
paragraph 87.  If this indicator is 
checked the CRP-1 producer signed 
date will be removed.   

Check (), if this contract should 
be placed in a placeholder status.  

CRP-1 Producer 
Signed Date 

The date the last producer on the 
CRP-1 signed the CRP-1.   

Enter the date in the mm/dd/yyyy 
format or select the date from the 
calendar icon.  

Finalize Child 
Contract  

After the user selects “Save” a pop-up 
window will be displayed to confirm 
they wish to save.  Selecting “OK” 
will save all data.   
 
CCMS will execute a series of 
validations.  If any validations fail, 
error messages will be displayed 
according to subparagraph F.  
 
If all validations pass the user will see 
the Success Screen.  CLICK “OK” to 
be returned to the View Contract 
Screen.  

CLICK “Finalize Child Contract” 
and “OK”.  

Back  Will return the user to the View 
Contract Screen and no data will be 
saved. 

CLICK “Back”. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

D Example of the Finalize Screen –Parent  
 

The following is an example of the Finalize Screen for the parent contract. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages  
 

The Finalize Contract Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“(XXX)'s involvement has changed 
for Fiscal Year (XXX), please update 
the producer's involvement.” 

The producer involvement on 
the contract must match the 
producer involvement in FRS. 

Correct producer 
according to 
paragraph 83. 

“All owners associated with the tract 
in Farm Records for Fiscal year 
(XXX) shall be on the contract, even 
if they are not receiving payments 
from the contract. Other Producers 
on the tract and Operators are 
optional. Please add all owners of the 
tract to the contract.” 

All owners must be on the 
contract, including those with 
zero percent interest on the 
contract. 

Correct producer 
according to 
paragraph 83. 

“Cropland acreage cannot be added 
to a contract which does not already 
have Cropland acreage.” 

A contract that does not have 
cropland acres cannot be 
revised to have cropland acres. 

Correct CLU or 
contract acre type 
according to 
paragraph 82. 

“CRP-1 Producer Signed Date is 
required.” 

Producer signed date is a 
required field. 

Enter date in 
mm/dd/yyyy format 
according to this 
paragraph.  

“Field/CLU Numbers are required. 
Please enter the Field/CLU Numbers 
before proceeding.” 

CLU number must be valid 
(cannot be null/missing, blank 
or -99). 

Enter CLU numbers 
according to 
paragraph 82. 

“MPL acreage cannot be added to a 
contract which does not already have 
MPL acreage.” 

A contract that does not have 
MPL acres cannot be revised 
to have MPL acres. 

Correct CLU or 
contract acre type 
according to 
paragraph 82. 

“MPL practices cannot be added to a 
contract which does not already have 
MPL acreage.” 

If the parent contract does not 
have MPL acres but a practice 
on the child contract has MPL 
acres (likely due to System 36 
migrated data), this warning 
occurs. 

Correct practice 
acreage according to 
paragraph 82. 

“No Available Practices Found.” There are no supporting 
practices for the acreage type 
of the contract.  Either the 
acreage type on the contract 
needs to be fixed or signup 
configuration needs to be 
updated. 

Enter practice data 
according to 
paragraph 84. 

 
 

5-15-19     5-CRP Amend. 1 Page 2-297  



Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages (Continued) 
 

Error Message Description Corrective Action 
“Non-Cropland acreage 
cannot be added to a 
contract which does not 
already have Non-
Cropland acreage.” 

If the parent contract does not 
have non-cropland acres but a 
practice on the child contract has 
non-cropland acreage (likely due 
to System 36 migrated data), this 
warning occurs. 

Correct CLU or Contract 
acre type according to 
paragraph 82. 

“Non-Cropland practices 
cannot be added to a 
contract which does not 
already have Non-
Cropland practices.” 

If the parent contract does not 
have non-cropland acres but a 
practice on the child contract has 
non-cropland acreage (likely due 
to System 36 migrated data), this 
warning occurs. 

Correct practice acreage 
type according to 
paragraph 84. 

“Only one Primary 
Producer may be assigned 
to the contract.” 

There cannot be more than one 
primary producer on the contract. 
On the View Contract Screen, this 
message shows as a warning. 
User would never see this if 
software was working correctly. 

Correct producer 
according to  
paragraph 83. 

“Pivot corner response 
shall be 'N/A' for practice 
(XXX).” 

If the available practice is not 
pivot corner eligible, that practice 
cannot have pivot corners. 

Correct pivot corner 
response under modify 
practices according to 
paragraph 84. 

“Pivot corner response 
shall be 'Yes' or 'No' for 
practice (XXX).” 

If the available practice is pivot 
corner eligible, the user must 
respond to the question of 
whether or not there is a pivot 
corner practice on this contract. 

Correct pivot corner 
response under modify 
practices according to 
paragraph 84. 

“Please add CLU before 
saving.” 

No CLU's have been found from 
the contract. 

Enter CLU numbers 
according to  
paragraph 82. 

“Practice (XXX) is 
defined on CLU (XXX) 
that is not on the 
contract.” 

The CLU numbers on the contract 
must contain all of the CLU 
numbers from the practices. 

Enter CLU numbers 
according to  
paragraph 82. 

“Practice (XXX) cannot 
have cropland Acres.” 

If the practice is not cropland 
eligible, it cannot have cropland 
acres. 

Correct practice acreage 
type according to 
paragraph 84. 

“Practice (XXX) cannot 
have MPL Acres.” 

If the practice is not MPL 
eligible, it cannot have MPL 
acres. 

Correct practice acreage 
type according to 
paragraph 84. 

“Practice (XXX) cannot 
have Wellhead Acres.” 

If the practice is not wellhead 
eligible, it cannot have wellhead 
acres. 

Correct practice acreage 
type according to 
paragraph 84. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages (Continued) 
 

Error Message Description Corrective Action 
“Practice (XXX) is a 
reforestation practice that 
needs to have its technical 
responsibility completed.” 

If there is a forestry practice on 
the contract, it must be 
completed. 

Enter required check box 
indicator according to this 
paragraph  

“Primary Producer Not 
Assigned.” 

A primary producer must be 
assigned to the contract. 

Correct producer 
according to paragraph 83. 

“Selection is required.” Form validation.  CPO must be 
received for a child or a rate 
revision. 

Enter required check box 
indicator according to this 
paragraph 

“Selection is required.” Form validation.  If a forestry 
practice exists on the contract, it 
must be completed before 
finalizing a revision or child. 

Enter required check box 
indicator according to this 
paragraph. 

“The combination of MPL 
acres and Non-Cropland 
acres (XXX) on the tract 
(XXX) are more than 
available acres (XXX) for 
Fiscal Year (XXX).” 

There cannot be more MPL and 
non-cropland acres on the farm 
tract than there are available 
(available amount retrieved 
from FRS and added to parent 
acreage).  Hard error that is 
only applicable for current year.  

Correct practice acreage 
type according to 
paragraph 84. 

“The Cropland acreage on 
this contract cannot be 
reduced to zero.” 

If the parent contract has 
cropland acres, the child 
contract must have cropland 
acres. 

Enter CLU cropland 
acreage value greater than 
0, acres values in 
hundredths according to 
paragraph 82. 

“The cropland acres (XXX) 
entered for the tract (XXX) 
exceed available acres 
(XXX) for Fiscal Year 
(XXX).” 

The cropland on the farm tract 
is greater than the available 
cropland acres (including base 
acres).  If current year, shown 
as error. If previous year, shown 
as warning.  

Correct CLU acres to not 
exceed tract acres 
according to paragraph 82. 

“The cropland acres (XXX) 
entered for the tract (XXX) 
exceed available acres 
(XXX) for Fiscal Year 
(XXX) The acreage entered 
can only be processed for 
this contract if there is an 
overall increase in available 
cropland acres.” 

Warning:  The cropland on the 
farm tract is greater than the 
available cropland acres 
(including base acres).   

Correct CLU acres to not 
exceed tract acres 
according to paragraph 82. 
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Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The CRP Contract acres 
are being placed on Base 
Acres. Please complete a 
base reduction in Farm 
Records for Fiscal Year 
(XXX).” 

Warning:  If the cropland acres 
do not exceed the available 
cropland + base acres but they 
do exceed the available 
cropland acres, this message 
will show as an error during a 
finalize contract action if the 
activity (contract start date) is in 
the current fiscal year. 

This is a warning 
message only, after the 
contract is approved 
reduce base according to 
10-CM.  

“The date of the CRP-1 
Producer Signature(s) 
cannot be later than today. 
Please correct the date.” 

Producer signatures cannot be 
future dated. 

Enter a date in the 
mm/dd/yyyy format that 
is not in the future.  

“The date you have entered 
for the CRP-1 Producer 
Signature(s) precedes the 
original contract start date. 
Please correct the date.” 

Producer signed date for a 
revision cannot precede the 
original start date of the 
contract family. 

Enter a date in the 
mm/dd/yyyy format that 
equal to or greater than 
the original contract start 
date.  

“The effective date (XXX) 
cannot be after the current 
date (XXX).” 

A new child contract (not yet 
approved) cannot be future 
dated unless its parent is also 
future dated. 

Enter a date in the 
mm/dd/yyyy format that 
is not in the future. 

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity cannot 
begin after the contract ends. 

Enter a date in the 
mm/dd/yyyy format that 
is prior to the contracts 
end date.  

“The effective date (XXX) 
cannot be different than 
parent effective date 
(XXX).” 

If the parent contract is deferred 
then the child contract must 
start on the same date as the 
parent. 

Enter a date in the 
mm/dd/yyyy format that 
matches the parent 
contract for the deferred 
contract.  

“The effective date (XXX) 
cannot be earlier than the 
start date (XXX).” 

A child contract cannot start 
before its parent. 

Enter a date in the 
mm/dd/yyyy format that 
equal to or greater than 
the original contract start 
date 

“The Farm number (XXX) 
currently on this contract is 
no longer in an active status 
for Fiscal Year (XXX). 
Without a valid Farm 
Number, all other data 
validations will fail. Please 
correct the Farm Number.” 

Farm on Contract must be in 
FRS. 

Correct the farm number 
or correct the effective 
date according to 
paragraphs 80 or 81. 

5-15-19     5-CRP Amend. 1 Page 2-300  



Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The following producer(s) 
are not associated with the 
Farm for Fiscal year (XXX). 
Please remove the invalid 
producer(s) from the 
contract. (XXX).” 

The producers on the contract 
must be in FRS. 

Correct producer 
according to  
paragraph 83. 

“The MPL acreage on this 
contract cannot be reduced to 
zero.” 

If the parent contract has 
MPL acres, the child contract 
must have MPL acres. 

Enter CLU MPL acreage 
value greater than 0, acres 
values in hundredths 
according to paragraph 82. 

“The Non-Cropland acreage 
on this contract cannot be 
reduced to zero.” 

If the parent has non-cropland 
acres, the child contract must 
have non-cropland acres. 

Enter CLU non-cropland 
acreage value greater than 
0, acres values in 
hundredths according to  
paragraph 82. 

“The sum of acres on all the 
child contracts cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths according to 
paragraph 82. 

“The sum of the Cropland 
Acres for the practices shall 
equal the Cropland Acres for 
the Contract.” 

The sum of cropland acres for 
farm tract must match the sum 
of cropland acres for the 
practices.  Error thrown on 
any finalizing action. 

Correct CLU or contract 
acres according to 
paragraph 82. 

“The sum of the MPL Acres 
for the practices shall equal 
the MPL Acres for the 
Contract.” 

The sum of MPL acres for 
farm tract must match the sum 
of MPL acres for the 
practices. Error thrown on any 
finalizing action. 

Correct CLU or contract 
acres according to 
paragraph 82. 

“The sum of the Non-
Cropland Acres for the 
practices shall equal the 
Non-Cropland Acres for the 
Contract.” 

The sum of non-cropland 
acres for farm tract must 
match the sum of non-
cropland acres for the 
practices. Error thrown on any 
finalizing action. 

Correct CLU or contract 
acres according to 
paragraph 82. 

“The total CLU acres cannot 
exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter acreage values in 
hundredths according to 
paragraph 82. 

“The total of share 
percentages shall equal 100.” 

The sum of the producer share 
percentages must equal 100. 

Correct producer shares 
according to  
paragraph 83. 

“The total practice acres 
cannot exceed more than two 
decimals.” 

All acreage entries must be 
entered in hundredths. 

Enter practice acres in 
hundredths according to 
paragraph 89. 

5-15-19     5-CRP Amend. 1 Page 2-301  



Par. 86 
86  Finalize Contracts – Division (Continued) 
 

E Error Messages (Continued) 
 

Error Message Description Corrective Action 
“The Tract and/or CLU 
Number on this contract 
were unavailable when this 
contract was migrated. They 
shall be updated in order to 
complete this transaction.” 

All tracts and CLUs on the 
contract cannot be unknown. 

Update Tract and CLU 
numbers according to 
paragraph 81 or 82. 

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX). Please 
establish the tract number for 
this county.” 

The tract number(s) cannot be 
missing. 

Add Tract number to the 
contract according to 
paragraph 81. 

“The Wellhead Acres (XXX) 
shall not exceed the 
Cropland Acres (XXX).” 

The wellhead acres must not 
exceed the cropland acres. 

Enter acreage values in 
hundredths according to 
paragraph 82. 

“Total practice acres not 
equal to contract acres.” 

The total acres for the contract 
must equal the total acres for 
the practices. 

Correct CLU or contract 
acres according to 
paragraph 82. 

“Total Wellhead acres 
(XXX) not equal to 
approved Wellhead acres 
(XXX).” 

The sum of the wellhead 
practice acreage must equal 
the wellhead protection acres 
on the contract. 

Correct CLU or contract 
acres according to 
paragraph 82. 

“Tract (XXX) shall have 
Cropland or MPL acres.” 

The tract must have at least 
one valid acreage type. 

Correct CLU or contract 
acres according to 
paragraph 82. 
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Par. 87 
87  Placeholder Contracts 
 

A Overview 
 

The placeholder contract was developed to allow a contract division to be completed and 
approved when not all details have been finalized on one of the resulting contracts.  This is 
needed for CCMS to strictly enforce that all resulting contracts of a division maintain the 
same effective start date.  Contracts placed in the status will be displayed with (PH) after the 
contract number and are not payable. 
 
After the details are finalized for a placeholder contract, users must revise the contract 
according to Part 5, however users will not be able to change the effective start date during 
the process. 
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Par. 88 
88  COC Approval – Division 
 

A Overview  
 
When COC approves a division, COC approval applies to all child contracts of the division, 
including child contracts identified as placeholders.   
 
After COC approval of a division, to enter COC approval information, on the View Contract 
Screen, select the parent contract.  From the “Select an action to perform” drop-down list, 
select “Modify >COC Approve” and CLICK “Go”. 
 

B Example of the COC Approval Screen    
 

The following is an example of the COC Approval Screen. 
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Par. 88 
88  COC Approval – Division (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the COC Approval Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract 
Number 

The contract numbers that was selected on the 
Select Contract Screen   

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The program year associated with this contract. 
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated 
contracts.  

 

Subcategory 
Type  

The applicable CRP subcategory recorded for 
this contract. 

 

COC Approval 
(mm/dd/yyyy) 

Allows the user to enter the date the COC 
approved the contract revision.   

Enter the date in the 
mm/dd/yyyy format 
or select the date 
from the calendar 
icon. 
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Par. 88 
88  COC Approval – Division (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 

Payment Schedule 
for FY 20XX 

This allows the user to shift payments 
between contracts in the effective year of the 
revision.  See paragraph 37 for complete 
Division of Payment schedule details.  
 
Note: The table will be populated based on 

active days of each contract in the FY 
as a default.   

As applicable adjust 
the percentage or 
dollar value to be 
paid to each 
contract.  

Approve  After the user selects “Approve” a pop-up 
window will displayed to confirm the 
approval.  Selecting “OK” will save all data.   
 
The user will see validation errors according 
to subparagraph D or the Success Screen.  
On the Success Screen CLICK “OK” to be 
returned to the View Contract Screen.  

CLICK “Approve” 
and “OK”. 

Reject  After the user selects “Reject” a pop-up 
window will be displayed confirming the 
rejection.  Selecting “OK” will return the 
user to the View Contract Screen and the 
contract will be returned to a Revision in 
Process status.  User will be able to further 
modify the contract as needed.  

CLICK “Reject” and 
“OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 

 
D COC Approval Error Messages 
 

The COC Approval Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Approval date (XXX) shall 
be no later than Today's 
Date (XXX).” 

The COC approval date 
cannot exceed today's date. 

Enter a date in the 
mm/dd/yyyy format or that 
is not a future date.  

“The COC Approval Date 
(XXX) for this contract 
cannot be earlier than the 
COC Approval Date of the 
original offer (XXX).” 

The COC approval date 
cannot exceed the contract 
family's original start date. 

Enter a date in the 
mm/dd/yyyy format or that 
is equal to or later than the 
approval date of the original 
offer.   
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Par. 89 
89  Cancel Division 
 

A Overview  
 
If at any time prior to COC approval of a division the user determines they have started the 
division in error, they can cancel the division and return the parent contract to an approved 
status.  To cancel a division, on the View Contract Screen of the parent contract, from the 
“Select an action to perform” drop-down list, select “Modify > Cancel” and CLICK “Go”. 
 

B Example of the Cancel Division Confirmation Screen    
 

The following is an example of the Cancel Divide Confirmation Screen. 
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Par. 89 
89  Cancel Division (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Cancel Divide 
Confirmation Screen.  
 

Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display No Activity, Divide, or Revise 

based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that was selected on the 
Select Contract Screen. 

 

Signup Number  The applicable signup number recorded for this 
contract.  

 

Program Type  Will display CRP.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The Program year associated with this contract.  
This value is set to the program year of the first 
month the contract was effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process. 
 
Note: Will be blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded for 
this contract. 

 

Are you sure that you want to Cancel Division at this time? 
OK Division will be canceled and the parent 

contract will be returned to an active status.  The 
user will be taken to the Success Screen and 
must select “OK” to be returned to the View 
Contract Screen.   

CLICK “OK”. 

Back  Will return the user to the View Contract Screen 
and no data will be saved. 

CLICK “Back”. 

 
90-99 (Reserved) 
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Par. 100 
 

Section 6    Contract Validity 
 
100 Determining Contract Validity 
 

A  Overview  
CCMS will begin processing messages from both the Farm Records and SCIMS applications.  
When a notification is received CCMS will compare the elements on the contract with the 
elements in FRS and SCIMS to determine if the change impacts the contract to the point that 
the current contract would not pass the validations normally applied at the time of COC 
approval. 
 
To help make users more aware the contract validity indicator has been added to the 
following screens: 
 
• Search Contract Screen 

 
Note: Allows the user to specifically search for any of the three status outlined in 

subparagraph B. 
 

• Select Contract Screen 
 

• View Contract Screen. 
 

B Validity Indicators 
 

CCMS will display one of the following three status for the contract validity. 
 

Contract Validity Status Definition  Action  
Invalid  One or more of the contract 

validations outlined in 
subparagraph C is no longer met. 

A correction to the 
source system or 
contract revision will be 
needed. 

Undetermined  Contract is in the process of 
modification and validity will be 
set after the contract is COC 
approved.   

None. 

Valid  After notification of change was 
received from FRS or SCIMS all 
contract validation are met.   

None. 
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Par. 100 
100 Determining Contract Validity (Continued) 
 

C Detected Validity Changes  
 

The following elements will be checked and used to determine if the Contact Validity Flag 
will be set to “Invalid”.  
 

Detected Change Action in CCMS 
Farm number becomes inactive  Modify the contract according to paragraph 27.  

Tract number becomes inactive  Modify the contract according to paragraph 27.   
Tract number is unknown Modify the contract according to paragraphs11 through 

14.   
Owner is added or removed 
from the tract  

Modify the contract according to paragraph 27. 
 
Note: If it was determined that the owner was 

added or removed incorrectly in FRS, once the 
owner is corrected in FRS, CCMS will 
revalidate the following night and the invalid 
indicator will be removed in CCMS.  

Producer with share on the 
CRP-1 is removed from the 
farm record  

Verify the addition or removal in FRS was correct.  
Modify the contract according to paragraph 27 or 29 to 
correct the producer.  

Producer becomes inactive  Modify the contract according to paragraph 27 or 29 to 
correct the producer.  

Confirmed death indicator is set Modify the contract according to paragraph 29 to 
correct the producer.  
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Par. 100 
100 Determining Contract Validity (Continued) 
 

D Error Messages 
 

CCMS will provide specific error messages for contract validity at time of COC approval.  
The following error messages may be displayed. 
 

Error Message Description Corrective Action 
“The Tract Number is 
unknown. Correct the tract 
number using Correct Tract 
CLU prior to any changes.” 

The tract number was not 
available at time of 
migration and is currently 
listed as unknown.    

Modify the contract 
according to paragraph 19 to 
correct the producer. 

“The Farm/Tract number 
(XXX) currently on this 
contract is no longer in an 
active status for Fiscal 
Year(s) (XXX). Without a 
valid Farm/Tract number all 
other data validations will 
fail. Please correct the 
Farm/Tract Number.” 

The farm and/or tract 
number listed on the 
contract is no longer active 
in farm records.   

Modify the contract 
according to paragraph 27. 

“Producer [Name] must be 
on the contract for fiscal 
year(s) (XXX).” 

A producer listed as an 
owner in FRS is not listed 
as a producer in CCMS for 
the year indicated.   

Modify the contract 
according to paragraph 29 to 
correct the producer. 

“Producer [Name] cannot be 
on the contract for fiscal 
year(s) (XXX).” 

A producer listed in CCMS 
is not linked to the farm 
and/or tract in FRS for the 
year indicated.   

Modify the contract 
according to paragraph 29 to 
correct the producer. 

“Producer [Name] on this 
contract has been 
deactivated in SCIMS.” 

A producer listed in CCMS 
is no longer active in 
SCIMS.   

Modify the contract 
according to paragraph 29 to 
correct the producer. 

“The producer [Name] is 
deceased and cannot be on 
the contract after his/her 
date of death (XXX).” 

The producer in CCMS is 
listed on the contract after 
the date of death.   

Modify the contract 
according to paragraph 29 to 
correct the producer. 

 
101-125 (Reserved) 
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Par. 126 
 

Section 7    State Office Access 
 
126 CCMS Access 
 

A Levels of State Office User Access 
 
 CCMS determines access based on the location of the user.  State office users are split into 

two different user roles.  At a minimum all State Office employees will have access to view 
contracts within their State(s).  These State users will only be able to search, view, and print 
CRP-1 by following the procedure in paragraph 10.  The second user role will be the State 
Office administrative role.  This role will allow State Office users to correct start dates, 
correct end dates, and correct termination dates.  

 
State office users in need of administrative access must request the 
“app.fsa.conservation.statecorrection” EAS role be added to their profile by submitting   
FSA-13-A to their state security officer.   
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Par. 127 
127 Start Date Corrections 
 

A Overview 
 

Users with the State Office administrative role will be able to correct start dates on all active 
or expired contracts.  If correcting the start date of a child contract resulting from a division, 
the new start date will apply to all children of the division and all children must be active or 
expired at the time the new start date is entered.   
 
State Office users will not be able to correct start dates when:  
 
• a contract has been extended and the requested start date is prior to the extension 
• a contract sibling has been terminated. 
• the requested start date is prior to the COC approval date. 

 
Note: For these situations submit the correction to the National Office.   
  
To modify the start date, users must select the action for “Correct>Start Date” and CLICK 
“Go” from the View Contract Screen.  

 
B Example of Correct Revised Contract Start Date Screen 
 

The following is an example of the Correct Revised Contract Start Date Screen 
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Par. 127 
127 Start Date Corrections (Continued) 
 

C Field Descriptions and Actions for Correct Revised Contract Start Date Screen 
 

The following table provides the field descriptions and actions for Correct Revised Contract 
Start Date Screen. 
 

Field/Button Description Action 

Parent Contract 
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the 

contract 
 

Contract Start Date This field will display the contract start date 
for the contract.    

 

Contract End Date This field will display the contract end date 
for the contract.    

 

Child Contracts 
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the 

contract 
 

Contract Start Date This field will display the contract start date 
for the contract.    

 

Contract End Date This field will display the contract end date 
for the contract.    

 

New Revised 
Contract Start Date 

Users will enter the corrected contract start 
date. 

Enter date in the 
mm/dd/yyyy 
format.   

Next  The review Revised Contract Start Date 
Screen will be displayed.    

CLICK “Next”. 

Back  User will be returned to the View Contract 
Screen and no changes will be saved.  

CLICK “Back”.  
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Par. 127 
127 Start Date Corrections (Continued) 
 

D Example of Review Revised Contract Start Date Screen 
 
The following is an example of the Review Revised Contract Start Date Screen. 
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Par. 127 
127 Start Date Corrections (Continued) 
 

E Field Descriptions and Actions for Review Revised Contract Start Date Screen 
 

The following table provides the field descriptions and actions for the Review Revised 
Contract Start Date Screen. 
 

Field/Button Description Action  

Parent Contract 
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the contract.  
Contract Start 
Date 

This field will display the contract start date for 
the contract.    

 

Contract End 
Date 

This field will display the corrected end date for 
the contract.  Date change will be highlighted in 
blue text.  

 

Child Contracts 
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the contract.  
Contract Start 
Date 

This field will display the corrected contract start 
date for the contract.  Date change will be 
highlighted in blue text. 

 

Contract End 
Date 

This field will display the contract end date for 
the contract.    

 

Save  The date change will be saved and the user will 
receive the Success Screen.  CLICK “OK” to 
return to the View Contract Screen.     

CLICK “Save”. 

Back  User will be returned to the View Contract Screen 
and no changes will be saved.  

CLICK “Back”. 
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Par. 127 
127 Start Date Corrections (Continued) 
 

F Error Messages 
 

The Review Revised Contract Start Date Screen is set up to provide potential validation 
errors when comparing the contract to the current year in Farm Records.  The following error 
messages may be displayed.  
 

Error Message Description Corrective Action 
“Value Shall be 
mm/dd/yyyy Format and it 
has to be a valid date” 

Date was entered in an 
incorrect format. 

Enter date in the 
mm/dd/yyyy format.   

“Start Date 
(XX/XX/XXXX) of the 
contract (XX) cannot be 
after its End Date.” 

Date entered was after the 
end date of the contract.  

Enter date in the 
mm/dd/yyyy format that is 
prior to the contracts end 
date. 

“Contract’s Start Date 
Cannot be after today’s 
Date.” 

Date entered was after the 
current date.  

Enter date in the 
mm/dd/yyyy format that is 
equal to or prior than the 
current date.  

“The Start Date 
(XX/XX/XXXX) cannot be 
earlier than it parent’s Start 
Date (XX/XX/XXXX).” 

Date entered was prior to 
the parent start date.  

Enter date in the 
mm/dd/yyyy format that is 
equal to or after the parent 
contracts start date. 

“Date corrections to the 
family are not allowed due 
to the status of contract(s) 
(XXX).” 

The original end date of a 
contract family cannot be 
changed if any contracts 
have extensions. All 
extensions that exist in the 
contract family must be 
cancelled in order to change 
the end date. 

Date correction cannot be 
made at the State Office 
level.  Submit correction to 
the National Office.  

“The duration of the contract 
family shall be between 10 
and 15 Fiscal Years.” 

The duration of the contract 
family must be between 10 
and 15 fiscal years. 

Enter date in the 
mm/dd/yyyy format that 
maintains the 10 to 15 years 
of contract length.   

“The original start date 
(XXX) cannot be less than 
original approval date 
(XXX).” 

The original start date 
cannot be less than the 
original approval date. 

Enter date in the 
mm/dd/yyyy format that is 
after the original approval 
date.  If the original 
approval date is incorrect, 
submit correction to the 
National Office.  

“The Original Start Date 
shall be on the 1st of the 
month.” 

For a continuous signup, the 
original start date of the 
family must begin on the 
first day of a given month. 

Enter date in the 
mm/dd/yyyy format that the 
start of a month.  
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Par. 128 
128 End Date Corrections 
 

A Overview  
 

State Office functionality is available in CCMS to allow administrative users to correct the 
original end date of the contract.  This functionality is designed as a data correction feature 
for an incorrect date that was migrated from the System 36 and COLS.  State Office users 
should only use this functionality to correct CCMS to match the current correctly signed and 
approved paper CRP-1.  If the end date is incorrect on the original CRP-1 and in CCMS, 
State Offices must obtain DAFP approval before making the date correction.    
 
To modify the Original End Date, users must select the action for “Correct>Original End 
Date” and CLICK “Go” from the View Contract Screen.  
 

   B Example of Correct Original End Date Screen 
 

The following is an example of the Correct Original End Date Screen. 
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Par. 128 
128 End Date Corrections (Continued) 
 

C Field Descriptions and Actions for Correct Contract Original End Date Screen 
 

The following table provides the field descriptions and actions for the Correct Original End 
Date Screen. 
 

Field/Button Description Action 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the contract  
Effective Start Date This field will display the contract start date for 

the contract.    
 

Effective End Date This field will display the contract end date for 
the contract.    

 

New End Date Users will enter the corrected contract end date. Enter date in the 
mm/dd/yyyy 
format.   

Original End Date  This field will display the contract end date for 
the contract. 

 

Next  The Review Correct Original End Date Screen 
will be displayed.  

CLICK “Next”. 

Back  User will be returned to the View Contract 
Screen and no changes will be saved.  

CLICK “Back”.  
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Par. 128 
128 End Date Corrections (Continued) 
 

D Example of Review Correct Original End Date Screen 
  

The following is an example of the Review Correct Original End Date Screen. 
 

 
 

E  Field Descriptions and Actions for Review Original End Date Screen 
 

The following table provides the field descriptions and actions for the Review Original End 
Date Screen.     

 
Field/Button Description Action 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Contract Number The contract number that was selected.  
Contract Status  Will display the current status of the contract.  
Effective Start Date This field will display the contract start date for 

the contract.    
 

Effective End Date This field will display the contract end date for 
the contract.    

 

New End Date Users will enter the corrected contract end date. Enter date in the 
mm/dd/yyyy 
format.   

Original End Date  This field will display the contract end date for 
the contract.    

 

Save The new end date will appear in blue font.   
After “Save” is selected and all validations 
outline in subparagraph F are passed the user 
will receive the Success Screen.  CLICK “OK” 
to return to the View Contract Screen.   

CLICK “Save”. 

Back  User will be returned to the Correct Original 
End Date Screen and no changes will be saved.  

CLICK “Back”.  
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Par. 128 
128 End Date Corrections (Continued) 
 

F Error Messages for Review Original End Date Screen 
 

The Review Original End Date Screen is set up to provide potential validation errors. 
The following error messages may be displayed.  

 
Error Message Description Corrective Action 

“The duration of the 
contract family shall be 
between 10 and 15 Fiscal 
Years.” 

Contract length must be 
between 10 and 15 years. 

Enter date in the mm/dd/yyyy 
format that between 10 and 
15 years in length.  

“The end date of the 
contract family cannot be 
modified due to the 
statuses of contract(s) 
(XXX).” 

Contract must be in 
approved, frozen, terminated, 
or expired status in order to 
correct signup. 

Date correction cannot be 
made at the State Office level.  
Submit correction to the 
National Office. 

“The end date of the 
family cannot be modified 
due to one or more 
extensions of contract(s) 
(XXX).” 

Extended contracts are 
excluded from end date 
corrections. 

Date correction cannot be 
made at the State Office level.  
Submit correction to the 
National Office. 

“The new end date cannot 
precede the early out date 
of contract(s) (XXX).” 

New end date cannot precede 
early out date. 

Enter date in the mm/dd/yyyy 
format that equal to or after 
the early out date.  

“The new end date cannot 
precede the start date of 
contract(s) (XXX).” 

New end date cannot precede 
the start date. 

Enter date in the mm/dd/yyyy 
format that is equal to or after 
the parent contracts start date. 

“The new end date cannot 
precede the termination 
date of contract(s) 
(XXX).” 

New end date cannot precede 
the termination date. 

Enter date in the mm/dd/yyyy 
format that equal to or prior 
to the termination date.  

“The new end date shall 
be at the end of a fiscal 
year.” 

All original end dates must 
be on 9/36 of the expiration 
year. 

Enter date in the 09/36/yyyy 
format that is between 10 and 
15 years in length. 
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Par. 129 
129 Correct Termination Date 
 

A Overview  
 

 State Office functionality is available in CCMS to allow administrative users to correct the 
termination date of the contract.  This functionality is designed as a data correction feature 
for correcting error made by county office users and to reduce the need to reinstate a contract 
to correct an error in the termination date.  

 
To modify the termination date, users must select the action for “Correct>Termination Date” 
and CLICK “Go” from the View Contract Screen.  
 

B Example of Correct Termination Date Screen 
 

The following is an example of the Correct Termination Date Screen. 
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Par. 129 
129 Correction Termination Date (Continued) 
 

C Field Descriptions and Actions   
 

The following table provides the field descriptions and actions for the Correct Termination 
Date Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display No Activity, Divide or Revise 
based on the maintenance being done to the 
contract.  

 

Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded for 
this contract.  

 

Program Type  Will display “CRP”.  
Signup Name  The applicable signup name recorded for this 

contract. 
 

Program Year  The Program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  The applicable signup type recorded for this 
contract. 

 

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process.  
 
Note: Will be blank for S36 migrated 

contracts.  

 

Subcategory Type  The applicable CRP subcategory recorded 
for this contract. 

 

Original Contract Start 
Date 

This field will display the original contract 
start date for the contract family.    

 

Contract End Date 
Without Termination  

Will display the contract’s original end date 
before the contract was terminated.  

 

Termination Type Will display the termination payment criteria 
that was selected according to paragraph 38. 

 

Current Termination 
Date  

Will display the termination date that was 
selected according to paragraph 38. 
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Par. 129 
129 Correction Termination Date (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Current Termination 
Date  

Will display the termination date that was 
selected according to paragraph 38. 

 

New Termination Date  Enter the corrected termination date.  Enter date in the 
mm/dd/yyyy format 
or select the date 
from the calendar 
icon.  

Save  After the user selects “Save” a pop-up 
window will bed displayed to confirm the 
save.  Selecting “OK” will save all data.   
 
After the user selects “OK” CCMS will 
execute a series of validations.  If any 
validations fail, error messages will be 
displayed according to subparagraph D.  
 
If all validations pass the user will see the 
Success Screen.  CLICK “OK” to be 
returned to the View Contract Screen.   

CLICK “Save” then 
“OK” or “Cancel”.  

Back  User will be returned to the View Contract 
Screen and no changes will be saved.  

CLICK “Back”. 

 
D Error Messages 

    
The Correct Termination Date Screen is set up to provide potential validation errors.  The 
following error messages may be displayed. 
 

Error Message Description Corrective Action 
“Date Format is invalid. 
Shall be mm/dd/yyyy.” 

Form validation.  The date 
must be in the format 
mm/dd/yyyy. 

Enter date in the mm/dd/yyyy 
format.  

“Termination date cannot 
be earlier than effective 
contract start date.” 

The termination date cannot 
precede the contract's start 
date. 

Enter date in the mm/dd/yyyy 
format that is after the 
contracts effective start date.  

“Termination date shall not 
be later than the contract 
end date.” 

The termination date cannot 
go beyond the contract's end 
date. 

Enter date in the mm/dd/yyyy 
format that is prior to the 
contracts original end date.  

 
130-139 (Reserved) 

 
 
 
 

5-15-19    5-CRP Amend. 1 Page 2-429 
(and 2-460)  



. 

  



Par. 140 
 

Section 8    Reports 
 
140 County Reports 
 

A Overview 
 
To generate reports, from the Welcome to the Conservation Contract Maintenance System 
Screen, under “CCMS Menu”, CLICK “County Reports”. 
 
The County Reports Screen will be displayed.  National and State Office users, and users 
who administer multiple counties, will need to select the State and county for which the 
report is to be generated.  From the “Report to Generate” drop-down list, select the desired 
report.  Some reports will require additional criteria to be selected.  CLICK “Generate 
Report”. 
 
The reports will be displayed as PDF files with the exception of the 578 Compliance Report 
which displays in Excel.  Use the PDF file “Print” option to make a hard copy of the selected 
report. 
 
For reports with filter criteria, if the user would like to select more than one option, click the 
first selection then use the “Shift” or “Ctrl” keys and click another selection.  “Shift” key will 
select all lines between 2 selections.  “Ctrl” key will select 1 additional line at a time that 
allows users to skip items on the list. 

 
B Available Reports 
 

The following table provides available reports, action required, and data elements on the 
report.   
 

Report Action Result 
Active Contracts Due to 
Expire on Sept 30 

Select all of the 
following: 
 
• admin State 
• admin county 
• report 
• fiscal year. 

Report will display all contracts 
due to expire on September 30 of 
the fiscal year the user selected 
 
The report will include: 
 
• contract number  
• farm number 
• tract number 
• acres approved 
• signup name  
• producer name. 
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
All CRP Producers  Select all of the 

following: 
 
• admin State 
• admin county 
•  report. 

Report will display all CRP 
producers for the selected county 
alphabetical.   
 
The report will include: 
 
• producer name  
• street address 
• city 
• State 
• zip 
• telephone number  
• e-mail address 
• contract number 
• signup name 
• producer share percent  
• primary producer.  

60-Day Notification 
Report  

Select all of the 
following: 
 
• admin State 
 
• admin county 
 
• report 
 
• sort criteria of contract 

number or 60-day 
notification date. 

Report will display all CRP 
contracts in the status of “Revision 
in Process”.  
 
The report will include: 
 
• physical State 
• physical county 
• contract number 
• signup number 
• signup type  
• signup sub-type 
• farm number 
• tract number 
• contract status  
• placeholder contract status  
• CRP acreage  
• 60-Day notification date  
• contract termination date  
• producer name 
• address 
• telephone number 
• e-mail address. 
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Par. 140 

140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
Contracts for a County  Select all of the following: 

 
• admin State 
• admin county 
• report. 
 
Sort by: 
 
• contract number 
• farm and tract number 
• program year 
• signup name. 

 
Filter by: 
 
• farm number - enter farm 

number 
 

• program year - select 
year(s) 

 
• signup name - select 

names(s) 
 

• signup type - select 
type(s) 

 
Select contract status: 
 
• all 
• active.  

The report will display all contracts based 
on the filter and sort criteria selected for 
the county. 
 
The report will include: 
 
• physical state 
• physical county 
• program year 
• contract number 
• signup number 
• signup type  
• signup sub-type 
• farm number 
• tract number 
• acres approved  
• rental rate 
• number of producers 
• annual payment  
• contract status 
• original CRP-1 start date  
• original CRP-1 end date  
• approval date  
• producer name  
• producer share percent  
• producer involvement 
• primary producer indicator.  

Contracts for a Producer  Select admin state, admin 
county, and report.  Use the 
find producer link to interface 
with the SCIMS Customer 
Search Screen to search for a 
producer.   

The report will display all contracts for 
the selected producer.  
 
The report will include: 
 
• contract number 
• contract status 
• physical State 
• physical county  
• farm number 
• tract number 
• sign up name  
• program year  
• acres approved 
• rental rate  
• annual payment  
• producer share percent 
• primary producer indicator  
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
Contracts that Expired 
on September 30.   

Select all of the of following: 
 
• admin State 
• admin county 
• report 
• fiscal year.   

The report will display all contracts 
that expired on Sept 30th of the 
selected fiscal year.   
 
The report will include: 
 
• contract number 
• signup name 
• farm number 
• tract number 
• program year  
• rental rate 
• annual payment  
• acres expired  
• number of producers.  

Contracts with 
Extension  

Select all of the following: 
 
• admin state, 
• admin county 
• report 
• signup name(s) 
•  extension type(s) 
• contract status.  

The report will display all contracts 
that had an extension applied by 
signup name. 
 
The report will include: 
 
• contract number 
• contract status 
• extension type 
• extension rate 
• program year  
• acres approved rental rate  
• annual payment 
• cumulative rental payment  
• number of producers with shares 
• proactive codes  
• practice acres.  
 
The report will also provide totals for 
the following by signup: 
 
• contracts extended 
• farm impacted 
• producers with shares 
• total practice acres 
• number of CRP-1 acres extended 
• total additional annual rental 

payments.  
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 

Early Out Summary  Select all of the following: 

• admin State 
• admin county 
• report 
• early out signup name. 

The report will display all contracts 
that had an early termination applied 
by signup name.  
 
The report will include: 
 
• contract number 
• contract status 
• program year 
• acres approved for early out  
• last year earned prorated value  
• list of practices with acres. 
 
The report will also provide totals for: 

• contract numbers 
• farms impacted 
• acres  
• practice by code and acres. 
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 

Individual Contract  Select all of the following: 

• admin State 
• admin county 
• report 
• contract number. 

The report will display the 
following data for the contract 
number selected.  

• contract number 
• contract status 
• signup name 
• physical State  
• physical county 
• original CRP-1 start date 
• original CRP-1 end date  
• effective start date  
• effective end date  
• farm number 
• tract number 
• CLU number 
• CLU acres  
• program year 
• rental rate 
• acres approved 
• annual payment 
• approval date 
• cropland acres  
• MPL acres 
• non-cropland acres 
• wellhead acres 
• practice code 
• CLU number 
• proactive acres 
• estimated cost share 
• producer name  
• producer share percent 
• producer involvement  
• primary  
• extension type description 
• extension rate 
• effective start date  
• effective end date. 
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
Practices Select all of the 

following: 
 
• admin State 
• admin county 
• report. 

 
Filter by: 
 
• program year - select 

year(s) 
 

• signup name – select 
names(s) 

 
• signup type - select 

type(s) 
 

• select practice(s). 

The report will display the 
following data by program year: 
• practice acres 
• estimate cost share  
• farm number  
• tract number 
• signup name. 

 
The report will also provide totals 
for: 
 
• number of contracts 
• number of farms  
• practice acres 
• estimate cost share.  
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
Terminated/Revised/ 
Divided Contracts 
Summary 

Select all of the 
following: 
 
• admin State 
• admin county 
• report. 

The report will display the 
following data by contract number: 
 
• contract number 
 
• contract State 
 
• reason for revision, termination, 

or division 
 
• effective date 
 
• revision/termination date 
 
• farm number 
 
• tract number 
 
• rental rate 
 
• acres approved 
 
• annual payment  
 
• total acres approved for all 

resulting contracts 
 
• total annual payment for all 

resulting contracts 
 
• acres approved remaining on 

revised contracts 
 
• difference between annual 

payments and total annual 
payments for the resulting 
contracts. 
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 
Transferred Contracts Select all of the 

following: 
 
• admin State 
• admin county 
• report. 

The report will include: 
 
• transferring State/county 
• receiving State/county  
• signup type 
• reason for transfer  
• date of transfer 
• old contract number 
• new contract number 
• acres approved 
• COC approval transfer date. 

 
The report will also provide totals 
for the following: 
 
• program subtype 
• transfers in number of contracts 
• transfers in total acres approved 
• transfers out number of contracts  
• transfers out acres approved.  

578 Compliance Report  Select all of the 
following: 
 
• admin State 
• admin county 
• report. 
 
Sort by: 
 
• contract number 
• farm number 
• producer name. 

This report will only be available for 
the current FY after June 1st.  The 
report will include on contracts when 
the practice acres on the contract 
exceed the CRP acreage certified on 
the 578.  The report will include: 
 
• farm number 
 
• contract number 
 
• total CRP-1 acres  
 
• total CRP acres certified 
 
• difference in practice acres and 

certified acres 
 
• primary producer name. 
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Par. 140 
140 County Reports (Continued) 
 

B Available Reports (Continued) 
 

Report Action Result 

Invalid Contract 
Report  

Select all of the 
following: 

• admin State 
• admin County 
• report. 

This report will list contract number and 
reason for the validity indicator to be set to 
“Invalid”.  The report will provide the 
following: 
 
• reason  
• State 
• county  
• contract number 
• reason 
• date set to invalid  
• number of days invalid. 
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Par. 141 
141 State Reports 
 

A Overview 
 
 The State Office user roll will provide access to both the state level and county level reports 

for the users State(s).   
 
To generate reports, from the Welcome to the Conservation Contract Maintenance System 
Screen, under “CCMS Menu”, CLICK “State Reports”. 
 
The State Reports Screen will be displayed.  From the “Report to Generate” drop-down list, 
select the desired report.  Some reports will require additional criteria to be selected.  CLICK 
“Generate Report”. 
 
The reports will be displayed as PDF files with the exception of the 578 Compliance Report 
and Early Out Summary which displays as a CSV format. 
 
For reports with filter criteria, if the user would like to select more than one option, click the 
first selection then use the “Shift” or “Ctrl” keys and click another selection.  “Shift” key will 
select all lines between 2 selections.  “Ctrl” key will select 1 additional line at a time that 
allows users to skip items on the list. 

 
B Available Reports 
  

The following table provides available reports, action required, and data elements on the 
report. 
 

Report Action Result 
Practice 
Summary  

Select all of the following: 
 
• state 
• report. 

 
Filter by: 
 
• program year 
• signup up number 
• signup up type 
• practices  

The report will summarize state 
totals for the following: 
 
• practice code 
• number of contracts 
• number of farms  
• number of acres 
• estimated cost share. 

Early Out 
Summary  

Select State, Report, and Early 
out Signup Name.  

The report will summarize totals 
by county for the following: 
 
• contracts 
 
• total acres 
 
• acres by the applicable practice 

eligible for the early 
terminations. 
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Par. 141 
141 State Reports 
 

B Available Reports 
 

Report Action Result 
578 Compliance Report Select State and Report  This report will only be available 

for the current FY after June 1st. 
The report will summarize totals 
by county for total number of  
non-compliant contracts.  

Pending Invalid Status 
Summary Report  

Select State and Report This report lists the number of 
contracts by county and age that 
have the validity indicator set to 
“invalid”.  
 
The report will summarize totals 
by county for the following: 
 
• total number of contracts invalid 
 
• number of contracts invalid for 

1 to 35 days 
 
• number of contracts invalid for 

36 to 59 days 
 
• number of contracts invalid for 

60 to 89 days 
 
• number of contracts invalid for 

90 days or more. 
 
142-150 (Reserved) 
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Par. 151 
 

*--Section 9    TIP Enrollment 
 
151 General Provisions  
 

A Overview 
 

The Agricultural Act of 2014 amended the Food Security Act of 1985 to authorize 
$33 million for the voluntary transition of land enrolled under an expiring CRP contract from 
a retired or retiring owner or operator to a veteran, beginning, or SDA farmer or rancher to 
return the land to production for sustainable grazing or crop production. 
 
Retired or retiring owners and operators who qualify under TIP may be eligible to receive 
annual rental payments for up to 2 additional years after the CRP-1 expiration date provided 
the transition is not to a family member as defined in 2-CRP, Exhibit 2. 
 
CCMS has been designed to automate the process of identifying and verifying the eligibility 
of the TIP participants, generating the CRP-1R, and recording the COC approval. 
 
CCMS will record the TIP enrollment starting with the 2018 year in a 3-step process: 
 
• initiate TIP enrollment  
• finalize CRP-1R 
• record COC approval. 

 
After the TIP is effective CCMS will also allow modification to the CRP-1R for: 
 
• acreage reductions  
• producer changes. 
 

B TIP Enrollment Time Frame  
 

CCMS will allow a TIP enrollment to be initiated on or after October 1 of the last year of the 
CRP contract.  The TIP enrollment must be initiated in CCMS before August 15 of the year 
when the CRP contract is scheduled to expire.  TIP enrollment must be approved in CCMS 
before September 30 of the year when the CRP contract is scheduled to expire.--* 
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Par. 152 
*--152 Initiate TIP Enrollment Screen 
 

A Overview  
 

To initiate the CRP-1R and create the TIP enrollment, users will SELECT “Initiate>TIP 
Enrollment” on the View Contract Screen of the CRP contract to which the TIP will be 
applied.  The TIP effective date will be automatically set as the day after the CRP contract is 
scheduled to expire.  The end date of the TIP enrollment will be set as 9/30, two years after 
the CRP contract expiration date. 

 
B Example of Initiate TIP Enrollment Screen 

 
The following is an example of the Initiate TIP Enrollment Screen. 

 

 
--* 
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Par. 152 
*--152 Initiate TIP Enrollment Screen (Continued) 
 

C Initiate TIP Enrollment Screen Options  
 

The following table provides the field descriptions and actions for the Initiate TIP Enrollment 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display “No Activity”.  
Admin State The administrative State of the contract.    
Admin County  The administrative county of the 

contract.  
 

Physical State  The State of physical location of the 
tract for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that were selected 
on the Select Contract Screen.   

 

Signup Number  The applicable signup number recorded 
for this contract.  

 

Program Type  Will display “CRP”.  
Signup Name  The applicable signup name recorded for 

this contract. 
 

Program Year  The program year associated with this 
contract.  This value is set at the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded for 
this contract. 

 

Contract 
Description  

This field will display the contract 
description entered in the 
TERRA/COLS process.  Will be blank 
for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

--* 
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Par. 152 
*--152 Initiate TIP Enrollment Screen (Continued) 
 

C Initiate TIP Enrollment Screen Options (Continued) 
 

Field/Button Description Action 
CRP Contract 
Start Date  

This date will display the effective 
start date of the CRP contract the TIP 
will be applied to.  

 

CRP Contract End 
Date  

This date will display 9/30 of the 
final year of the CRP contract.   

 

TIP Effective 
Date  

This date will be set as 10/1 of the 
year after the CRP contract expires. 

 

TIP End Date  This date will be 9/30 two years after 
the TIP effective date.  

 

Activity Reason  Will display “enrolling contract in 
TIP”.  

 

Next  The user will select “Next” to 
continue the TIP enrollment process.  
When the user clicks “Next” a pop-up 
window will be displayed confirming 
the TIP initiation of the contract.  
Once “OK” is clicked the Success 
Screen will be displayed, CLICK 
“OK” to be returned to the View 
Contract Screen. 

Click “Save”, then “OK” or 
“Cancel”.   

Back The View Contract Screen will be 
displayed, no data will be saved, and 
the TIP initiation will be canceled. 

Click “Back”. 

--* 
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Par. 152 
*--152 Initiate TIP Enrollment Screen (Continued) 
 

D Initiate TIP Enrollment Screen Error Messages 
 

The Initiate TIP Enrollment Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  
 

Error Message Description Corrective Action 
TIP Enrollment is only 
allowed on Approved or 
Expired contracts. 

The CRP contract the user 
is attempting to apply the 
TIP enrollment to is not in 
an approved or expired 
status.   

The user must complete or 
cancel the existing CRP 
contract modification before 
attempting to apply the TIP 
enrollment.  

Unknown contract validity, 
please ‘Determine Contract 
Validity’. 

The contract’s validity 
status is unknown.  

Follow paragraph 100 to 
determine validity.  

Only valid contracts are 
allowed to be enrolled in TIP. 

The source CRP contract 
has a validity indicator of 
invalid indicating a 
contract modification is 
needed.  

Follow paragraph 100 to 
determine invalid reason 
and action needed to resolve 
the issue on the CRP 
contract.  

Contracts with early outs are 
not eligible for TIP. 

The source CRP contract 
has an early out applied.  

Determine if the source 
contract’s early out is valid.  
If so, a TIP cannot be 
applied. 

Placeholder contracts are not 
eligible for TIP. 

The source CRP contract is 
in a placeholder status. 

Follow paragraph 87 to 
resolve the placeholder.   

The fiscal year in which the 
contract ends ({0}) is not 
eligible for TIP.  Eligible 
fiscal years are {1}. 

Only contracts in the last 
year of length can have a 
TIP applied.  The selected 
contract is not in the last 
year of length.  

Review CRP contract to 
determine if the end date is 
correct in CCMS.  If an end 
date correction is needed 
follow paragraph 128.  

--* 
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Par. 153 
*--153 Modify TIP Acreage  
 

A Overview  
 

To record the TIP acres and to modify or add CLU number and acres on the contract, users 
must select the action for “Modify >Acreage” and CLICK “Go” after TIP has been initiated 
according to paragraph 152. 

 
Important: Farm and tract numbers cannot be changed during the TIP enrollment process.  

If the farm and tract number(s) are not active the CRP contract must be 
modified before TIP can be applied.  

 
If 100 percent of the CRP contract acres will be entering in to the TIP enrollment no action 
will be needed on the screen.  Users will only need to use this option if the TIP enrollment 
will be smaller than the enrolled CRP acres.   

 
B Example of Adjust Acreage Screen 

 
The following is an example of the Adjust Acreage Screen. 

 

 
--* 
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Par. 153 
*--153 Modify TIP Acreage (Continued) 
 

C Adjust Acreage Screen Options 
 

The following table provides the field descriptions and actions for the Adjust Acreage 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display “TIP Enrollment”.   
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of the tract for 

this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that were selected on 
the Select Contract Screen with “TIP” added 
to the suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive Program”.  
Program Year  The program year associated with this 

contract.  This value is set as the program 
year of the first month the contract was 
effective.  

 

Signup Type  Will be blank.  
Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  Will 
be blank for S36 migrated contracts.  

 

Subcategory Type  Will be blank.  
CRP- Total Acres  Will display the total contract acres from the 

CRP-1.  The TIP enrollment will not be able 
to exceed this value.  

 

--* 
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 Par. 153 
*--153 Modify TIP Acreage (Continued) 
 

C Adjust Acreage Screen Options (Continued) 
 

Field/Button Description Action 
Farm Number The farm number associated with the 

contract. 
 

Tract Number The tract number associated with the 
contract.  

 

CLU The CLU number associated with the 
contract.  

Enter the CLU number 
from farm records.  

CLU Acres The acreage value that corresponds to 
the CLU number that was entered.  

Enter the CLU acres value 
in 100ths for the CLU 
number entered.  

Delete  Removes the CLU record for the line 
item that “Delete” was selected.  

Click “Delete”. 

Add New CLU Information 
Farm Number  This value will be prepopulated based 

on the farm number associated with the 
contract. 

 

Tract Number  This value will be prepopulated based 
on the tract number associated with the 
contract. 

 

CLU The CLU number to associate with the 
contract. 

Enter the CLU number.  

CLU Acres The acreage value that corresponds to 
the CLU number to associate with the 
contract. 

Enter the CLU acres value 
in 100ths for the CLU 
number entered.  

Add Adds the data entered. Click “Add”. 
Total  Total CLU acreage on the contract.   

--* 
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 Par. 153 
*--153 Modify TIP Acreage (Continued) 
 

C Adjust Acreage Screen Options (Continued) 
 

Field/Button Description Action 
Save After the user selects “Save”, they will 

receive a popup window to confirm to 
save.  Selecting “OK” will save all data.   
 
The Success Screen will be displayed if 
all page validations are met.  User will 
click “OK” on the Success Screen to be 
returned to the View Contract Screen.   
 
Selecting “Cancel” on the popup window 
will return the user to the Adjust Acreage 
Screen without saving data.   

Click “Save”, then 
“OK” or “Cancel”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

Click “Back”. 

 
D Adjust Acreage Screen Error Messages 

 
The Adjust Acreage Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  
 

Error Message Description Corrective Action 
“Field/CLU Number 
(XXX) is missing acreage 
information.” 

CLU cannot have null value for 
acreage amount. 

Enter the acreage 
value for the CLU. 

“Field/CLU Numbers are 
required. Please enter the 
Field/CLU Numbers before 
proceeding.” 

CLU number must be valid (cannot 
be null/missing, blank or -99). 

Enter a valid CLU 
number. 

“The sum of the CLU 
Acres is greater than the 
Contract Acres.” 

Sum of CLU acres must be equal to 
or less than the contract acreage. 

Correct CLU contract 
acres. 

--* 
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 Par. 154 
*--154 TIP Modify Producers Screen 
 

A Overview  
 

To modify producers on the contract, on the View Contract Screen, from the “Select an 
action to perform” drop-down list, select “Modify > Producers” and CLICK “Go”. 
 
The Modify Producers Screen will be displayed with information for all owners and other 
producers associated with the tract and all operators associated with the farm from FRS for 
the program year that corresponds to the revision effective date set in CCMS.  If a producer 
is not displayed in CCMS, they must first be added to the farm record.   
 
According to 2-CRP, paragraph 803, policy requires all CRP contract participants to be listed 
on the TIP enrollment, even if they are not receiving any shares.  During the TIP enrollment 
process users will not be able to remove any producer listed on the CRP contract the TIP is 
based on.  If CRP-1 participants need to be added or removed before the TIP enrollment, a 
CRP-1 modification is needed first.  
 
The Modify Producers Screen will be displayed in 2 sections.  The first, the “Assigned 
Producers” section will list all producers listed on the CRP contract the TIP is based on.  No 
modifications can be made to this section.  
 
The “Assigned Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producers” 
section will be displayed with producers listed in farm records that are not currently part of 
the CRP contract.  One of these producer(s) will be added as the qualifying party to meet the 
veteran, beginning farmer, or SDA provisions for the TIP enrollment.--* 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9-16-19 5-CRP Amend. 2 Page 2-510 



Par. 154 
*--154  TIP Modify Producers Screen (Continued) 
 

B Example of Modify Producers Screen 
 

The following is an example of the Modify Producers Screen. 
 

 
--* 
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*--154 TIP Modify Producers Screen (Continued) 
 

C Modify Producers Screen Options 
 

The following table provides the field descriptions and actions for the Modify Producers 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the 
contract. 

 

Activity Type  Will display “TIP Enrollment”.   
Admin State The administrative State of the 

contract.   
 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of the 
tract for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that were 
selected on the Select Contract Screen 
with “TIP” added to the suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive 

Program”. 
 

Program Year  The program year associated with this 
contract.  This value is set at the 
program year of the first month the 
contract was effective.  

 

Signup Type  Will be blank.  
Contract Description  This field will display the contract 

description entered in the 
TERRA/COLS process.  Will be blank 
for S36 migrated contracts.  

 

Subcategory Type  Will be blank.  
--* 
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*--154 TIP Modify Producers Screen (Continued) 
 

C Modify Producers Screen Options (Continued) 
 

Field/Button Description Action 
Assigned Producers 

Producer Name  Name of the producer associated 
with the CRP contract the TIP 
enrollment is being applied too.  

 

Type The type of association the 
producer has on the tract associated 
with the contract according to Farm 
Records.  “Owner”, “Operator”, or 
“Other Tenant” will be displayed.  

 

Share  The percent share interest the 
producer has in the CRP-1.  

Enter the percentage value 
between 0.00 and100.00 
percent in 100ths.   

Primary Designates the primary point of 
contact for the CRP contract.  

Enter a “check” in the box of 
the producer that is the 
primary point of contact.   

Assigned Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producer  
Action  Will display “Remove”. Select “Remove” to remove 

the producer from the list as 
applicable.   

Producer Name Name of producers linked to the 
farm/tract in farm records that are 
not part of the CRP contract the TIP 
enrollment is being applied too.  

 

Type The type of association the 
producer has on the tract associated 
with the contract according to Farm 
Records.  “Owner”, “Operator”, or 
“Other Tenant” will be displayed. 

 

Classification  Will display “SD” for socially 
disadvantage, “VT” for veteran, 
“BF” for beginning farmer or 
rancher, or “Blank” if no 
clarification is found.  
 
These values are read from the 
corresponding values in the 
producer’s eligibility file for the 
year the TIP enrollment is being 
applied too.   

 

--* 
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*--154 TIP Modify Producers Screen (Continued) 
 

C Modify Producers Screen Options (Continued) 
 

Field/Button Description Action 
Available Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producer 
Action  Will display as “Add”.  Select “Add” to move the 

producer from the available 
list to the assigned list.  

Producer Name Name of producers linked to the 
farm/tract in farm records that are not 
part of the CRP contract the TIP 
enrollment is being applied too.  

 

Type The type of association the producer has 
on the tract associated with the contract 
according to Farm Records.  “Owner”, 
“Operator”, or “Other Tenant” will be 
displayed. 

 

Classification  Will display “SD” for socially 
disadvantage, “VT” for veteran, “BF” 
for beginning farmer or rancher, or 
“Blank” if no clarification is found.  
 
These values are read from the 
corresponding values in the producer’s 
eligibility file for the year the TIP 
enrollment is being applied too.   

 

--* 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9-16-19 5-CRP Amend. 2 Page 2-514 



Par. 154 
*--154 TIP Modify Producers Screen (Continued) 
 

C Modify Producers Screen Options (Continued) 
 

Field/Button Description Action 
Save Will save the data entered on 

the Modify Producers Screen. 
Click “Save”, then “OK” or 
“Cancel”.  After the user 
selects “Save” a popup 
window will be displayed to 
confirm they wish to save.  
Selecting “OK” will save all 
data.   
 
The Success Screen will be 
displayed if all page 
validations are met.  User will 
click “OK” on the Success 
Screen to be returned to the 
View Contract Screen.   
 
Selecting “Cancel” on the 
popup window will return the 
user to the Modify Producers 
Screen without saving data.   

Back  Will return the user to the 
View Contract Screen and no 
data will be saved. 

Click “Back”. 

--* 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9-16-19 5-CRP Amend. 2 Page 2-515 



Par. 154 
*--154 TIP Modify Producers Screen (Continued) 
 

D Modify Producers Screen Error Messages 
 

The Modify Producers Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  
 

Error Message Description Corrective Action 
The primary participant 
must be a CRP producer. 

The primary producer must 
be selected from a list of 
assigned producers.  

Select and assigned producer as 
the primary participant.  

Please select a producer to 
add. 

An assigned beginning 
farmer/rancher, socially 
disadvantaged, or veteran 
producer has not been 
identified.   

Use the “Add” button to 
identify an assigned beginning 
farmer/rancher, socially 
disadvantaged, or veteran 
producer 

All producers on the 
contract must have shares, 
even if zero.  But cannot 
be negative. 

A producer has a blank or 
negative value entered for 
the share.  

Enter a value between 0 and 
100 for each producer, not to 
exceed 100 for all producers.   

--* 
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Par. 155 
*--155 Finalize TIP Contracts 
 

A Overview 
 
CCMS requires a step after the details of the TIP enrollment have been updated and CRP-1R 
has been signed by all required producers that verifies all recorded eligibility rules are 
completed before COC approval.  To finalize the TIP enrollment, on the View Contract 
Screen, from the “Select an action to perform” drop-down list, select “Modify > Finalize” 
and CLICK “Go”. 

 
B Example of the Finalize TIP Contract Screen 

 
The following is an example of the Finalize TIP Contract Screen. 

 

 
--* 
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*--155 Finalize TIP Contracts (Continued) 
 

C Finalize TIP Contract Screen Options 
 

The following table provides the field descriptions and actions for the Finalize TIP Contract 
Screen. 

 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display “TIP Enrollment”.   
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of the tract for 

this contract.  
 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract numbers that were selected on 
the Select Contract Screen with “TIP” added 
to the suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive Program”.  
Program Year  The program year associated with this 

contract.  This value is set at the program year 
of the first month the contract was effective.  

 

Signup Type  Will be blank.  
Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  Will 
be blank for S36 migrated contracts.  

 

Subcategory 
Type  

Will be blank.  

--* 
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Par. 155 
*--155 Finalize TIP Contracts (Continued) 
 

C Finalize TIP Contract Screen Options (Continued) 
 

Field/Button Description Action 
Contract Description  A free form optional field that the 

user can add contract descriptions 
based on revisions. 

Add contract descriptions as 
applicable.  Do not load any PII 
information in this field.   

CRP Contract Start Date The start date of the CRP contract 
the TIP has been applied too. 

 

CRP Contract End Date  The end date of the CRP contract 
the TIP has been applied too. 

 

TIP Effective Date This date will be set as 10/1 of the 
year after the CRP contract 
Expires. 

 

TIP End Date  This date will be 9/30 two years 
after the TIP Effective Date.  

 

Activity Reason   Will be displayed as “Enrolling 
contract in TIP”. 

 

Check box to indicate a 
modified Conservation plan 
is approved for land 
Improvements in the last 
year of the CRP-1:  

Indicator to allow the user to 
record that the CPO has been 
updated if land improvements are 
taking place in the last year of the 
CRP-1. 

Check (), if CPO update has 
been received. 

Check box to indicate all 
Land Eligibility Criteria has 
been met: 

Indicator to the user to record that 
all land eligibility has been 
reviewed and criteria has been 
reached.   

Check (), if review has been 
completed.  

CRP-1 Producer Signed Date The date the last producer on the 
CRP-1R signed the CRP-1.   

Enter the date in the 
mm/dd/yyyy format or select 
the date from the calendar 
popup.  

Finalize  Will save the data entered on the 
Finalize Screen and create the 
new child contract. 

Click “Finalize” and “Ok”.  
 
After the user selects “Save” 
they will receive a popup 
window to confirm they wish to 
save.  Selecting “OK” will save 
all data.   
 
A CCMS will execute a series 
of validations.  If any 
validations fail, and error 
message will be displayed.  

Back  Will return the user to the View 
Contract Screen and no data will 
be saved. 

Click “Back”. 

--* 
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Par. 155 
*--155 Finalize TIP Contracts (Continued) 
 

D Finalize TIP Contract Screen Error Messages 
 

The Finalize TIP Contract Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  

 
Error Message Description Corrective Action 

The parent is invalid and needs 
to be corrected before enrolling 
in TIP. 

The source CRP contract is in an 
invalid status. 

Identify and correct the 
invalid status according to 
paragraph 100.  

The sum of the CLU acreage 
must be less than or equal to 
the contract acreage. 

The CLU acreage recorded on the 
TIP enrollment exceeds the 
contract acres from the original 
CRP contract.  

Adjust TIP acreage 
according to paragraph 153. 

The TIP contract acreage 
(XXX) cannot exceed the 
expiring CRP contract acreage 
(XXX). 

The CLU acreage recorded on the 
TIP enrollment exceeds the 
contract acres from the original 
CRP contract.  

Adjust TIP acreage 
according to paragraph 153. 

The TIP contract acreage 
(XXX) cannot exceed the 
expiring CRP contract payable 
acreage (XXX). 

The CLU acreage recorded on the 
TIP enrollment exceeds the 
payable contract acres from the 
original CRP contract.  

Adjust TIP acreage 
according to paragraph 153. 

The TIP contract must have at 
least 1 TIP participant. 

An assigned beginning 
farmer/rancher, socially 
disadvantaged, or veteran producer 
has not been added to the TIP 
enrollment.  

Add an assigned beginning 
farmer/rancher, socially 
disadvantaged, or veteran 
producer according to 
paragraph 154.  

Participant {XXX} must be on 
the TIP contract since they 
participated in the expiring 
contract. 

A producer listed on the CRP-1 
according to CCMS of the source 
CRP contract is not listed as an 
assigned producer for this TIP 
enrollment.  

Add an assigned producer 
according to paragraph 154. 

Participant {XXX} cannot be 
on the TIP contract since they 
did not participate in the 
expiring contract. 

A producer has been added as an 
assigned producer that was not on 
the source CRP contract.   

Remove the participant 
from the list of assigned 
producers according to 
paragraph 154. 

User must indicate a modified 
Conservation plan is approved 
for land Improvements in the 
last year of the CRP-1. 

The check mark has not been 
placed in the box to confirm a 
modified conservation plan is 
approved for land improvements 
in the last year of the CRP-1. 

Follow this paragraph to 
provide the checkmark to 
confirm a modified 
conservation plan is 
approved for land 
improvements in the last 
year of the CRP-1. 

--* 
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Par. 155 
*--155 Finalize TIP Contracts (Continued) 
 

D Finalize TIP Contract Screen Error Messages (Continued) 
 

Error Message Description Corrective Action 
User must indicate All Land 
Eligibility Criteria has been met. 

The check mark has not been 
placed in the box to confirm all 
land eligibility criteria has been 
met.  

Follow this paragraph to 
provide the checkmark to 
confirm all land eligibility 
criteria has been met. 

Participant (XXX) is not eligible 
for TIP participation.  Eligibility 
checked in year {XXXX}. 

No corresponding “SDA”, 
“BF”, “Vet” flag was found in 
the subsidiary eligibility file for 
the producer in the year 
indicated.  

Review the eligibility file 
for the producer to ensure 
all values are recorded for 
the correct year.  

All owners associated with the 
tract in Farm Records for Fiscal 
year {0} must be on the contract, 
even if they are not receiving 
payments from the contract.  
Other Producers on the tract and 
Operators are optional, unless 
they were on the parent contract.  
Please add all owners of the tract 
to the contract. 

Not all owners on the tract are 
recorded on the TIP enrollment.  

Verify farm records is 
correct and modify the CRP 
contract to correct all 
owners according to 
paragraph 29. 

XXX Producer Signed Date is 
required. 

Producer signed date is a 
required field. 

Enter date in mm/dd/yyyy 
format according to this 
paragraph. 

The date you have entered for 
the {XXX} Producer 
Signature(s) precedes the 
original contract start date. 
Please correct the date. 

The date entered is earlier than 
the original contract start date.  

Enter the correct date in 
mm/dd/yyyy format 
according to this paragraph. 

The date of the (XXX) Producer 
Signature(s) cannot be later than 
today.  Please correct the date. 

Producer signatures cannot be 
future dated. 

Enter a date in the 
mm/dd/yyyy format that is 
not in the future. 

--* 
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Par. 156 
*--156 Cancel TIP Enrollment 
 

A Overview 
 
If at any time before COC approval of a TIP enrollment the user determines they have started 
the enrollment in error, they can cancel the enrollment and return the parent contract to an 
approved status.  To cancel a revision, on the View Contract Screen, from the “Select an 
action to perform” drop-down list, select “Modify > Cancel” and CLICK “Go”. 

 
B Example of the Cancel TIP Enrollment Confirmation Screen 

 
The following is an example of the Cancel TIP Enrollment Confirmation Screen. 

 

 
--* 
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Par. 156 
*--156 Cancel TIP Enrollment (Continued) 
 

C Cancel TIP Enrollment Confirmation Screen Options 
 

The following table provides the field descriptions and actions for the Cancel TIP Enrollment 
Confirmation Screen. 
 
Field/Button Description Action 

Contract Status  Will display the current status of the contract.  
Activity Type  Will display “TIP Enrollment”.   
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of the tract for this 

contract.  
 

Physical County  The county of the physical location associated with 
this contract. 

 

Contract Number The contract numbers that were selected on the 
Select Contract Screen with “TIP” added to the 
suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive Program”.  
Program Year  The program year associated with this contract. 

This value is set as the program year of the first 
month the contract was effective.  

 

Signup Type  Will be blank.  
Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  Will be 
blank for S36 migrated contracts.  

 

Subcategory Type  Will be blank.  
Are you sure that you want to Cancel TIP Enrollment at this time? 

OK TIP enrollment will be canceled and the parent 
contract will be returned to an active status.  The 
user will be taken to the Success Screen and must 
select “Ok” to be returned to the View Contract 
Screen.   

Click “OK”.  

Back  Will return the user to the View Contract Screen 
and no data will be saved. 

Click “Back”. 

--* 
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Par. 157 
*--157 TIP COC Approval  
 

A Overview  
 
Once COC has approved the TIP enrollment, the approval needs to be recorded in CCMS. 
 
After users have selected a contract according to paragraph 9, the View Contract Screen will 
be displayed.  On the View Contract Screen, from the “Select an action to perform” 
drop-down list, select “Modify >COC Approve” and CLICK “Go”. 
 

B Example of the COC Approval Screen 
 

The following is an example of the COC Approval Screen. 
 

 
--* 
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Par. 157 
*--157 TIP COC Approval (Continued) 

 
C COC Approval Screen Options 

 
The following table provides the field descriptions and actions for the COC Approval Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display “TIP Enrollment”.  
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of the tract 

for this contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that were selected on 
the Select Contract Screen with “TIP” 
added to the suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive 

Program”. 
 

Program Year  The program year associated with this 
contract. This value is set as the program 
year of the first month the contract was 
effective.  

 

Signup Type  Will be blank.  
Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process.  Will be blank for S36 migrated 
contracts.  

 

Subcategory 
Type  

Will be blank.  

COC Approval 
(mm/dd/yyyy) 

Allows the user to enter the date COC 
approved the contract revision.   

Enter the date in the 
mm/dd/yyyy format or 
select the date from the 
calendar popup 

--* 
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Par. 157 
*--157 TIP COC Approval (Continued) 

 
C COC Approval Screen Options 

 
Field/Button Description Action 
Approve  After the user selects “Approve” they will receive a 

popup window to confirm they wish to “approve”.  
Selecting “OK” will save all data.   
 
The user will see validation errors according to 
subparagraph D or the Success Screen.  On the 
Success Screen click “OK” to be returned to the View 
Contract Screen.  

Click “Approve” 
and “OK”. 

Reject  After the user selects “Reject” they will receive a 
popup window to confirm they wish to reject.  
Selecting “OK” will return the user to the View 
Contract Screen and the contract will be returned to a 
revision in process status.  User will be able to further 
modify the contract as needed.  

Click “Reject” 
and “OK”.  

Back  Will return the user to the View Contract Screen and 
no data will be saved. 

Click “Back”. 

 
D COC Approval Error Messages 

 
The COC Approval Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.   
 

Error Message Description Corrective Action 
Approval date (XXX) 
shall be no later than 
Today's Date (XXX) 

The COC approval date 
cannot exceed today's 
date. 

Enter a date in the mm/dd/yyyy 
format or that is not a future 
date.  

The COC Approval Date 
(XXX) for this contract 
cannot be earlier than the 
COC Approval Date of 
the original offer (XXX) 

The COC approval date 
cannot exceed the 
contract family's original 
start date. 

Enter a date in the mm/dd/yyyy 
format or that is equal to or later 
than the approval date of the 
original offer.   

--* 
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Par. 158 
*--158 TIP Enrollment Revisions 
 

A TIP Enrollment Revise Actions 
 
The TIP enrollment revise actions are used for changing acreage, farm and tract numbers, 
and producers. 

 
After selecting the TIP enrollment requiring maintenance on the Search Contract Screen 
(paragraph 8), the selected contract will be displayed on the View Contract Screen.  At the 
bottom of the screen is a “Select an action to perform” drop-down list.  When the user selects 
“Initiate>Revise”,  the user will need to select the revision effective date and reason for 
revision, on the Start Contract Revision Screen according to paragraph 13.  Then the user 
will be able to do the following maintenance actions to the TIP enrollment: 
 
• “Modify > Acreage” (subparagraph B) 
• “Modify > Effective Date/Reasons (subparagraph C) 
• “Modify > Farm/Tract” (subparagraph E) 
• “Modify > Producers” (subparagraph D). 
 
Users only need to perform actions for which the TIP enrollment is being changed.  These 
actions may be performed in any order; however, if there has been a reconstitution and new 
farm and/or tract numbers are needed, the “Modify > Farm/Tract” action should be accessed 
first so that the acreage validations will be applied to the appropriate information in Farm 
Records. 

 
After each action the user will see a Success Screen once that step passes all screen 
validations.  After they click “ok” they will be returned to the View Contract Screen and will 
be able to select another action to complete, as needed.  
 
Note: If the selected TIP enrollment was in “Approved” status, when user clicks “Go”, the 

parent contract status will be changed from “Approved” to “Terminated (Pending 
Finalization and Approval)”.  The contract number for the child contract will be the 
same as the parent with the next available alphabetic suffix added.  The child contract 
will be set to “Revision in Process” status.--* 
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Par. 158 
 
*--158 TIP Enrollment Revisions (Continued) 
 

B TIP Enrollment Revise Acreage 
 

The “Modify >Acreage” option can be used to modify the acreage under the TIP enrollment.  
The modify acreage process for revisions will use the same screens as the enrollment 
process.  Users will refer to paragraph 153 for adjusting acres.  The acreage will not be able 
to be increased over the total contract acres on the source CRP contract that the TIP was 
enrolled from.  If the acreage was incorrect on the CRP-1 contract, the TIP enrollment must 
be reverted, the CRP contract revised, then the TIP re-enrolled if applicable.  

 
If the TIP needs to be reverted, users should contact the State Office which will request the 
removal of the TIP enrollment to the National Office CCMS contact.  

 
C TIP Enrollment Revise Effective Date/Reasons 

 
The “Modify>Effective Date/Reasons” option can be used during the TIP revision process to 
correct the selected effective date or reason code.  The modify effective date/reason process 
for revisions will use the same screens as the enrollment process.  Users will refer to 
paragraph 152 for adjusting either the effective date or reason codes.  CCMS will only allow 
the effective date to fall between the current system date and the start date of the TIP 
enrollment.   

 
The TIP enrollment date is based on the source CRP contract that the TIP was enrolled from, 
if it is determined that the TIP original start date is incorrect, the TIP enrollment must be 
reverted, the CRP contract revised, then the TIP re-enrolled if applicable.  

 
If the TIP needs to be reverted, users should contact the State Office which will request the 
removal of the TIP enrollment to the National Office CCMS contact.--* 
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Par. 158 
158 TIP Enrollment Revisions (Continued)  
 

D TIP Enrollment Revise Producer 
 

The “Modify>Producer” option can be used during the TIP revision process to update either 
the assigned producers or the assigned beginning farm/rancher, socially disadvantaged, or 
veteran producer.  The modify producer process for revisions will use the same screens as the 
enrollment process.  Users will refer to paragraph 154 for modifying producers.  All producer 
updates must be recorded in farm records for the applicable year before updating CCMS.   
 
TIP assigned producers are based on the source CRP contract that the TIP was enrolled from, 
if it is determined that the TIP original producers are incorrect, the TIP enrollment must be 
reverted, the CRP contract revised, then the TIP re-enrolled if applicable.  

 
If the TIP needs to be reverted, users should contact the State Office which will request the 
removal of the TIP enrollment to the National Office CCMS contact. 

 
E TIP Enrollment Revise Farm/Tract  

 
The “Modify >Farm/Tract” option can be used to modify the farm and or tract number under 
the TIP enrollment.  The modify farm/tract process for revisions will use the same screens as 
the contract revision process.  Users will refer to paragraph 27 for updating farm and/or tract 
numbers.  If the farm/tract was incorrect on the CRP-1 contract that the TIP enrollment was 
created from, the TIP enrollment must be reverted, the CRP contract revised, then the TIP 
re-enrolled if applicable.  
 
If the TIP needs to be reverted, users should contact the State Office which will request the 
removal of the TIP enrollment to the National Office CCMS contact.  

 
F TIP Enrollment Revise Cancel, Finalize, and COC Approve 

 
The TIP enrollment cancellation, finalize, and COC approval for revision will use the same 
screens displayed during the TIP enrollment.  Refer to paragraph: 
 
 33 for canceling the revision 
 155 for finalization steps  
 157 to record the COC approval. 
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Par. 159 
*--159 TIP Divisions  
 

A Overview  
 
 CCMS allows users to record a TIP contract division.  CCMS is designed to allow the user to 

choose the number of contracts the existing TIP contract will be divided into and then align 
the farm/tract, producers, and acres for each resulting contract.  CCMS strictly enforces that 
no overall acreage changes are made as a result of the division. 

 
 CCMS will create child TIP contracts for the number of divisions entered.  Each child TIP 

contract will be prepopulated with the contract information from the parent.  Therefore, all 
child contracts have the same acreage, the same farm and tract, and the same producers.  The 
first step in the division process is setting the effective date. 

 
After selecting the TIP enrollment requiring maintenance on the Search Contract Screen 
(paragraph 8), the selected contract will be displayed on the View Contract Screen.  At the 
bottom of the screen is a “Select an action to perform” drop-down list.  When the user selects 
“Initiate > Divide”,  the user will need to select the Divide Effective Date, Reason for 
Division, and Number of Contract Divisions on the Divide Contract Screen.  Then the user 
will be able to do the following maintenance actions to the TIP Enrollment: 
 
 “Modify > Acreage” (paragraph 161) 
 “Modify > Effective Date/Reasons (paragraph 159) 
 “Modify > Farm/Tract” (paragraph160) 
 “Modify > Producers” (paragraph 162). 
 
Users only need to perform actions for which the TIP enrollment is being changed.  These 
actions may be performed in any order; however, if there has been a reconstitution and new 
farm and/or tract numbers are needed, the “Modify > Farm/Tract” action must be accessed 
first so that the acreage validations will be applied to the appropriate information in FRS. 

 
After each action, the user will see a “Success” screen, once that step passes all screen 
validations.  After the user clicks “OK” the user will be returned to the View Contract Screen 
and will be able to select another action to complete as needed. --* 
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Par. 159 
*--159 TIP Divisions (Continued) 
 

B Example of the Divide Contract Screen 
 
 The following is an example of the Divide Contract Screen. 
 

 
--* 
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Par. 159 
*--159 TIP Divisions (Continued) 
 

C Field Descriptions and Actions 
 
 The following table provides the field descriptions and actions for the Divide Contract 
 Screen.  
 

Field/Button Description Action 
Contract Status  Will display the current status of 

the contract. 
 

Activity Type  Will display “No Activity”.  

Admin State The administrative State of the 
contract. 

 

Admin County  The administrative county of the 
contract. 

 

Physical State  The State of physical location of 
tract for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract number(s) that was 
selected on the Select Contract 
Screen. 

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display “CRP”.  

Signup Name  The applicable signup name 
recorded for this contract. 

 

Program Year  The program year associated with 
this contract.  This value is set to 
the program year of the first month 
the contract was effective.  

 

Signup Type  The applicable signup type 
recorded for this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process.  Will be 
blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

--* 
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Par. 159 
*--159 TIP Divisions (Continued) 
 

C Field Descriptions and Actions (Continued) 
 

Field/Button Description Action 
Enter the number of 
Contract Division 

The user must enter the number of 
resulting contracts. 

Enter a whole number 
greater than one. 

Parent Contract Start 
Date 

The effective start date of the parent 
contract. 

 

Contract End Date The last day the contract will be in 
effect. 

 

Divide Effective 
Date 

The date the divided contracts will 
become effective. 

Enter the date in the 
mm/dd/yyyy format or 
select the date from the 
calendar icon. 

Reason for Division Select the reason for division. Select reason from the 
drop-down menu. 

Save The user will receive a popup 
window to confirm they want to 
divide the contract.  Selecting “OK” 
will save the Division Effective 
Date and Reason for 
Division. 
 
The Success Screen will be 
displayed if all page validations are 
met.  User must click “OK” on the 
Success Screen to be returned to the 
View Contract Screen. 
 
Selecting “Cancel” on the popup 
window will return the user to the 
Start Contract Revision Screen 
without saving data. 

CLICK “Save” then “OK” 
or “Cancel”. 

Back The View Contract Screen will be 
displayed, no data will be saved, 
and the division will be canceled. 

CLICK “Back”. 

--* 
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Par. 159 
*--159 TIP Divisions (Continued) 
 

D Error Messages  
 

The Divide Contract Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Selection is required.” Reason for Revision is a 

required field.  
Select a reason for revision 
for the drop-down menu. 

“The effective date (XXX) 
cannot be after the current 
date (XXX).” 

A new child contract (not 
yet approved) cannot be 
future dated unless its parent 
is also future dated. 

Set an effective date equal 
to or prior to the current 
date. 

“The effective date (XXX) 
cannot be after the end date 
(XXX).” 

The date of the activity 
cannot begin after the 
contract ends. 

Set an effective date prior to 
the last day the contract is 
active. 

“The effective date (XXX) 
cannot be different than the 
parent effective date 
(XXX).” 

If the parent contract is 
deferred, then the child 
contract must start on the 
same date as the parent.   

Set the effective date as the 
deferred start date of the 
parent contact. 

“The effective date (XXX) 
cannot be earlier than the 
start date (XXX).” 

A child contract cannot start 
before its parent. 

Set the effective date equal 
to or late than the parents 
start date.   

 
E Modify Effective Date/Reason 
 

If the user enters the Division Effective Date or Reason for Revision incorrectly, the user can 
return to the Start Contract Revision Screen by selecting “Modify > Effective Date/Reasons” 
and CLICK “Go” on the View Contract Screen of one of the child contracts.--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide  

 
A Overview  
 

To modify the farm and/or tract number on the contract, on the View Contract Screen, from 
the “Select an action to perform” drop-down list select Modify > Farm/Tract and CLICK 
“Go” after the division has been started according to paragraph 159. 
 
The farm, tract, and producer name will be returned for the program year in FRS based on 
the revision effective date recorded in paragraph 159. 

 
B Example of Modify Farm and Tract Screen  

 
The following is an example of the Modify Farm and Tract Screen. 

 

 
--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide  

 
C Modify Farm and Tract Screen Options  

    
The following table provides the field descriptions and actions for Modify Farm and Tract 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display “No Activity”.  

Admin State The administrative State of the 
contract.   

 

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of tract 
for this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract number(s) that was 
selected on the Select Contract 
Screen.   

 

Signup Number  The applicable signup number 
recorded for this contract.  

 

Program Type  Will display “CRP”.  

Signup Name  The applicable signup name recorded 
for this contract. 

 

Program Year  The program year associated with this 
contract.  This value is set to the 
program year of the first month the 
contract was effective.  

 

Signup Type  The applicable signup type recorded 
for this contract. 

 

Contract Description  This field will display the contract 
description entered in the 
TERRA/COLS process.  Will be 
blank for S36 migrated contracts.  

 

Subcategory Type  The applicable CRP subcategory 
recorded for this contract. 

 

--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide (Continued) 

 
C Modify Farm and Tract Screen Options (Continued) 

    
Field/Button Description Action 

Farm/Tract and CLU Information 

Farm Number  This value will be prepopulated based 
on the farm number associated with 
the contract. 

 

Tract Number  This value will be prepopulated based 
on the tract number associated with 
the contract. 

 

CLU The CLU number(s) on the contract.  

CLU Acres Number of acres in hundredths for 
each CLU entered. 

 

Producer Name  Users will be taken to the SCIMS 
Customer Search page to search for 
the desired producer.  Once the 
producer is selected on the SCIMS 
Customer Search page, their name 
will populate in the “Producer Name” 
field. 

CLICK “Find Producer”. 

Search  The Modify Farm and Tract Screen 
will be updated with the farms and 
tracts that meet the search criteria. 

CLICK “Search”. 

Back  The View Contract Screen will be 
displayed, no data will be saved. 

CLICK “Back”. 

Reset  All entered values will be removed. CLICK “Reset”. 

 
D Example of the Bottom of the modify Farm and Tract Screen- After Search  
 

The following is an example of the bottom of the Modify Farm and Tract Screen after the 
user searched by farm, tract, or producer. 

 

 
--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide (Continued) 

 
  E Field Descriptions and Actions for Bottom of the Modify Farm and Tract Screen-After 

Search Options 
 

The following table provides the field descriptions and actions for the updated Modify Farm 
and Tract Screen after the user searched for a farm, tract, or producer. 

 
Field/Button Description Action 

Farm Number All farm numbers that matched the 
search criteria will be displayed. 

Select the radio 
button on the 
desired farm. 

Tract Number The tract number(s) for the 
corresponding farm number that 
matched the search criteria will be 
displayed. 

 

Tract Description The tract description for the 
corresponding farm/tract number 
that matched the search criteria will 
be displayed. 

 

Farmland Acres The farmland acres for the 
corresponding farm/tract number 
that matched the search criteria 
will be displayed. 

 

Cropland Acres The cropland acres for the 
corresponding farm/tract number 
that matched the search criteria 
will be displayed. 

 

CRP Cropland 
Acres 

The CRP cropland acres for the 
corresponding farm/tract number that 
matched the search criteria will be 
displayed. 

 

CRP MPL Acres The CRP MPL acres for the corresponding 
farm/tract number that matched the search 
criteria will be displayed. 

 

Modify Search The farm, tract, and producer options 
according to subparagraph C will be 
displayed. 

CLICK “Modify 
Search”. 

--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide (Continued) 

 
  E Descriptions and Actions for Bottom of the Modify Farm and Tract Screen-After 

Search Options (Continued) 
 

Field/Button Description Action 
Save After the user selects the radio button for 

the “Farm/Tract Number” to add to the 
contract and they select “Save” a popup 
window will be displayed to confirm the 
save.  Selecting “OK” will save all data. 

 
The Success Screen will be displayed if 
all page validations are met. CLICK 
“OK” on the Success Screen to be 
returned to the View Contract Screen. 

 
Selecting “Cancel” on the popup 
window will return the user to the 
Modify Farm and Tract Screen without 
saving data. 

CLICK “Save” 
then “OK” or 
“Cancel”. 

Back Will return to the View Contract Screen 
and no data will be saved. 

CLICK “Back”. 

--* 
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Par. 160 
*--160 Modify TIP Farm and Tract - Divide (Continued) 

 
F Error Messages  
 

The Modify Farm and Tract Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  The following error messages 
may be displayed. 

 
Error Message Description Corrective Action 

“The farm number (XXX) 
currently on this contract is 
no longer in active status for 
Fiscal Year (XXX).” 

Farm number the user is 
adding to the contract must 
be active in the FY of the 
contract revision effective 
date.  

Enter active farm number 
for the year of the contract 
revision effective date.  

“The tract number (XXX) is 
not valid for this county for 
Fiscal Year (XXX).  Please 
establish the tract number 
for this county.” 

The tract number(s) cannot 
be missing or inactive. 

Enter active tract number 
for the year of the contract 
revision effective date. 

--* 
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Par. 161 
*--161 TIP Adjust Acreage - Divide 
 
  A Overview  

 
 To record the TIP acres and to modify or add CLU number and acres on the contract, on the 

View Contract Screen, from the “Select an action to perform” drop-down list, select Modify 
>Acreage and CLICK “Go” after the TIP division has been initiated, according to paragraph 
159.  

 
During a division, users will need to adjust the contract acres on each resulting child contract 
to represent the acres for the new contract.  However, the total number of acres on all 
resulting contracts must equal the original acres of the parent contract. 

 
B Example of Adjust Acreage Screen   

 
The following is an example of the Adjust Acreage Screen.     

 

 
--* 
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Par. 161 
*--161 TIP Adjust Acreage - Divide (Continued) 
 
  C Adjust Acreage Options 
    

The following table provides the field descriptions and actions for the Adjust Acreage 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  
Activity Type  Will display “TIP Enrollment”.   
Admin State The administrative State of the contract.    
Admin County  The administrative county of the contract.   
Physical State  The State of physical location of tract for this 

contract.  
 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract number(s) that was selected on 
the Select Contract Screen with “TIP” added 
to the suffix.   

 

Signup Number  Will be blank.   
Program Type  Will display “CRP”.  
Signup Name  Will display “Transition Incentive Program”  
Program Year  The program year associated with this 

contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  Will be blank.  
Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process.  Will be blank for S36 migrated 
contracts.  

 

Subcategory Type  Will be blank.  
CRP-1 Total Acres  Will display the total contract acres from the 

CRP-1.  The TIP enrollment will not be able 
to exceed this value.  

 

--* 
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  C Adjust Acreage Options (Continued) 
 

Field/Button Description Action 
Farm Number  The farm number associated with the 

contract. 
 

Tract Number The tract number associated with the 
contract.  

 

CLU The CLU number associated with the 
contract.  

Enter the CLU 
number from farm 
records.  

CLU Acres The acreage value that corresponds to the 
CLU number that was entered.  

Enter the CLU acres 
value in 100ths for the 
CLU number entered.  

Delete  Removes the CLU record for the line item 
that delete was selected.  

CLICK “Delete”. 

Add New CLU Information 
Farm Number  This value will be prepopulated based on the 

farm number associated with the contract. 
 

Tract Number  This value will be prepopulated based on the 
tract number associated with the contract. 

 

CLU The CLU number to associate with the 
contract. 

Enter the CLU 
number.  

CLU Acres The acreage value that corresponds to the 
CLU number to associate with the contract. 

Enter the CLU acres 
value in 100ths for the 
CLU number entered.  

Add Adds the data entered. CLICK “Add”. 
Total TIP Enrolled 
Acres 

Total CLU Acreage on the contract.   

--* 
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  C Adjust Acreage Options (Continued) 
 

Field/Button Description Action 
Save After the user selects “Save”, they will 

receive a popup window to confirm to 
save.  Selecting “OK” will save all data.   
 
The Success Screen will be displayed if all 
page validations are met.  User will click 
“OK” on the Success Screen to be returned 
to the View Contract Screen.   
 
Selecting “Cancel” on the popup window 
will return the user to the Adjust Acreage 
Screen without saving data.   

CLICK “Save” then 
“OK” or “Cancel”. 

Back Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 

 
D Adjust Acreage Screen Error Messages 

    
The Adjust Acreage Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 

“Field/CLU Number 
(XXX) is missing acreage 
information.” 

CLU cannot have null value for 
acreage amount. 

Enter the acreage value 
for the CLU. 

“Field/CLU Numbers are 
required. Please enter the 
Field/CLU Numbers before 
proceeding.” 

CLU number must be valid 
(cannot be null/missing, blank or -
99). 

Enter a valid CLU 
number. 

“The sum of the CLU 
Acres is greater than the 
Contract Acres.” 

Sum of CLU acres must be equal 
to or less than the contract acreage. 

Correct CLU contract 
acres. 

--* 
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A Overview 
 

To modify producers on the contract, on the View Contract Screen, from the “Select an 
action to perform” drop-down list, select “Modify > Producers” and CLICK “Go”. 
 
The Modify Producers Screen will be displayed with information for all owners and other 
producers associated with the tract and all operators associated with the farm from FRS for 
the program year that corresponds to the Division Effective Date set in CCMS.  If a producer 
is not displayed in CCMS, they must first be added to the farm record.   

 
The modify Producer Screen is displayed in two sections.  The “Assigned Producers” section 
will list all producers listed on the CRP contract the TIP is based on.  No modifications can 
be made to this section.  
 
The “Assigned Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producers" 
section will display producers listed in farm records that are not currently part of the CRP 
contract.  One of these producer(s) will be added as the qualifying party to meet the Veteran, 
Beginning Farmer, or SDA provisions for the TIP enrollment.--* 
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*--162 TIP Modify Producers - Divide (Continued)  
 

B Example of Modify Producers Screen 
 

The following is an example of the Modify Producers Screen. 
 

 
--* 
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C Modify Producers Options 
    

The following table provides the field descriptions and actions for the Modify Producers 
Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the contract.  

Activity Type  Will display “TIP Enrollment”.   

Admin State The administrative State of the contract.    

Admin County  The administrative county of the contract.   

Physical State  The State of physical location of tract for this 
contract. 

 

Physical County  The county of the physical location associated 
with this contract. 

 

Contract Number The contract number(s) that was selected on 
the Select Contract Screen with “TIP” added 
to the suffix.   

 

Signup Number  Will be blank.   

Program Type  Will display “CRP”.  

Signup Name  Will display “Transition Incentive Program”  

Program Year  The program year associated with this 
contract.  This value is set to the program year 
of the first month the contract was effective.  

 

Signup Type  Will be blank.  

Contract 
Description  

This field will display the contract description 
entered in the TERRA/COLS process.  Will 
be blank for S36 migrated contracts.  

 

Subcategory Type  Will be blank.  

Assigned Producers 

Producer Name  Name of the producer associated with the 
CRP contract the TIP enrollment is being 
applied to.  

 

Type The type of association the producer has on 
the tract associated with the contract 
according to Farm Records.  “Owner”, 
“Operator”, or “Other Tenant” will be 
displayed.  

 

--* 
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C Modify Producers Options (Continued) 
 

Field/Button Description Action 
Assigned Producers (Continued) 

Share  The percent share interest the producer 
has in the CRP-1.  

Enter the percentage 
value between 0.00 and 
100.00 percent in 
100ths.   

Primary Designates the primary point of contact 
for the CRP contract.  

Click the radio button of 
the producer that is the 
primary point of 
contact.   

Action Will display “Remove” only if the 
producer is no longer an owner on the 
tract.  

Select “Remove” to 
remove the producer 
from the list as 
applicable. 

Assigned Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producer  

Action  Will display “Remove”. 
 

Select “Remove" to 
remove the producer 
from the list as 
applicable.   

Producer Name Name of producers linked to the 
farm/tract in farm records that are not part 
of the CRP contract the TIP enrollment is 
being applied to.  

 

Type The type of association the producer has 
on the tract associated with the contract 
according to Farm Records.  “Owner”, 
“Operator”, or “Other Tenant” will be 
displayed. 

 

Classification  Will display SD for Socially 
Disadvantaged, VT for Veteran, BF for 
beginning farmer or rancher, or “Blank” if 
no clarification is found.  
 
These values are read from the 
corresponding values in the producer’s 
eligibility file for the year the TIP 
enrollment is being applied to.   

 

--* 
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C Modify Producers Options (Continued) 
 

Field/Button Description Action 

Available Beginning Farmer/Rancher, Socially Disadvantaged, or Veteran Producer 

Action  Will display “Add”. Select “Add” to move the 
producer from the 
available list to the 
assigned list.  

Producer Name Name of producers linked to the 
farm/tract in farm records that are not 
part of the CRP contract the TIP 
enrollment is being applied to.  

 

Type The type of association the producer 
has on the tract associated with the 
contract according to Farm Records.  
“Owner”, “Operator”, or “Other 
Tenant” will be displayed. 

 

Classification  Will display SD for Socially 
Disadvantaged, VT for Veteran, BF for 
beginning farmer or rancher, or 
“Blank” if no clarification is found.  
 
These values are read from the 
corresponding values in the producer’s 
eligibility file for the year the TIP 
enrollment is being applied to.   

 

--* 
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C Modify Producers Options (Continued) 
 

Field/Button Description Action 

Save Will save the data entered on the 
Modify Producers screen. 

CLICK “Save” then 
“OK” or “Cancel”.  
After the user selects 
“Save” they will receive 
a popup window to 
confirm they wish to 
save.  Selecting “OK” 
will save all data.   
 
The Success Screen will 
be displayed if all page 
validations are met.  User 
will click “OK” on the 
Success Screen to be 
returned to the View 
Contract Screen.   
 
Selecting “Cancel” on 
the popup window will 
return the user to the 
Modify Producer Screen 
without saving data.   

Back  Will return the user to the View 
Contract Screen and no data will be 
saved. 

CLICK “Back”. 

--* 
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D Modify Producers Screen Error Messages 
    

The Modify Producers screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“The primary participant 
must be a CRP producer.” 

The primary producer must 
be selected from a list of 
Assigned Producers.  

Select an assigned 
producer as the primary 
participant.  

“Please select a producer to 
add.” 

An Assigned Beginning 
Farmer/Rancher, Socially 
Disadvantaged, or Veteran 
Producer has not been 
identified.   

Use the add button to 
identify an Assigned 
Beginning 
Farmer/Rancher, Socially 
Disadvantaged, or Veteran 
Producer 

“All producers on the 
contract must have shares, 
even if zero. But cannot be 
negative.” 

A producer has a blank or 
negative value entered for 
the share.  

Enter a value between 0 
and 100 for each producer, 
not to exceed 100 for all 
producers.   

--* 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8-10-20 5-CRP Amend. 4 Page 2-551 



Par. 163 
*--163 Finalize TIP Contracts - Divide  
 

A Overview  
 
CCMS requires a step after the details of the TIP enrollment have been updated and the  
CRP-1R has been signed by all required producers that verifies all recorded eligibility rules 
are completed prior to COC approval.  To finalize child contracts, on the following View 
Contract Screen, from the “Select an action to perform” drop-down list, select “Modify > 
Finalize Child” and CLICK “Go”.  To finalize parent contracts, on the following View 
Contract Screen, from the “Select an action to perform” drop-down list, select “Modify > 
Finalize Parent” and CLICK “Go”. 

 
B Example of the Finalize TIP Screen    

 
   The following is an example of the Finalize TIP Screen.     
 

 
--* 
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  C Finalize TIP Contract Options 
    

The following table provides the field descriptions and actions for the Finalize TIP Contract 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display TIP Enrollment.   

Admin State The administrative State of the contract.    

Admin County  The administrative County of the contract.   

Physical State  The state of physical location of tract for 
this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen with “TIP” 
added to the suffix.   

 

Signup Number  Will be blank.   

Program Type  Will display “CRP”.  

Signup Name  Will display “Transition Incentive 
Program” 

 

Program Year  The Program year associated with this 
contract. This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type   Will be blank.  

Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process. Will be blank for S36 migrated 
contracts.  

 

Subcategory Type  Will be blank.  

Contract 
Description  

A free form optional field that the user can 
add contract descriptions based on 
revisions. 

Add contract 
descriptions as 
applicable.  Do not load 
any PII information in 
this field.   

--* 
 
 
 
 
 
 
 
8-10-20 5-CRP Amend. 4 Page 2-553 



Par. 163 
*--163 Finalize TIP Contracts - Divide (Continued)  
 
  C Finalize TIP Contract Options 
    

Field/Button Description Action 

CRP Contract Start 
Date 

The start date of the CRP contract 
the TIP has been applied too. 

 

CRP Contract End 
Date  

The end date of the CRP contract 
the TIP has been applied too. 

 

TIP Effective Date This date will be set as 10/1 of the 
year after the CRP contract 
expires. 

 

TIP End Date  This date will be 9/30 two years 
after the TIP Effective Date.  

 

Activity Reason   Will be displayed as “Enrolling 
contract in TIP”. 

 

Check box to indicate 
a modified 
Conservation plan is 
approved for land 
Improvements in the 
last year of the CRP-1:  

Indicator to allow the user to 
record that the CPO has been 
updated if land improvements are 
taking place in the last year of the 
CRP-1.   

Check (), if CP0 update has 
been received. 

Check box to indicate 
all Land Eligibility 
Criteria has been met: 

Indicator to all the user to record 
that all land eligibility has been 
reviewed and criteria is been 
reached.   

Check (), if review has 
been completed.  

CRP-1R Producer 
Signed Date 
(mm/dd/yyyy) 

The date the last producer on the 
CRP-1R signed the CRP-1.   

Enter the date in the 
mm/dd/yyyy format or select 
the date from the calendar 
popup.  

Finalize  Will save the data entered on the 
Finalize Screen and create the new 
child contract. 

CLICK “Finalize” and “OK”  
 
After the user selects “Save” 
they will receive a popup 
window to confirm they wish 
to save.  Selecting “OK” will 
save all data.   
 
CCMS will execute a series 
of validations.  If any 
validations fail, and error 
message will be displayed.  

Back  Will return the user to the View 
Contract Screen and no data will 
be saved. 

CLICK “Back”. 

--* 
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D Finalize TIP Contract Screen Error Messages 
    

The Finalize TIP Contract Screen is set up to provide potential validation errors when 
comparing the contract to the current year in Farm Records.  The following error messages 
may be displayed. 

 
Error Message Description Corrective Action 

“The parent is invalid and 
needs to be corrected before 
enrolling in TIP.” 

The source CRP contract is in 
an invalid status. 

Identify and correct the 
invalid status according to 
paragraph 100.  

“The sum of the CLU acreage 
must be less than or equal to 
the contract acreage.” 

The CLU acreage recorded 
on the TIP enrollment 
exceeds the contract acres 
from the original CRP 
contract.  

Adjust TIP acreage according 
to paragraph 153.   

“The TIP contract acreage 
(XXX) cannot exceed the 
expiring CRP contract acreage 
(XXX).” 

The CLU acreage recorded 
on the TIP enrollment 
exceeds the contract acres 
from the original CRP 
contract. 

Adjust TIP acreage according 
to paragraph 153.   

“The TIP contract acreage 
(XXX) cannot exceed the 
expiring CRP contract 
payable acreage (XXX).” 

The CLU acreage recorded 
on the TIP enrollment 
exceeds the payable contract 
acres from the original CRP 
contract.  

Adjust TIP acreage according 
to paragraph 153.   

“The TIP contract must have 
at least 1 TIP participant.” 

An Assigned Beginning 
Farmer/Rancher, Socially 
Disadvantaged, or Veteran 
Producer has not been added 
to the TIP enrollment.  

Add an Assigned Beginning 
Farmer/Rancher, Socially 
Disadvantaged, or Veteran 
Producer according to 
paragraph 154.  

“Participant {XXX} must be 
on the TIP contract since they 
participated in the expiring 
contract.” 

A producer listed on the 
CRP-1 according to CCMS 
of the source CRP contract is 
not listed as an Assigned 
Producer for this TIP 
enrollment.  

Add an Assigned Producer 
according to paragraph 154. 

“Participant {XXX} cannot be 
on the TIP contract since they 
did not participate in the 
expiring contract.” 

A producer has been added as 
an Assigned Producer that 
was not on the source CRP 
contract.   

Remove the participant from 
the list of assigned producers 
according to paragraph 154. 

“User must indicate a 
modified Conservation plan is 
approved for land 
Improvements in the last year 
of the CRP-1.” 

The check mark has not been 
placed in the box to confirm a 
modified conservation plan is 
approved for land 
improvements in the last year 
of the CRP-1. 

Follow this paragraph to 
provide the checkmark to 
confirm a modified 
conservation plan is approved 
for land improvements in the 
last year of the CRP-1. 

--* 
 
8-10-20 5-CRP Amend. 4 Page 2-555 



Par. 163 
*--163 Finalize TIP Contracts - Divide (Continued)  
 

D Finalize TIP Contract Screen Error Messages (Continued) 
 

Error Message Description Corrective Action 
“User must indicate All Land 
Eligibility Criteria has been 
met.” 

The check mark has not 
been placed in the box to 
confirm All Land Eligibility 
Criteria has been met.  

Follow this paragraph to 
provide the checkmark to 
confirm All Land Eligibility 
Criteria has been met. 

“Participant (XXX) is not 
eligible for TIP participation.  
Eligibility checked in year 
{XXXX}.” 

No corresponding SDA, BF, 
Veteran flag was found in 
the subsidiary eligibility file 
for the producer in the year 
indicated.  

Review the eligibility file for 
the producer to ensure all 
values are recorded for the 
correct year.  

“All owners associated with 
the tract in Farm Records for 
Fiscal year {0} must be on 
the contract, even if they are 
not receiving payments from 
the contract.  Other 
Producers on the tract and 
Operators are optional, 
unless they were on the 
parent contract.  Please add 
all owners of the tract to the 
contract.” 

Not all owners on the tract 
are recorded on the TIP 
enrollment.  

Verify farm records is 
correct and modify the CRP 
contract to correct all owners 
according to paragraph 29.   

“XXX Producer Signed Date 
is required.” 

Producer signed date is a 
required field. 
 

Enter date in mm/dd/yyyy 
format according to this 
paragraph. 

“The date you have entered 
for the {XXX} Producer 
Signature(s) precedes the 
original contract start date. 
Please correct the date.” 

The date entered is earlier 
than the original contract 
start date.  

Enter the correct date in 
mm/dd/yyyy format 
according to this 
paragraph. 

“The date of the (XXX) 
Producer Signature(s) cannot 
be later than today. Please 
correct the date.” 

Producer signatures cannot 
be future dated. 

Enter a date in the 
mm/dd/yyyy format 
that is not in the 
future. 

--* 
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*--164 Cancel TIP Enrollment - Divide 
 

A Overview  
 
If at any time prior to COC approval of a TIP Division, the user determines they have started 
the division in error, they can cancel the division and return the parent contract to an 
approved status.  To cancel a revision, on the View Contract Screen, from the “Select an 
action to perform” drop-down list, select “Modify > Cancel” and CLICK “Go”.  This option 
must be taken on the parent TIP contract. 

 
B Example of the Cancel TIP Enrollment Confirmation Screen 

 
   The following is an example of the Cancel TIP Enrollment Confirmation Screen. 
 

 
--* 
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C Cancel TIP Enrollment Confirmation Options      
    

The following table provides the field descriptions and actions for the Cancel TIP Enrollment 
Confirmation Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display “TIP Enrollment”.   

Admin State The administrative State of the contract.    

Admin County  The administrative county of the 
contract.  

 

Physical State  The State of physical location of tract for 
this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected 
on the Select Contract Screen with “TIP” 
added to the suffix.   

 

Signup Number  Will be blank.   

Program Type  Will display “CRP”.  

Signup Name  Will display “Transition Incentive 
Program”. 

 

Program Year  The Program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type  Will be blank.  

Contract Description  This field will display the contract 
description entered in the TERRA/COLS 
process.  Will be blank for S36 migrated 
contracts.  

 

Subcategory Type  Will be blank.  

Are you sure that you want to Cancel Divide at this time? 

OK TIP division will be Canceled, and the 
parent contract will be returned to an 
active status.  The user will be taken to 
the Success screen and must select “OK” 
to be returned to the View Contract 
Screen.   

CLICK “OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 

--* 
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A Overview  
 
When COC approves a division, COC approval applies to all child contracts of the division, 
including child contracts identified as placeholders. 
 
After COC approval of a division, to enter COC approval information, on the View Contract 
Screen select the parent contract.  From the “Select an action to perform” drop-down list, 
select “Modify > COC Approve” and CLICK “Go”. 
 
 

B Example of the COC Approval Screen 
 

The following is an example of the COC Approval Screen. 
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C COC Approval Options 

    
The following table provides the field descriptions and actions for the COC Approval Screen. 
 

Field/Button Description Action 
Contract Status  Will display the current status of the 

contract. 
 

Activity Type  Will display “TIP Enrollment”.   

Admin State The administrative State of the contract.    

Admin County  The administrative county of the contract.   

Physical State  The State of physical location of tract for 
this contract.  

 

Physical County  The county of the physical location 
associated with this contract. 

 

Contract Number The contract numbers that was selected on 
the Select Contract Screen with “TIP” 
added to the suffix.   

 

Signup Number  Will be blank.   

Program Type  Will display “CRP”.  

Signup Name  Will display “Transition Incentive 
Program”. 

 

Program Year  The Program year associated with this 
contract.  This value is set to the program 
year of the first month the contract was 
effective.  

 

Signup Type   Will be blank.  

Contract 
Description  

This field will display the contract 
description entered in the TERRA/COLS 
process. Will be blank for S36 migrated 
contracts.  

 

Subcategory Type  Will be blank.  

COC Approval 
(mm/dd/yyyy) 

Allows the user to enter the date the COC 
approved the contract revision.   

Enter the date in the 
mm/dd/yyyy format or 
select the date from the 
calendar popup. 

--* 
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C COC Approval Options (Continued) 
 

Field/Button Description Action 
Approve  After the user selects “Approve” they will 

receive a popup window to confirm they 
wish to “approve”.  Selecting “OK” will 
save all data.   
 
The user will see validation errors 
according to subparagraph D or the 
Success Screen.  On the Success Screen 
click “OK’ to be returned to the View 
Contract Screen.  

CLICK “Approve” 
and “OK”. 

Reject  After the user selects “Reject” they will 
receive a popup window to confirm they 
wish to reject.  Selecting “OK” will return 
the user to the View Contract Screen and 
the contract will be returned to a Revision 
in Process status.  User will be able to 
further modify the contract as needed.  

CLICK “Reject” and 
“OK”. 

Back  Will return the user to the View Contract 
Screen and no data will be saved. 

CLICK “Back”. 

 
D COC Approval Error Messages 
 

The COC Approval Screen is set up to provide potential validation errors when comparing 
the contract to the current year in Farm Records.  The following error messages may be 
displayed. 
 

Error Message Description Corrective Action 
“Approval date (XXX) must 
be no later than Today's 
Date (XXX)” 

The COC approval date 
cannot exceed today's date. 

Enter a date in the 
mm/dd/yyyy format or that 
is not a future date.  

“The COC Approval Date 
(XXX) for this contract 
cannot be earlier than the 
COC Approval Date of the 
original offer (XXX)” 

The COC approval date 
cannot exceed the contract 
family's original start date. 

Enter a date in the 
mm/dd/yyyy format or that 
is equal to or later than the 
approval date of the original 
offer.   

--* 
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A Overview  
 

 The transfer option is used for TIP contract transfers is the same process as the transfer of a 
CRP contract to another county and/or State.  During a transfer: 

 
 a new contract number will be automatically assigned using the next available number 

from the receiving county 
 
 the producers assigned to the contract may change 

 
 there can be a producer Division of Payment agreement, if new producers are assigned. 

 
 Any outstanding TIP contract revisions needed must completed prior to the farm being 

transferred in CRM Farm Records.  
 

The transfer is initiated by the original or sending county.  The transferring county user needs 
to know the farm and tract number to which the contract will be assigned in the receiving 
county.  The receiving county will need to establish the farm and tract in FRS.  It is important 
that the contract is not terminated as part of the farm record transfer.  For the farm records 
transfer in CRM Farm Records, the user needs to remove the contract attributes from the 
fields enrolled in CRP and the CRP cropland from the tract level data before CCMS will 
allow the transfer of the farm. 

 
When the receiving county farm and tract numbers have been established in FRS, the 
transferring county user can begin the transfer.  Contracts transferred from System 36 will 
show “unknown” for “CLU” field and possibly for the “Tract Number” field when the 
contract is displayed on the View Contract Screen.  These are required fields and must be 
updated before the transferring county transfer steps can be completed. 

 
Important: The transfer in CCMS must happen in the same FY as the transfer of the land 

in CRM Farm Records. 
 

Complete the transfer of a TIP contract between counties according the following: 
 
 Transfer Contract - Transferring County (paragraph 50) 
 Transfer Contract Finalize - Receiving County (paragraph 51) 
 Transfer Contract COC Approve- Receiving County (paragraph 52) 
 Transfer Contract Cancel (paragraph 53) 
 

167-170 (Reserved) 
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Part 3    (Reserved) 
 
171-249 (Reserved) 
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Par. 250 
Part 4    Conservation Payments 

 
250 General Payment Provisions 
 

A Introduction 
 

The CRP payment process is an automated process that determines: 
 
• whether the producer is eligible to receive payment 
• the payment amount that can be sent to NPS for disbursement 
• the overpayment amount that will be updated to the Pending Overpayment Report. 

 
B Frequency of Payment Processing 
 

The initial Batch payment process for CRP Annual rental is performed each October.  CRP 
payments are processed nightly for the following: 
 
• payment amounts staged by the user during the workday 
 
• any payment on the Nonpayment Report to determine whether the condition 

previously preventing the payment has been corrected. 
 
C Obtaining FSA-325 

 
FSA-325 shall be completed, according to 1-CM, paragraph 779 by individuals or entities 
requesting payment earned by a producer who has died, disappeared, or been declared 
incompetent subsequent to applying for CRP benefits.  Payment shall be issued to the 
individuals or entities requesting payment using the deceased, incompetent, or disappeared 
producer’s ID number 
 

D Administrative Offset 
 

CRP payments are subject to administrative offset provisions. 
 

E Assignments 
 

A producer entitled to a CRP payment may assign payments according to 63-FI. 
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Par. 250 
250 General Payment Provisions (Continued) 
 

F Bankruptcy 
 

Bankruptcy status does not exclude a producer from requesting CRP benefits. 
 
Note: Contact the OGC Regional Attorney for guidance on issuing CRP payments on all 

bankruptcy cases. 
 

G Payments Less Than $1 
 

CRP payment processes will: 
 
• issue payments that round to at least $1 
• not issue payments less than 50 cents. 

 
H Payment Due Date 
 

See 61-FI for general guidance to determine payment due dates for various programs.  The 
CRP payment system sends the current system date to NPS as the payment due date.  The 
system cannot determine the payment due date because of numerous factors. 
 
County Offices shall manually determine the payment due date by determining the later of 
the following: 
 
• the date producer filed payment eligibility documentation, including the following: 

 
• the date the producer signed the CRP-1 
• AD-1026 
• CCC-902 
• CCC-526, CCC-931, or CCC-941, as applicable 

 
• if the producer is an entity or joint operation, the date members filed the requisite 

payment eligibility documentation 
 
• the date software was available to process the payment. 
 
If the payment is not issued within 30 calendar days after the later of the dates in this 
subparagraph, then prompt payment interest is payable to the producer.  County Offices shall 
follow provisions in 61-FI for issuing the interest payment. 
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Par. 251 
251 Payment Eligibility 
 

A Determining Payment Eligibility 
 

The payment process reads the web-based eligibility system for the applicable year to 
determine whether a producer or member of a joint operation is eligible to be paid.  If the 
producer or member is ineligible to be paid, then the individual or entity will be listed on the 
Nonpayment Report with the applicable message. Eligibility values must be updated before 
the producer or member can be paid. 
 

B Eligibility Values 
 

The following table provides web-based eligibility determinations applicable to CRP. 
 

Certification/Determination Eligible Values Ineligible Values Applicable to 
Members 

Joint 
Operations 

Entities 

Crop Years 2002 and Prior 
* * * * * * * * * * * * * * * 
Conservation Compliance 
- Farm/Tract Eligibility 

 In Compliance 
 Partial Compliance 
 Reinstated. 

 In Violation 
 Past Violation 
 No Association. 

Yes No 

Controlled Substance ●*--Growing--* 

 No Violation. 
* * * 
 Trafficking 
 Possession. 

Yes No 

AD-1026  Certified 
 

 Good Faith 
Determination 

 
 COC Exemption. 

 Not Filed 
 
 Awaiting Affiliate 

Certification 
 
 Affiliate Violation. 

Yes No 

Adjusted Gross Income AGI provisions do not apply to CRP contracts approved in 2002 and 
prior crop years. 

Foreign Person  Yes 
 Not Applicable. 

 No 
 Pending. 

Yes Yes 

Actively Engaged  Actively Engaged 
 Exempt. 

 Not Filed 
 
 Awaiting 

Determination 
 
 Awaiting Revision 
 
 Not Actively 

Engaged. 

Yes No 

Permitted Entity Yes No Yes Yes 
Person Eligibility COC Determination 

Completed 
 Note Filed 
 
 Awaiting 

Determination 
 

 Awaiting Revision. 

Yes No 
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Par. 251 
251 Payment Eligibility 
 

B Eligibility Values (Continued) 
 

Certification/Determination Eligible Values Ineligible Values Applicable to 
Members 

Joint 
Operations 

Entities 

Crop Years 2003 through 2008 
Fraud, including FCIC 
Fraud 

Compliant Not Compliant Yes No 

* * * * * * * * * * * * * * * 
Conservation Compliance 
- Farm/Tract Eligibility 

 In Compliance 
 Partial Compliance 
 Reinstated.  

 In Violation 
 Past Violation 
 No Association. 

Yes No 

Controlled Substance ●*--Growing--* 
 No Violation. 

* * * 
 Trafficking 
 Possession. 

Yes No 

AD-1026  Certified 
 
 Good Faith 

Determination 
 
 COC Exemption. 

 Not Filed 
 
 Awaiting Affiliate 

Certification 
 
 Affiliate Violation. 

Yes No 

Adjusted Gross Income The AGI provisions applicable to the original CRP contract continue to 
apply for the life of the contract. See 2-CRP, paragraph 131 for 
additional information on AGI provisions for CRP contracts approved 
in crop years 2003 through 2008. 

Foreign Person  Yes 
 Not Applicable. 

 No 
 Pending. 

Yes Yes 

Actively Engaged – 2002 
Farm Bill 

Actively Engaged  Not Filed 
 

 Awaiting 
Determination 

 
 Awaiting Revision 
 
 Not Actively 

Engaged. 

Yes No 

Permitted Entity – 2002 
Farm Bill 

Yes No Yes Yes 

Person Eligibility – 2002 
Farm Bill 

COC Determination 
Completed 

 Not Filed 
 

 Awaiting 
Determination 

 
 Awaiting 

Revision. 

Yes No 
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Par. 251 
251 Payment Eligibility (Continued) 
 

B Eligibility Values (Continued) 
 

Certification/Determination Eligible Values Ineligible Values Applicable to 
Members 

Joint 
Operations 

Entities 

Crop Years 2009 through 2013 
Fraud, including FCIC Fraud Complaint Not Compliant Yes No 

* * * * * * * * * * * * * * * 

Conservation Compliance 
 - Farm/Tract Eligibility 

 In Compliance 
 Partial Compliance 
 Reinstated. 

 In Violation 
 Past Violation 
 No Association. 

Yes No 

Controlled Substance ●*--Growing--* 
 No Violation. 

* * * 
 Trafficking 
 Possession. 

Yes No 

AD-1026  Certified 
 
 Good Faith 

Determination 
 
 COC Exemption. 

 Not Filed 
 
 Awaiting Affiliate 

Certification 
 
 Affiliate Violation. 

Yes No 

Adjusted Gross Income The AGI provisions applicable to the original CRP contract continue to 
apply for the life of the contract.  See 2-CRP, paragraph 131 for additional 
information on AGI provisions for CRP contracts approved in crop years 
2009 through 2013. 

Foreign Person  Yes 
 Not Applicable. 

 No 
 Pending. 

Yes Yes 
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Par. 251 
251 Payment Eligibility (Continued) 
 

B Eligibility Values (Continued) 
 

Certification/Determination Eligible Values Ineligible Values Applicable to 
Members 
Joint 
Operations 

Entities 

Crop Year 2014 
Fraud, including FCIC Fraud Compliant Not Compliant Yes No 
* * * * * * * * * * * * * * * 
Conservation Compliance 
- Farm/Tract Eligibility 

 In Compliance 
 Partial Compliance 
 Reinstated. 

 In Violation 
 Past Violation 
 No Association. 

Yes No 

Controlled Substance ●*--Growing--* 
 No Violation. 

* * * 
 Trafficking 
 Possession. 

Yes No 

AD-1026  Certified 
 
 Good Faith 

Determination 
 
 COC Exemption/ 

 Not Filed 
 
 Awaiting Affiliate 
Certification 

 
 Affiliate Violation 

Yes No 

Adjusted Gross Income AGI provisions do not apply to CRP contacts approved in crop year 2014 
(Sign-up 46). 

Foreign Person  Yes 
 Not Applicable. 

 No 
 Pending. 

Yes Yes 
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Par. 251 
251 Payment Eligibility (Continued) 
 

B Eligibility Values (Continued) 
 

Certification/Determination Eligible Values Ineligible Values Applicable to 
Members 
Joint 
Operations 

Entities 

Crop Years 2015 and Future 
Fraud, including FCIC Fraud Compliant Not Compliant Yes No 
* * * * * * * * * * * * * * * 
Conservation Compliance 
- Farm/Tract Eligibility 

 In Compliance 
 Partial Compliance 
 Reinstated. 

 In Violation 
 Past Violation 
 No Association. 

Yes No 

Controlled Substance ●*--Growing--* 
 No Violation 

* * * 
 Trafficking 
 Possession. 

Yes No 

AD-1026  Certified 
 
 Good Faith 

Determination 
 
 COC Exemption/ 

 Not Filed 
 
 Awaiting Affiliate 
Certification 

 
 Affiliate Violation 

Yes No 

Adjusted Gross Income The AGI provisions applicable to the original CRP contract continue to 
apply for the life of the contract.  See 2-CRP, paragraph 131 for additional 
information on AGI provisions for CRP contracts approved in crop years 
2015 and future. 

Foreign Person  Yes 
 Not Applicable 

 No 
 Pending. 

Yes Yes 
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Par. 251 
251 Payment Eligibility (Continued) 
 

B Eligibility Values (Continued) 
 

The following table provides additional rules that apply to this program. 
 

Rule Applicability 
Crop Years 2002 and Prior  

Do “person” or attribution rules apply to the program? “Person” 
Do cash-rent tenant rules apply to the program? Yes 
Does substantive change rule apply? *--No--* 
Does the 3-member level rule apply? No 
Are Federal entities eligible? No 
Are State and Local Governments eligible? Yes 
Are Public Schools eligible? Yes 

Crop Years 2003 through 2008 
Do “person” or attribution rules apply to the program? “Person” 
Do cash-rent tenant rules apply to the program? Yes 
Does substantive change rule apply? *--No--* 
Does the 3-member level rule apply? No 
Are Federal entities eligible? No 
Are State and Local Governments eligible? Yes 
Are Public Schools eligible? Yes 

Crop Years 2009 through 2013 
Do “person” or attribution rules apply to the program? Attribution 
Do cash-rent tenant rules apply to the program? No 
Does substantive change rule apply? Yes 
Does the 3-member level rule apply? Yes 
Are Federal entities eligible? No 
Are State and Local Governments eligible? No 
Are Public Schools eligible? No 

Crop Year 2014 
Do “person” or attribution rules apply to the program? Attribution 
Do cash-rent tenant rules apply to the program? No 
Does substantive change rule apply? Yes 
Does the 3-member level rule apply? Yes 
Are Federal entities eligible? No 
Are State and Local Governments eligible? No 
Are Public Schools eligible? No 

Crop Years 2015 and Future 
Do “person” or attribution rules apply to the program? Attribution 
Do cash-rent tenant rules apply to the program? No 
Does substantive change rule apply? Yes 
Does the 3-member level rule apply? Yes 
Are Federal entities eligible? No 
Are State and Local Governments eligible? No 
Are Public Schools eligible? No 
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Par. 251 
251 Payment Eligibility (Continued) 
 

B Eligibility Conditions Priority 
 

If a producer has multiple invalid subsidiary eligibility conditions, only the highest priority 
ineligible condition will be printed on the Nonpayment Report.  The following table provides 
the priority of conditions. 
 

Priority Condition 
1 FCIC Fraud 
2 Conservation Compliance 
3 Controlled Substance 
4 Actively Engaged-2002 Farm Bill 
5 AD-1026 
6 Person Eligibility-2002 Farm Bill 

* * * * * * 
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Par. 252 
252 Funds Control  
 

A eFunds Allotment 

CRP operates at the national allotment level and does not require State or county allotments. 
All collection, obligation, and payment transactions update the national allotment.  Only the 
National Office can update and view the national allotment. 
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Par. 253 
253 CRP Refunds 
 

A 2012 and prior year CRP refunds 
 

All 2012 and prior year CRP refunds (annual and incentive) will be handled manually 
following instructions in 64-FI, Par. 21. 
 
Exception: For CRP incentive payments that were issued using the OLP follow 

instructions in 1-FI, Par 65. 
 
 B CRP Refunds for full contract terminations 
 

The county user must select the “Cancel NPS Payment” option in the Conservation Payments 
System to process CRP refunds (annual and incentive) due for full contract terminations for 
payment years 2013 and forward.  See paragraph 307 for detailed instructions. 
 
Any payment that was signed in NPS will appear on the Pending Overpayment Report in 
CPR the following day.  The county user shall SELECT “Transfer Overpayment” from the 
report to immediately transfer the overpayment to NRRS.  If no action is taken the 
overpayment will be transferred by the system to NRRS after 80 business days.  
 
Note: Receivables are currently generated by the system for the producer that received the 

payment.  Follow 64-FI, subparagraph 26 B to change a producer’s name on a 
receivable when necessary. 

 
C CRP Refunds for partial contract terminations 

Manual receivables will be created in most cases by the county user, according to  
64 FI, paragraph 21, when CRP annual rental refunds are due for partial contract 
terminations. 
 
Incentive payment amounts should be adjusted in the “Make NPS Payment” option to trigger 
system generated receivables, according to paragraph 282. 

  
Exception:  For CRP incentive payments that were issued using OLP follow instructions 

in 1-FI, paragraph 65.   
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Par. 254 
254 CRP Payments 
 

A Supporting Files for Integrated Payment Processing 
 

The CRP payment process is a web-based integrated process that uses a wide range of 
information and other program determinations and values to determine whether a payment 
should be issued and the amount of gross payment, applicable reductions, and the net 
payment amount.  For payments to be calculated correctly, all supporting files must be 
updated correctly.   

 
Type of 

Information 
How Information Is Used for Payment Processing  

Source 
*--CRP-1 and 
CRP-1R Data--* 

The information from CRP-1 is used to compute the 
CRP payment amount for the producer. 

CCMS 

Payment 
Eligibility 
Information 

Used to determine whether the producer and/or member 
of a joint operation is eligible for payment for the 
applicable payment year. 

Subsidiary 
Eligibility 
System 

General 
Name and 
Address 
Information 

Used to determine the producer’s business type and 
general name and address information. 

Business 
Partner/ 
SCIMS 

Entity and 
Joint 
Operation 
Information 

Used to determine the following for the applicable 
payment year. 
 
 member contribution value 
 substantive change value 
 members and member’s share of the following: 

 entities 
 general partnerships 
 joint ventures. 

Business File 

Combined 
Producer 
Information 

Used to determine whether CRP producers or members of
entities or joint operations are combined with other 
producers.  This information is used to ensure that the 
payment limitation is controlled properly. 

Combined 
Producer 
System 

Available 
Payment 
Limitation 

Used to determine payment limitation availability. Payment 
Limitation 
System 

Cropland 
Reporting 
Indicator 

Used to determine whether the producer has met 
Cropland Reporting provisions. 

Compliance 
System 

Financial 
Related 
Information 

Used to: 
 
 calculate payment information is provided to NPS 

 
 determine overpayment amount, may be provided to 

NRRS. 

NPS or NRRS 
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Par. 254 
254 CRP Payments (Continued) 
 
 B Prerequisites for Payments 

Certain actions must be completed to ensure that the producer is eligible for payment.  The 
following table provides the steps that must be completed to issue payments properly.  COC, 
CED, or designee shall ensure that the actions are completed. 
 

Step Action 
1 Ensure that CRP-1 has been approved and that the approval date has been recorded 

in the system. 
2 Ensure that AD-1026 is on file for the applicable year for producers seeking benefits 

and the eligibility information is recorded in the Subsidiary Eligibility System. 
3 Ensure that the applicable CCC-902 is on file and actively engaged determinations 

are completed according to 1-PL, 4-PL, or 5-PL for the applicable year for 
producers and members of joint operations seeking benefits. 

4 Ensure that CCC-526, CCC-931, or CCC-941, as applicable is on file for the 
applicable year for producers seeking benefits and the certification information is 
recorded in the web-based eligibility system.  See 1-PL, 4-PL, 5-PL. 

5 Ensure that all other eligibility determinations have been updated according to the 
determinations made by COC for producers and members of joint operations.  See 1-
PL, 3-PL, 4-PL,5-PL. 

6 Ensure that joint operation and entity ownership structure information is updated in 
Business File for the applicable year. See 3-PL (Rev. 2). 

7 Ensure that the member contribution and substantive change values are updated 
according to 1-PL, 3-PL, 4-PL, 5-PL. 

8 Ensure that the combined producer files are updated correctly for the applicable 
year.  See 1-PL, 3-PL, 4-PL, 5-PL  

9 Ensure that all assignments and joint payees have been updated in NPS if CCC-36, 
CCC-37, or both were filed for CRP. 
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Par. 255 
255 CRP Overpayments 
 
  A Introduction 
 

The CRP payment process is an integrated process that reads data from many systems to 
determine whether payments issued to a producer were earned in-full or in-part.  These 
systems include: 
 
• Subsidiary Eligibility System which includes data about eligibility, combined producer, 

and Business File 
 

• SCIMS. 
 
If something changes in any of these systems for the applicable payment year, the CRP 
payment process is automatically triggered to recalculate the payment.  The producer is 
overpaid if the information that has been changed results in the current calculated amount to 
be less than the amount originally paid to the producer. 

 
  B Determine Overpayments 
 

For any overpayment amount calculated as $1 or greater, the system will update the 
applicable information to the Pending Overpayment Report.  See 9-CM, paragraph 65 for 
information on the Pending Overpayment Report. 
 
Warning: Because the system is integrated with other systems, it is critical that County 

Offices do not make unnecessary changes to producer information that could 
cause an overpayment to be computed.  County Offices are required to update the 
system properly but removing or deleting data to “trigger” the system to function 
could worsen the situation.  

 
C Handling Debits Less Than $100 
 

County Offices shall follow 58-FI for handling receivables less than $100. 
 

D Charging Interest 
 

Use the rate of interest CCC is required to pay for borrowing from the Department of the 
Treasury on the date payment was issued.  See 50-FI. 
 
Interest accrues from the date of disbursement to the earlier of the following: 
 
• date of payment 
• date of first delinquency letter. 

 
256-269 (Reserved) 
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Par. 270 
Part 5    Conservation Payments Automated System 

 
270 General Information 
 

A Introduction 
 

This part provides information and procedure for accessing and updating the web-based 
Conservation Payments System. 
 

B Purpose of the Conservation Payments System 
 

The purpose of the Conservation Payments System is to allow: 
 
• State Office users to: 
 

• view contract payments 
• view and print reports 
• update and load AGI information 
• manually obligate contracts 
• record reductions 

 
• County Office users to: 
 

• make payments 
• cancel payments 
• view contract payments 
• view and print reports 
• record reductions. 
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Par. 271 
Section 1    Accessing Conservation Payments 

271 Access to the Conservation Payments Website 

A Accessing the Conservation Payments Website 

Access the Conservation Payments Main Menu from the FSA Applications Intranet  
website at http://fsaintranet.sc.egov.usda.gov/fsa/applications.asp.  From the FSA Intranet 
Screen, under “FSA Applications”, “Applications Directory”, CLICK “A-C”.  The FSA 
Intranet Screen will be redisplayed with applications with names starting with A to C.  
CLICK “Conservation - Payment Process”. 

Note: Internet Explorer shall be used when accessing the Conservation Payments software. 
The Conservation Payments Login Screen will be displayed.  The options available 
will be dependent upon the user role whether State Office user or County Office user. 

B Login Screen 

After users click “Conservation – Payments Process”, users will be prompted to login 
through the USDA eAuthentication Login Screen.  CLICK “Login with LincPass (PIV)” or 
enter user ID and password and CLICK “Login”. 

The following Conservation Payments Home Page will be displayed for County Office users. 
The left menu shows options available to the county user. 

5-15-19 5-CRP Amend. 1 Page 5-2 

http://fsaintranet.sc.egov.usda.gov/fsa/applications.asp


Par. 271 
271 Access to the Conservation Payments Website (Continued) 

B Login Screen (Continued) 

The following Conservation Payments Home Page will be displayed for State Office users. 
The left menu shows options available to the State user. 

C Top Navigation Bar 

The top navigation bar will be displayed on all screens within the Conservation Payments 
System.  The following table provides the field descriptions on the top navigation bar.  

Field/Button Description 
Payments Home Conservation Payments Main Menu will be displayed. 
About Payments A page describing the purpose of Conservation Payments will be 

displayed. 
Help Conservation Home Page will be displayed for a selection of 

options that may provide additional assistance. 
Contact Us A page will be displayed with information about: 

• who to contact for help

• what information to include in user’s e-mail or voice mail
message.

Exit Payments FSA Intranet Page will be displayed. 
Logout of eAuth The window browser will close and a pop-up window will be 

displayed with the message, “for security reasons, your browser 
window will close automatically”.  On the pop-up window, when 
users click “OK”, they will be logged off the USDA eAuthentication 
System. 
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Par. 271 
271 Access to the Conservation Payments Website (Continued) 

D Left Navigation Bar 

The left navigation bar will be displayed on all screens within the Conservation Payments 
System.  The following table provides the field descriptions on the left navigation bar for 
County Office users.  

Field/Button Description 
Make NPS Payment Provides the ability for the user to manually stage a payment 

for overnight processing. 
Cancel NPS Payment Provides the ability for the user to manually stage a payment 

for cancellation for overnight processing. 
View Contract Payment 
Summary 

Provides the ability for the user to view 2012 and prior 
year payment information for individual CRP contracts 
and producers.  

Prepayment Process This option is not available for CRP payments. 
Payment Reports Provides the user with static/historical 2012 and prior year 

payment information for CRP contracts and producers. 
Record Reduction Provides the ability for the user to record payment reduction 

amounts that will be reduced from CRP annual rental 
payments. 

The following table provides the field descriptions on the left navigation bar for State Office 
users. 

Field/Button Description 
View Contract Payment 
Summary 

Provides the ability for the user to view 2012 and prior year 
payment information for individual CRP contracts and 
producers. 

Prepayment Process This option is not available for CRP payments. 
Payment Reports Provides the user with Static/Historical 2012 and prior 

year payment information for CRP contracts and 
producers. 

Update AGI Provides the user with the ability to override the system stored 
AGI value. 

Load AGI Provides the user with the ability to bring in the most 
current producer information from the Business File. 

Obligate Payment Provides the user with the ability to manually obligate 
contracts that are not obligated automatically by Kansas City 
batch obligation processes. 

Record Reduction Provides the ability for the user to record payment reduction 
amounts that will be reduced from CRP annual rental 
payments. 

272-281 (Reserved)
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Par. 282 
Section 2    Make NPS Payment Functions 

 
282 Make NPS Payment  
 

A Overview 
 

CRP is part of the Common Payment System.  See 9-CM for more information on the 
Common Payment System.  
 

 *--CRP annual rental and TIP payments are processed by a batch payment process run each year 
in early October.  Annual rental and TIP payments that do not get processed during this--* 
batch can be processed by the user taking the Make NPS Payment option in Conservation 
Payments.  CRP incentive payments must be processed by the user taking the Make NPS 
Payment option.  
 

 *--The “Make NPS Payment” option for CRP is used to “stage” annual rental payments, TIP 
payments, and incentive payments.  The “Make NPS Payment” option for CRP is a--* 
“trigger” for the common payment process.  The payments will be available in NPS the 
following day to be certified and signed if all eligibility criteria have been met. 
 
Staging a payment using the “Make NPS Payment” option in Conservation Payments will 
trigger a payment to process and re-compute that payment for any type of change including: 
 
 contract changes 

 
 payment reductions such as hay/graze reductions entered by the user in Conservation 

Payments 
 

 changes in external systems including, but not limited to, SCIMS, Subsidiary, Combined 
Producer, Payment Limitation, Business File, and CARS 

 
 changes to AGI compliance due to use of “Update AGI” option in Conservation 

Payments. 
 

 *--Note: The following changes require the use of the “Make NPS payment” option to 
trigger the system to pick up changes that take place after the annual payment 
run:  

 
 contract changes 
 
 addition or modification to payment reductions such as haying/grazing 

 
 addition or modification to CRP acreage in CARS 

 
 changes to AGI compliance due to the use of the “Update AGI” option in 

Conservation Payments.--* 
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Par. 282 
282 Make NPS Payment (Continued) 
 

B General Incentive Information  
 

The following table provides general information about CRP incentives. 
 

 
 
 
 
 
Incentive 
Type 

 
Available 
payment 
years in 
Conservation 
payments 
system 

 
 
 
 
 
 
Earned 

 
 
 
 
 
Payment 
year 

 
 
 
 
 
 
Validation 

 
 
 
 
 
Divided among 
producers 

 
 
 
 
 
 
Available  

CRP-SIP 2013 and 
forward 

When CRP-1 
is COC 
approved. 

Shall always 
be the fiscal 
year the 
CRP-1 was 
approved. 

The 
payment 
software 
will 
validate 
that the 
correct SIP 
payment 
year has 
been 
selected. 

The SIP amount 
will always be 
divided 
automatically by 
the payments 
system 
according to the 
producer shares 
on the CRP-1. 

All States 

CRP-PIP 2013 and 
forward 

When the 
technical 
agency and/or 
producer 
certifies 
performance 
FSA-848B. 

Shall always 
be the fiscal 
year the 
producer or 
TSP 
certifies 
completion 
of the CRP 
practice. 

NA The PIP amount 
will 
automatically be 
displayed 
according to the 
shares on the 
CRP-1. The user 
can select the 
producer to 
receive payment 
and make 
downward 
adjustments in 
the payment 
amount if 
necessary. 

All States 

CRP-BIP 2015 and 
forward 

When the 
enhancement 
for honey bee 
habitat is 
modified on 
the 
conservation 
plan and 
approved by 
COC. 

Shall always 
be the fiscal 
year the 
conservation 
plan is 
modified 
and 
approved by 
COC. 

N/A The BIP amount 
will always be 
divided 
automatically by 
the payments 
system 
according to the 
producer shares 
on the CRP-1. 

Michigan, 
Minnesota, 
North 
Dakota, 
South 
Dakota, 
and 
Wisconsin 
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Par. 282 
282 Make NPS Payment (Continued) 
 

B General Incentive Information (Continued)  
 
 
 
 
 
Incentive 
Type 

Available 
payment 
years in 
Conservation 
payments 
system 

 
 
 
 
 
Earned 

 
 
 
 
Payment 
year 

 
 
 
 
 
Validation 

 
 
 
Divided 
among 
producers 

 
 
 
 
 
Available  

CRP-TTI *--2016 and 
forward--* 

When the 
technical agency 
and/or producer 
certifies 
performance. 

Will 
always be 
the fiscal 
year the 
producer 
or TSP 
certifies 
completio
n of the 
CRP 
practice 

N/A The TTI 
amount will 
be 
automatically 
displayed 
according to 
the shares on 
the CRP-1. 
The user can 
select the 
producer to 
receive 
payment and 
make 
downward 
adjustments in 
the payment 
amount if 
necessary. 

All states 

CRP-
CBIP 

2016 and 
forward 

When CRP-1 is 
COC approved 

Will 
always be 
the fiscal 
year the 
CRP-1 
was 
approved. 

The 
payment 
software 
will validate 
that the 
correct 
CBIP 
payment 
year has 
been 
selected. 

The CBIP 
amount will 
always be 
divided 
automatically 
by the 
payments 
system 
according to 
the producer 
shares on the 
CRP-1. 

Virginia, 
West 
Virginia, 
Delaware, 
and New 
York 
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Par. 283 
283 Make NPS Payment Screen 
 

A Overview 
 

The Make NPS Payment option provides users the ability to stage CRP annual and incentive 
payments for overnight payment processing.   
 

B Example of Make NPS Payment Screen 
 

The following in an example of the Make NPS Payment Screen. 
 

 
 

C Fields and Actions  
 

The following table provides that fields and actions on the Make NPS Payment Screen.   
 

Field/Button Action 
Program Name   Select “CRP”. 
Payment Year Select the year the payment was earned.  Payment years 2013 and future 

are available for CRP payments.  Payment years 2012 and prior year 
payments annual rental and incentive payments are issued using the OLP 
according to 2-CRP, Exhibit 35.7.   

State-County Select correct State and county to stage the CRP annual rental payment. 
 
Note: Users will only see State and counties linked to their EAS profile. 

Contract Number Enter the CRP contract number that will receive payment. 
 
Note: This is an optional field for payment type annual rental, leaving 

this field blank will display all available contracts for the county. 
Payment Type *--Select “Annual”, “TIP”, or “Incentive”. 
Payment Status “All”.--* 
Search CLICK “Search” and Contract Selection Screen will be displayed. 
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Par. 284 
284 Make NPS Payment – Contract Selection Screen 
 

A Overview 
 

The Make NPS Payment – Contract Selection Screen allows the user to select the CRP 
 *--or TIP contract for payment.--* 

 
B Example of Make NPS Payment – Contract Selection Screen 
 

The following is an example of the Make NPS Payment – Contract Selection Screen for CRP 
annual rental payments. 
 

 
 

The following is an example of the Make NPS Payment – Contract Selection Screen for CRP 
incentive payments. 
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Par. 284 
284 Make NPS Payment – Contract Selection Screen 
 

B Example of Make NPS Payment – Contract Selection Screen (Continued) 
 
 *--The following is an example of the Make NPS Payment – Contract Selection Screen for TIP 

payments.  
 

 
--* 
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Par. 284 
284 Make NPS Payment – Contract Selection Screen (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions on the Make NPS Payment – 
Contract Selection Screen.   
 

Field/Button Description Action 
Program Program as selected.  
State State as selected and State 

code. 
 

County County as selected and 
county code. 

 

Payment Type Payment type as selected.  
Payment Year  Payment year as selected.  
Contract Number Contract number as 

selected.  
Click the radio button of the 
desired contract number to 
select. 

Contract Effective State 
Date 

Date the selected  
* * * contract became 
effective. 

 

Farm Number Farm number associated 
*--to the CRP or TIP 
contract. 

 

Tract Number Tract number associated 
to the CRP or TIP--* 
contract. 

 

SIP/PIP/BIP/TTI Amount Applicable to incentive 
payments only.   

Enter the amount of the 
incentive payment as 
calculated outside the system.  
The amount must be in whole 
dollars with no decimals. 

Continue Takes user to the 
Producer Selection 
Screen.  

After clicking the radio 
button for the applicable 
contract number, CLICK 
“Continue”.  Producer 
Selection Screen will be 
displayed. 

Reset Clears previously 
selected contract. 

Click to clear the contract 
selected 
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Par. 285 
285 Make NPS Payment – Producer Screen  
 

A Overview 
 

The Make NPS Payment – Producer Screen displays the producer(s) associated with the CRP 
contract that will receive payment.  
 

B Example of Make NPS Payment –Producer Screen 
 

The following is an example of the Make NPS Payment –Producer Screen for CRP annual 
rental payments. 
 

 
 
The following is an example of the Make NPS Payment –Producer Screen for CRP incentive 
payments. 
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Par. 285 
285 Make NPS Payment – Producer Screen (Continued) 
 

B Example of Make NPS Payment –Producer Screen (Continued)  
 
 *--The following is an example of the Make NPS Payment – Producer Screen for TIP 

payments. 
 

--* 
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Par. 285 
285 Make NPS Payment – Producer Screen (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions on the Make NPS Payment – 
Producer Screen.   
 

Field/Button Description Action 
Contract Number Contract Number as entered.  
Start Date Start Date of the contract.  
Program Year Program Year of the contract.  
Farm Number Farm number associated with the 

contract. 
 

Tract Number Tract number associated with the 
contract. 

 

Payment Amount Annual rental or incentive payment 
amount for the contract. 

 

Customer Name *--Producers on the CRP-1 or CRP-1R--* 
with shares greater than zero will be 
displayed.  

 

Shared Amount Producer share amount based on 
producer(s) shares on the CRP-1 
*--or CRP-1R.--* 

 

Send Payment User will stage the payment for 
overnight processing.  

CLICK “Send 
Payment”  

Return to List User will be taken to the previous 
payment screen and no payment will 
be sent.   

CLICK “Return 
to List”. 
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Par. 286 
286 Make NPS Payment – Confirmation Screen  
 

A Overview 
 

The Make NPS Payment – Confirmation Screen provides confirmation of a payment 
successfully staged for overnight processing. 
 
Payments will be available in NPS the following day for certifying and signing if no 
conditions preventing payment are present for the producer being paid.  The user can identify 
payment reduction reasons using the Nonpayment/Reduction Report found in CPR.  See  
9-CM for information on the CPR. 
 

B Example of Make NPS Payment – Confirmation Screen 
 

The following is an example of the Make NPS Payment –Confirmation Screen displaying the 
message “Contract payments have been successfully queued for the nightly batch process”.   
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Par. 287 
*--287 Make NPS Payment – PIP Exception Screens 
 

A Overview 
 

The Make NPS Payment PIP Exception Screens will display error messages when a PIP 
payment is attempted on a contract that is not eligible to receive PIP, or a PIP payment is 
attempted that must be issued from the Cost Share System. 

 
  B Example of Make NPS Payment – PIP Exception Screen when PIP must be issued from 

the Cost Share System 
 
   The following is an example the Make NPS Payment – PIP Exception Screen displaying the 

message “PIP must be issued from Cost Share System”. 
 

 
_--* 
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Par. 287 
*--287 Make NPS Payment – PIP Exception Screens (Continued) 
 

C Example of Make NPS Payment – PIP Exception Screen when a contract is not eligible 
to receive a PIP Payment 

 
The following is an example of the Make NPS Payment – PIP Exception Screen when a 
contract is not eligible to receive a PIP Payment. 
 

 
--* 

 
288-296 (Reserved) 
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Par. 297 
Section 3    Modifying CRP Incentive Data 

 
297 Modifying Previously Recorded CRP Incentive Payment Data 
 

A Overview 
 

Previously entered CRP incentive payment amounts can be modified by selecting the “Make 
NPS Payment” option and selecting the Contract and payment year for the previously 
recorded incentive payment. 
 
Note: This section only applies to CRP incentive payments. 
 

B Effect on Previously Processed Payments 
 

Modifying previously recorded payment amounts impacts previously processed payments in 
different ways depending on whether the original payment was sent to NPS and certified and 
signed.  This table describes how a previously recorded payment is affected when the 
amounts are modified or deleted. 
 
IF 
previously 
recorded 
payment 
amounts 
are… 

AND 
previously 
recorded 
payment 
amounts 
were… 

 
 
 
 
AND the payment in NPS 
was… 

 
 
 
 
 
THEN the… 

reduced 
 

sent to NPS certified and signed system will retrigger the payment to 
reprocess to determine the 
overpayment amount for the 
producer.  A transaction will be sent 
to the Pending Overpayment Report. 
See 9-CM. 

either not certified or 
certified, but not signed 

• original amount in NPS will be 
canceled and the system will 
retrigger the payment to reprocess 

 
• new payment amount will be listed 

in NPS signature, provided all 
eligibility requirements are met 

increased sent to NPS certified and signed system will retrigger the payment to 
reprocess to determine the 
underpayment amount for the 
producer.  A transaction will be sent 
to NPS. 

either not certified or 
certified, but not signed 

• original amount in NPS will be 
canceled and the system will 
retrigger the payment to reprocess 

 
• new payment amount will be listed 

in NPS for signature, provided all 
eligibility requirements are met. 
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Par. 297 
297 Modifying Previously Recorded CRP Incentive Payment Data (Continued) 
 

C Modification Examples for CRP Incentives 
 

The following is an example of a CRP incentive overpayment. 
 
Example: Contract 100 is issued an incentive payment of $1000 on 1/01/2016 for payment 

year 2016.  The user realized Contract 100 should only receive $500.  The user 
will access the “Make NPS Payment” option in Conservation Payments and select 
contract 100 and payment year 2016.  The user would enter the correct amount of 
$500 and ‘click’ the send payment option.  The system will see the contract was 
paid $1000 on 1/1/2016 and if the payment was signed in NPS, now send a $500 
overpayment amount to the Pending Overpayment Report in CPR (See 9-CM). If 
the payment was not signed in NPS, the incorrect $ 1,000 payment request will be 
removed from NPS and the correct amount of $500 will be sent to NPS for 
certifying and signing. 

 
The following is an example of a CRP underpayment.  
 
Example: For contract 100, the user realized that the incentive should have been $1500 

rather than $1000.  The user will access the “Make NPS Payment” option in 
conservation payments and select contract 100 for payment year 2016 and enter 
the correct amount of $1500 and click the “Send Payment” option.  The system 
will see the $1000 payment that was issued 1/1/2016 and send the additional $500 
to NPS.  

 
The following is an example of a CRP incentive payment modification for the same contract 
and payment year.  
 
Example: An initial incentive payment for PIP is issued at practice completion for  

contract 200, for payment year 2016 in the amount of $1000. 
 
A second PIP for $500 is due upon completion of the second practice for contract 
200, for payment year 2016.  The user would access the “Make NPS Payment” 
option in conservation payments again choosing contract 200 and payment year 
2016 and enter $1,500 as the payment amount and click the “Send Payment” 
option.  The system will see that $1000 was initially paid and issue the additional 
$500 PIP payment to NPS.  
 

298-306 (Reserved) 
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Par. 307 
Section 4    Cancel NPS Payment 

 
307 Introduction 
 

A Overview 
 
 *--The Cancel NPS Payment option for CRP annual rental, incentives, and TIP is a “trigger”--* 

for the common payment process.  When the user cancels a payment, the cancellation is 
“staged” for overnight processing. I f the contract payment was signed in NPS, the contract 
payment will process overnight to the CPR system and appear on the Pending Overpayment 
Report.  If the contract payment was not signed, the payment request is simply cancelled in 
NPS and will not appear on the Pending Overpayment Report.  See 9-CM for more 
information on the Pending Overpayment Report.  Once pending overpayments are 
transferred to NRRS through the CPR, users must then follow 64-FI, subparagraph 23 B to 
adjust the automated receivable created in NRRS.   
 
The Cancel NPS Payment option: 
 
 is only available to County Office users 
 
●*--will be used when CRP and TIP contracts are terminated, and refunds are due--* 
 
 will be used when the parent CRP contract is placed in a terminated status due to 

revisions or division and previously issued payments are affected the for the year(s) the 
revision or division is effective.   
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Par. 308 
308 Cancel Payment  
 

A Overview  
 

The Cancel Payment Screen provides the user with the ability to select a payment for 
cancellation.   
 

B Example of the Cancel Payment Screen 
 

The following is an example of the Cancel Payment Screen. 
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Par. 308 
308 Cancel Payment (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Cancel Payment 
Screen.   
 

Field/Button Description Action 
Program Name   Program name as selected.  Select “CRP”. 
Payment Year Year the payment was issued.  Select the correct payment year. 

 
Note: Only 2013 and future years 

are available for CRP 
payment cancellation.  
Manual receivables must 
be created for refunds 
according to 64-FI, 
paragraph 21 for prior 
payment years not 
available in Conservation 
payments.  

 
Exception: For CRP incentive 

payments that were 
issued using the OLP 
follow instructions in 
1-FI, paragraph 65. 

State State from which payment was 
issued. 

Select the correct state. 
 
Note: Users will only see States 

linked to their EAS profile. 
County County from which payment was 

issued. 
Select the correct county.   
 
Note: Users will only see counties 

linked to their EAS profile. 
Contract Number Contract number for which payment 

is to be cancelled.  
 

*--Enter the CRP or TIP contract 
number. 
 
Notes: This is an optional field for 

annual rental and TIP--* 
payments, leaving this 
field blank will display all 
contracts for the county 
that have annual rental 
payments available for 
cancellation for that 
payment year. 

 
The contract number must be 
entered when cancelling a CRP 
incentive payment.   

Payment Type Payment type as selected.  Select “Annual” or “Incentive”. 
Search Contract Selection Screen will be 

displayed. 
CLICK “Search”. 
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Par. 308 
309 Cancel Payment – Contract Selection  
 

A Overview 
 

The Cancel Payment – Contract Selection Screen provides the user with the ability to select 
a contract for payment cancellation. 
 

B Example of Cancel Payment - Contract Selection Screen 
 

The following is an example of the Cancel Payment - Contract Selection Screen. 
 

 
 
C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Cancel Payment – 
Contract Selection Screen. 

 
Field/Button Description Action  

Program Program as selected.  
State State as selected and State code.  
County County as selected and county code.  
Payment Type Payment Type as selected.  
Payment Year  Payment Year as selected.  
Contract Number Contract Number as selected.  
Effective Date Effective date of the selected contract.  
Farm Number Farm number associated to the contract.  
Tract Number Tract number associated to the contract.  
Continue Will display the Producer 

Selection Screen. 
After clicking the radio 
button for the applicable 
contract number, CLICK 
“Continue”. 

Reset Will clear the selected contract.  CLICK “Reset”. 
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Par. 310 
310 Cancel Payment – Producer Selection 
 

A Overview 
 

The Cancel Payment – Producer Selectin Screen provides the user with the ability to select a 
contract producer for payment cancellation. 
 

B Example of Cancel NPS Payment - Producer Selection Screen 
 

The following is an example of the Cancel Payment - Producer Selection Screen. 
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Par. 310 
310 Cancel Payment – Producer Selection (Continued) 
 

C Field Descriptions and Actions 

The following table provides the field descriptions and actions for the Cancel Payment – 
Producer Selection Screen. 

Field/Button Description Action 
Contract Number Contract Number as entered.  
Start Date Start Date of the contract.  
Program Year Program Year of the contract.  
Farm Number Farm number associated with 

the contract. 
 

Tract Number Tract number associated with 
the contract. 

 

Payment Amount Payment amount that was 
issued on the contract. 

 

Customer Name Customer receiving payment 
cancellation.  

Check () the box to select 
customer(s) for payment 
cancellation. 
 
Note: In cases of multiple 

producers, the user 
must select each 
individual producer for 
payment cancellation. 

Estimated Amount Producer share payment amount 
that will be cancelled. 

 

Cancel Payment Stages the payment 
cancellation.  

CLICK “Cancel 
Payment”. 

Return to List User will be taken to the 
previous payment screen and 
no payment will be sent. 

CLICK “Return to List”. 
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Par. 311 
311 Cancel Payment – Confirmation 
 

A Overview 
 

The Cancel Payment – Confirmation Screen provides confirmation of a payment successfully 
staged for cancelled for overnight processing.   
 
A payment that was signed in NPS will appear on the Pending Overpayment Report in CPR 
the following day.  Information on the Pending Overpayment Report can be found in 9-CM. 
A payment that has not been signed will simply be removed from NPS. 
 

B Example of Cancel Payment Confirmation Screen 
 

 The following is an example of the Cancel Payment - Confirmation Screen. 
 

 
 
312-321 (Reserved) 
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Par. 322 
Section 5    View Contract Payment Summary Functions  

 
322 View Contact Payment Summary 
 

A Overview 
 

The View Contract Payment Summary option provides the user with information on 
payments for individual contracts.  
 
• View Contract Payment Summary for CRP is only available for payments issued from 

the web-based Conservation Payments system prior to 2013.  For payment years 2013 
forward please refer to the Common Payment Reports according to 9-CM. 
 

• CRP payments for prior years that were issued from S/36 must be researched using the 
FWADM reports.  See 1-FI, Part 8 for FWADM reports available for these payments. 

 
• SIP and PIP Payments for prior years that were issued manually through OLP must be 

researched using the FWADM reports found on the FSA Applications Intranet website at 
http://fsaintranet.sc.egov.usda.gov/fsa/applications.asp.  From the FSA Intranet 
Screen, under “FSA Applications”, “Applications Directory”, CLICK “D-F”.  CLICK 
“Data Marts”. 

 
Note: The View Contract Payment Summary option is available to State and County users.  
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Par. 323 
323 View Payment  
 

A Overview 
 

The View Payment Screen provides the ability to select specific payment years to view 
contract payments. 
 

B Example of View Payment Screen 
 

The following is an example of the View Payment Screen. 
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Par. 323 
323 View Payment (Continued) 

 
C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the View Payment 
Screen. 

 
Field/Button Description Action 

Program Name   Program name as selected. Select “CRP”. 
Payment Year Payment year as selected.  
State State as selected.   Select State. 

 
Note: Users will only see States 

linked to their EAS 
profile. 

County County as selected.  Select county.  
 
Note: Users will only see 

counties linked to their 
EAS profile. 

Contract Number Contract number as selected. Enter the CRP contract number. 
 
Notes:  This is an optional field 

for annual rental 
payments, leaving this 
field blank will display 
all contracts for the 
county that have annual 
rental payments available 
for cancellation for that 
payment year. 

 
The Contract number 
must be entered for a 
CRP incentive payment. 

Payment Type Payment type as selected.   Select “Annual”, “SIP”, or 
“PIP”. 

Search Contract Selection Screen will 
be displayed. 

CLICK “Search”. 
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Par. 324 
324 View Payment – Contract Selection  
 

A Overview 
The View Payment – Contract Selection Screen provides the user the ability to select a 
contact to view payments. 
 

B Example of View Payment - Contract Selection Screen 
 

The following is an example of the View Payment - Contract Selection Screen.  
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Par. 324 
324 View Payment – Contract Selection (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the View Payment – 
Contract Selection Screen. 
 

Field/Button Description Action  
Program Program as selected.  
State State as selected and State 

code. 
 

County County as selected and 
county code. 

 

Payment Type Payment Type as selected.  
Payment Year  Payment Year as selected.  
Contract Number Contract Number as selected.  
Contract Effective 
Date 

Effective date of the selected 
contract. 

 

Farm Number Farm number associated with 
the contract. 

 

Tract Number Tract number associated with 
the contract. 

 

Continue Displays the View Payment 
Producer Screen. 

After clicking the radio button 
for the applicable contract 
number, CLICK “Continue”.  . 

Reset Clears selected contract.  CLICK “Reset”.  
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Par. 325 
325 View Payment – Producer 
 

A Overview 
 

The View Payment – Producer Screen provides the user payment information for the selected 
contract and producer. 
 

B Example of View Payment - Producer Screen 
 

The following is an example of the View Payment - Producer Screen. 
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Par. 325 

325 View Payment – Producer (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the View Payment – 
Producer Screen. 
 

Field/Button Description Action 
Contract Number Contract number as entered.  
Start Date Start date of the contract.  
Program Year Program Year of the contract.  
Farm Number Farm number associated 

with the contract. 
 

Tract Number Tract Number associated 
with the contract. 

 

Payment Amount Payment amount that was 
issued on the contract. 

 

Customer Name Producer for which payment is 
being viewed. 

 

Paid Date Date the payment was issued.  
Estimated/Paid 
Amount 

Producer share payment 
amount that will be cancelled. 

 

Payment Code Status of payment being 
viewed. 

 

Confirmation Number Payable ID number 
associated with the 
payment. 

 

Return to List Returns user to previous 
screen.   

CLICK “Return to List”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5-15-19    5-CRP Amend. 1 Page 5-141  



Par. 326 
326 View Payment – No Payment Information Available  
 

A Overview 
 

The View Payment – No Payment Information Available Screen provides a message to 
indicate no payment information is available for the selected year and contract. 
 

B Example of the View Payment – No Payment Information Available Screen 
 

The following is an example of the View Payment – No Payment Information Available 
Screen. 

 

 
 
Important: If no payment information is found for the selected contract criteria the 

message “No payment information available for payment year XXXX” will be 
displayed.   

 
327-336 (Reserved) 
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Par. 337 
Section 6    Reports  

 
337 Payment Reports  
 

A Overview 
 

Payment Reports for CRP are only available for payments issued from the web based 
Conservation Payments system prior to 2013.  See 9-CM for information on reports for CRP 
for 2013 and future year payments. 
 
[need lead in for bullets or make paragraphs] 
 

 
• Prepayment with Exceptions  
• Prepayment without Exceptions 
• NPS Payment with Exceptions 
• NPS Payment without Exceptions 
• NPS Partial Payments with Exceptions. 

 
B Example of Payment Report Screen 
 

The following is an example of the Payment Report Screen 
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• Payment reports for CRP are static and for historical information only. 
 

• CRP payments issued from S/36 and OLP will not be available.  See 1-FI, Part 8 for 
FWADM reports available for these payments. 

 
• Payment reports are available for State and County users.  

 
• The five payment reports available are: 



Par. 337 
337 Payment Reports (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Payment Report 
Screen. 
 

Field/Button Description Action  
Program Name   Program name as selected. Select “CRP”. 
Payment Year Payment year as selected.  
State-County State and county as selected. 

 
 

Select the correct State and 
county.   
 

Note: Users will only see 
State and counties 
linked to their EAS 
profile. 

Contract Number Contract number as selected. Enter the CRP contract 
number. 
 
Notes: This is an optional field 

for annual rental 
payments, leaving this 
field blank will display 
all contracts available 
for the payment report 
type selected. 

 
The Contract number 
must be entered for a 
CRP SIP or PIP 
payment. 

Contract Number 
Range 

Date range as entered.   Enter a date range. The system 
will display all contracts 
available based on the date 
rate entered and the payment 
report type selected 

Payment Type Payment type as selected. Select “Annual”, “SIP”, or 
“PIP”. 

Payment  Allows the user to select from the 
five available report types. 

Select report type from the 
drop-down menu.   

Report Type Details or Summary level is 
available for each type of report. 

Select details or summary. 

Search Search Selection Screen will be 
displayed. 

CLICK “Search”. 
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Par. 338 
338 Prepayment with Exceptions Report 
 

A Overview 
 

The Prepayment with Exceptions Report will provide a list of contracts and producers for the 
county that had a reduction issue before payment was attempted that would prevent payment 
or cause a payment reduction. 
 

B Example of Prepayment with Exceptions Detail Report 
 

The following is an example of the Prepayment with Exceptions Detail Report. 
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Par. 338 
338 Prepayment with Exceptions Report (Continued) 
 

C Field Descriptions 
 
This report includes information for eligibility nonpayment conditions for the payment entity 
and/or any ineligible member 
 
The following table provides the field descriptions for the Prepayment with Exceptions 
Detail Report. 

 
Field Description 

Program Program as selected. 
Payment Year  Payment year as selected. 
State State as selected.  
County County as selected.  
Date Date the report was run. 
Payment Type  Payment type as selected. 
Report Type Report type as selected/ 
Contract Number Contract number as selected. 
Start Date Effective date of the selected contract. 
Name Producer(s) associated to the contract with shares greater than 

zero. 
 
Note: Entity members will be also be displayed when 

applicable reductions exist. 
Share Amount Producer payment share amount.  
Amount Payable Net payment amount after reductions. 
Reduction Reason Reason the payment is not processed or reduced. 
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Par. 339 
339 Prepayment without Exceptions Report 
 

A Overview 
 

The ‘Prepayment without exceptions’ report provided a list of all contracts and producers for 
the county with no reductions issues. 
 

B Example of Prepayment without Exceptions Report 
 
 The following is an example of the Prepayments without Exceptions Detail Report. 
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Par. 339 
339 Prepayment without Exceptions Report (Continued) 
 

C Field Descriptions 
 

This report includes information for eligibility nonpayment conditions for the payment entity 
and/or any ineligible member. 
 
The following table provides the field descriptions for the Prepayment without Exceptions 
Detail Report. 
 

Field Description 
Program Program as selected. 
Payment Year  Payment Year as selected. 
State State as selected.  
County County as selected.  
Date Date the report was run. 
Payment Type  Payment type as selected. 
Report Type Report type as selected.  
Contract Number Contract Number as selected. 
Start Date Effective date of the selected contract. 
Name Producer(s) associated to the contract with shares greater than 

zero. 
 
Note: Entity members will be also be displayed when 

applicable reductions exist. 
Share Amount Producer payment share amount.  
Amount Payable Net payment amount after reductions. 
Reduction Reason Will be blank. 
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Par. 340 
340 NPS Payment with Exceptions Report 
 

A Overview 
 

The NPS Payment with Exceptions Report provides information on contracts and producers 
after payment was attempted either through a batch payment process initiated by Kansas City 
or by the user selecting the ‘Make NPS Payment’ option.  The report provides a list of 
contracts and producers for the county that have a reduction issue.  These reduction messages 
will be the same reductions listed on the Prepayment with Exceptions Report unless the 
reduction issues were resolved before payment was processed.  The reductions message 
could also reflect issues such as insufficient eFunds or payment limitation.  The NPS 
Payments with exceptions displays all payments with nonpayment reasons including 
payments that are zero. 
 

B Example of NPS Payment with Exceptions Report 
 

The following is an example of the NPS Payment with Exceptions Report. 
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Par. 340 
340 NPS Payment with Exceptions Report (Continued) 
 

C Field Descriptions 
 

This report includes information for eligibility nonpayment conditions for the payment entity 
and/or any ineligible member. 
 
The following table provides the field descriptions for the Prepayment with Exceptions 
Detail Report. 
 

Field Description 
Program Program as selected. 
Payment Year  Payment Year as selected. 
State State as selected.  
County County as selected.  
Date Date the report was run. 
Payment Type  Payment type as selected. 
Report Type Report type as selected. 
Contract Number Contract number as selected. 
Start Date Effective date of the selected contract. 
Name Producer(s) associated to the contract with shares greater than zero. 

 
Note: Entity members will be also be displayed when applicable 

reductions exist. 
Share Amount Producer payment share amount.  
Amount Payable Net payment amount after reductions. 
Reduction Reason Reason the payment is not processed or reduced. 
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Par. 341 
341 NPS Payment without Exceptions Report 
 

A Overview 
 

The NPS Payment without Exceptions Report provides information on contracts and 
producers after payment was attempted either through a batch payment process initiated by 
Kansas City or by the user selecting the Make NPS Payment option.  The report provides a 
list of contracts and producers for the county with no reduction issues and payment has 
successfully been sent to NPS.  The contracts on this report have received a full payment. 

 
B Example of NPS Payment without Exceptions Report 
 

The following is an example of the NPS Payment without Exceptions Report. 
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Par. 341 
341 NPS Payment without Exceptions Report (Continued) 
 

C Field Descriptions 
 

The following table provides the field descriptions for the NPS Payment without 
Exceptions Report. 
 
Field Description 
Program Program as selected. 
Payment Year  Payment Year as selected. 
State State as selected.  
County County as selected.  
Date Date the report was run. 
Payment Type  Payment Type as selected. 
Report Type Report type as selected. 
Contract Number Contract Number as selected. 
Start Date Effective date of the selected contract. 
Name Producer(s) associated to the contract with shares greater than zero.  

 
Note: Entity members will be also be displayed when applicable 

reductions exist. 
Share Amount Producer payment share amount.  
Amount Payable Net payment amount after reductions. 
Reduction Reason Will be blank. 
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Par. 342 
342 NPS Partial Payment with Exceptions Report 
 

A Overview 
 

The NPS Partial Payment with Exceptions Report provides information on contracts and 
producers with payment amounts greater than zero that have been issued with reductions 
with nonpayment reasons displayed. 
 

B Example of NPS Partial Payment with Exceptions Report 
 

The following is an example of the NPS Partial Payment with Exceptions Report. 
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Par. 342 
342 NPS Partial Payment with Exceptions Report (Continued) 
 

C Field Descriptions 
 

This report includes information for eligibility nonpayment conditions for the payment entity 
and/or any ineligible member. 
 
The following table provides the field descriptions for the NPS Partial Payment with 
Exceptions Report. 
 

Field Description 
Program Program as selected. 
Payment Year  Payment Year as selected. 
State State as selected.  
County County as selected.  
Date Date the report was run. 
Payment Type  Payment type as selected. 
Report Type Report type as selected.  
Contract Number Contract number as selected. 
Start Date Effective date of the selected contract. 
Name Producer(s) associated to the contract with shares greater than 

zero. 
 
Note: Entity members will be also be displayed when applicable 

reductions exist. 
Share Amount Producer payment share amount.  
Amount Payable Net payment amount after reductions. 
Reduction Reason Reason the payment was reduced. 

 
343-352 (Reserved) 
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Par. 353 
Section 7    Common Payment Report 

 
353 Common Payment Report in CRP  
 

A Displaying or Printing CRP Payment Reports 
 

CRP Payment Reports are available to provide information about each payment or 
nonpayment.  Most of the payment reports have information that is common between 
program areas; therefore, information about these reports is in 9-CM.  The CRP Payment 
History Report – Detail has program-specific data; therefore, information for this report is in 
this handbook. 
 
The following table provides CRP Payment Report information. 

 
Report Name Type of Data Reference 

Prepayment Report Live 9-CM, paragraph 71  
Submitted Payments Report Live 9-CM, paragraph 63 
Submitted Overpayments Report Live 9-CM, paragraph 64 
Pending Overpayment Report 
 
Note:  The Pending Overpayment 

Report is accessed through 
the Pending Overpayment 
Summary Report according 
to 9-CM, paragraph 64.5. 

Live 9-CM, paragraph 65 

Nonpayment/Reduction Report Report Database 9-CM, paragraph 66 
Insufficient Funds Report Live 9-CM, paragraph 67 
Payment History Report – Summary Report Database 9-CM, paragraph 69 
Payment History Report – Detail Report Database 9-CM, paragraph 70 

 
Note: See 9-CM, paragraph 52 for complete instructions on accessing the Common 

Payment Report System. 
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Par. 354 
354 Payment History Report - Detail 
 

A Background 
 

The Payment History Report – Detail provides detailed information about a CRP payment. 
 

B Field Descriptions  
 

The following table provides the field descriptions for the Payment History Report – Detail. 
 

Field Description 
Program Year Program year selected by the user. 
Program Name Conservation Reserve Program. 
State Full name of the State selected by the user. 
County Full name of the county selected by the user. 
Producer Name Name from SCIMS as follows: 

 
• for individuals: last name, middle name, first name, and suffix 
• for businesses: business name. 

Date (Report) Date the report is generated by the user. 
Date (Payment) Date the payment was processed and sent to NPS or the date the 

overpayment transaction was processed and sent to NRRS. 
State/County State and county code associated with the applicable transaction record. 
Payment 
Entity/Member 
Name 

Will provide payment entity or member name information if the CRP 
Payment History Report – Detail is generated for: 
 
• an entity or joint operation where amounts were attributed to members 
 
• a member to show the payment entity through whom the amount was 

attributed. 
Payment ID 
Number 

Unique number that ties the program history data to the NPS history data. 

Business Type Business type of the producer and/or member. 
Type of 
Transaction 

One of the following transaction types will be displayed: 
 
• Payment 
• Receivable 
• Canceled Payment 
• Canceled Receivable. 

Member Level 
Reduction 
Amount 

Reduction amount because of a member level reduction. 

Reduction 
Amount 

Reduction amount because of a subsidiary eligibility value, AGI, or 
compliance.  

Net Payment 
Amount 

Net payment amount for the producer after all reductions have been 
applied. 
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Par. 354 
354 Payment History Report – Detail (Continued) 
 

C Example of Payment History Report – Detail 
 

The following is an example of the Payment History Report – Detail for CRP annual rental. 
 

 
 
D Report Options 
 

The following table provides the options and descriptions for the Payment History Report – 
Detail.  
 
Option Description 
Previous The previous Payment History Report – Detail will be displayed. 

 
Note: If a single producer was selected for processing, this button will not 

be available. 
Print The Payment History Report – Detail will be sent to the applicable printer. 
Next The Payment History Report – Detail for the next producer will be displayed. 

 
Note: If a single producer was selected for processing, this button will not 

be available. 
 

 
355-364 (Reserved) 
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Par. 365 
Section 8    Recording Reductions 

 
365 Reduction – Record Reduction 
 

A Background 
 

The Record Reduction option allows State or county users to record reduction amounts that 
will be deducted from a producer’s CRP annual rental payment. 
 
Notes: The Add Reduction option can be used multiple times if more than one reduction 

reason applies to a single contract or producer. 
  

If more than one producer is associated to the contract the user can select one or 
more producers to record a reduction. 

 
If the recorded reduction amount is entered before the annual rental payment is 
issued (signed in NPS), the reduction amount will be deducted from the 
applicable CRP contract/producer annual rental payment for the selected payment 
year. 
 
If a reduction amount is entered for the current year or previous years after the 
annual rental payment is issued (signed in NPS) an overpayment will appear on 
the pending overpayment report. Please refer to Handbook 9-CM for information 
on the pending overpayment report. 
 
Adjustments to reduction amounts after annual rental payments have been signed 
will result in under or over payments. 
 
Total reduction amounts for a contract can never be greater than the contract 
payment. 
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Par. 366 
366 Record Reduction Screen 
 

A Overview 
 

The Record Reduction Screen provides the ability for a user to select a contract to record a 
reduction.   
 

B Example of Record Reduction Screen 
 

The following is an example of the Record Reduction Screen. 
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Par. 366 
366 Record Reduction Screen (Continued) 

 
C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Record Reduction 
Screen. 
 

Field/Button Description Action 
Program Name   Program as selected. Select “CRP”. 
Payment Year Payment year as selected.  
State State as selected. Use the drop-down to select the 

correct State. 
 
Note: Users will only see 

States linked to their 
EAS profile. 

County County as selected. Use the drop-down to select the 
correct county. 
 
Note: Users will only see 

counties linked to their 
EAS profile. 

Contract Number Contract number as selected. 
 
 

Enter the CRP contract number.  
 
Note: This is an optional field.  

Leaving this field blank 
will display all contracts 
available for the county. 

Payment Type Payment type as selected. Select “Annual”. 
Producer Name/ 
SCIMS Search 

The SCIMS search button can be 
used to select a producer and 
display all contracts associated to 
that producer. 

CLICK “SCIMS Search”. 

Clear The clear button will clear the 
producer name field. 

CLICK “Clear”. 

Search Contract Selection Screen will be 
displayed. 

CLICK “Search”. 
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Par. 367 
367 Record Reduction – Contract Selection Screen 
 

A Overview 
 

The Record Reduction – Contract Selection Screen provides the ability for the user to 
confirm contract selection to record a reduction. 
 

B Example of Record Reduction - Contract Selection Screen 
 

The following is an example of the Record Reduction – Contract Selection Screen. 
 

 
C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Record Reduction – 
Contract Selection Screen. 
 

Field/Button Description Action 
Program Program as selected.  
State  State and State code as selected.  
County County and county code as 

selected 
 

Payment Type Payment type as selected.  
Payment Year Payment year as selected.  
Contract Number Contract number as selected.  
Contract Effective Date Effective date of the selected 

contract.  
 

Farm Number Farm number associated with 
the contract. 

 

Tract Number Tract number associated with 
the contract.  

 

Continue Displays the Record Reduction 
Producer Screen. 

After clicking the radio 
button for the applicable 
contract number, CLICK 
“Continue”.  
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Par. 368 
368 Record Reduction – Producer Selection Screen 
 

A Overview 
 

The Record Reduction – Producer Selection Screen provides the ability for the user to 
select the producer to record a reduction. 
 

B Example of Record Reduction – Producer Selection Screen 
 

The following is an example of the Record Reduction – Producer Selection Screen. 
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Par. 368 
368 Record Reduction – Producer Selection Screen 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Record Reduction –
Producer Selection Screen. 
 

Field/Button Description Action 
Contract Number Contract number as selected.  
Start Date Start date of the contract.  
Program Year Program year of contract  
Farm Number Farm number associated with 

the contract. 
 

Tract Number Tract number associated with 
the contract.  

 

Payment Amount Producer payment amount.  
Producer Name Producer for which reduction is 

being recorded.   
 

Reduction Amount Current reduction amount.  
Add Add Reduction Screen is 

displayed.  
Select “Add Reduction” if 
an additional reduction is 
needed.  

Return to List Returns user to the previous 
page.  

CLICK “Return to List”.   
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Par. 369 
369 Record Reduction – Add Reduction Screen 
 

A Overview  
 

The Record Reduction – Add Reduction Screen provides the ability for the user to add a 
reduction for the selected contract and producer. 
 

B Example of Record Reduction – Add Reduction Screen 
 

The following is an example of the Record Reduction – Add Reduction Screen. 
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Par. 369 
369 Record Reduction – Add Reduction Screen (Continued) 
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Record Reduction – 
Add Reduction Screen. 

 
Field/Button Description Action 

Contract Number Contract number as selected.  
Start Date Start date of the contract.  
Program Year Program year of contract  
Farm Number Farm number associated with 

the contract. 
 

Tract Number Tract number associated with 
the contract. 

 

Payment Amount Producer payment amount.  
Producer Name Producer for which reduction is 

being recorded.   
 

Add Reduction Add Reduction Amount Screen 
is displayed. 

CLICK “Add Reduction”. 

Back  Returns user to the previous 
screen. 

CLICK “Back”. 
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Par. 370 
370 Record Reduction – Add Reduction Amount Screen 
 

A Overview  
 

The Record Reduction – Add Reduction Amount Screen provides the ability for the user to 
add a reduction amount and choose the reason for the reduction. 
 

B Example of Record Reduction – Add Reduction Amount Screen 
 

The following is an example of the Record Reduction – Add Reduction Amount Screen. 
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Par. 370 
370 Record Reduction – Add Reduction Amount Screen (Continued)  
 

C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Record Reduction – 
Add Reduction Amount Screen. 
 

Field/Button Description Action 
Contract Number Contract number as selected.  
Start Date Start date of the contract.  
Program Year Program year of contract  
Farm Number Farm number associated with the 

contract. 
 

Tract Number Tract number associated with the 
contract. 

 

Payment Amount CRP annual rental payment 
amount. 

 

Contract Number CRP contract number.   
Producer Name Producer for which reduction is 

being recorded.   
 

Add Reduction Add a reduction. CLICK “Add Reduction” 
Back Displays the Search Selection 

Screen for the producer and 
contract. 

CLICK “Back”. 

Reduction Description Reason for reduction. 
 

Select the correct reason for 
the payment reduction from 
the drop-down. 

Amount Reduction amount. Enter the reduction amount in 
whole dollars.  Amount can 
never be greater than the 
contract payment amount. 

Add Allows reduction, description, and 
amount to be updated.   

CLICK “Add”. 

Delete Deletes reduction.  CLICK “Delete”. 
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Par. 371 
371 Record Reduction – Edit Reduction Amount Screen  
 

A Overview  
 

The Record Reduction – Edit Reduction Amount Screen provides ability for the user to edit 
the recorded reduction information for a producer.  

 
B Example of Record Reduction – Edit Reduction Amount Screen 
 

The following is an example of the Record Reduction – Edit Reduction Amount Screen. 
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Par. 371 
371 Record Reduction – Edit Reduction Amount Screen (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Record Reduction – 
Edit Reduction Amount Screen. 
 

Field/Button Description Action 
Contract Number Contract number as entered.  
Start Date Start date of the contract.  
Program Year Program year of contract.  
Farm Number Farm number associated with 

the contract. 
 

Tract Number Tract number associated with 
the contract. 

 

Producer Name Producer for which reduction 
was recorded. 

 

Payment Amount Producer payment amount.  
Reduction Amount Reduction amount entered. 

 
Note: This amount will be 

deducted from the annual 
rental payment.   

 

Edit Add Reduction Amount Screen 
is displayed for updating or 
deleting the reduction amount. 

CLICK “Edit”. 

Return to List  Search Selection Screen is 
displayed for the producer and 
contract.  

CLICK “Return to List”. 

 
372-381 (Reserved) 
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Par. 382 
Section 9    Modifying Recorded Reduction Data 

 
382 Modifying or Deleting Previously Recorded Reduction Data 
 

A Overview  
 

Previously entered payment amounts can be modified or deleted from the Record Reduction 
Menu using the “Update, Edit, or Delete” options. 

 
B Effect on Previously Processed Payments 
 

Modifying or deleting previously recorded payment amounts impacts previously processed 
payments in different ways depending on whether the original payment was sent to NPS and 
certified and signed.  This table provides how a previously recorded payment is affected 
when the amounts are modified or deleted. 
 

 
IF previously 
recorded 
payment 
amounts 
are… 

AND 
previously 
recorded 
payment 
amounts 
were… 

 
 
 
 
AND the payment 
in NPS was… 

 
 
 
 
 
THEN the… 

modified sent to 
NPS 

certified and signed system will retrigger the payment to 
reprocess to determine whether the 
producer is overpaid or underpaid.  A 
transaction will be sent to NPS or the 
Pending Overpayment Report, as 
applicable. 

either not certified 
or certified, but not 
signed 

• original amount in NPS will be 
canceled and the system will retrigger 
the payment to reprocess 

 
• new payment amount will be listed in 

NPS for certification and signature, 
provided all eligibility requirements 
are met. 
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Par. 382 
382 Modifying or Deleting Previously Recorded Reduction Data (Continued) 
 

B Effect on Previously Processed Payments (Continued) 
 

 
IF previously 
recorded 
payment 
amounts 
are… 

AND 
previously 
recorded 
payment 
amounts 
were… 

 
 
 
 
AND the payment 
in NPS was… 

 
 
 
 
 
THEN the… 

deleted sent to 
NPS 

certified and signed system will retrigger the payment to 
reprocess to determine the overpayment 
amount for the producer.  A transaction 
will be sent to the Pending Overpayment 
Report. 

either not certified 
or certified, but not 
signed 

original amount in NPS will be canceled. 

 
383-392 (Reserved) 
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Par. 393 
Section 10    Update AGI – State Office User Functionality 

 
393 Update AGI 
 

A Overview 
 

For program year 2012 and prior program year CRP contracts, at initial COC approval in 
COLS and at COC revision approval in CCMS (for newly added producers), the AGI value 
recorded in Subsidiary for the producer(s) on the CRP contract, is stored by the Conservation 
Payments system.  This value, compliant or non-compliant remains for the life of the CRP 
contract. The Update AGI Option in Conservation Payments is available to the State Office 
user. This option is available to override the stored AGI value.  State Office specialists must 
not use the “Update AGI” option to modify AGI that was correctly recorded. After verifying 
the producer’s correct AGI at contract approval, the State Office will select the “Update 
AGI” option to correct stored AGI data. 
 

 *--For program year 2013 and greater CRP and TIP contracts, AGI determinations are not--* 
stored by the Conservation Payments system, but the values are obtained from the Subsidiary 
Eligibility system in real time. The AGI obtained is based on the producer subsidiary year 
and AGI threshold displayed on the CRP contract in the Conservation Contract Maintenance 
System (CCMS). 
 
Note: The Update AGI process: 
 

 does not impact the eligibility files in the subsidiary 
 is available for State and National users 
 is only available for program year 2012 and prior program year contracts. 

 
B Example of Update AGI Screen 

 
The following is an example of the Update AGI Screen. 
 

 
 
 
 
 
 
8-10-20     5-CRP Amend. 4 Page 5-321 



Par. 393 
393 Update AGI (Continued) 
 

C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Update AGI Screen. 
 

Field/Button Description Action 
Program Name Program name as selected.  Select “CRP.” 
State State as selected. 

 
Note: Users will only see 

States linked to their 
EAS profile.   

 

County County as selected. 
 
Note: Users will only see 

counties linked to their 
EAS profile.   

 

Contract Number *--CRP or TIP contract--* 
number as entered. 
 
* * *  

 

Searc Contract Selection Screen will 
be displayed.  

CLICK “Search”. 
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Par. 394 
394 Update AGI – Contract Selection Screen  
 

A Overview  
 

The Update AGI – Contract Selection Screen provides the ability for the State Office user to 
select a contract to modify the AGI value. 
 

B Example of the Update AGI – Contract Selection Screen 
 

The following is an example of the Update AGI – Contract Selection Screen. 
 

 
 
C Field Descriptions 
 
 The following table provides the field descriptions for the Update AGI – Contract Selection 

Screen. 
 

Field/Button Description 
Program Program as selected. 
State State and State code. 
County County and county code. 
Contract Number Contract number as selected. 
Contract Effective Date Effective date of the selected contract. 
Farm Number Farm number associated with the contract. 
Tract Number Tract number associated with the contract. 
Modify AGI Information Update AGI Producer Selection Screen will be displayed 
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Par. 395 
395 Update AGI – Producer Selection Screen  
 

A Overview  
 

The Update AGI – Producer Selection Screen allows the user to choose the contract producer 
to update the AGI. 
 

B Example of Update AGI-Producer Selection Screen  
 
 The following is an example of the Update AGI – Producer Selection Screen. 
 

 
 
  C Field Descriptions and Actions 
 
   The following table provides the field descriptions and actions  for the Update AGI – 

Producer Screen. 
 

Field/Button Description Action 
State State Name.  
County County Name.  
Contract Number Contract Number as selected.  
Producer/Member  All producers/members associated 

to the contract will be displayed.  . 
Click the producer or member 
name to update the system 
stored AGI value. 

Open All or ‘+’ Displays members of entities  
Close All or ‘-‘ Hides members of entities  
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Par. 396 
396 Update AGI – Compliance Indicator Screen  
 
  A Overview  
 
   The Update AGI-Compliance Indicator Screen provides the user with the ability to update 

the AGI to compliant or non-compliant. 
 
  B Example of Update AGI – Compliance Indicator Screen 
 
   The following is an example of the Update AGI – Compliance Indicator Screen. 
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Par. 396 
396 Update AGI – Compliance Indicator Screen (Continued) 
 
  C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Update AGI – 
Compliance Indicator Screen. 
 

Field/Button Description Action 
State State Name.  
County County Name.  
Contract Number Contract Number as selected.  
Producer/Member  All producers/members associated 

to the contract will be displayed.  . 
Click the producer or member 
name to update the system 
stored AGI value. 

Open All or ‘+’ Displays members of entities  
Close All or ‘-‘ Hides members of entities  
Customer Name Producer selected.  
Check if AGI 
Compliant 

The check () in the box indicates 
the producer is AGI compliant.  
An empty box indicates the 
producer is not AGI compliant. 
The State Office user has the 
option to enter the check for 
compliant or remove the check for 
non-compliance. 
 
Note: Because AGI is at contract 

approval, when updating 
an AGI for a producer, the 
AGI must be updated back 
to the first contract in the 
family to which the 
producer was added.  In 
subparagraph B contract 
205A was updated. If the 
producer was originally 
added to contract 205, the 
AGI will need to be 
updated for 205 and 205A . 

Enter check () for compliant 
or remove the check () for 
non-compliant. 

Submit Submits AGI update. CLICK “Submit”. 
Cancel Previous Update AGI Screen is 

displayed.   
CLICK “Cancel”. 

 
 
 
 
 
 
 
5-15-19    5-CRP Amend. 1 Page 5-326  



Par. 397 
397 Update AGI – Confirmation Screen  
 
  A Overview 
 

The Update AGI – Confirmation Screen displays the message “AGI Information Updated 
Successfully for XXXX”.  The CCID is also displayed for the producer. 
 

  B Example of the Update AGI – Confirmation Screen 
 

The following is an example of the Update AGI – Confirmation Screen. 
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Par. 398 
398 Update AGI – Option Not Available Screen  
 
  A Overview 
 

The Update AGI – Option Not Available Screen displays the message “This option is not 
 *--available for CRP or TIP contracts with a program year greater than 2012”.  This message 

will be displayed when a program year 2013 or greater program year CRP or TIP contract is 
selected.  AGI for program year 2013 and subsequent program year CRP and TIP contracts 
are not stored by conservation payments but is obtained from subsidiary eligibility system--* 
in real time. 
 

B Example of AGI Update – Option Not Available Screen  
 

The following is an example of the AGI Update – Option Not Available Screen. 
 

 
 
399-408 (Reserved) 
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Par. 409 
Section 11    Load AGI – State Office User Functionality 

 
409 Load AGI 
 

A Overview 
 

The Load AGI process is available to State Office users.  The State Office must select the 
“Load AGI” option for instances where the AGI structure is not correct under the “Update 
AGI” option.  The Conservation Payments System will call the AGI service to obtain the data 
that was entered in the Business File for the producer for the year selected. 
 
Notes: Load AGI is only available for program year 2012 and prior program year contracts.  
 

For program year 2013 and subsequent program year contracts the AGI structure is 
 *--obtained from the producer information provided on the CRP or TIP contract in--* 

CCMS. 
 

B Example of Load AGI Screen 
 

The following is an example of the Load AGI Screen. 
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Par. 409 
409 Load AGI (Continued) 
 
  C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Loan AGI Screen.   
 

Field/Button Description Action  
Program Name   Program name as selected. Select “CRP”. 
State State as selected. 

 
Use the drop-down to select the 
appropriate State. 
 
Note: Users will only see States 

linked to their EAS 
profile. 

County County as selected.  Use the drop-down to select the 
appropriate county. 
 
Note: Users will only see 

counties linked to their 
EAS profile. 

Payment year Payment year as selected. Use the drop-down to select the 
appropriate payment year.  

Contract Number Producer’s * * * contract number. Manually enter the * * * contract 
number.   

Submit Query Load AGI Confirmation Screen is 
displayed. 

CLICK “Submit Query”. 
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Par. 410 
410 Load AGI – Confirmation Screen 
 
  A Overview  
 

The Lad AGI – Confirmation Screen will display the producer’s CCID and the message 
“AGI loaded successfully for fiscal year XXXX”.  
 

B Example of Load AGI – Confirmation Screen 
 

The following is an example of the Load AGI – Confirmation Screen. 
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Par. 411 
411 Load AGI – Option Not Available Screen 
 
  A Overview  
 

The Load AGI – Option Not Available Screen will display the message “This option is not 
 *--available for CRP or TIP contracts with a program year greater than 2012”.  This message--* 

will be displayed when a 2013 or subsequent program year contract is selected.  
 
For program year 2013 and subsequent program year contracts the AGI structure is obtained 
from the producer information provided on the CRP contract in CCMS) 
 

  B Example of Load AGI-Option Not Available Screen 
 

The following is an example of the Load-AGI – Option Not Available Screen. 
 

 
 
412-421 (Reserved) 
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Par. 422 
Section 12    Obligations – State Office User Functionality 

 
422 Obligate Payment 
 

A Overview 
 

 *--CRP and TIP contract payments are obligated by batch runs processed by Kansas City on--* 
a periodic basis.  “The ‘Obligate Payment” option is needed on occasion to manually obligate 
any contract that may not get obligated by the KC batch process.  This can occur if a contact 
is not in an approved status when the batch obligation process is run.  It can also occur when 
a contract start date is changed to a prior program year.  In such cases the Obligate Payment 
option is available for State Office users to manually obligate the contact. 

 
  B Example of the Obligate Payment Screen 
 

The following is an example of the Obligate Payment Screen. 
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Par. 422 
422 Obligate Payment (Continued) 
 
  C Field Descriptions and Actions  
 

The following table provides the field descriptions and actions for the Obligate Payment 
Screen. 
 

Field/Button Description Action 
Program Name   Program name as selected. Select “CRP”. 
Payment year Payment year as selected. Use the drop-down to select 

the appropriate payment year. 
State State as selected. 

 
 

Use the drop-down to select 
the appropriate State. 
 
Note: Users will only see 

States linked to their 
EAS profile. 

County County as selected.  
 

Use the drop-down to select 
the appropriate county. 
 
Note: Users will only see 

counties linked to their 
EAS profile. 

Contract Number  *--Producer’s CRP or TIP 
contract number. 
 
Note: This is an optional field.  

Leaving this field blank 
will display all the contract 
available for the county.   

Manually enter the CRP 
or TIP contract number.--* 
 
 

Payment Type Payment type as selected.   Select “Annual” or 
*--“TIP”.--*   

Search Contract Selection Screen will be 
displayed. 

CLICK “Search”.   
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Par. 423 
423 Obligate Payment – Contract Selection Screen  
 

A Overview 
 

The Obligate Payment – Contract Selection Screen provides users the ability to select the 
contract for manual obligation. 
 

B Example of Obligate Payment - Contract Selection Screen 
 

The following is an example of the Obligate Payment - Contract Selection Screen. 
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Par. 423 
423 Obligate Payment – Contract Selection Screen (Continued) 
 
  C Field Descriptions and Actions (Continued) 
 

The following table provides field descriptions and actions for the Obligate Payment – 
Contract Selection Screen.   
 

Field/Button Description  Action  
Program Program as selected.  
State State as selected and State code.  
County County as selected and county code.  
Payment Type Payment Type as selected.  
Payment Year  Payment Year as selected.  
Contract 
Number 

* * * Contract number. Click radio button of desired 
contract number to select. 

Continue The Obligated Amount Screen will 
be displayed. 

After clicking the radio button 
for the applicable contract 
number, CLICK “Continue”.   

Reset Clears the selected * * * contract. CLICK “Reset”.  
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Par. 424 
424 Obligate Payment – Submit for Obligation Screen  
 

A Overview 
 

The Obligate Payment – Submit for Obligation Screen provides users with the ability to 
submit the contract to be obligated. 
 

B Example of Obligate Payment - Submit for Obligation Screen 
 

The following is an example of an Obligate Payment Submit for Obligation Screen. 
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Par. 424 
424 Obligate Payment – Submit for Obligation Screen (Continued) 
 
  C Field Descriptions and Actions 
 

The following table provides the field descriptions and actions for the Obligate Payment – 
Submit for Obligation Screen.   
 

Field/Button Description Action 
Contract Number Contract Number as entered.  
Start Date Start date of the contract.  
Program Year Program year of the contract.  
Farm Number Farm number associated with 

the contract. 
 

Tract Number Tract number associated with 
the contract.  

 

Payment Amount Annual rental payment amount 
for the contract. 

 

Obligated Program 
Year 

Obligated program year will 
normally default to ‘N/A’ 
when the payment is not 
obligated. 

 

Obligated Amount Obligated amount will 
normally default to ‘0’ when 
the payment is not obligated. 

 

Obligation Adjustment 
Amount 

Obligation adjustment amount 
will normally equal the 
payment amount. 

 

Submit The Obligation Confirmation 
Screen will be displayed. 

CLICK “Submit” to obligate 
the payment. 

Return to List Returns to the previous screen 
and will not obligate the 
payment. 

CLICK “Return to List”. 
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Par. 425 
425 Obligate Payment – Confirmation Screen  
 

A Overview 
 

The Obligate Payment – Confirmation Screen will display the message “Obligated 
successfully” .  The Obligated Program Year now displays the year and the Obligated 
Amount and Obligated Adjustment Amount have both been updated. 
 

B Example of Obligate Payment - Confirmation Screen 
 

The following is an example of the Obligate Payment - Confirmation Screen. 
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Par. 426 
426 Obligate Payment – Failure Screen 
 

A Overview 
 

The Obligate Payment - Failure Screen provides the message “Contract obligation has 
failed. Reason: Duplicated obligation request. No obligation to be established” indicting 
that contract is already obligated.  The obligation is already reflecting the correct Obligated 
Amount. 
 

B Example of Obligate Payment - Failure Screen 
 

The following is an example of the Obligate Payment - Failure Screen. 
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Exhibit 1 
Reports, Forms, Abbreviations, and Redelegations of Authority 
 

Reports 
 
None. 
 

Forms 
 
The following lists all forms referenced in this handbook. 
 

Number Title 
Display 

Reference Reference 
AD-1026 Highly Erodible Land Conservation (HELC) 

and Wetland Conservation (WC) 
Certification 

 250, 251, 254 

CCC-36 Assignment of Payment  254 
CCC-37 Joint Payment Authorization  254 
CCC-505 Voluntary Permanent Base Acres Reduction  28, 39 
CCC-526 Payment Eligibility Average Adjusted Gross 

Income Certification   
 250, 254 

CCC-902 Farm Operating Plan for Payment Eligibility 
2009 and Subsequent Payment Years 

 250, 254 

CCC-931 Average Adjusted Gross Income (AGI) 
Certification and Consent to Disclosure of 
Tax Information. 

 250, 254 

CCC-941 Average Adjusted Gross Income (AGI) 
Certification and Consent to Disclosure of 
Tax Information 

 250, 254 

CRP-1 Conservation Reserve Program Contract  Text 
CRP-1R Conservation Reserve Program Transition 

Incentives Program Contract 
 151, 152, 155 

CRP-41 Conservation Reserve Program Early 
Termination Contract 

 10, 65, 68 

FSA-13-A System Access Request Form  126 
FSA-325 Application for Payment of Amounts Due 

Persons Who Have Died, Disappeared, or 
Have Been Declared Incompetent. 

 250 

FSA-848B Cost Share Performance Certification and 
Payment (Includes FSA-848B-1, 
Continuation of FSA-848B) 

 282 
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Exhibit 1 
Reports, Forms, Abbreviations, and Redelegations of Authority (Continued) 

 
Abbreviations Not Listed in 1-CM 

 
The following lists approved abbreviations not listed in 1-CM. 
 

Approved 
Abbreviation Term Reference 

BIP Honey Bee Incentive Payment  282 
CBIP Chesapeake Bay Incentive Payment 282 
CCID Core Customer ID  397, 410 
COLS Conservation Online System Text 
CCMS Conservation Contract Maintenance System Text 
CPR Common Payment Reports 253, 297, 307, 311, 422 
EAS Extensible Authorization System  Text  
FCI Federal Crop Insurance 251 
FRS Farm Records System  Text 

FWADM Financial Web Application Data Mart  322, 337 
FWP Farmable Wetlands Pilot Program 30, 31, 84, 85 
PIP Practice Incentive Payment  282, 284, 297, 322, 323, 

337 
SIP Signup Incentive Payment 6, 282, 284, 322, 323, 337  
TIP Transition Incentive Payment Text 
TTI Tree Thinning Incentive 282, 284 

TERRA Tool for Environmental Resource Results 
Assessment 

Text 

 
Redelegations of Authority 

 
None 
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Exhibit 2 
Definitions of Terms Used in This Handbook 

 
Approved Status  
 

Approved status means the CRP contract is active in CCMS and the current date is between 
effective start date and contract end date as recorded on CCMS. 

 
  *--Beginning Farmer or Rancher 
 

A beginning farmer or rancher is, as determined by CCC, a person or entity who: 
 

• has not been a farm or ranch operator or owner for more than 10 consecutive years 
 

• materially and substantially participates in the operation of the farm or ranch involved in 
the CRP contract modification 

 
• if an entity, is an entity in which 50 percent of the members or stockholders of the 

entity meets the first 2 requirement of this definition.--* 
 
CRP Contract or CRP-1 
 

CRP contract or CRP-1 means the approved agreement, including the approved conservation 
plan, that: 
 

• is entered into, in writing, between COC and the participant 
• sets forth the terms and conditions for participation in CRP. 

 
  *--SDA Farmer or Rancher 
 

An SDA farmer or rancher means a farmer or rancher who is a member of an SDA group whose 
members have been subjected to racial or ethnic prejudice because of their identity as members or 
a group without regard to their individual qualities.  Gender is not included as a covered group.  
SDA groups include the following and no others unless approved in writing by the Deputy 
Administrator, Farm Programs: 
 
• American Indians or Alaskan Natives 
• Asians or Asian-Americans 
• Blacks or African Americans 
• Hispanics 
• Native Hawaiians or other Pacific Islanders.--* 

 
User 

 
User means county FSA employees with level II eAauthentication access and State Office 
administrative users, except where specifically noted.  
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Exhibit 3 
Menu and Screen Index 

 
The following menus and screens are displayed in this handbook. 
 

Menu or 
Screen Title Reference 

 Add Practice CLU Screen 14 
 Add Practice Screen 31, 85 
 Adjust Acreage Screen 28, 82, 153 
 Adjust Re-Enrolled Acreage Screen 17, 28.5, 82.5 
 Cancel Division Screen 89 
 Cancel Payment Screen 308 
 Cancel Payment Confirmation Screen 311 
 Cancel Payment – Contract Selection Screen 309 
 Cancel Payment – Producer Selection Screen 310 
 Cancel Revision Confirmation Screen 33 
 Cancel TIP Enrollment 156 
 Cancel TIP Enrollment Confirmation Screen 156 
 Cancel Transfer Confirmation Screen 53 
 CCMS Home Page 7 
 COC Approval Screen 34, 88, 157 
 COC Approve Early Out Screen 69 
 Conservation Payments Main Menu Screen 271 
 Contract Family Producer Subsidiary Year Screen 16 
 Contract Farm Number by Year Screen 15 
 Correct Original End Date Screen 128 
 Correct Revised Contract Start Date Screen 127 
 Correct Termination Date Screen 129 
 Correct Tract/CLU Screen 11 
 Divide Contract Screen 80 
 Finalize Screen 32, 51, 86 
 Finalize Child Contract Screen 86 
 Finalize Early Out Screen 68 
 Finalize TIP Contract 155 
 Finalize TIP Screen 155 
 Initiate TIP Enrollment Screen 152 
 Load AGI Screen 409 
 Load AGI – Confirmation Screen 410 
 Load AGI – Option Not Available Screen 411 
 Make NPS Payment Screen 283, 284 
 Make NPS Payment – Confirmation Screen 286 
 Makes NPS Payment – PIP Exception Screens 287 
 Make NPS Payment – Producer Screen 285 
 Modify Practices Screen 30, 84 
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Exhibit 3 

Menu and Screen Index (Continued) 
 

Menu or 
Screen Title Reference 

 Modify Producers Screen 29, 83, 154 
 Modify Farm and Tract Screen 27, 81 
 Modify the Notification sent date Screen 64 
 One-Year Extension Screen 65 
 Obligate Payment Screen 422 
 Obligate Payment – Confirmation Screen 425 
 Obligate Payment – Contract Selection Screen 423 
 Obligate Payment – Failure Screen 426 
 Obligate Payment – Submit for Obligation Screen 424 
 Payment Report Screen 337 
 Predecessor – Successor Division(s) of Payment Agreement Screen 37 
 Propose Early Out Screen 67 
 Record Reduction Screen 366 
 Record Reduction – Add Reduction Screen 369 
 Record Reduction – Add Reduction Amount Screen 370 
 Record Reduction – Contract Selection Screen 367 
 Record Reduction – Edit Reduction Amount Screen 371 
 Record Reduction – Producer Selection Screen 368 
 Reinstate Contract Screen 39 
 Revise Acreage CLU Screen 12 
 Revise Practice CLU Screen 13 
 Revise Rates Screen 36 
 Review Correct Original End Date Screen 128 
 Search Contract Screen 8 
 Select Contract Screen 9 
 Start Contract Revision Screen 26 
 Start Rates Revision Screen 35 
 Terminate Contract Screen 30 
 TIP COC Approve 157 
 TIP Initiate Enrollment 152 
 TIP Modify Acreage 153 
 TIP Modify Producer 154 
 Transfer Contract Screen 38 
 Update AGI Screen 393 
 Update AGI – Confirmation Screen 397 
 Update AGI – Compliance Indicator Screen 396 
 Update AGI – Contract Selection Screen 394 
 Update AGI – Producer Selection Screen 395 
 Update AGI – Option Not Available Screen 398 
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Exhibit 3 

Menu and Screen Index (Continued) 
 

Menu or 
Screen Title Reference 

 View Contract Screen 10 
 View Payment Screen 323 
 View Payment – Producer Screen 325 
 View Payment – Contract Selection Screen 324 
 View Payment – No Payment Information Available Screen 326 
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